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Getting Started
This chapter provides information on the basics of using Axiom Cost Accounting, such as:

l General system navigation and user interface
l Managing favorites
l Launching Axiom software applications
l Viewing system information

Welcome to Axiom Cost Accounting
Axiom Cost Accounting plays an important role in the financial management of healthcare organizations
by providing cost information for activities, supplies, and services at the patient or encounter level. The
benefits of cost accounting information and its application in health service organizations are numerous
and may include:

l Identification of high cost activities for improved cost management.
l Identification of low or negativemargin services for improved service linemanagement.
l Identification of patient care cost variations across services, populations, and providers for

improved caremanagement.
l Evaluation of fixed and variable costs as they relate to products and services for informing

decisions about pricing.
l Identification of key trends in patient, encounter, and activity costs for improved management

decisions.
l Cost information by payer and insurance plans for improved managed care and contract

management decisions.

Axiom Cost Accounting contains all the necessary tools to record, track, and report costs incurred by an
organization to aid management in decision support. These tools include the ability to:

l Copy or load cost information from a variety of sources such as General Ledgers, payroll, supply
masters, and so on.

l Load encounter information, including detailed activity or chargeable items.

l Summarize encounter level activities to calculate volumes by posting and service dates.

1
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l Adjust and reclass the cost information in a flexible and easy manner, while retaining the ability to
reconcile the reclassifications and keep track of the original data.

l Allocate overhead to direct patient care departments for full-absorption costing and reconcile the
allocations.

l Define cost behavior in terms of fixed, variable, or semi-variable costs at the account, department,
and entity level by cost category.

l Develop activity unit costs using multiple methods within the same department. Thesemethods
includeMicrocosts, ReverseMarkup, Relative Value Units (RVUs), Ratio of Cost to Charges (RCCs),
and Relative Cost Units (RCUs).

l Apply unit costs to patient activities and to encounters for reporting by various dimensions, which
include entities, patient types, service lines, providers, payers and insurance plans, diagnosis,
procedures, DRG, and so on.

What's new
Welcome to Axiom Cost Accounting 2019.4!

Enhancements in this release include:

l Set custom run order for reclass definitions - Axiom Cost Accounting now processes reclass
definitions in the order you define. You can also group order definitions by method type - Payroll,
Account, and Department - by using the newReorder by Reclass Method button at the top of the
page. Even if you decide to group definitions, you can still edit the order of the definitions within
each group.

l Activate or deactivate definitions - Instead of deleting reclass or overhead allocation definitions,
you can now simply deactivate and activate them as needed. Users can perform these actions
from the definition list view page or the add/edit definition dialog. Hide or display the deactivated
definitions in the list of definitions by clicking the Show only active definitions check box at the
top of the list page.

l Add new allocation button - The top of the reclass and overhead allocation definition pages now
include a button that allows users to quickly add new definitions to the system. This adds the new
definition to the bottom of the list of active definitions.

l Manage and review department RVU - Users can now track the status of the RVU review process
for their departments using the newRVUDepartment Status page. People that are outside of your
organization's costing department can be set up by the administrator with the newRVUUser role
profile to allow them to access this page and designated as an owner and/or reviewer.
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Manage and review department RVUs
Users can now track the status of the RVU review process for their departments using the newRVU
Department Status page. People that are outside of your organization's costing department can be set
up by the administrator with the newRVUUser role profile to allow them to access this page and
designated as an owner and/or reviewer.

From the RVUDepartment Status page, owners and reviewers can set the status for each department's
RVU for the RVU version, view the department's RVU values, and view a change history for each
department.

For more information, see the following:

l Setting up RVU users
l Managing department RVU status

Enhancements to reclass and overhead allocation definitions
New enhancements include the following:

l Set custom run order for reclass definitions - Axiom Cost Accounting now processes reclass
definitions in the order you define. You can also group order definitions by method type - Payroll,
Account, and Department - by using the newReorder by Reclass Method button at the top of the
page. Even if you decide to group definitions, you can still edit the order of the definitions within
each group.

For instructions, see Ordering reclass definitions.
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l Activate or deactivate definitions - Instead of deleting reclass or overhead allocation definitions,
you can now simply deactivate and activate them as needed. Users can perform these actions
from the definition list view page or the add/edit definition dialog. Hide or display the deactivated
definitions in the list of definitions by clicking the Show only active definitions check box at the
top of the list page.

For instructions, see Activating or deactivating reclass definitions or Activating or deactivating
overhead allocation definitions.

l Add new allocation button - The top of the reclass and overhead allocation definition pages now
include a button that allows users to quickly add new definitions to the system. This adds the new
definition to the bottom of the list of active definitions.

For instructions, see Adding, editing, or cloning reclass definitions or Adding, editing, or cloning
overhead allocation definitions.

Using Axiom Cost Accounting
Set up and configuration of Axiom Cost Accounting is performed mostly using aWeb Client interface.
From here, you can easily walk through the process of configuring default system settings, managing
data, setting up and processing methods, reclasses, and overhead allocations. You can also manage unit
cost calculations and cost assignments.
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TheWeb Client interface also includes an Checklist View, which offers administrators an easy and
convenient way to manage and track each the tasks required to set up the costing process. You can add,
edit, clone, and delete processes as well as toggle to view different costing processes. The page also
displays the high-level configuration parameters for the current costing process, including the active cost
set as well as themethod and versions being used.

NOTE: TheMethod section only displays thosemethods that have been selected in the System
Configuration page to be used by your organization. The Active Cost Set version comes from the
Method Definition version.
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While you can perform most of the setup and configuration tasks from theWeb Client interface, there
are times when you may need to finer control and more details. TheWindows or Excel Client provides all
of the options provided by theWeb Client interface as well as access to multiple reports. You can also
manage security, processes, and other system administration tasks.

Administrator's Guide 2019.4 Axiom Cost Accounting │ 10



Home page
The home page displays automatically when you log into Axiom Cost Accounting. Depending on your
system, this home pagemay be one of the following:

l A product-specific home page for Axiom Cost Accounting
l A custom home page created specifically for your organization

If you have any questions about your home page, please contact your system administrator.

If you navigate away from the home page, you can return to it by using the Area menu in the Global
Navigation Bar:

If you are in a system with installed products, this menu may contain product names instead of the
Home item. In that case, you can select a product name to return to the home page for that product.

� Default home page
If a user does not have an available web-enabled home page, then the default home page is used. The
default home page displays notifications, favorites, and quick links.
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This page has the following features:
l Notifications: You can read and delete notifications using the same features available in the

Notifications panel.

l Quick Links: You can use a set of global quick links that are displayed here for easy access. These
links are built-in to the page and cannot be customized. However, the link to the Excel Client may
not be present if your system has been configured to hide it.

l Favorites: You can open and delete web favorites.

About the Web Client
TheWeb Client is the browser-based client for Axiom Cost Accounting. TheWeb Client supports cross-
platform distribution of browser-based reports and plan files to end users. It also provides access to
certain administration features for system administrators and other power users.

End users can use theWeb Client to:
l Build and view reports
l Access pre-built reports and plan files

Administrators and power users can use theWeb Client to:
l Perform certain table management activities
l View the audit log for the system
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l Apply software updates and perform other administration activities for the Axiom Application
Server

l Define custom help for browser-based files

TheWeb Client does not require any software installation. The only requirement is a supported browser.
See the separate Technical Requirements document for information on supported browsers for your
version.

The Excel Client and Windows Client are the desktop client options for Axiom Cost Accounting. The
desktop clients provide full support for system setup, administration, and file design. End users can also
use the desktop clients to work with spreadsheet reports and plan files. Both clients can be launched
from the Quick Launch menu of theWeb Client. For more information on using the Excel Client and
Windows Client, see themain Axiom Software Help.

Web Client overview
Most Web Client features and navigation can be accessed using the two bars across the top of each
page:

l Global Navigation Bar: The blue bar at the top of the page provides access to system-level areas
and features.

l Task Bar: The gray bar underneath it provides access to various features that are specific to the
current area, page, or document.

The Global Navigation Bar and the Task Bar are available everywhere in theWeb Client except as follows:
l All areas of the Data Explorer use an older web interface. The Data Explorer has been de-

emphasized in favor of the Report Builder. Although you can still use the Data Explorer, it will not
be further enhanced.
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l Axiom forms that do not have theWeb Client Container enabled. Generally speaking, this would
only be the case for legacy forms that have not yet been migrated to use the newer web interface
that was first introduced in version 2016.1.

� Global Navigation Bar
TheWeb Client Global Navigation Bar provides access to various system-level areas and features. Using
this bar, you can:

l Navigate to home, system administration, and various products (if applicable)
l Launch various client applications
l View alerts and notifications from various system processes and features
l View user information, configure session settings, and log out

� Task Bar
TheWeb Client Task Bar provides access to various features that are specific to the current area, page, or
document. Using this bar, you can:

l Navigate to your browser-based files and related areas of theWeb Client
l Filter the data shown on the current page
l Comment on the current document and review comments from others
l Access tools relating to the current document or area
l Save the current page or document as a favorite
l View help for Axiom Cost Accounting or for the current document
l Perform other context-sensitive tasks such as managing attachments or working with the Report

Builder
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The left-hand side of the task bar contains a task toolbar. You can click on any icon in this toolbar to open
the panel for the associated feature. For example, clicking the filter icon opens the Filters panel. Clicking
the icon again closes the panel.

The panel can be pinned or unpinned using the pin icon in the top right of the panel. If the panel is
unpinned, the panel overlays the current page contents, and clicking on the page closes the panel. If the
panel is pinned open, then the form is pushed to the side so that the panel contents and the form can be
viewed at the same time. When pinned, clicking on the page does not close the panel—you must unpin
the panel or click the toolbar icon again to close the panel.

The contents of the task bar vary depending on the current page or document. For example, the
Message Stream and the Filters panel are only available if they have been enabled for the current
document. If a particular feature is not available for a particular document or area, then either it has not
been enabled or it does not apply.

Navigation panel
Using the Navigation panel, you can navigate to your documents and to various areas of theWeb Client.

To open the Navigation panel, click themenu icon in the left side of the gray task bar. To navigate to an
area or document listed in the panel, click on the item.
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Example Navigation panel

The Navigation panel updates dynamically to show the available navigation links for the currently active
area of theWeb Client. The following areas are available:

Area Description

Default Axiom Cost Accounting provides a set of standard navigation links that show by
default when you are in theWeb Client. The previous screenshot shows the
standard navigation links. These links provide access to your favorites, recent
places, web-enabled reports and forms, and the Report Builder.

Product-Specific Systems with installed products may have product-specific web navigation links.
When you select a product name from the Area menu in the Global
Navigation Bar., the product-specific links display in the Navigation panel. For
more information, see the product-specific documentation.

Additionally, when you open a report or other browser-based document, that document may be
associated with a set of document-specific navigation links. These links are added to the Navigation panel
while you are in that document.

Managing favorites
You can save Axiom files and Web Client pages as favorites, for quick access to commonly used items.
Your favorites list is available in the following locations:

l The Navigation panel
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l The default Web Client home page

Example favorites in Navigation panel

Your favorites list displays any favorites that you have saved in theWeb Client.

� Saving favorites
To save the current document or page as a favorite in theWeb Client, click the star icon in the right side
of the Task Bar. The star icon toggles from outline (not a favorite) to filled (a favorite).

Favorite icon in Web Client task bar

Once a favorite has been saved, it displays in your favorites list in theWeb Client. You can use the saved
favorite to quickly open the document or page.

Web favorites are saved using the name shown in the browser tab. Web reportssupport the ability to
define a title that displays in the browser tab, which means the title may be different than the file name.
If the title is changed after the favorite is saved, the favorite does not update to show the changed title
(however, the favorite still works to open the specified document).
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Currently, theWeb Client does not support the ability to rename or reorder web favorites, or to organize
web favorites into folders. Web favorites display as a flat list, in alphabetical order.

NOTES:
l When favorites are saved in theWeb Client, they are saved as URLs instead of as document

shortcuts. This allows you to save any page in theWeb Client as a favorite, not just
documents.

l If a web favorite points to a document, and that document is later moved or renamed, the
favorite will continue to open that document (but the favorite name is not updated).

� Deleting favorites
To delete a favorite, hover your cursor over the favorite name (in either the Navigation panel or your
home page), then click the delete icon . The favorite is deleted in theWeb Client.

If the document or page for an existing favorite is deleted, the favorite is not automatically deleted. If you
try to use the favorite, you are informed that the document or page cannot be found. In this case you
must manually delete the favorite.

Launching Axiom Cost Accounting applications
You can launch various Axiom Cost Accounting applications from theWeb Client Quick Launch menu,
including the Axiom Excel Client and AxiomWindows Client.

The Quick Launch menu serves the following purposes:
l Users can install applications from this area as needed. Afterward, they can continue to launch

installed applications from this location, or they can use other options (such as a shortcut on their
desktop).

l Users can install and launch add-ins such as the add-ins for Microsoft Office applications.

To open the Quick Launch menu:

l Click the Quick Launch icon in the Global Navigation Bar.
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� Launching the Axiom Desktop Client
Using the Quick Launch menu, you can launch the Axiom Desktop Client. Click on one of the following
icons:

Item Description

Windows Client Launches the AxiomWindows Client on your desktop.

Excel Client Launches the Axiom Excel Client on your desktop. Requires Microsoft Excel.

NOTE: This option may not display in themenu, in which case you should use
theWindows Client as your desktop client.

For more information, see About theWindows and Excel Client.

� Launching add-ins
Using the Quick Launch menu, you can launch Axiom Cost Accounting add-ins. Click on one of the
following icons:

Item Description

MSWord Add-In Launches the Axiom Cost Accounting Add-In for Microsoft Word.

MS PowerPoint
Add-In

Launches the Axiom Cost Accounting Add-In for Microsoft PowerPoint.
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NOTE: One or both add-ins may not display in themenu, depending on your organization's
preferences.

TheWord and PowerPoint Add-ins are optional applications to support document integration between
Axiom Cost Accounting and Word or PowerPoint.

Viewing system information
You can view the Axiom Software About box to see information about your current system, such as:

l System name
l Version numbers for the Axiom Cost Accounting platform and any installed products
l Application server URL
l Web server name

To open the About box:

1. Click themenu icon in the Global Navigation Bar.

2. At the bottom of the Area menu, click About Axiom Software.

Using the Guide View
The Guide View includes all of the setup and configuration tasks for Axiom Cost Accounting.
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1. Setup and maintenance tasks are grouped together into similar areas and sub-areas. For example,
you can find all of the tasks associated with setting up and managing methods and assumptions in
theMethod and Assumptions section. Next to the button, the page displays a description. Click
the button to navigate to the task(s) for that area.

2. The status column on the right side of the page displays tasks as Completed, In Progress, or Not
Started. You can click the circle to toggle the status from one status type to another. For example,
if all of the tasks for Data Management are now complete, click the circle to toggle the status from
In Progress to Complete.

NOTE: All of the tasks in a specific area need to bemarked as complete in order for the button
above it to bemarked as complete. For example, in Data Management area, all of the tasks in
Data Management must bemarked complete in order for the Status column for the Data
Management button to bemarked as complete.

3. The Checklist View provides a list of tasks you need to complete as part of the set up and
configuration process.

TIP: You can toggle back and forth between the Guide View and the Checklist View.

4. If you need help configuring a specific area, click the question mark in the upper right corner of
each screen. A help panel displays conceptual information or contextual instructions for the page
that displays. For more detailed help, some of the contextual instructions include links to fuller
topics in the online help. To access the full online help system for Axiom Cost Accounting, click the
question mark in the upper right corner of the page, and click Open Help. The online help will
open in a separate browser window.
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Using the Checklist View
Setting up and configuring Axiom Cost Accounting requires you to completemultiple tasks, many of
which require considerable validation and review to ensure that they are completed before advancing to
subsequent tasks.

The Checklist View page provides an easy and convenient way for administrators to manage the tasks
required for setting up the costing processes from one location, including:

l Manage and track each major task that is part of the costing setup process.
l View task status.
l Maintain different cost processes, such as rolling forward from one period to another.
l View current costing system parameters, such as the current active cost set and themethods and

versions being used.
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� Open the Checklist View page
From the Guide View, click the Checklist View link in the top right corner of the page.

About the Windows and Excel Client
All Axiom Software products share a common Windows and Excel Client interface and make use ofmany
of the same features. The interface includes several sections, including:
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� Display area
Themain display area displays the open files. By default, it shows the Kaufman Hall Home dashboard,
which displays announcements, assigned tasks, links to dashboards, and contact information for
administrators. Your Axiom Software product administrator configures the information that displays on
this screen.

� Task panes
A task pane provides access to commands, utilities, reports, plan files, and so on for Axiom Cost
Accounting, and displays on the left side of themain display area. To switch between task panes, click the
tabs on the left side of the interface. To expand or collapse the task panes, click the arrow in the left-hand
corner above the tabs.
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� Ribbon tabs
Ribbon tabs provide access to commonly used features and shortcuts to frequently accessed files. They
display above the task pane and main display areas. The role assigned to you determines the ribbon tabs
that display. For example, the Admin ribbon tab only displays to those users assigned the Administrator
role profile.

Main
Includes commands for accomplishing most tasks in Axiom:

l Opening, closing, and saving files
l Viewing data in spreadsheets
l Printing or emailing files
l Accessing shortcuts to frequently accessed reports
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Admin
Includes commands for managing and configuring security, Scheduler jobs, processes, and data as well
as other system-related tools used by administrators. This ribbon tab only displays to users with
administrator privileges.

Home
Includes standard spreadsheet commands.

Some options on the ribbon tabs display grayed out unless certain types of files such as reports or plan
files are currently open or if you do not have the necessary security permissions to use the feature.

Excel Client
The Excel Client displays all of the same ribbon tabs included in a normal Excel file. TheWindows Client
only includes a subset of the same ribbon tabs located in the Home ribbon tab.

TIP: When creating reports, we recommend that you use the Excel Client.
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Windows or Excel Client Home page
The home page for theWindows or Excel Client is a designated file that automatically opens when you
enter Axiom Cost Accounting. The home page that you see is determined by your system administrator.
The home pagemay contain reporting data, plan deadlines, announcements, or other information. If
you have any questions about the home page or its contents, please contact your system administrator.

The default label for the home page is Home. The name on the file tab may be different if the
administrator has assigned an alternate home page.

The home pagemay be configured as non-closeable, which means it is always open while you are
working in Axiom Cost Accounting. If the home page is closeable, you can close and open it as follows:

l To close the home page, click the X button in the file tab, or right-click the file tab and select Close.

NOTE: The Close All and Close All But This options do not close the home page; it must be
individually closed. If you are using the Axiom Excel Client and the home page is the last open
file, then closing the home page will close the application.

l To reopen the home page in the current session, click the Show Home button in theDisplay
group on the Axiom tab. (In product systems, this button may be located on theMain tab.) This
button can also be used to jump directly to the home page when multiple files are currently open.

System administrators can customize the default home page, or assign each user or role an alternate
home page. Additional files may also be opened at startup. For more information, see the System
Administration Guide.

Using the Axiom Assistant
The Axiom Assistant area provides quick and easy access to files and features as you work throughout
Axiom Cost Accounting. A variety of task panes is available to help you perform general and context-
sensitive tasks.

The Axiom Assistant area is located on the left side of the screen, below the ribbon and to the left of any
opened files. By default, the area is expanded, and you can work with any of its available task panes by
clicking the side-tabs along the left edge of the pane.
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� Axiom Assistant task panes
The task panes available to you in the Axiom Assistant area depend on your system configuration and
your security permissions. The following task panes may be available:

Task pane Description Availability

My Files and Tasks Bookmark and view favorites and
recent files, utilities, and so on.

This task pane displays for all users. Use to
bookmark favorite files as well as view
recent files, utilities, reports, and so on that
you have viewed. You can also view items
in your My Documents folders.

Data Source
Assistant

Helper tool to build data sources, such
as Refresh Variables, DataLookup, and
Grid.

This task pane is system-controlled and
displays if you have the appropriate
security permissions, and the file is an
Axiom file.

Explorer Open files and other items that you
have access to, including favorites.

This task pane is included by default, but
may be disabled in your system or
restricted to only certain users.

File Processing Configure and perform file processing
for an Axiom file, such as to perform
Multipass processing, file collect, or
batch processing.

This task pane is system-controlled and
displays if you have the appropriate
security permissions, and the file is
enabled for File Processing.

Form Assistant Configure form settings for an Axiom
file, and preview the form.

This task pane is system-controlled and
displays if you have the appropriate
security permissions, and the file is
enabled for Axiom forms.

Messages View comments about the current
document, and add comments.

This task pane is system-controlled and
displays for all eligible documents.

Administrator's Guide 2019.4 Axiom Cost Accounting │ 28



Task pane Description Availability

Notifications View alert and system notifications,
and open associated files.

This task pane is system-controlled and
displays if you have any active notifications.

Process View process information and
complete process tasks. By default, this
task pane only displays if it is relevant
to you. For example, if you are the
assigned owner of a process task.

This task pane is included by default, but
may be disabled in your system.

Sheet Assistant Configure workbook and worksheet
settings for an Axiom file, including
Axiom queries.

This task pane is system-controlled and
displays if you have the appropriate
security permissions, and the file is an
Axiom file.

Table View table details, set a filter, and
refresh the currently opened table.

This task pane is system-controlled and
displays when using Open Table in
Spreadsheet.

Workflow Work with currently assigned plan files
and complete workflow tasks. By
default, this task pane only displays if
you have assigned tasks (current or
completed) for an active workflow.

This task pane is included by default in
older systems, but may be disabled in your
system or may use different configuration
settings to determine visibility. Newer
systems do not have this task pane.

<Custom Task
Panes>

Your organization may have defined
one or more custom task panes for
your system.

Custom task panes may open automatically
when Axiom Cost Accounting is launched,
or you may have access to the Task Panes
Library to open certain task panes, as
needed.

The order of task panes in the Axiom Assistant area cannot bemanually changed. Your Axiom Software
product administrator specifies an order for the task panes to open when you start Axiom Cost
Accounting. System-controlled task panes display after these startup task panes.

� Minimizing the Axiom Assistant
By default, the Axiom Assistant area is maximized when you first start Axiom Cost Accounting. If desired,
you can minimize this area—for example, to gain more screen space while working on a file. When
minimized, the area displays as a thin strip along the left side of the application, with one or more side-
tabs for each task pane.

You can expand the Axiom Assistant area to perform a task, and then minimize it again when you are
finished.

l To minimize the Axiom Assistant pane, click the button in the header.
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l To expand the Axiom Assistant pane, click the button in the collapsed header, or click one of
the task pane tabs.

Axiom Cost Accounting remembers the state of the Axiom Assistant (minimized or expanded) when you
exit the application, and applies that state the next time you open it on the samemachine.

TIP: It is not possible to completely hide the Axiom Assistant area when task panes are open,
however, if no task panes are open, then the Axiom Assistant area is automatically hidden (and
automatically displays again when you open a task pane).

� Opening task panes
In some cases, task panes open automatically—you do not need to manually open them.

l Certain task panes are configured to open automatically when you start Axiom Cost Accounting.
These task panes are considered to be global task panes that you may want to use at any time
while you work in the system. For example, if you have administrator privileges, the Admin task
panemay open for you automatically.

l Other context-sensitive task panes only open when using certain features. For example, the File
Processing task pane only displays when you open a file that is enabled for File Processing. There
is no need to manually open the task pane because it is always available when it is relevant (and
assuming that you have security permissions to view it).

� Closing task panes
To close a task pane, click the X icon on the side-tab for the task pane.

� Using task panes in Excel 2013 or Excel 2016
When using Axiom Cost Accounting with Excel 2013 or 2016, each file opens within its own window, and
each windowmaintains its own set of ribbon tabs and task panes. This means that, as you switch
windows, the set of task panes available in each windowmay be different. For example:

l If you manually opened a task pane in one window, that task pane will only be present in that
window. It will not be present in other windows.

l The currently active task pane is managed independently for each window, so the active task pane
may change as you change windows. This can also occur when using theWindows Client or Excel
2007 / 2010, if you switch between files that have different default task pane associations.
However, in Windows 2013 / 2016, it may also happen when switching between files with the same
default task pane associations.

l The current state of task panes such as the Explorer task pane is managed independently for each
window. For example, if you expand the Reports Library in one window, that expansion is not
present if you switch to a different window.
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Opening the task panes
TIP: For Axiom Cost Accounting, the Admin and End User task panes are the same.

To open the Axiom Cost Accounting task panes:
l For administrators, in the Admin ribbon tab, click Admin Task Panes, and select Cost Accounting

Admin.

l You can also open the task pane from theMain ribbon tab. Click Open App Menus, and then
select Cost Accounting.

Administrator's Guide 2019.4 Axiom Cost Accounting │ 31



Opening the Explorer task pane
Axiom Cost Accounting provides a built-in Explorer task pane so that you can quickly access your
favorites, recent items, and all the files that you have rights to access.

TIP: You can also access Favorites, Recent, and My Documents from theMy Files and Tasks task
pane.

By default, all users are given access to this task pane. If desired, administrators can disable use of this
task pane entirely, or restrict access to certain sets of users.

To access the Explorer task pane:
l In theMain ribbon tab, click Navigation, and select Explorer.

Managing favorites
You can save files and other items as favorites for quick access to commonly used items. Your favorites
list is available in the following locations:

l The Explorer task pane in the Axiom Assistant area
l The Axiom Explorer dialog (if you have permission to access this dialog)

NOTE: Your organization may choose not to use the Explorer task pane or to restrict it to certain
users. In this case, you can access your favorites from theMy Files and Tasks task pane.

When an item is saved to favorites, you can open the item by double-clicking it, or you can right-click it to
access any other commands available on the item in its native area. For example, if you have rights to the
Table Library and you save a table as a favorite, you can right-click the table favorite and perform actions
such as editing the table structure.

If an item that a favorite points to is deleted, then the favorite becomes invalid and a red arrow icon
displays next to it.
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If you attempt to open an invalid favorite, a message box informs you that the item has been deleted,
and asks whether you want to delete the favorite. If a file is moved or renamed within the Axiom file
system but it retains the same document ID, then the shortcut is not broken.

� Saving favorites
l In the Explorer task pane and the Axiom Explorer dialog, by right clicking an item and selecting

Add to Favorites.
l By right clicking the file tab of an opened file and selecting Add to Favorites.

TIP: If you open a table using Open Table in Spreadsheet, and save the open table as a
favorite (using the file tabs), the settings you used are automatically saved as part of the
favorite in the shortcut properties. You may want to rename the favorite to indicate the
particular settings.

� Organizing favorites
You can create sub-folders in the Favorites area to organize favorites by folder. To create a new folder,
right-click Favorites, and select New Folder.

By default, favorites display in the order that they were added. New favorites are added to the bottom of
the list. You can drag and drop individual favorites to change the order. You cannot reorder sub-
folders—they always display in alphabetical order.

To rename a favorite, right-click the item, and select Rename. The name becomes editable, and you can
type a new name.

� Shortcut properties
You can edit the shortcut properties for a favorite. Right-click the favorite, and select Shortcut
Properties. In this dialog, you can edit the shortcut name, change the shortcut target, and define certain
shortcut properties.

The available shortcut properties vary by file type. For example, you can configure a report favorite to
always open as read-only, or to automatically apply a Quick Filter when opening.

� Deleting favorites
To delete a favorite, right-click the item, and select Delete.

Opening recent files
Axiom Cost Accounting maintains a list of your recently opened files. You can use this list for quick access
to recent files.
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The recent file list is located in theMy Files section of the Explorer task pane and Axiom Explorer. You can
double-click files to open them, or right-click to access the context menu for the file type.

The list displays the last 15 files that you recently opened. Note the following:
l If you want to clear the list, right-click Recent and select Clear History.
l If you want to continue to have quick access to a recent file, you can add it to your favorites.

Right-click the file and select Add to favorites.
l If the icon next to a file name is a red arrow, this means that the file has been moved or deleted

since you accessed it, so it can no longer be opened from the recent file list.

In the AxiomWindows Client only, recent files can also be accessed from the Filemenu. In the Axiom
Excel Client, although your recent files are tracked in File > Recent, those links point to the temporary
versions of the file stored on your local drive, not the source versions of the files stored in the Axiom Cost
Accounting database. Therefore, Excel's recent file list cannot be used to open Axiom files.

Changing your Axiom Cost Accounting password
If your authentication method is Axiom Prompt, you can change your password as needed. This feature
does not apply to users who are using any other authentication method (such as Windows User
Authentication), because those passwords are controlled externally from Axiom Cost Accounting.

To change your password:
1. On the Axiom tab, in theHelp group, click Help > Change Password.

NOTE: In systems with installed products, this featuremay be located on theMain or Admin
tab.

This command is only available to Axiom Prompt users.

2. In the Set Password dialog, enter your current password, then enter and confirm your new
password.

If password rules are being enforced, your password must meet the rules. A validation message
will inform you of the rules if necessary. Alternatively you can click Generate Password to auto-
generate a password that meets the rules. If you do this, make sure to note the generated
password because you will not have another opportunity to see it. If you do not note the
password and cannot log in later, an administrator will need to reset your password.

3. Click OK.

Your password is now changed. You will need to use this new password the next time that you log in.

Closing Axiom Cost Accounting
To close Axiom Cost Accounting, in theMain ribbon tab, click the Close Axiom Software button in the
Exit group.
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TIP: You can also close the application by clicking the X button in the top right corner of the window.
The system prompts you to save any changes to unsaved files.

Using the FilterWizard
You can use or create your own filters to customize the data to view. The Filter Wizard walks you through
the process of building complex limit query filters rather than having to construct them manually. You
can create and save new filters for future use as well as use and edit existing filters.

� Using an existing filter
1. Next to the Preview field, click the folder icon.

2. In the Filter Library dialog, select the filter to use, and click OK.

3. In the Filter Wizard dialog, click Apply.

4. Click OK.

� Creating a filter

TIP: You can create a new filter from an existing filter by selecting it from the folder icon in the
Preview field, and then follow these steps to make the appropriate changes. Make sure to give the
filter a new name so that you do not overwrite the existing filter.

1. On the left side of the dialog, select the table column on which you want to base the filter. After
you select a table column, the values in that column display in the right side of the dialog.
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2. In the right side of the dialog, type or select the value on which to base the filter. You can type into
the field above the list of values to filter the list or to specify a value. If one or more values are
selected, then those items are used in the filter. Otherwise, whatever you type into the field is
used by the filter.

3. In the space between the two selection boxes, select the operator to use for the filter criteria
statement, such as equals, not equals, greater than, or less than.

4. Review the filter criteria statement in the Preview box to ensure that it is as intended. If you need
to make changes, edit your selections made above.
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5. Do one of the following:
l If the filter criteria statement is finished, click OK. The Filter Wizard uses the statement in

the Preview box (you do not have to click Apply in this case).
l To create a compound filter, click Apply to move the current criteria statement into the

Filter box. Then, repeat Steps a-d to create another criteria statement. When the next
statement is complete, click AND orOR to join it to the prior statement.

6. In the File name field, type a name for the filter.

7. In theDescription field, type a description of what the filter does.

8. Click Save.

9. In the Filter Wizard dialog, click OK.
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Setting Up Axiom Cost Accounting
This chapter includes topics related to setting up and configuring Axiom Cost Accounting.

Using the Guide View
The Guide View includes all of the setup and configuration tasks for Axiom Cost Accounting.

1. Setup and maintenance tasks are grouped together into similar areas and sub-areas. For example,
you can find all of the tasks associated with setting up and managing methods and assumptions in
theMethod and Assumptions section. Next to the button, the page displays a description. Click
the button to navigate to the task(s) for that area.

2. The status column on the right side of the page displays tasks as Completed, In Progress, or Not
Started. You can click the circle to toggle the status from one status type to another. For example,
if all of the tasks for Data Management are now complete, click the circle to toggle the status from
In Progress to Complete.

NOTE: All of the tasks in a specific area need to bemarked as complete in order for the button
above it to bemarked as complete. For example, in Data Management area, all of the tasks in
Data Management must bemarked complete in order for the Status column for the Data
Management button to bemarked as complete.

3. The Checklist View provides a list of tasks you need to complete as part of the set up and
configuration process.

TIP: You can toggle back and forth between the Guide View and the Checklist View.

4. If you need help configuring a specific area, click the question mark in the upper right corner of
each screen. A help panel displays conceptual information or contextual instructions for the page
that displays. For more detailed help, some of the contextual instructions include links to fuller
topics in the online help. To access the full online help system for Axiom Cost Accounting, click the
question mark in the upper right corner of the page, and click Open Help. The online help will
open in a separate browser window.

2
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Using the Checklist View
Setting up and configuring Axiom Cost Accounting requires you to completemultiple tasks, many of
which require considerable validation and review to ensure that they are completed before advancing to
subsequent tasks.

The Checklist View page provides an easy and convenient way for administrators to manage the tasks
required for setting up the costing processes from one location, including:

l Manage and track each major task that is part of the costing setup process.
l View task status.
l Maintain different cost processes, such as rolling forward from one period to another.
l View current costing system parameters, such as the current active cost set and themethods and

versions being used.
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� Open the Checklist View page
From the Guide View, click the Checklist View link in the top right corner of the page.

Marking the status of a task
Using the Costing Process Checklist page, you can do the following:
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l Expand and contract tasks -All tasks and sub-tasks display in a tree structure format. You can
expand or contract all of the tasks by clicking Expand All/Collapse All at the top of the list. For a
specific task, click the down arrow to expand the task, and click the up arrow to contract it.

l Navigate to task utilities or pages - Each task name links to the corresponding utility or page in
the system used for configuration. For example, if you click the first task, System Configuration,
the link opens to the System Configuration page.

l Mark task status - After you complete each task, you can click the check mark next to it to
indicate that it has been completed. After you select the check mark, the system displays
Completed in the Status column. You can unselect the check mark at any time if it turns out that
the task was not fully completed or you need to reprocess it.

The page displays the tasks in a table format with columns that include the following information:

l Status - The status of the task. Status types include Not Started, In Progress, and Complete.

l Last Activity - The status of the last activity and the date and timewhen the activity occurred.

To mark the status of a task:
1. From the Guide View, click Checklist View.

2. In the Status column, click the status circle to toggle to set the status from In Progress to
Completed or from Completed back to In Progress.
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NOTE: You cannot mark a task as complete if it contains sub-tasks that are still in process.

Viewing a costing process
From the Costing Process Checklist page, you can view different cost processes that have been created
for your organization.

IMPORTANT: Any changes you make in the System Configuration page and Active Cost Set are only
applied to the cost process in which they reside. All other changes, including changes to
dimensions, methods, assumptions, reclasses, overallocations, and so on will be applied at the
global level across all cost processes.

To view a costing process:
1. In the Checklist View, click the notepad icon.
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2. Click Choose Processes.

3. From the Process Name drop-down, select the process to view.
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Adding a costing process
You can add a new costing process from scratch or clone the setup of an existing costing process as the
basis for a new costing process.

To add a costing process:
1. In the Checklist View, click the notepad icon.

2. Click Add Process.

3. Do one of the following:
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Option Description

Create a new costing
process from scratch

a. Click Add Process.

b. In the Process Name field, type a name for the new
process,

c. Click OK.

Create a new costing
processing by cloning an
existing process

a. Click Clone Process.

b. From the Source Process drop-down, select the process
to copy.

c. In theNew Process Name field, type a name for the new
process.

d. Select the check box next to each configuration setting to
copy for the new process.

NOTE: System Configuration and Data Management are
selected by default.

e. Click OK.

Editing the name of a costing process
You can title the costing process using a name that makes themost sense to your organization.

TIP: We recommend using a name that indicates the period in which the costing process takes place.
For example, Costing 2019 or Costing 2019Q1.

To edit the name of a costing process:

1. In the Checklist View, click the notepad icon.
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2. Click Edit Process Name.

3. In the Process Name field, type the new name, and click OK.

Deleting a costing process
The system will only allow you to delete previous cost processes. You cannot delete the current cost
process.

To delete a costing process:
1. In the Checklist View, click the notepad icon.
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2. Click Remove Process.

3. From the Process Name drop-down, select the process to delete, and click OK.

Configuring system options
After installation, use this page to select and specify options used to configure your system.

NOTE: Depending on the selections you make on this page, some features may be hidden from view
in the system.
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To configure system options:
1. In the Guide View, click System Configuration.

2. Complete the following questions:

Calendar Settings

Question Options

01. What is the current fiscal year? Select the current fiscal year for your organization.

02. What is your first month in the
fiscal year?

Select themonth in which your organization's fiscal
year begins.
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Costing System

Question Options

01. What is the source of the
GL data?

Select the source to use for your General Ledger (GL)
data:

02. Will you load payroll detail for
labor distributions?

If you plan on loading payroll detail to use for labor
distributions, click the toggle to Yes; otherwise leave
the toggle as No.

03. If you answered Yes to the
previous question, what is the
source?

Select the source for your payroll detail.

04. Howwill you compute cost item
volumes?

Select how you want to compute cost item volumes.

05. Calculate allocations using
Simultaneous Equations (default as
Single-Step Down)?

IMPORTANT: We recommend that you first review the
Understanding simultaneous equations section below
before setting this option. If you choose to implement
SE, please consult with one of our Axiom Cost
Accounting consultants to ensure you understand the
implications.

Do one of the following:

l To enable simultaneous equations, click the toggle
to Yes.

l To use single-step down, click the toggle to No.

Costing Methodologies

Question Options

01. Which methods do you plan to
implement?

Select the check box next to themethods your
organization will use.

IMPORTANT: You must select at least one
methodology. Methodologies you do not select will
not be included in the Unit Cost Calculations page or
the Process Advanced Cost Methods page. They may
also not display in other parts of the Guide View.
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Direct to Encounter

Question Options

01. Will you be implementing Direct
to Encounter Features?

Direct to Encounter allows you to spread costs
historically allocated as indirect overhead to specific
encounters that use the services of that particular
department or area.

To use Direct to Encounter, click the toggle to Yes;
otherwise leave the toggle as No.

3. After making your changes, click Save.

� Understanding simultaneous equations
The simultaneous equation (SE)method of cost allocation provides a more accuratemethod of allocating
department costs. When processing allocations, the system places the records and allocation rules into a
matrix, and then system processes them together. If your organization decides to use SE, you need to
define Axiom Cost Accounting allocation rules to take this into account. For this reason, we recommend
that you do not switch back and forth between SE and single step down because it could result in
inaccurate data. If you enable this feature, the Allocation Definitions page will display Simultaneous
Equations at the top of the page.

Importing data
Before importing your data, we recommend you first review the file review checklist.
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� General Ledger
One of the first steps in the costing process is to generate a Costing General Ledger (CGL). The CGL is
associated with a period of financial data and becomes the primary and only source of all costs, statistics,
adjustments, reclasses, and allocations used in the cost accounting process.

To import General Ledger data:
1. From the Setup Guide page, click Data Management > External Financial Data > General Ledger.

Click images to view full size

2. From the Variables drop-down, select the year to import.

3. Click Run Now.

File review checklist
Use the steps listed in the following table to prepare your files for import:
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Process Description

Perform basic file format checks 1. Verify that the file is plain text and pipe-delimited (uses
the | character).

2. Verify that the first line contains a header listing all of the
fields.

NOTE: Consult the file specification document provided
by your Kaufman Hall Implementation Consultant for a
list of all fields to contain in each file.

Perform data-type checks 1. Verify that data types are correct. For example, integer
or numeric fields should not contain text values.

NOTE: Consult the file specification document for the
data type of each field.

2. Verify that all date and time fields are formatted as
“YYYY-MM-DD” and/or “YYYY-MM-DD hh24:mi:ss”.

3. Verify that the file does not contain numerous instances
of the word “NULL”. Null values should be extracted as
blanks. For example, integer or numeric fields should not
contain text values.

4. Verify that amount (Numeric data type) fields are
formatted correctly. Use a negative sign to indicate
negative amounts (“-“ in front of the number, instead of
parentheses). Amounts should not contain commas.

Verify key fields on each table NOTE: Refer to the file specification document to determine
the key fields, which are listed in bold.

1. Use the filter function in Excel to verify that all key fields
are populated (no blanks). Keep in mind the following:

l If there is only one key on the table, it must always
be populated.

l If there are multiple keys on the table and only some
of them are blank, check with your Kaufman Hall
Implementation Consultant or an Application
Specialist for further guidance

2. For all files except Cost Detail, use the Remove
Duplicates function in Excel on the key column(s) to
verify that they do not contain duplicate values. In other
words, there should be only one row for each unique
combination of key values.
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Validating imported data
Data validation is required during the implementation as well as ongoing for recurring data loads
(imports) to the Axiom system. Data validation should be performed by both your organization and
Kaufman Hall during the implementation process.

The following table lists the validation reports available:

Report Description

Audit_01 Income Statement Summary
report

Provides a point of validation to ensure proper import of the
General Ledger file into the Axiom system from the source
system.

Audit_02 Encounters by Month report Allows you to validate the Encounter data loaded to the
Encounter table by summarizing encounter cases, charges
(chargeable records), and charge-per-case by month.

Audit_03 Detail Charges to Billing report Summarizes Cost Detail Volume and Charge totals (only
chargeable items at this point) for monthly validation to the
billing source system based on the posting date of Cost Items for
a selected month and entity.

Audit_04 Detail Charges to GL report Allows you to validate Cost Detail data by comparing the cost
detail (chargeable items with a unit or total charge amount) by
postdate to Patient Revenue on the General Ledger.

Audit_05 Payroll Source Reconciliation
report

Allows you to evaluate and reconcile payroll related data
(dollars and hours) by month.

Running the Audit_01 Income Statement Summary report

The Income Statement Summary report provides a point of validation to ensure proper import of the
General Ledger file into the Axiom system from the source system. You need to generate a similar report
from the source system to validate against this standard Costing Income Statement Summary. The
report populates based on your defined fiscal period configured at implementation as well as the costing
period you define in the Key Dates driver file.

To run the Audit_01 Income Statement Summary report:
1. In the Explorer task pane, in the Libraries section, click Costing Reports > Data Import

Validations, and double-click Audit_01 Income Statement Summary.
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2. Refresh the variables by doing one of the following:
l In theMain tab, in theWorkbook Options section, click Refresh Data.

l Press F9.

3. In the Refresh Variables dialog, select the variables to include in the report, and click OK.

When compared to the generated source system report:

l This report should equal or tie out completely in total and ideally by line items.
l Line item variances are likely due to classification at the FSDetail level in the ACCT dimension table

and the definition of the financial statements and/or reports used as the comparison.
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l Variances in total are likely due to filters applied on either side of the reporting, e.g., defined
Entities.

NOTE: You need to update any new accounts or departments added during an import in in the
ACCT and DEPT dimension tables for the reconciliation report to tie out completely.

Running the Audit_02 Encounters by Month report

The Encounters by Month report allows for validation of Encounter data loaded to the Encounter table.
This report summarizes encounter cases, charges (chargeable records), and charge-per-case by month
for validation to the source system for a selected entity and date range. It ensures that the encounters in
the Axiom system are the same as what the external system is reporting.

You can run this report admission or discharge, and compares the selected refresh variable to the
appropriate date to the YRMO defined date in the Refresh Variables dialog. You can also run this report
by Entity.

To run the Audit_02 Encounters by Month report:
1. In the Explorer task pane, in the Libraries section, click Costing Reports > Data Import

Validations, and double-click Audit_02 Encounters by Month.

2. Refresh variables by doing one of the following:
l In theMain tab, in theWorkbook Options section, click Refresh Data.

l Press F9.

3. In the Refresh Variables dialog, do the following, and click OK:
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Option Description

Select Admits or Discharges Select to populate the report with admits or charges.

Entity Select one or more entities.

Beginning of Calendar Period Select a beginning date to include in the report.

End of Calendar Period Select an end date to include in the report.

The report populates inpatient and outpatient encounters separately, with IP grouped for inpatient and
OP/ER grouped for outpatient based on how the Patient Types aremapped in the Patient Type
dimension table to the DSSPtType IP, OP, or PB.

To validate the data imported to the encounter table, you need to generate a report from the source
system, validating between the Source and Encounter table.

When comparing the encounter-level data to the Costing General Ledger:

l This data should tie out completely in terms of Total Charges by month.
l Differences could be due to filtering issues with source system extract creation.

If the extracts are not matching the reporting from source system, you may need to revisit and
update the extracts.
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Running the Audit_03 Detail Charges to Billing report

This report summarizes Cost Detail Volume and Charge totals (only chargeable items at this point) for
monthly validation to the billing source system based on the posting date of Cost Items for a selected
month and entity.

The Detail Charges to Billing report allows for validation of Cost Detail data (chargeable items with a Unit
Charge value) through comparison of summed volume and charges by department.

To run the Audit_03 Detail Charged to Billing report:
1. In the Explorer task pane, in the Libraries section, click Costing Reports > Data Import

Validations, and double-click Audit_03 Detail Charged to Billing report.

2. Refresh variables by doing one of the following:
l In theMain tab, in theWorkbook Options section, click Refresh Data.

l Press F9.

3. In the Refresh Variables dialog, do the following, and click OK:

Option Description

Select Entity (leave blank for all)
(optional)

Select the one or more entities.

Select Calendar Year and Month Select the year and month.
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After you select variables, the report populates total volume and charges by department for the selected
calendar year and month.

To validate the data pulled into the Cost Detail, generate a report from the source system, validating
between the source and Cost Detail table. When you compare this data to the data of the billing source
system:

l This should tie-out completely.
l Differences could be due to filtering issues with source system extract creation.
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NOTE: If these extracts are not matching the reporting from source system, you may need to
update the extracts.

l There could also be timing differences in the billing system versus the encounter source system.

Running the Audit_04 Detail Charges to GL report

The Detail Charges to GL report allows for validation of Cost Detail data by comparing the cost detail
(chargeable items with a unit or total charge amount) by postdate to Patient Revenue on the General
Ledger. This report is a department level report showing monthly charges and variances.

To run the Audit_04 Detail Charges to GL report:
1. In the Explorer task pane, in the Libraries section, click Costing Reports > Data Import

Validations and double-click Audit_04 Detail Charges to GL.

2. Refresh variables by doing one of the following:
l In theMain tab, in theWorkbook Options section, click Refresh Data.

l Press F9.

3. In the Refresh Variables dialog, do the following, and press OK:

Option Description

Select Entity (leave blank for all) Select one or more entities.

Select Calendar Year and Month Select the year and month.
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The report populates Cost Detail Gross Charges for comparison to Financial Gross Charges (Costing GL)
while calculating any variance value and percent.

You need to review and resolve variances between the cost detail and cost GL, and then re-import and
rerun the validation reports.

When this data is compared to the data of the billing source system:

l This should tie-out completely.
l Differences could be due to filtering issues with source system extract creation.
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NOTE: If these extracts do not match, you may need to update the extracts for Cost Detail.

l There could also be timing differences in the financial billing system versus the encounter source
system.

Running the Audit_05 Payroll Source Reconciliation report

Use this report to evaluate and reconcile payroll related data (dollars and hours) by month.

To run the Audit_05 Payroll Source Reconciliation report:
1. In the Explorer task pane, in the Libraries section, click Costing Reports > Data Import

Validations, and double-click Audit_05 Payroll Source Reconciliation.

2. Refresh variables by doing one of the following:
l In theMain tab, in theWorkbook Options section, click Refresh Data.

l Press F9.

3. In the Refresh Variables dialog, do the following:
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Option Description

Select Entity a. Click Choose Value.

b. In the Choose Value dialog, select an entity to include in the
report.

c. Click OK.

Select Payroll Fiscal Year Select the payroll fiscal year to include in the report.

4. Click OK.

The following is an example of this report:

Managing Cost Sets
A cost set includes the attributes for each cost item in terms of the range of service dates, the costing
period, themethod definition version, and RVUs used when calculating costs. This simplifies the costing
process as the cost set information can then be used across unit cost calculations.

A cost set defines:

1. The expenses from your GL to spread

2. The service dates that cover the cost items

3. The definition set to use.

4. The set of RVU values to use for those items marked as RVUs
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All of these generate parameters generate a specific set of unit costs, and if you change any of the
parameters above, the system will generate a different unit cost. For example, if you add a month to
your service dates, your costs could change dramatically. However, if you change themethod definition,
your unit costs may changemore subtly because you're changing themethod in which your organization
receives costs. While most costs will remain the same, somewill change. So for the same time period, the
total cost will stay the same for the organization, but which cost items get howmuch cost will change.
The same idea applies to RVUs. If you pick a different RVU to apply to the cost set, then different cost
items will get a different proportion of the cost relative to the other RVU items.

You can create different variations of costs, which you can then choose when processing the unit costs to
assign to the patients. Let's say at the beginning of each year, you define a cost set for each quarter, for
example 2018QTR1, 2018QRT2, and so on. Then, as needed, you can createmultiple cost set iterations
for the same time period but using different parameters. For example, 2018QTR1A, 2018QTR1B, and so
on. When you calculate and assign the unit cost to patients, you can then select the cost set you want to
use.

Adding or editing a cost set
To add or edit a cost set:

1. In the Guide View, clickMethods and Assumptions > Cost Set Maintenance.

2. On the Cost Set Maintenance page, do any of the following:
l To add, click + Add Cost Set.

l To edit, click the cost set to highlight it, and click the notepad icon .
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3. In the Add/Edit Allocation Rule dialog, complete the following:

Field Description

Name A name for the cost set.

TIP: Use a naming convention that is meaningful to your organization, such
as "2018QTR1".

Description A longer description for the cost set.

TIP: An example description would be "2018QTR1, Version A. Using
method definitions from 2019".

Fiscal Year Select the fiscal year in which to designate the cost items you want to
spread.

Start Period Select the start date of the cost items to include in the cost set.

End Period Select the end date of the cost items to include in the cost set.

General Ledger Table Displays the General Ledger table in which the cost items are derived.

Beginning Service
Date

Displays the beginning service date in which the costs are derived.

Ending Service Date Displays the ending service date in which the costs are derived.

Version of Method
Definitions to Use

Select the version method definition to use for the cost set.

Version of RVUs to
Use

Select the RVU version to use for the cost set.

4. After you finish making changes, click Save.
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Deleting a cost set
To delete a cost set:

1. In the Guide View, clickMethods and Assumptions > Cost Set Maintenance.

2. On the Cost Set Maintenance page, hover your mouse over the definition to highlight it, and click
the trash bin icon.

3. At the Confirm Delete Cost Set prompt, click OK.

Creating or updating RVU versions
The RVUMaintenance page allows you to create or update an RVU version for a cost set. An RVU version
determines the cost impact as costs are shifted across department items.
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Prerequisite: The system assumes that you set up method definitions and cost sets (including assigning
it a method definition and activating it) before you continue using this screen. If you do not have a cost
set activated, the system will automatically open the Cost Set Maintenance screen. Activate a cost set by
clickingmark active in the Active Cost Set column, then navigate back to the RVUMaintenance screen
(step 1 below).

When creating or updating an RVU version, the RVU Maintenance page displays a table with a row for
each cost item for the department. The table also includes a column for item type, so if there are two or
more of the same cost item, you can enter RVU values for each. Columns A-G (blue cells) shows the cost
item usage for the specified time period (from the Costing Period field in the Cost Set section of the
page). Starting with column H, the system shows the cost pools that apply based on themethod
definition version assigned to the cost set. You can add RVUs to these columns and save them to the
database.

NOTE: The RVUMaintenance page does not include provider information.
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TIP: If the table does not show cost pools, it means that the department has not set up RVU as a
version for the cost items. It can also mean that the RevCodes that display are not set up as RVU for
whichever cost pools that are not shown. Keep in mind that the page does not show Provider RVU
method type.

NOTE: To copy an existing RVU version and use it as the basis for a new RVU version, see Copying
RVU versions and cost components.

To create or update RVU versions:
1. In the Guide View, click RVU Development and Maintenance > RVU Maintenance.
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NOTE: For this utility to display in the Guide View, your organization must have RVU selected
as a costing methodology on the System Configuration page.

2. To set the RVU version, click Set Version.

3. From the Set RVU Version dialog, do one of the following:

To... Then...

Create a newRVU version a. From the Create New RVU version drop-down,
select the newRVU version.

b. Click Continue.

c. Review theUpdate Pending prompt, and click OK.

Update an existing RVU
version

a. From the Select existing RVU version drop-down,
select the RVU version to update.

b. Click Save and Continue.

4. From the Entity drop-down, select the entity in which to filter the department list.

TIP: To search for an entity, type the entity name into the search field. The list automatically
filters the list of entity names.

5. From theDepartment drop-down, select department in which to add or edit the RVUs.

6. In the table, starting with column H, enter the values in the cost pool columns for the appropriate
cost items, as needed.

7. After you make your changes, click Save.

8. Review the save to database prompt, and click OK.

9. Run the RVUMethod Assignment process to update themethod to be RVU in themethod
definition table for the cost items under the cost pools that have RVU values.
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Working withMarkup Groups
Markups are generally applied to supply items that have a variable cost to them based on the time and
type of purchase. For example, all pacemakers may use the same cost item number, but the prices can
vary by tens of thousands of dollars based on type and manufacturer as well as any purchasing
agreements in place. Instead of a fixed charge, your organization uses a markup from the base cost to
price the item in a way that ensures that they do not losemoney on a consumable item.

The amount or percentage an item is marked up is determined using a markup table (referred to as a
markup group in Axiom Cost Accounting). There are two methods you can use to apply markups:
percentage or multiplier.

NOTE: Refer to your organization to determine which one to use when defining markups.

In Axiom Cost Accounting, a markup group consists ofmultiple pricing tiers, with each tier encompassing
a price range and a markup percentage or multiplier that is added to the items in that price range. In the
following example, a Supply markup group includes ten tiers that uses a percentagemarkup type, so
items from $.01 to $100 are charged a 20%markup, $100.01 to $200 are charged a 30%markup and so
on.

� Reverse Markup method and unit costs
When using the ReverseMarkup method, unit costs are calculated by taking the price of an item and
marking it down based on the original markup percentage or multiplier defined in themarkup group in
which the item falls. Basically, you are reverse engineering the current price to determine the unit cost.

To illustrate themath, consider the following example:

Administrator's Guide 2019.4 Axiom Cost Accounting │ 69



l A $1,000 item falls into a tier that carries a 4.0multiplier (some refer to this a 400%markup, please
verify for your specific organization) from the base cost.

l Themarkdown rate would be: 1 / 400%→1 / 4.00→ 1/4→ .25
l The original cost of the item would then be computed as: $1,000 * .25 = $250
l You can check this by reapplying themarkup rate: $250 *Multiplier → $250 * 4.0 = $1,000

NOTE: Please check with your Kaufman Hall Implementation Consultant or with Kaufman Hall
Customer Success for any questions about the computation ofmarkup percentages or the
differences between a markup percentage and a markup multiplier.

The ReverseMarkup assignment results in either a remainder or an overage of dollars (or negative
dollars) that is applied during the next methods based on methods assigned to other cost items. If no
other methods are assigned or no other cost items are remaining, the balance is left on the GL as a
variance. Each Cost Category could have its own markup table, which you should assign to the
corresponding departments and cost categories.

To maintain markup groups for departments, do the following:

l Identify the cost items, cost pools, or entity/department combinations that you will assign to use
the ReverseMarkup costing method.

l Determine with department leaders and the Supply/Materials Management department themost
appropriate costing method for medical supplies, implants, and pharmaceuticals.

l Obtain themarkup tables from the CDM department. Departments that would commonly use a
markup table would be Surgery, Cardiac Cath Lab, Ambulatory Surgery Centers, and the
Pharmacy. Also consider Cost Items within departments that use large amounts ofmedical
supplies, implants, or pharmaceuticals.

� Markup group versions
Axiom Cost Accounting allows you to create a version of your markup groups as market conditions
change. Each version includes all markup groups. You can then keep your markup tiers current without
losing your historical settings should you ever need to rerun costing for a prior period of time. This allows
you to update your tier structures without needing to update your Method Definition table version.

Adding or editing a markup group definition
TheMarkup Group Definition page provides a centralized location to add, edit, and deletemarkup
groups (previously referred to as markup tables) that are used to reverse engineer the original cost of an
item based on themarkup percentages or multiplier applied by your organization's purchasing
department.
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To add or edit a markup group definition:
1. In the Guide View, clickMethods and Assumptions > Assumptions > Manage Markup Group

Definitions.

2. Do one of the following:
l To add, click + Add Markup Group in the top right corner of the page.

l To edit, click the definition to highlight it, and click the notepad icon .

3. In the Add/Edit Markup Group Definition dialog, complete the following:

Field Description

Title Type the title for the definition.

Description Type the details for the definition.

Choose Markup Type Select one of the following:

l Markup - Apply markup amounts based on percentage and/or a fixed
amount.

l Multiplier - Apply markup amounts using a multiplying factor.

NOTE: This option only displays when you create a new markup group.
When you edit an existing markup group, the window displays the markup
type.

Tier Level Displays the tier level number.
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Field Description

Range Minimum Displays the minimum amount the item must meet to qualify for the tier
level.

TIP: This amount is determined by the amount entered in the Range
Maximum column from the preceding tier row. For example, if you enter
299.99 in Tier 2, the Range Minimum would display 300 for Tier 3.

Range Maximum Type the maximum amount to define the tier price range.

Markup Factor Type the percentage or multiplier markup to apply to the items that fall
within the tier price range.

+ Fixed Amount Type an amount to add in addition to the percentage or multiplier markup.
This is an optional step.

4. Do any of the following, as needed:
l To add more tiers, click + Add Tier at the bottom of the list.

l To delete a tier row, click the row to highlight it, and then click the trash bin icon in the
Action column. At theDelete Markup Tier prompt, click OK.

5. After making your changes, click Save.

Deleting a markup group
IMPORTANT: When deleting a markup group definition, the system deletes all of its versions. Once
deleted, it cannot be retrieved.
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To delete a markup group:
1. In the Guide View, clickMethods and Assumptions > Assumptions > Manage Markup Group

Definitions.

2. Click themarkup group to highlight it, and click the trash bin icon .

3. At theDelete this Definition? prompt, click OK.

Configuring cost behavior exceptions
By default, Axiom Cost Accounting calculates the fixed versus variable percentages for a cost category
based on whether its component costs have been defined as fixed or variable at the account level.

You can, however, override this percentage for a specific department or account, for a range of
departments or accounts, or by entity. There are three different types of exceptions that you can define:

l Account exceptions by entity - Overrides the variability of accounts within an entity
l Cost category exceptions by departments - Overrides the variability of a cost category by

departments
l Account exceptions by department - Overrides the variability of accounts with a department.

To configure cost behavior exceptions:
1. In the Guide View, clickMethods and Assumptions > Assumptions > General Configuration.

2. Click the Cost Behavior Exceptions link.

3. To add exceptions, click + Add Exception under the appropriate section.
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4. Complete any of the following:

Exception Type Options

Account Exceptions by Entity Account - Select the account to override.
Entity - Select the entity in which to make an exception.

Cost Variability % - Type the override for the calculated
cost variance percentage to apply.

Cost Behavior Exceptions Cost Category- Select the cost category to override.
Department- Select the department in which to make an
exception.

Cost Variability % - Type the override for the calculated
cost variance percentage to apply.

Account Exceptions by Department Account - Select the account to override.
Department- Select the department in which to make an
exception.

Cost Variability % - Type the override for the calculated
cost variance percentage to apply.

5. To delete a exception, hover your cursor next to the Cost Variability % field, and click the trash
can icon

6. To save your changes, click the disk icon in the upper right corner of the page.

Managing Dimensions
Dimensions are the key index fields for the tables in the Axiom Cost Accounting database. There are three
types of dimensions: Core, Encounter, and Cost Item. The Core dimensions store generic data and
options used throughout most Axiom products. The Encounter dimensions store information specific to
the services provided by your organization. The Cost Item dimensions are specific to Axiom Cost
Accounting.

� Core dimensions
l Accounts - Stores records for various pools to which values (dollars, days, and so on) can be

assigned—Patient Days, Construction Costs, Medicaid discounts—quite literally anything to which
a dollar amount or statistic can be assigned. This includes accounts that can be found on the
balance sheet, income statement, hours, and statistics.

l Calendar Dates - Ensures referential integrity for core data tables that are period based or other
data driven attributes. It is also used as a means ofmanaging the relationship between a calendar
date and the fiscal equivalent.
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l Cost Categories - Defines the cost category and represents a grouping of accounts in the General
Ledger used to perform the costing process. The cost category is the lowest level of detail at which
costs are calculated for unit costs. They are stored for the calculated variable and fixed amounts.

l Cost Pools - Defines the level at which the cost method are defined and assigned for the cost
categories. For example if an entity is using the RCC method for all departments and all items,
then only one cost pool is necessary. It is also used to define the level at which an RVU is used. For
example, if three labor Cost Categories are using the same RVU to allocate labor costs, one cost
pool can be used for the three Cost Categories. Cost Pools are a group of cost categories using the
samemethod or RVU.

l Departments - Includes records for each department within an organization (e.g., radiology,
emergency, finance, etc.).

l Entities - Provides basic information about the entities supported by the software and can
determine for some products, e.g. Cost Accounting, which entities to include in processing of
data.

l Job Codes - Stores records for all of the job codes within your organization. Each job code
represents a job position or role within the organization.

l Pay Types - Stores records for all of the possible categories of compensation that an employee
might receive. For example, regular pay, paid time off, sick pay, incentive pay, and so on.

l YRMO Dates - A simpler version of the Cal Date dimension table, which helps processing and
performance speed of the system.

� Encounter Dimensions
l Age - The age of the patient during the loaded encounter. Age is a reference field for the Enc_

Patient.Age, Encounter.AgeAtAdmission, and Encounter.AgeAtDischarge.
l APR DRGs - The APR DRGs for your organization, which are commonly implemented as part of the

coding and billing process.
l Bill Types - The bill type for the primary insurance claim upon final bill drop for the encounter.
l Discharge Status - The discharge disposition of a patient admission and/or how the patient left the

provider facility for the loaded encounter.
l Financial Classes - Use to group insurance plans into financial classes for the primary insurance

claim.
l ICD Diagnosis Codes - The ICD Diagnostic information, which is referred to by a number of tables in

the system.
l ICD Procedure Codes - The clinical procedures performed for the patient in the course of care for

the encounter being loaded.
l Insurance Plans - The insurance plan of the subscriber or guarantor for the loaded patient

encounter.
l Locations - The physical locations that have been billed within your organization. This information

is used for monthly reporting and provider-level budgeting.
l MDC Codes - Use to place a DRG into a higher level category.
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l Modifiers - The additional standard codes used to further identify services or supplies used in the
course of patient care.

l MS DRGs - TheMS DRGs for hospital acute care providers.
l Patient Types - The type of patient for the loaded encounter.
l Place of Service Codes - The Place of Service (POS) codes, which are standard industry accepted

codes that indicate where the services were rendered.
l Point of Origin - The nature of a diagnosis coded for a patient during the IP encounter being

loaded.
l Present On Admission - The nature of a diagnosis coded for a patient during the IP encounter

being loaded.
l Providers - The providers within your organization. This information is used for monthly reporting

and provider-level budgeting.
l Reporting DRGs - Use to combine or determine the primary DRGs used for reporting purposes.
l Services - The services of the patient during the encounter course of care.
l Sex - The sex of the patient during the loaded encounter. Sex is a reference field for the Enc_

Patient.Sex.
l Stations - The nursing station of a patient when first admitted to a facility as well as the station

from which the discharge occurred for the loaded encounter.
l Transaction Codes - The transaction codes for payments and adjustments stored in the Enc_

Payments table for the loaded encounter.

� Cost Item Dimensions
l CDM Codes - The charge codes within your organization. The charge codes are used to track gross

revenue and statistics at an inpatient (IP) and outpatient (OP) level.
l Cost Items - Defines the cost object to which costs are allocated during the unit cost calculation

processes for all methods.
l CPT Codes - The CPT Codes that have been billed within your organization. This information is

used for monthly reporting and provider-level budgeting.
l HCPCS Codes - The HCPCS codes within your organization used as "level 3" CPT codes, which

provide further detail as to the services, procedures, or supplies that were used in the course of
care.

l Revenue Codes - The revenue codes used within your organization.

Opening dimension tables in spreadsheet mode
You can access and manage all dimensions directly from theWindows or Excel Client editions using the
Open Table in Spreadsheet (OTIS)mode.

NOTE: On users with the Cost Accounting administrator role can access and manage the dimensions
tables using this method.
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To open dimension tables in spreadsheet mode:

1. Click the Quick Launch icon in the Global Navigation Bar.

2. Click eitherWindows Client or Excel Client.

NOTE: The only difference between the clients is that the Excel Client includes Excel-based
features.

3. In theMain ribbon tab, click Navigation > Explorer.

4. In the Libraries section, click Table Library > !Dimensions.
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5. Double-click the dimension table to edit.

6. In theOpen Table in Spreadsheet dialog, click OK.

7. Make the appropriate changes in the table.

IMPORTANT: We recommend that you work closely with your Implementation Consultant or
Kaufman Hall Support beforemaking significant changes to any dimension tables.

8. After you finish making your changes, in theMain ribbon tab, click Save.

Creating or modifying custom columns in dimensions
Some dimension tables allow you to add additional custom columns. These "grouping" columns allow
you to customize the data you want to query into reports. You can add up to five grouping columns to
the following dimensions:
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l Accounts
l Age
l Cost Categories
l CPT Codes
l Departments
l Revenue Codes

NOTE: At this time, this utility is only available from the DSS Admin task pane, accessible from the
Windows or Excel Client. Only users assigned the DSS Admin role can access this task pane (assuming
your organization has a license for Axiom Decision Support).

To create or modify custom columns in dimensions:
1. In the Cost Accounting Admin task pane, in the Costing Data Maintenance section, double-click

Configure Variable Columns.

2. In the Configure Variable Columns page, in the Enabled column, click the check box next to the
column to use.

3. In the Preferred Name field, type a name for the column that makes sense for reporting purposes.

NOTE: The column namemust start with a letter. The name can only include letters A-Z, 0-9,
and/or an underscore (_), and can only include up to 200 characters. The system displays a
check mark next to the name if it is allowed by the system; otherwise, it displays an x. The
system will not allow you to save your changes until the check mark displays.

4. When you are donemaking changes, click Save.

After you save the changes, the system updates the appropriate dimension tables with the new
columns. You then update the columns with the appropriate records.
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CORE DIMENSIONS

Accounts dimension
The Accounts dimension contains records for each account in the GL of your organization. This includes
accounts that can be found on the balance sheet, income statement, hours, and statistics.

� Accessing the Account dimension
In the Guide View, click Data Management > Core Dimensions > Accounts.

The page can only display up to a maximum of 10,000 records.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.
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� Adding or editing an account
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To add or edit an account:
1. In the table, do any of the following:

l To add an account, click Add Row. The new row displays at the bottom of the table. Enter
information in each column. After you save, the table will display the new row in order by
the ACCT column.

IMPORTANT: If you add a new record that already exists in the table, the system will
overwrite the original column values with your new entries when you save your
changes. We recommend that you review your entries before saving any changes.

l To edit an account, click in the cell(s) to make your changes.

NOTE: Columns that are grayed out cannot be edited.

l To undo your changes, click the left arrow icon .
l To redo your changes, click the right arrow icon .

2. When you finish making changes, click Save.

� Deleting an account
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To delete an account:
1. In the table, select the row to highlight it, and then click Delete Row.

2. At the Continue? prompt, click OK.

3. When you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the Accounts dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.
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TIP: In this dimension, you can add custom "grouping" columns to customize the data you want to
query into reports. For more information, see Creating or modifying custom columns in dimensions.

Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

ACCT - The Axiom Software account number. This can be the combination of the prime account and sub
account, if that is how your GL system is set up.

Description - The account description from the GL.

TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.

Cost
These columns are specific to the set up and maintenance of Axiom Cost Accounting.

COSTCAT - Represents the cost category mapping of accounts, which is used to assign cost categories to
incoming data when the GL data is imported into a CGL format table.

CostMethod - Identifies the cost calculation offset accounts used for writing offsets to the GL-oriented
tables and matches them to themethod that they represent.

NOTE: This options in this column are system generated. We highly recommend that you not make
changes to this column.

CostVarPct - The percent variable for costing; 0 = Fixed, 1=Variable. A value between 0 and 1 represent a
percentage of variability.

CostDSSSummary - An FSSummary clone, but owned by Axiom Cost Accounting and Axiom Decision
Support so that cost accounts can be categorized differently to facilitate costing and DSS needs without
impacting Axiom Financial Reporting.

CostProvider - Identifies the salary accounts of providers for the Provider RVUmethod of cost
calculation.

ReclassType - Defines the type reclass that was used to calculate the values in the account. This
information is important for post-reclass reporting.

AllocType - Defines the type of allocation account for indirect allocation in Axiom Cost Accounting.
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CostAdjustmentID - Used in Axiom Cost Accounting to tie allocation and reclass step IDs to account
numbers for easier referencing in downstream reports. This number represents the ReclassID (reclasses)
or the StepID (overhead allocations) accounts that are not reclass or allocation accounts that have a
value of zero in this column.

Calendar Dates dimension
The Calendar Dates dimension ensures referential integrity for core data tables that are period based or
other data driven attributes, e.g., admission date for a patient in Axiom Decision Support. This forces
valid dates in an integer format are loaded into the system and can be cross referenced across the
various tables and processes.

It is also used as a means ofmanaging the relationship between a calendar date and the fiscal equivalent.
The fiscal equivalent of the calendar date can used by data processing and also be presented back to the
user in reporting.

� Accessing the Calendar Dates dimension
In the Guide View, click Data Management > Core Dimensions > Calendar Dates.

The page can only display up to a maximum of 10,000 records.

NOTE: At this time, you can only add records in this dimension table directly through Axiom
Explorer > Table Library > !Dimensions > CALDATE in theWindows or Excel Client. For more
information, see Opening dimension tables in spreadsheet mode.
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� Editing a date
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To edit a date:
1. In the table, click in the cell(s) to edit, make your changes.

NOTE: Columns that are grayed out cannot be edited.

2. Click Save.

� Deleting a date
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To delete a date:
1. In the table, select the row to highlight it, and then click Delete Row.

2. At the Continue? prompt, click OK.

3. When you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the Calendar Dates dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

CALDATE - The day of the year used for each record in the Daily Productivity table. The values must be an
Integer and created as YYYYMMDD (ex. 20171231).

Description - The description can be the long form of the date such as December 31, 2017.

TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.

Administrator's Guide 2019.4 Axiom Cost Accounting │ 84



Cost Categories dimension
The Cost Categories dimension defines the cost category and represents a grouping of accounts in the
general ledger used to perform the costing process. The cost category is the lowest level of detail at
which costs are calculated for unit costs. They are stored for the calculated variable and fixed amounts.

� Accessing the Cost Categories dimension
In the Guide View, click Data Management > Core Dimensions > Cost Categories.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Adding or editing a cost category
Due to the large number of records that this table may contain, the page can only display a maximum of
10,000 records.
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To edit a cost category:
1. In the table, do any of the following:

l To add a cost category, click Add Row. The new row displays at the bottom of the table.
Enter information in each column. After you save, the table will display the new row in
order by the COSTCAT column.

IMPORTANT: If you add a new record that already exists in the table, the system will
overwrite the original column values with your new entries when you save your
changes. We recommend that you review your entries before saving any changes.

l To edit a cost category, click in the cell(s) to make your changes.

NOTE: Columns that are grayed out cannot be edited.

l To undo your changes, click the left arrow icon .
l To redo your changes, click the right arrow icon .

2. When you finish making changes, click Save.

� Deleting a cost category
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To delete a cost category:
1. In the table, select the row to highlight it, and then click Delete Row.

2. At the Continue? prompt, click OK.

3. When you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the Cost Categories dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

TIP: In this dimension, you can add custom "grouping" columns to customize the data you want to
query into reports. For more information, see Creating or modifying custom columns in dimensions.
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Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

COSTCAT - An abbreviated definition of the cost category description. Keeping this short, yet intuitive, is
best.

Description - A full description of the cost category.

Cost
These columns are specific to the set up and maintenance of Axiom Cost Accounting.

ShortDescription - A shortened description to use for reporting purposes to save space.

DisplayOrder - Determines the order in which cost category data displays in the workbook utilities and
can be used to order them in reports.

COSTPOOL - A key attribute of a cost category and determines the cost method to use in calculating the
cost category cost information. In some instances, a one to one relationship may need to exist between
a cost category and a cost pool. For example: Supplies, where the reversemarkup is used as calculating
the cost using such a method applies to only one cost and would not be applicable to more than on cost
category.

DirectFlag - Determines the definition of costs contained and calculated for each cost category as a direct
cost or an indirect cost. Used primarily for reporting cost results and is separate from the Direct Flag at
the department level used to drive other costing processes.

AccountNum - The base account number to use for cost method account numbers in the CGL table.

IMPORTANT: DO NOT CHANGE after the accounts are created and used in the Accounts dimension.

ReportGroup - The grouping of cost categories for Axiom Decision Support reporting purposes.

ReportDetail - The detail expense assignment for Axiom Decision Support reporting. This should either be
at the FSDetail level or highly correlated. Some FSDetail accounts can be grouped for costing purposes
and may not have a corresponding cost category, e.g., EX_Utilities may be grouped into OtherExpenses.

ReportDetailOrder - The order of the report detail definitions used in reporting.

RCUDEF1-5 - RCU definitions #1-5 or Relative Cost Unit definition. One of five fields that provides the
ability to define the cost category as part of a RVU cost calculation. Valid options are include the
following: Variable, Fixed, or Total, which defines which measures to use for this cost category within the
definition. See related information in the Cost Pools dimension.
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Cost Pools dimension
The Cost Pools dimension defines the level at which the cost methods are defined and assigned for the
cost categories. For example if an entity is using the RCC Method for all departments and all items, then
only one cost pool is necessary. It is also used to define the level at which an RVU is used. For example, if
three labor cost categories are using the same RVU to allocate labor costs, one cost pool can be used for
the three cost categories. Cost pools are a group of cost categories, using the samemethod or RVU.

NOTE: In some cases the cost pool and the cost category need to be the same, e.g., when the
ReverseMarkup method is assigned, the calculated costs is always assigned to only one cost
category based on themarkup table.

� Accessing the Cost Pools dimension
In the Guide View, click Data Management > Core Dimensions > Cost Pools.

NOTE: The page can only display up to a maximum of 10,000 records.

� Adding or editing a cost pool
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To add or edit a cost pool:
1. In the table, do any of the following:

Administrator's Guide 2019.4 Axiom Cost Accounting │ 88



l To add a cost pool, click Add Row. The new row displays at the bottom of the table. Enter
information in each column. After you save, the table will display the new row in order by
the CostPool column.

IMPORTANT: If you add a new record that already exists in the table, the system will
overwrite the original column values with your new entries when you save your
changes.

l To edit a cost pool, click in the cell(s) to make your changes.

NOTE: Columns that are grayed out cannot be edited.

l To undo your changes, click the left arrow icon .
l To redo your changes, click the right arrow icon .

2. When you finish making changes, click Save.

� Deleting a cost pool
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To delete an account:
1. In the table, select the row to highlight it, and then click Delete Row.

2. At the Continue? prompt, click OK.

3. When you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the Cost Pools dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

CostPool - The primary key for the Cost Pools dimension table. We recommend using short, intuitive
abbreviations.
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Description - A longer, full description for the cost pool.

TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.

Cost
These columns are specific to the set up and maintenance of Axiom Cost Accounting.

DefaultCostMethod - The cost method to use for the pool of cost categories.

DisplayOrder - The order in which to display column elements on reports and in utilities.

RCUdef - The RCU definition number.

ResourceClass - Reserved for future use.

Departments dimension
The Departments dimension contains records for each department within an organization. For example,
radiology, emergency, finance, and so on.

� Accessing the Department dimension
In the Guide View, click Data Management > Core Dimensions > Departments > Edit DEPT Dimension.
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NOTE: At this time, you can only add or delete records in this dimension table directly through
Axiom Explorer > Table Library > !Dimensions > DEPT in theWindows or Excel Client. For more
information, see Opening dimension tables in spreadsheet mode.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Editing a department
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To edit a department:
1. Click in the cell(s) to edit, and make your changes.

NOTE: Columns that are grayed out cannot be edited.

2. After you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the Departments dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

TIP: In this dimension, you can add custom "grouping" columns to customize the data you want to
query into reports. For more information, see Creating or modifying custom columns in dimensions.
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Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

DEPT - The Axiom Software department number, which is formed by combining the entity and cost
center.

Description - The department description. The naming convention is entity abbreviation with
department description. For example, Operating Room.

NOTE: For closed departments, add three asterisks to the beginning of the description. For example,
*** Operating Room. Descriptions should not be in all capital letters.

TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.

Cost
These columns are specific to the set up and maintenance of Axiom Cost Accounting.

ActivityGroup - Reserved for future use.

CostMap - Allows departments to process as a group in the unit cost processing phase of cost
accounting. All costs for the group are combined and allocated to all of the cost items within the group.
In most cases, the first or largest department of the groups becomes the target CostMap definition to
which the other members aremapped.

DeptType - Determines the direct or indirect department category. Direct departments are those that
generally provide patient care services and generate revenue, while indirect departments are involved in
support services and do not generate patient care related revenue.

MarkupName - The specified markup table to use when processing unit costs using the ReverseMarkup
method.

Entities dimension
The Entities dimension provides basic information about the entities supported by the software and can
determine for some products which entities to include in processing of data.

� Accessing the Entity dimension
In the Guide View, click Data Management > Core Dimensions > Entities > Edit Entities.
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The page can only display up to a maximum of 10,000 records.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Adding or editing an entity
To add or edit an entity:

1. In the table, do any of the following:
l To add an entity, click Add Row. The new row displays at the bottom of the table. Enter

information in each column. After you save, the table will display the new row in order by
Entity number.
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IMPORTANT: If you add a new record that already exists in the table, the system will
overwrite the original column values with your new entries when you save your
changes. We recommend that you review your entries before saving any changes.

l To edit an entity, click in the cell(s) to make your changes.

NOTE: Columns that are grayed out cannot be edited.

l To undo your changes, click the left arrow icon .
l To redo your changes, click the right arrow icon .

2. When you finish making changes, click Save.

� Deleting an entity
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To delete an entity:
1. In the table, select the row to highlight it, and then click Delete Row.

2. At the Continue? prompt, click OK.

3. When you finish making changes, click Save.

� Column descriptions
This section provides description for each column in the Entities dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

ENTITY - The primary key for the table using an integer data format.

Description - The long entry description for the entity.

TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.
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Cost
These columns are specific to the set up and maintenance of Axiom Cost Accounting.

Abbrev - The standard abbreviation for the entity.

Costing - Do one of the following:

l If the entity is used in Axiom Cost Accounting, select True.
l If the entity is not used in Axiom Cost Accounting, select False.

Job Codes dimension
The Job Codes dimension includes records for all of the job codes within your organization. Each job
code represents a job position or role within the organization.

� Accessing the Jobcode dimension
In the Guide View, click Data Management > Core Dimensions > Job Codes.

The page can only display up to a maximum of 10,000 records.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.
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2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Modifying the Job Codes dimension
To modify the Job Codes dimension:

1. In the Filter panel, type the number of records to display in theMaximum Records field. The
default is 1000.

NOTE: Due to the large number of records that this table may contain, the page can only
display a maximum of 10,000 records.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

4. In the table, do any of the following:
l To add a job code, click Add Row. The new row displays at the bottom of the table. Enter

information in each column. After you save, the table will display the new row in order by
the JOBCODE column.

IMPORTANT: If you add a new record that already exists in the table, the system will
overwrite the original column values with your new entries when you save your
changes. We recommend that you review your entries before saving any changes.

l To edit a job code, click in the cell(s) to make your changes.

NOTE: Columns that are grayed out cannot be edited.

l To delete a job code, select the row to highlight it, and then click Delete Row. At the
Continue? prompt, click OK.

l To undo your changes, click the left arrow icon .
l To redo your changes, click the right arrow icon .

5. When you finish making changes, click Save.
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� Column descriptions
The following section describes the areas and columns in the Job Codes dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

JOBCODE - The Axiom Software job code. This entry must be an alpha-numeric field so that during the
import process a J is prepended to all job codes to ensure they are alpha numeric.

Description - The job code description from the payroll system.

TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.

Cost
These columns are specific to the set up and maintenance of Axiom Cost Accounting.

CostHr - The Prod Hours Account Definitions for Costing.

ResourceJobClass - Used in the RVU developer process by themapping of job codes to a Resource Job
Class, which determines the level of detailed RVU development for labor resources. This attribute is also
used in themapping of payroll hour and dollar into an average wage rate in the resource table that then
drives the calculation of the RVU.

CostGL - The Prod Dollars Account Definitions for Costing.

CostClass - An alternative grouping column used in the costing process that is invoked during the loading
of payroll information into the CGL as statistics to support a payroll related reclassification of GL dollars
or hours.

CostVariable - Determines whether the job code is a fixed or variable cost.

Pay Types dimension
The Pay Types dimension includes records for all of the possible categories of compensation that an
employeemight receive. For example, regular pay, paid time off, sick pay, incentive pay, and so on.

Administrator's Guide 2019.4 Axiom Cost Accounting │ 97



� Accessing the Pay Type dimension
In the Guide View, click Data Management > Core Dimensions > Pay Types.

The page can only display up to a maximum of 10,000 records.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Adding or editing a pay type
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To modify the Pay Types dimension:
1. In the table, do any of the following:
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l To add a pay type, click Add Row. The new row displays at the bottom of the table. Enter
information in each column. After you save, the table will display the new row in order by
the PAYTYPE column.

IMPORTANT: If you add a new record that already exists in the table, the system will
overwrite the original column values with your new entries when you save your
changes. We recommend that you review your entries before saving any changes.

l To edit a pay type, click in the cell(s) to make your changes.

NOTE: Columns that are grayed out cannot be edited.

l To undo your changes, click the left arrow icon .
l To redo your changes, click the right arrow icon .

2. When you finish making changes, click Save.

� Deleting an pay type
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To delete a pay type:
1. In the table, select the row to highlight it, and then click Delete Row.

2. At the Continue? prompt, click OK.

3. When you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the Pay Types dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

PAYTYPE - The Axiom Software pay type. This must be an alpha-numeric field, so that during the import
process, a P is prepended to all pay types to ensure they are alpha numeric.
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Description - Identifies the pay type description from the payroll system. Be as explicit as possible, avoid
abbreviations, and use layman’s terms.

TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.

Cost
These columns are specific to the set up and maintenance of Axiom Cost Accounting.

ResourcesCalculation - Determines the calculation behavior for the hours or dollars within the pay type
when using the payroll information within the RVU development process. When labor rates are
calculated for the Resource Table, the designation here determines if the Hours, Dollars, or Both are to
be used in the numerator and denominator in the average.

CostVariable - Determines whether the pay type is a fixed or variable cost.

YRMO Dates dimension
The YRMO Dates dimension is a simpler version of the Cal Dates dimension table, which helps processing
and performance speed of the system.

� Accessing the YRMO Dates dimension
In the Guide View, click Data Management > Core Dimensions > YRMO Dates.

The page can only display up to a maximum of 10,000 records.
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NOTE: At this time, you can only add, edit, or delete records in this dimension table directly through
Axiom Explorer > Table Library > !Dimensions > YRMO in theWindows or Excel Client. For more
information, see Opening dimension tables in spreadsheet mode.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Column descriptions
This section provides descriptions for each column in the YRMO Dates dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

YRMO - Zero (0) is a default value, 999999 is used in costing to denote a current effective date range (To
/From).

Cost
These columns are specific to the set up and maintenance of Axiom Cost Accounting.

CQtr - The calendar quarter.

CQtrCount - Themonth counter within a quarter period.

FYear - The fiscal year.
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FMonth - The fiscal month. It is the same as the GL Period associated with YRMO to link patient centric
tables with the CGL tables.

FQtr - The fiscal quarter.

FQtrCount - Themonth counter within a quarter period.

DaysInMth - The number of days in a month.

CopyPass - Reserved for future use.

MonthName - The name of themonth.

LongName -Month, yyyy

ShortName - mmm-yyyy

FLongName -Month, Fiscal yyyy

FShortName - mmm-Fiscal yyyy

ENCOUNTER DIMENSIONS

Age dimension
The Age dimension is a reference table used to capture the age of the patient during the loaded
encounter. Age is a reference field for the Enc_Patient.Age, Encounter.AgeAtAdmission, and
Encounter.AgeAtDischarge. The codes and descriptions used here will generally match your
organization's source systems and data standards, however, conversions may be warranted to improve
analysis and reporting.

� Accessing the Age dimension
In the Guide View, click Data Management > Encounter Dimensions > Age.
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The page can only display up to a maximum of 10,000 records.

NOTE: At this time, you can only add, edit, or delete records in this dimension table directly through
Axiom Explorer > Table Library > DSS > Reference > Age in theWindows or Excel Client. For more
information, see Opening dimension tables in spreadsheet mode.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Column descriptions
This section provides descriptions for each column in the Age dimension table: department

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.
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TIP: In this dimension, you can add custom "grouping" columns to customize the data you want to
query into reports. For more information, see Creating or modifying custom columns in dimensions.

Keys

Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

AGE - A five-character string value entered as an abbreviation. Examples include the following:

l N for newborn, delivered on-premise

l 3_H, for a newborn delivered and admitted

l 1_D for one day old

l 4_M for a four month old

l 25 for a twenty five year old

APR DRGs dimension
The APR DRGs dimension is a reference table used to manage the APR DRGs for your organization, which
are commonly implemented as part of the coding and billing process. These values will generally match
industry standards or your organization's source systems and data standards.

� Accessing the APR DRGs dimension
In the Guide View, click Data Management > Encounter Dimensions DRGs > APR DRGs.

The page can only display up to a maximum of 10,000 records.
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NOTE: At this time, you can only add or delete records in this dimension table directly through
Axiom Explorer > Table Library > DSS > Reference > APRDRG in theWindows or Excel Client. For
more information, see Opening dimension tables in spreadsheet mode.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Editing an APR DRG code
To edit an APR DRGs dimension:

1. In the table, do any of the following:
l To edit an APR DRG, click in the cell(s) to make your changes.

NOTE: Columns that are grayed out cannot be edited.

l To undo your changes, click the left arrow icon .
l To redo your changes, click the right arrow icon .

2. When you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the APR DRGs dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.
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APRDRG - The value for the All Patient Refined DRG.

Description - The description for the value.

TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.

Bill Types dimension
The Bill Types dimension is a reference table used to capture the bill type for the primary insurance claim
upon final bill drop for the encounter. Codes and descriptions will generally match your organization's
source systems and data standards. Bill types may also comply with regulatory requirements in some
cases, e.g., CMS Medicare claims.

� Accessing the Bill Type dimension
In the Guide View, click Data Management > Encounter Dimensions > Bill Types.

The page can only display up to a maximum of 10,000 records.

NOTE: At this time, you can only add or edit records in this dimension table directly through Axiom
Explorer > Table Library > DSS > Reference > BillType in theWindows or Excel Client. For more
information, see Opening dimension tables in spreadsheet mode.
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� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Editing a bill type
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To edit a bill type:
1. Click in the cell(s) to edit, and make your changes.

NOTE: Columns that are grayed out cannot be edited.

2. After you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the Bill Types dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys

Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

BillType - The bill type code that represents the primary insurance claim for the encounter.

Description - The description for the bill type.

Administrator's Guide 2019.4 Axiom Cost Accounting │ 107



TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.

Discharge Status dimension
The Discharge Status dimension is a reference table used to capture the discharge disposition of a patient
admission and/or how the patient left the provider facility for the loaded encounter. Codes and
descriptions generally match your organization's source systems and data standards. Discharge status
codes and descriptions may also comply with regulatory requirements in some cases, e.g., CMS
Medicare claim.

� Accessing the Discharge Status dimension
In the Guide View, click Data Management > Encounter Dimensions > Discharge Status.

The page can only display up to a maximum of 10,000 records.

NOTE: At this time, you can only add or delete records in this dimension table directly through
Axiom Explorer > Table Library > DSS > Reference > DischargeStatus in theWindows or Excel Client.
For more information, see Opening dimension tables in spreadsheet mode.
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� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Editing a discharge status
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To edit a bill type:
1. Click in the cell(s) to edit, and make your changes.

NOTE: Columns that are grayed out cannot be edited.

2. After you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the Discharge Status dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

DischargeStatus - The code used to identify the discharge disposition status of a patient.

Description - The description for the code.
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TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.

Financial Classes dimension
The Financial Class dimension is a reference table used to group insurance plans into financial classes for
the primary insurance claim. Codes and descriptions will generally match the your organization's source
systems and data standards. This dimension is shared with other Axiom Healthcare solutions.

� Accessing the Financial Classes dimension
In the Guide View, click Data Management > Encounter Dimensions > Financial Classes.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.
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� Adding or editing a financial class
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To add or edit financial classes:
1. In the table, do any of the following:

l To add a financial class, click Add Row. The new row displays at the bottom of the table.
Enter information in each column. After you save, the table will display the new row in
order by the FinClass column.

IMPORTANT: If you add a new record that already exists in the table, the system will
overwrite the original column values with your new entries when you save your
changes. We recommend that you review your entries before saving any changes.

l To edit a financial class, click in the cell(s) to make your changes.

NOTE: Columns that are grayed out cannot be edited.

l To undo your changes, click the left arrow icon .
l To redo your changes, click the right arrow icon .

2. When you finish making changes, click Save.

� Deleting an financial class
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To delete a financial class:
1. In the table, select the row to highlight it, and then click Delete Row.

2. At the Continue? prompt, click OK.

3. When you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the Financial Classes dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.
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Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

FinClass - The financial class code. This must be an alpha code so that an F is prefixed during the import
process.

Description - The description for the code.

TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.

ICD Diagnosis Codes dimension
The ICD Diagnosis Codes dimension includes the ICD diagnosis information, which is referred to by a
number of tables in the system. This information is used primarily used with cost detail, which my refer
to up to five standard ICDDIAG fields and more if needed in COSTDETAIL.Custom.

� Accessing the ICD Diagnosis Code dimension
In the Guide View, click Data Management > Encounter Dimensions > ICD Diagnosis Codes.

The page can only display up to a maximum of 10,000 records.

Administrator's Guide 2019.4 Axiom Cost Accounting │ 112



� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Adding or editing an ICD diagnosis code
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To add or edit an ICD diagnosis code:
1. In the table, do any of the following:

l To add an account, click Add Row. The new row displays at the bottom of the table. Enter
information in each column. After you save, the table will display the new row in order by
the ICDDIAGIDcolumn.

IMPORTANT: If you add a new record that already exists in the table, the system will
overwrite the original column values with your new entries when you save your
changes. We recommend that you review your entries before saving any changes.

l To edit a code, click in the cell(s) to make your changes.

NOTE: Columns that are grayed out cannot be edited.

l To undo your changes, click the left arrow icon .
l To redo your changes, click the right arrow icon .

2. When you finish making changes, click Save.

� Deleting an ICD diagnosis code
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To delete an ICD diagnosis code:
1. In the table, select the row to highlight it, and then click Delete Row.
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2. At the Continue? prompt, click OK.

3. When you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the ICD Diagnosis Codes dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

ICDDIAGID - The code for the ICD diagnosis identification.

Description - A description for the ICD diagnosis code (20 character limit)

ICD Procedure Codes dimension
The ICD Procedure Codes dimension is a reference table used to capture the clinical procedures
performed for the patient in the course of care for the encounter being loaded. These procedures are
referenced by the Encounter and Enc_Proc tables.

NOTE: These procedure codes are specific to the International Classification of Diseases (ICD)
procedure codes and do not include CPT or HPCPS procedure codes.

� Accessing the Account dimension
In the Guide View, click Data Management > Encounter Dimensions > ICD Procedure Codes.
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The page can only display up to a maximum of 10,000 records.

NOTE: At this time, you can only add or delete records in this dimension table directly through
Axiom Explorer > Table Library > DSS > Reference > ICDPROC in theWindows or Excel Client. For
more information, see Opening dimension tables in spreadsheet mode.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Editing an ICD procedure code
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To edit an ICD procedure code:
1. Click in the cell(s) to edit, and make your changes.
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NOTE: Columns that are grayed out cannot be edited.

2. After you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the ICD Procedure Codes dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys

Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

ICDPROCID - The code used for the ICD Procedure.

Description - The long entry description for the ICD Procedure code.

TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.

Insurance Plans dimension
The Insurance Plans dimension is a reference table used to capture the insurance plan of the subscriber
or guarantor for the loaded patient encounter. Codes and descriptions will generally match your
organization's source systems and data standards. This table also includes insurance plans grouped into
payors and financial classes.

� Accessing the Insurance Plans dimension
In the Guide View, click Data Management > Encounter Dimensions Insurance Plans.
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The page can only display up to a maximum of 10,000 records.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Adding or editing an insurance plan
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To add or edit an insurance plan code:
1. In the table, do any of the following:

l To add an insurance plan, click Add Row. The new row displays at the bottom of the table.
Enter information in each column.
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IMPORTANT: If you add a new record that already exists in the table, the system will
overwrite the original column values with your new entries when you save your
changes.

l To edit an insurance plan, click in the cell(s) to make your changes.

NOTE: Columns that are grayed out cannot be edited.

l To undo your changes, click the left arrow icon .
l To redo your changes, click the right arrow icon .

2. When you finish making changes, click Save.

� Deleting an insurance plan
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To delete an insurance plan:
1. In the table, select the row to highlight it, and then click Delete Row.

2. At the Continue? prompt, click OK.

3. When you finish making changes, click Save.

Locations dimension
The Locations dimension contains all of the physical locations that have been billed within the
organization and is used for monthly reporting and provider-level budgeting.

� Accessing the Locations dimension
In the Guide View, click Data Management > Encounter Dimensions > Locations.
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The page can only display up to a maximum of 10,000 records.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Adding or editing locations
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To add or edit locations:
1. In the table, do any of the following:

l To add a location, click Add Row. The new row displays at the bottom of the table. Enter
information in each column. After you save, the table will display the new row in order by
the LOCATION column.
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IMPORTANT: If you add a new record that already exists in the table, the system will
overwrite the original column values with your new entries when you save your
changes. We recommend that you review your entries before saving any changes.

l To edit a location, click in the cell(s) to make your changes.

NOTE: Columns that are grayed out cannot be edited.

l To undo your changes, click the left arrow icon .
l redo your changes, click the right arrow icon .

2. When you finish making changes, click Save.

� Deleting a location
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To delete a location:
1. In the table, select the row to highlight it, and then click Delete Row.

2. At the Continue? prompt, click OK.

3. When you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the Locations dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

LOCATION - The code used to represent the location. This must be an alpha code, so an L is prefixed
during the import process. Default should be used as the Location code if this dimension is not being
used.

Description - Describes the location associated with the code.
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TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.

DSS
These columns are used for the future development of Axiom Decision Support.

LocationEntity - The entity location code used to identify the physical location of the department
(entity).

TIP: The entity location code is different from the entity code, which is associated with a financial
department. For example, departments on a hospital campus may have different entity codes but
share the same entity location code because they reside in the same physical area.

MDC Codes dimension
TheMDC Codes dimension is a reference table used to place a DRG into a higher level category. Major
Diagnostic Categories (MDC) are universally defined and apply to DRGs, MDC values, and descriptions,
which will generally match your organization's source systems and data standards.

� Accessing the MDC Codes dimension
In the Guide View, click Data Management > Encounter Dimensions > DRGs > MDC Codes.

The page can only display up to a maximum of 10,000 records.

NOTE: At this time, you can only add or edit records in this dimension table directly through Axiom
Explorer > Table Library > DSS > Reference > MDC in theWindows or Excel Client. For more
information, see Opening dimension tables in spreadsheet mode.
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� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Editing an MDC code
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To edit an MDC code:
1. Click in the cell(s) to edit, and make your changes.

NOTE: Columns that are grayed out cannot be edited.

2. After you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in theMDC Codes dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys

Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

MDC - The code for theMDC.

Description - The description for theMDC code. You can enter up to 50 descriptions in this field.

Administrator's Guide 2019.4 Axiom Cost Accounting │ 122



TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.

Modifiers dimension
TheModifiers dimension includes the additional standard codes used to further identify services or
supplies used in the course of patient care. They can modify the CPT or the HCPCS. For example a
procedure donemultiple times, will have a modifier of 51. This may mean that there is a discount in
reimbursement, but also perhaps a reduction in the cost of the item.

� Accessing the Modifiers dimension
In the Guide View, click Data Management > Encounter Dimensions > Modifiers.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.
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� Adding or editing a modifier
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To add or edit a modifier:
1. In the table, do any of the following:

l To add a modifier, click Add Row. The new row displays at the bottom of the table. Enter
information in each column. After you save, the table will display the new row in order by
theMODIFIER column.

IMPORTANT: If you add a new record that already exists in the table, the system will
overwrite the original column values with your new entries when you save your
changes. We recommend that you review your entries before saving any changes.

l To edit a modifier, click in the cell(s) to make your changes.

NOTE: Columns that are grayed out cannot be edited.

l To undo your changes, click the left arrow icon .
l To redo your changes, click the right arrow icon .

2. When you finish making changes, click Save.

� Deleting a modifier
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To delete a modifier:
1. In the table, select the row to highlight it, and then click Delete Row.

2. At the Continue? prompt, click OK.

3. When you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in theModifiers dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.
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Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

MODIFIER - The additional status codes used to identify services and supplies.

Description - The long form description of the code.

TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.

MS DRGs dimension
TheMS DRGs dimension is a reference table used to manage theMS DRGs for hospital acute care
providers. Codes and descriptions will generally match industry standards or your organization's source
systems and data standards.

� Accessing the MS DRGs dimension
In the Guide View, click Data Management > Encounter Dimensions DRGs > MS DRGs.

The page can only display up to a maximum of 10,000 records.

NOTE: At this time, you can only add or delete records in this dimension table directly through
Axiom Explorer > Table Library > DSS > Reference > MSDRG in theWindows or Excel Client. For
more information, see Opening dimension tables in spreadsheet mode.
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� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Editing an MS DRG code
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To edit an MS DRG code:
1. In the table, do any of the following:

l To edit an MS DRG code, click in the cell(s) to make your changes.

NOTE: Columns that are grayed out cannot be edited.

l To undo your changes, click the left arrow icon .
l To redo your changes, click the right arrow icon .

2. When you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in theMS DRGs dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys

Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

MSDRGID - The value for theMS DRG.

Description - The description for the value.
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TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.

Patient Types dimension
The Patient Types dimension is a reference table used to capture the type of patient for the loaded
encounter. Codes and descriptions will generally match the your organization's source systems and data
standards.

NOTE: At this time, you can only edit records in this dimension table directly through Axiom
Explorer > Table Library > DSS > Reference > PTTYPE in theWindows or Excel Client. For more
information, see Opening dimension tables in spreadsheet mode.

� Accessing the Patient Types dimension
In the Guide View, click Data Management > Encounter Dimensions > Patient Types.

The page can only display up to a maximum of 10,000 records.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.
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2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Adding a patient type
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To add a patient type:
1. In the table, do any of the following:

l To add a patient type, click Add Row. The new row displays at the bottom of the table.
Enter information in each column. After you save, the table will display the new row in
order by the PtType column.

IMPORTANT: If you add a new record that already exists in the table, the system will
overwrite the original column values with your new entries when you save your
changes. We recommend that you review your entries before saving any changes.

l To undo your changes, click the left arrow icon .
l To redo your changes, click the right arrow icon .

2. When you finish making changes, click Save.

� Deleting a patient type
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To delete a patient type:
1. In the table, select the row to highlight it, and then click Delete Row.

2. At the Continue? prompt, click OK.

3. When you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the Patient Types dimension table:
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NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys

Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

PtType - The code for the patient type.

Place of Service Codes dimension
The Place of Service Codes dimension stores the place of service (POS) codes, which are standard
industry accepted codes that indicate where the services were rendered.

� Accessing the Place of Service Codes dimension
In the Guide View, click Data Management > Encounter Dimensions >Place of Service Codes.

The page can only display up to a maximum of 10,000 records.
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� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Adding or editing a Place of Service code
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To add or edit a Place of Service code:
1. Review and/or make selections for the following columns:

l To add a code, click Add Row. The new row displays at the bottom of the table. Enter
information in each column. After you save, the table will display the new row in order by
the PlaceOfService column.

IMPORTANT: If you add a new record that already exists in the table, the system will
overwrite the original column values with your new entries when you save your
changes. We recommend that you review your entries before saving any changes.

l To edit a code, click in the cell(s) to make your changes.

NOTE: Columns that are grayed out cannot be edited.

l To undo your changes, click the left arrow icon .
l To redo your changes, click the right arrow icon .

2. When you finish making changes, click Save.

� Deleting a Place of Service code
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To delete a Place of Service code:
1. In the table, select the row to highlight it, and then click Delete Row.
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2. At the Continue? prompt, click OK.

3. When you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the Place of Service Codes dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

PlaceOfService - The code used to indicate where the service was rendered.

Description - A long form description of where the service took place.

TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.

Point of Origin dimension
The Point of Origin dimension is a reference table used to capture the source of the patient admission
and/or how the patient was presented to the provider for the loaded encounter. Codes and descriptions
will generally match your organization's source systems and data standards. Point of Origin codes and
descriptions may also comply with regulatory requirements in some cases, e.g., CMS Medicare claims.

� Accessing the Point of Origin dimension
In the Guide View, click Data Management > Encounter Dimensions > Point of Origin.
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The page can only display up to a maximum of 10,000 records.

NOTE: At this time, you can only add or delete records in this dimension table directly through
Axiom Explorer > Table Library > DSS > Reference > PointOfOrigin in theWindows or Excel Client.
For more information, see Opening dimension tables in spreadsheet mode.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Editing a Point of Origin
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To edit a Point of Origin:
1. Click in the cell(s) to edit, and make your changes.
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NOTE: Columns that are grayed out cannot be edited.

2. After you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the Point of Origin dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys

Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

PointOfOrigin - The code for the source of the patient admission.

Description - The description for the Point of Origin.

TIP: To help make reports more readable

Present On Admission dimension
The Present On Admission dimension is a reference table used to capture the nature of a diagnosis coded
for a patient during the IP encounter being loaded. The Present On Admission code helps establish if a
diagnosis was a Hospital Acquired Condition (HAC). Codes and descriptions will generally match your
organization's source systems and data standards. This is a reference to the Enc_Diag.PresentOnAdmit.

� Accessing the Present on Admission dimension
In the Guide View, click Data Management > Encounter Dimensions > Present On Admission.

Administrator's Guide 2019.4 Axiom Cost Accounting │ 133



The page can only display up to a maximum of 10,000 records.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Adding or editing a Present On Admission code
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To add or edit a Present On Admission code:
1. In the table, do any of the following:

l To add a code, click Add Row. The new row displays at the bottom of the table. Enter
information in each column. After you save, the table will display the new row in order by
the PresentOnAdmit column.
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IMPORTANT: If you add a new record that already exists in the table, the system will
overwrite the original column values with your new entries when you save your
changes. We recommend that you review your entries before saving any changes.

l To edit a code, click in the cell(s) to make your changes.

NOTE: Columns that are grayed out cannot be edited.

l To undo your changes, click the left arrow icon .
l To redo your changes, click the right arrow icon .

2. When you finish making changes, click Save.

� Deleting a Present on Admission code
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To delete a Present on Admission code:
1. In the table, select the row to highlight it, and then click Delete Row.

2. At the Continue? prompt, click OK.

3. When you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the Present On Admission dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys

Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

PresentOnAdmit - The code that describes the nature of a diagnosis for a patient during the IP
encounter.

Desc - The description for the code.
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TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.

Providers dimension
The Providers dimension contains all of the providers within the organization and is used for monthly
reporting and provider-level budgeting.

� Accessing the Providers dimension
In the Guide View, click Data Management > Encounter Dimensions > Providers.

The page can only display up to a maximum of 10,000 records.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.
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� Adding or editing a provider
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To add or edit a provider:
1. In the table, do any of the following:

l To add an account, click Add Row. The new row displays at the bottom of the table. Enter
information in each column. After you save, the table will display the new row in order by
the Providercolumn.

IMPORTANT: If you add a new record that already exists in the table, the system will
overwrite the original column values with your new entries when you save your
changes. We recommend that you review your entries before saving any changes.

l To edit a provider, click in the cell(s) to make your changes.

NOTE: Columns that are grayed out cannot be edited.

l To undo your changes, click the left arrow icon .
l To redo your changes, click the right arrow icon .

2. When you finish making changes, click Save.

� Deleting a provider
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To delete a provider:
1. In the table, select the row to highlight it, and then click Delete Row.

2. At the Continue? prompt, click OK.

3. When you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the Providers dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.
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Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

Provider - The Provider ID used in Axiom Budgeting and Performance Reporting. Must be an alpha code,
so a D is prefixed during the import process.

Description - Identifies the provider description to use for budgeting and reporting.

TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.

Cost
These columns are specific to the set up and maintenance of Axiom Cost Accounting.

KAINT - Used to identify which tab an account should be interfaced during the plan file create process in
Axiom Budgeting.

DSS
These columns are reserved for future use with Axiom Decision Support.

CostProvider - The provider to use for costing purposes when using the Provider RVUmethod. This
allows providers to be grouped into a generic group for costing purposes.

MedicalGroup - The primary medical gGroup the provider is associated with for grouping and reporting
purposes.

City - The city where the provider resides.

State - The state where the provider resides.

SecondarySpecialty2 - The secondary specialty offered by the provider.

Reporting DRGs dimension
The Reporting DRGs dimension is a reference table used to combine or determine the primary DRGs used
for reporting purposes. In some cases, multiple DRGs may be assigned to an inpatient or in others only
certain DRGs may be assigned, e.g., MS DRGs are assigned to Medicare encounters and APR DRGs are
assigned to Medicaid encounters. This reference table allows you to combine or determine which DRG to
use within a single reference table. These values will generally match one of the DRG reference values.

� Accessing the Reporting DRGs dimension
In the Guide View, click Data Management > Encounter Dimensions DRGs > Reporting DRGs.
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The page can only display up to a maximum of 10,000 records.

NOTE: At this time, you can only add or delete records in this dimension table directly through
Axiom Explorer > Table Library > DSS > Reference > REPORTINGDRG in theWindows or Excel Client.
For more information, see Opening dimension tables in spreadsheet mode.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Editing a Reporting DRG code
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To edit a Reporting DRG code:
1. In the table, do any of the following:

l To edit a Reporting DRG code, click in the cell(s) to make your changes.

NOTE: Columns that are grayed out cannot be edited.

l To undo your changes, click the left arrow icon .
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l To redo your changes, click the right arrow icon .

2. When you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the Reporting DRGs dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

ReportingDRG - The value for the Reporting DRG.

Services dimension
The Services dimension is a reference table used to capture the services of the patient during the
encounter course of care. Services is a reference field for the Encounter.PrimaryService. The codes and
descriptions heremay match your organization's source systems and data standards, but can also be
created to meet specific analysis and reporting needs.

� Accessing the Services dimension
In the Guide View, click Data Management > Encounter Dimensions > Services.
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The page can only display up to a maximum of 10,000 records.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Adding or editing a service
To add or edit a service:

1. In the table, do any of the following:
l To add a service, click Add Row. The new row displays at the bottom of the table. Enter

information in each column. After you save, the table will display the new row in order by
the Services column.
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IMPORTANT: If you add a new record that already exists in the table, the system will
overwrite the original column values with your new entries when you save your
changes. We recommend that you review your entries before saving any changes.

l To edit a service, click in the cell(s) to make your changes.

NOTE: Columns that are grayed out cannot be edited.

l To undo your changes, click the left arrow icon .
l To redo your changes, click the right arrow icon .

2. When you finish making changes, click Save.

� Deleting a service
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To delete a service:
1. In the table, select the row to highlight it, and then click Delete Row.

2. At the Continue? prompt, click OK.

3. When you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the Services dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

Services - The code the represents the service for the patient.

Description - The description for the service.

TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.
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Sex dimension
The Sex dimension is a reference table used to capture the sex of the patient during the loaded
encounter. Sex is a reference field for the Enc_Patient.Sex. The codes and descriptions will generally
match your organization's source systems and data standards.

� Accessing the Sex dimension
In the Guide View, click Data Management > Encounter Dimensions > Sex.

The page can only display up to a maximum of 10,000 records.

NOTE: At this time, you can only edit records in this dimension table directly through Axiom
Explorer > Table Library > DSS > Reference > Sex in theWindows or Excel Client. For more
information, see Opening dimension tables in spreadsheet mode.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.
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3. Click Apply.

� Adding the sex code
To add the sex code:

1. In the table, do any of the following:
l To add a sex, click Add Row. The new row displays at the bottom of the table. Enter

information in each column. After you save, the table will display the new row in order by
the SEX column.

IMPORTANT: If you add a new record that already exists in the table, the system will
overwrite the original column values with your new entries when you save your
changes. We recommend that you review your entries before saving any changes.

l To undo your changes, click the left arrow icon .
l To redo your changes, click the right arrow icon .

2. When you finish making changes, click Save.

� Deleting a sex code
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To delete a sex code:
1. In the table, select the row to highlight it, and then click Delete Row.

2. At the Continue? prompt, click OK.

3. When you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the Sex dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys

Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

SEX - The code for the sex of the patient.
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TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.

Stations dimension
The Stations dimension is a reference table used to capture the nursing station of a patient when first
admitted to a facility as well as the station from which the discharge occurred for the loaded encounter.
Codes and descriptions will generally match the your organization's source systems and data standards.

� Accessing the Stations dimension
In the Guide View, click Data Management > Encounter Dimensions > Stations.

The page can only display up to a maximum of 10,000 records.

NOTE: At this time, you can only add or delete records in this dimension table directly through
Axiom Explorer > Table Library > DSS > Reference > Station in theWindows or Excel Client. For
more information, see Opening dimension tables in spreadsheet mode.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

Administrator's Guide 2019.4 Axiom Cost Accounting │ 145



2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Editing a station
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To edit a station:
1. Click in the cell(s) to edit, and make your changes.

NOTE: Columns that are grayed out cannot be edited.

2. After you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the Stations dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

Station - The code assigned to the nursing station.

Description - The description for the code.

TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.
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Transaction Codes dimension
The Transaction Codes dimension is a reference table used to capture the transaction codes for
payments and adjustments stored in the Enc_Payments table for the loaded encounter. Codes and
descriptions will generally match your organization's source systems and data standards. You can also
use this table to group transaction codes into transaction types.

� Accessing the Transaction Code dimension
In the Guide View, click Data Management > Encounter Dimensions > Transaction Codes.

The page can only display up to a maximum of 10,000 records.

NOTE: At this time, you can only add or delete records in this dimension table directly through
Axiom Explorer > Table Library > DSS > Reference > TransactionCode in theWindows or Excel
Client. For more information, see Opening dimension tables in spreadsheet mode.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter

Administrator's Guide 2019.4 Axiom Cost Accounting │ 147



statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Editing a transaction code
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To edit a transaction code:
1. Click in the cell(s) to edit, and make your changes.

NOTE: Columns that are grayed out cannot be edited.

2. After you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the Transaction Codes dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

TransactionCode - The financial class code. This must be an alpha code so that an F is prefixed during the
import process.

Description - The description for the code.

TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.

LongDescription - A longer description or comments about the transaction code.

TransactionType - Type of transaction code. Allows you to group individual transaction codes into types.
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COST ITEM DIMENSIONS

CDM Codes dimension
The CDM Codes dimension includes all the charge codes within an organization. The charge codes are
used to track gross revenue and statistics at an inpatient (IP) and outpatient (OP) level.

� Accessing the CDM Codes dimension
In the Guide View, click Data Management > Costing Data > Cost Item Dimensions > CDM Codes.

The page can only display up to a maximum of 10,000 records.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Editing a CDM code
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.
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To edit a CDM code:
1. In the table, click in the cell(s) to edit, make your changes.

NOTE: Columns that are grayed out cannot be edited.

2. Click Save.

� Column descriptions
This section provides descriptions for each column in the CDM Codes dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

CDMCODE - The charge codes used within your organization. This must be an alpha numeric field so that
during the import process, a C is appended to all CDM codes to ensure they are alpha numeric.

Description - Identifies the CDM code description. Try to be as explicit as possible, avoid abbreviations,
and use layman’s terms.

TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.

CPT Codes dimension
The CPT Codes dimension contains all of the CPT codes that have been billed within the organization and
is used for monthly reporting and provider-level budgeting.

� Accessing the CPT Codes dimension
In the Guide View, click Data Management > Costing Data > Cost Item Dimensions > CPT Codes.
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The page can only display up to a maximum of 10,000 records.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Adding or editing a CPT code
To add or edit a CPT code:

1. In the table, do any of the following:
l To add a code, click Add Row. The new row displays at the bottom of the table. Enter

information in each column. After you save, the table will display the new row in order by
the CPT column.

IMPORTANT: If you add a new record that already exists in the table, the system will
overwrite the original column values with your new entries when you save your
changes. We recommend that you review your entries before saving any changes.

l To edit a code, click in the cell(s) to make your changes.
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NOTE: Columns that are grayed out cannot be edited.

l To delete a code, select the row to highlight it, and then click Delete Row. At the Continue?
prompt, click OK.

l To undo your changes, click the left arrow icon .
l To redo your changes, click the right arrow icon .

2. When you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the CPT Codes dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

TIP: In this dimension, you can add custom "grouping" columns to customize the data you want to
query into reports. For more information, see Creating or modifying custom columns in dimensions.

Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

CPT - The CPT code used in Axiom Budgeting and Performance Reporting. This must be an alpha code, so
a C is prefixed during the import process.

Description - Identifies the CPT description to use for budgeting and reporting.

TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.

HCPCS Codes dimension
The HCPCS Codes dimension includes HCPCS codes used within your organization as level 3 CPT codes
that provide further detail as to the services, procedures, or supplies that were used in the course of
care.

� Accessing the HCPCS Codes dimension
In the Guide View, click Data Management > Costing Data > Cost Item Dimensions > HCPCS Codes.
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The page can only display up to a maximum of 10,000 records.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Adding or editing an HCPCS code
To add or edit an HCPCS code:

1. In the table, do any of the following:

l To add a code, click Add Row. The new row displays at the bottom of the table. Enter
information in each column. After you save, the table will display the new row in order by
the HCPCS column.

IMPORTANT: If you add a new record that already exists in the table, the system will
overwrite the original column values with your new entries when you save your
changes. We recommend that you review your entries before saving any changes.

l To edit a code, click in the cell(s) to make your changes.
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NOTE: Columns that are grayed out cannot be edited.

l To delete a code, select the row to highlight it, and then click Delete Row. At the Continue?
prompt, click OK.

l To undo your changes, click the left arrow icon .
l To redo your changes, click the right arrow icon .

2. When you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the HCPCS Codes dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

HCPCS - The HCPCS codes, which can be unique to states, payors, etc.

Description - A long form description of the code.

TIP: To help make reports more readable, we recommend that you do not use all capital letters in the
description content.

Revenue Codes dimension
The Revenue Codes dimension lists all of the revenue codes.

� Accessing the Revenue Codes dimension
In the Guide View, click Data Management > Costing Data > Cost Item Dimensions > Revenue Codes.
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The page can only display up to a maximum of 10,000 records.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Adding or editing a revenue code
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To add or edit a revenue code:
1. In the table, do any of the following:

l To add a revenue code, click Add Row. The new row displays at the bottom of the table.
Enter information in each column. After you save, the table will display the new row in
order by the REVCODE column.

IMPORTANT: If you add a new revenue code that already exists in the table, the system
will overwrite the original column values with your new entries when you save your
changes.
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l To edit a revenue code, click in the cell(s) to make your changes.

NOTE: Columns that are grayed out cannot be edited.

l To undo your changes, click the left arrow icon .
l To redo your changes, click the right arrow icon .

2. When you finish making changes, click Save.

� Deleting a revenue code
Due to the large number of records that this table may contain, you need to use the Filter panel to
identify the records to display.

To delete a revenue code:
1. In the table, select the row to highlight it, and then click Delete Row.

2. At the Continue? prompt, click OK.

3. When you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the Revenue Codes dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

TIP: In this dimension, you can add custom "grouping" columns to customize the data you want to
query into reports. For more information, see Creating or modifying custom columns in dimensions.

Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

REVCODE - The UB revenue code associated with a chargeable cost item in an institutional setting where
UB billing is supported.
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Cost Items dimension
The Cost Items dimension defines the cost object to which costs are allocated during the unit cost
calculation processes for all methods. It can be a chargeable activity or item, thus the foreign key
reference to CDM codes, but it can also be a non-chargeable item. The cost item can also be created
during a Direct to Encounter costing process, whereby the encounters can be assigned cost items based
on business rules.

� Accessing the Cost Items dimension
In the Guide View, click Data Management > Costing Data > Cost Item Dimensions > Cost Items.

The page can only display up to a maximum of 10,000 records.

� Filtering records
To filter records:

1. Click the funnel icon in the upper left corner of the page.

2. In the Filter box, you can narrow down the records to display by selecting or creating a filter using
the Filter Wizard. To access the Filter Wizard, click Edit. If you are familiar with writing filter
statements, you can type the statement syntax directly in the Filter box.

3. Click Apply.

� Editing cost items
To edit cost items:

1. In the table, do any of the following:
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l To edit a cost item, click in the cell(s) to make your changes.

NOTE: Columns that are grayed out cannot be edited.

l To delete a cost item, select the row to highlight it, and then click Delete Row. At the
Continue? prompt, click OK.

l To undo your changes, click the left arrow icon .
l To redo your changes, click the right arrow icon .

2. When you finish making changes, click Save.

� Column descriptions
This section provides descriptions for each column in the Cost Items dimension table:

NOTE: The table may display some columns that are related to other Kaufman Hall products or have
been created specifically for your organization. Contact your Kaufman Hall Implementation
Consultant or Kaufman Hall Support if you need help with these columns.

Keys
Every table in the databasemust have at least one key column. Key columns define unique records of
data in the table. If a table has one key column, then each value in that key column must be unique and
defines a unique record in the table. If a table has multiple key columns, then each combination of values
in those key columns defines a unique record in the table.

CostItem - The primary key for the table and uniquely identifies the cost item.

Cost
These columns are specific to the set up and maintenance of Axiom Cost Accounting.

DEPT - The default department for the cost item. Many chargeable items are used in multiple
departments.

CDMCODE - The reference to the CDM code potentially associated to the cost item, if not set to the
default.

REVCODE - The UB revenue code associated with a chargeable cost item in an institutional setting where
UB billing is supported.

CPT - The CPT code associated with a chargeable cost item in an institutional or professional setting.

TYPE - A client-controlled Type indicator helpful in filtering cost items of particular nature or category.
This can be used to indicate different cost treatment in the costing process.
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HCPCS - The HCPCS code associated with a chargeable cost item in an institutional or professional
setting.

CreateDate - Reserved for future use.

Configuring system account ranges
In the cost accounting process, you can apply costs incurred by one department to other departments
using the reclass, allocation, or adjustment processes. For example, applying costs for inpatient
transportation, building maintenance, or marketing to a clinical department.

To reflect these transactions, Axiom Cost Accounting creates pseudo-accounts within departments to
offset costs in source departments and write costs to receiving departments. These accounts are created
and stored in the System Account Ranges driver file.

For example, when applying inpatient transportation costs to a clinical department, a pseudo-offset is
created in the transportation department with a negative balance, and a correlating pseudo-account is
created in the clinical department reflecting the dollars allocated.

The driver displays the following range sections:

l Reclass Account Ranges - Typically, the reclass process involves reclassifying dollars that you want
to appear as direct costs in the receiving department, regardless of whether the departments
involved are direct or indirect.

l Allocation Account Ranges - The allocation account ranges allow for allocation of overhead and
other account/department combinations based on a driver statistic.

l Cost Item Calculation Offsets - As expenses are applied to cost items, offset accounts will balance
them out. For example, as labor dollars are applied to a cost item, fixed and variable offset
accounts will be created in the source department to offset dollars transferred to these cost items.

l Statistic Account Ranges - These account ranges define statistics created within the system. These
may include payroll variability statistics or any other statistic that might factor into cost
calculations.

IMPORTANT: We recommend that you only set this during the implementation of Axiom Cost
Accounting. If you change this after implementation, it will impact the entire system.

To configure account ranges:
1. In the Guide View, clickMethods and Assumptions > Assumptions > General Configuration.
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2. Click the System Account Ranges link.

3. From theNumber of digits for Beginning and End ranges drop-down, select the number of digits
in the account ranges.

4. To save your changes, click the disk icon in the upper right corner of the page.
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Managing Unit Cost Method
Assignments

This chapter includes topics related to configuring and maintaining method assignments.

Managing default cost methods exceptions
After the Cost Pool table is set up by your Kaufman Hall Implementation consultant, you can configure
any default cost method exceptions for any entities, departments, or revenue codes from the Setup
Default Cost Methods page.

When you click the Entity and Department link at the top of the page, the exception departments display
by entity on the left side of the page. The first row shows the default cost method for each cost pool
listed in the second row. The columns then display the default cost methods for each cost pool column.

From this page, you can add or edit a cost method exception for an entity or department. Any changes
are treated as an exception to the Default Cost PoolMethod assignment set up in prior steps in the
costing process. Blue cells indicate that the cost method has changed from the original value so that you
can easily track what cost methods have changed for which departments or entities.

3
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The entity row displays in the line above the list of departments and shows the default cost pool
assignment. The departments under that entity are assigned that default method assignment. If you
make a change at the entity level, that exception will propagate down to the department level.

NOTE: If the values in the department is already defined, then changes made at the entity level will
not bemade at the department level. You will need to make any default method changes manually.

You can also perform these same actions for revenue codes and/or revenue codes for departments.
They are accessible through the Setup Default Cost Methods page from the following links at the top of
the page:

l Revenue Code -Manage the default cost method exceptions for revenue codes only.
l Revenue Code and Department -Manage the default cost method exceptions for revenue codes

across departments.

To manage default cost methods exceptions:
1. In the Guide View, clickMethods and Assumptions > Methods > Assign Default Cost Methods.
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2. At the top of the page, click one of the following links, depending on the exceptions to manage:
l Entity and Department
l Revenue Code
l Revenue Code and Department

2. Do one of the following:

l Edit a department or revenue exception - Navigate to the department or revenue code in
which to make an exception, from the drop-down list in the cost pool column, select the
cost method.

TIP: Any cell changes you make display in italics until you save your changes, at which
point they will change to a blue cell.
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NOTE: The drop-down list ofmethods only displays those set up by your organization
in the System Configuration page.

l Add a department or revenue code to the list of exceptions - Click Add Row at the top of
the page. In the dialog, select the entity and then the department. Click OK. From the
department or revenue code drop-down list in the cost pool column, select the cost
method to assign as the exception.

l Delete a department or revenue code from the list of exceptions - Click Delete Row at
the top of the page. At the conformation prompt, click OK.

3. After making your changes, in the upper right corner of the page, click Save.

Using the Relative Value Units (RVU) method
Relative Value Units allocation method is themost commonly chosen methodology to calculate cost at
the cost item level. RVU allocations allow you to comparatively evaluate cost items in a department so
that you can allocate cost according to the resources that you use (labor, supply, capital, etc.).

RVUs are assigned to cost items for each cost pool within a department. This allows codes to receive only
the related expenses, such as labor for time charges and supply expense for implant items. The RVU basis
should reflect the department structure and data available.

You should update RVUs, as needed. For example, when minutes are used for procedures, you should
check in once a year with the department managers to verify whether or not anything has changed. Have
they made processes changes that havemade some procedures quicker, or is there no longer a need to
have an RN present for certain procedures? Have any procedures been added? Setting up an annual
review of RVUs is best practice to assure that you are allocating costs properly.

TIP: Themost basic rule of RVU costing is that any item that does not consume resources in a
particular cost pool should receive an RVU value of 0 (zero) so that no cost is assigned for that cost
pool to that cost item.

The following table lists the types of RVUs available:
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Type Description

Variable Labor The RVU for variable labor is often time required for the activity.
You can express this in minutes or hours, as long as it is
consistent within the department. The cost data becomes more
flexible, and you can perform additional analysis if the RVU
reflects estimated time by resource group (For example, RN,
Tech).

Supply Expense The RVU for variable supplies can be the acquisition cost for all
chargeable items and an estimate of non-chargeable costs for
the other codes in a department (For example, Room and
Board). As noted earlier in this document, chargeable and non-
chargeable items will ideally not be in the same GL account. If
that tenet holds true, use separate cost pools for each category.

Depreciation Allocating depreciation provides both opportunities and
challenges. Areas such as the OR often have major equipment
that is specific to a procedure, such as a YAG laser. However, the
depreciation is typically in an account along with all equipment,
both patient care and non-patient care (For example, office
furniture). Invoke the following strategies to provide a more
accurate assignment of cost:

l Costing reclass – You can shift patient care equipment
depreciation into pseudo-accounts set up for costing. This
allows you to isolate and assign the expense to the
appropriate cost items. This requires access to the asset cost
information in the Fixed Asset System.

l Spread general equipment by one of the following methods:
o Allocating evenly across all cost items
o Allocating to procedure or room charges only
o Allocating only to set up or initial time charge (assuming

that is the charge structure, such as in an OR)

Other Cost Pools RVUs for other types of cost pools should reflect the cost
structure of those pools. For example, if Purchased Services is a
cost pool, the RVU could be the actual cost per unit (or average
cost) for the purchased service (lithotripsy, nuclear scans, neuro
monitoring, and so on).
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Type Description

Alternative RVU Structures For some departments, developing detailed RVUs is not feasible.
The Clinical Lab is an example where the level of detail required
to calculate the RVU for each test can be greater than the
benefit. You can use a scale method (1-20 scale of resource
utilization) to assign costs. This approach is easier to maintain
and can be just as accurate if the department has a
knowledgeable manager who can assign the scale for each cost
pool.

Collecting RVUs
The following list describes a general procedure to gather the information you need to determine RVUs.

1. Determine the department(s) in which to collect RVUs.

2. Set up meetings with department managers to discuss the process and the benefits of using RVUs
in costing. It is likely that you will need to havemore than onemeeting. If possible, have a meeting
with all of the department leaders of a particular service line at the same time. For example, all
radiology or pharmacy. If you are a multi-facility organization, plan to bring together someone
from each facility to participate.

3. Collect revenue and usage data on each department that is relative to the time period that is
being costed. Revenue and usage data contains a list of cost items (charges, procedures, etc.)
along with volume and unit charge that are captured within that department.

4. Set up a spreadsheet for each department that lists the cost items vertically, with the volume,
revenue, unit charge, and all cost categories used in that department in columns.

5. Discuss departmental operations.

a. Discuss the staff and their roles within the department: RN, Tech, Managers/Supervisors,
etc.

b. Walk through the process of servicing an average patient who has a visit in this
department:

l Howdoes the patient arrive to the department? Are they transported by the
transport department, or does someone from this department retrieve the patient
from their room or other area? Is this an outpatient department where the patient
arrives without assistance?

l Is registration involved? Who registers the patient?

l Is pre-procedure work completed? Who performs this work? Is it performed prior to
arriving to this department?
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l Who performs each function and how long does it take? Howmany procedures are
charged to the patients in this department? Does an RN take 10minutes, 20, or not
involved at all with specific procedures? How about the tech or aide? Or perhaps all
are involved but for different lengths of time.

NOTE: For multi-facility organizations, there will be nuances that will dictate differences
in RVU collection. For example, a larger hospital may have a transport department that
moves patients around to where their next test is located, but the small hospital has to
send staff to retrieve the patient from their room. The time it takes to perform a task in
the hospital with the transport department will be less than the hospital who has to get
the patient. Theremay be small hospitals, however, who bring the equipment to the
bedside and may actually take less time than the larger hospital. The goal is to
understand the process involved within each department for an average case and to
determine the skill mix and time needed to perform procedures.

c. Collect supply, pharmacy, depreciation, and other RVUs based on various measures, which
may or may not involve a measure of time. Supplies are typically acquisition cost
(Microcosted), as is pharmacy. Depreciation is typically fixed asset information, all of which
are a separate function from the traditional RVU process in Axiom Cost Accounting.

Assigning the RVU method
To assign the RVU Method:

1. In the Guide View, clickMethods and Assumptions > Methods > RVU Method Assignment.

2. From the RVU YRMO drop-down, select the year and month.
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3. From the Select Target Method Version drop-down, select the version number to use for the
method definition table.

4. Click Run Now.

The system schedules a job to run the import.

TIP: After you run themethod assignment, the system displays a separate tab that displays the
status of the assignment tasks, including the result, the time the job was started, how long it lasted,
and the user that ran the job. For more information, see Viewing scheduled job results.

Setting up RVU users
Many times, managing department RVUs is handled by people outside of the costing department. In
Axiom Cost Accounting, you can set up these individuals to manage and review RVUs for their
department without the need to access the entire system. To do this, administrators need to complete
two main steps:

1. Assign the RVU user role profile.

2. Designate RVU owners and reviewers.

� Assigning the RVU User role profile
The first step to setting up an RVU user is for the administrators to assign the RVUUser role profile. For
these users, the system only displays RVUs specific to the user's defined department. For administrators,
the system displays all department RVUs.

To assign the RVU User role profile:
1. Open theWindows Client.

2. Open the Security Manager.

3. Add a new user or select an existing user.

4. Above the Assigned Roles box, click +.
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5. In the Assign Roles dialog, select RVU User, and click Add.

6. Above the Assigned Subsystems box, click +.

7. In the Assign Subsystems dialog, click Cost Accounting.

8. After making your changes, click Apply, and then click OK.

� Designating RVU owners and reviewers
After the administrator assigns the RVUUser role profile, they need to designate an RVU owner and
reviewer for each department. Administrators can also be an owner and/or reviewer, but they must also
be assigned the RVU user role.

To assign RVU owners and reviewers:
1. In the Guide View, click RVU Development and Maintenance > RVU Department Status.
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2. For each department, do the following:
a. In theOwner column, select an RVU user from the drop-down

b. In the Reviewer column, select an RVU user from the drop-down.

NOTE: Both an owner and reviewer must be assigned before status updates can be saved.

3. After making your changes, click Save in the upper right corner of the page.

For instructions on maintaining and reviewing RVUs, seeManaging department RVU status.

Managing department RVU status
The RVUDepartment Status page allows you to track the status of the RVU review process for your
departments. Users of this page are set up by the administrator as a department owner and/or reviewer.
Owners and reviewers can set the status for each department's RVU for the RVU version, view the
department's RVU values, and view a change history for each department. The system only displays
departments assigned to you.

NOTE: The actions taken in the RVUDepartment Status page do not affect any processes done in
Axiom Cost Accounting at this time. This page simply provides an easy way to manage the review
process for your organization.

Administrators - You can set up people outside of the costing organization to manage and review RVUs
for their department by assigning them the RVUUser role profile and assigning them as a owner and/or
reviewing. For instructions, see Setting up RVU users.

� Accessing the RVU Department Status page
In the Guide View, click RVU Development and Maintenance > RVU Department Status.
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� Editing department RVU values
You can view or update an RVU version by moving your cursor to the right of the Status column, and

then clicking the notepad icon.

The RVUMaintenance page displays. For more information, see Creating or updating RVU versions.
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� Setting department RVU status
From the Status column, select one of the following status descriptions:

Status Description

Inactive The department does not have any RVUmethods, by default. This
state can also be used to skip the department from being worked on.

Active The department has RVUmethods associated with it. This state can
also be used to indicate it needs to be worked on.

Pending The department is being worked on.

Review The department is completed and ready for review and/or accepted
as Done.

Done The department is updated and completed for this version (only the
person assigned to the reviewer or administrator role can move to
this state).

NOTE: The available status descriptions listed above depends on whether the user is designated as
an owner or reviewer.

After making your changes, click Save in the upper right corner of the page.
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IMPORTANT: Both an owner and reviewer must be assigned for status changes to save in the
system. The owner and reviewer can be the same user.

� Viewing department RVU status history

In the RVU line item, move your cursor to the right of the Status column, and then click the clock
icon.

The history dialog displays a history of the assigned owners, reviewers, status, and date the changes
weremade. To close the dialog, click OK.

Assigning the Microcost method
Microcost is a costing method applied to cost items for selected cost categories where the vendor
acquisition cost per unit is used as the unit cost. This costing method is used in situations where a supply
item has a known cost that can be assigned, such as when using a single vendor and a contract price is
negotiated for an extended period of time. Cost items that belong to the following cost categories are
likely candidates to assign as Microcost:

l Medical supplies
l Implants
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l Pharmaceuticals

Update the acquisition cost of cost items, as needed. As fiscal months close (or quarters, depending on
how often you process costs), review the new cost items used during that month’s or quarter’s service
date range. You will need to evaluate new cost items to determine themost appropriate costing method
assignment that reflects the information available (RVU, RCC, Microcost, and ReverseMarkup).

The per-unit cost imported into theMicrocost Item table is expected to be an average for themonth
imported.

Prerequisite: Before you begin this process, make sure you review your chart of accounts, and map
them to cost categories as well as map the cost categories to cost pools. For each cost pool, look at the
cost items, and assign a method to each.

TheMicrocost method only assigns cost to cost items if the vendor cost is loaded into theMicrocost
table.

To assign the Microcost method:
1. In the Guide View, clickMethods and Assumptions > Methods > Microcost Method Assignment.

2. From the Select Cost Set drop-down, select the cost set in which to assign themethod.

NOTE: The system defaults to the currently active cost set.
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3. From the YRMO Start Date drop-down, select the starting year and month.

4. From the YRMO End Date drop-down, select the ending year and month.

5. From the Select Target Method Version drop-down, select the version number to use for the
method definition table.

6. Click Run Now.

The system schedules a job to run the import.

TIP: After you run themethod assignment, the system displays a separate tab that displays the
status of the assignment tasks, including the result, the time the job was started, how long it lasted,
and the user that ran the job. For more information, see Viewing scheduled job results.

Assigning the Transaction Cost method
To assist with assigning many methods to a large number of cost items, similar to RVU and Microcost,
you can use the Transaction Cost Method Assignment page to update the cost item method.

To assign the Transaction Cost Methods:
1. In the Guide View, clickMethods and Assumptions > Methods > Transaction Cost Method

Assignment.
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2. From the Select Cost Set drop-down, select the cost set in which to assign themethod.

NOTE: The system defaults to the currently active cost set.

3. From the YRMO Start Date drop-down, select the starting year and month.

4. From the YRMO End Date drop-down, select the ending year and month.

5. From the Select Target Method Version drop-down, select the version number to use for the
method definition table.

6. Click Run Now.

The system schedules a job to run the import.

TIP: After you run themethod assignment, the system displays a separate tab that displays the
status of the assignment tasks, including the result, the time the job was started, how long it lasted,
and the user that ran the job. For more information, see Viewing scheduled job results.

Processing default cost method assignments tomethod
definitions

Use this page to create a newmethod definition version from the defaults.
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IMPORTANT: If a cost item is already assigned a method in the given method definition version, the
system will skip the cost item. You cannot use this page to update or change an assignment. To
update to an assigned method to an already-mapped cost item, go to the Cost Methods by Cost
Item page. You will need to do this after you create a new version using this page. To remap defaults
(for example, to change themethodology/ies in which you want to calculate costs, whether to test a
new scenario or correct a mistake), you need to re-setup cost pool table defaults, department
assignments, revenue code assignments, revenue code department exceptions, and then return to
the Process Defaults Into Method Definition page and type in a new version number.

To process defaults into method definitions:
1. In the Guide View, clickMethods and Assumptions > Methods > Process Defaults Into Method

Definition.

Click image to view full size

2. From the YRMO Start Date drop-down, select the YRMO start date in which to assign the cost
items.

3. From the YRMO End Date drop-down, select the YRMO end date in which to assign the cost
items.

4. From the Select Target Method Version drop-down, select the version of theMethod Definition
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table in which to process the default cost method assignments.

5. Click Run Now.

6. In the Information dialog, click OK.

To view the status of the processes, see Viewing scheduled job results.

Assigning default cost methods to cost items
Use the Default Cost Method Assignment utility to assign cost methods to cost items. For each cost item,
Axiom Cost Accounting assigns the cost method from one or more of the following dimension tables:

l CostPool
l DeptCostPoolMethod
l RevCodeCostPoolMethod
l RevCodeDeptCostPoolMethod

NOTE: You can only use this utility save to a newmethod definition version. You cannot overwrite an
existing definition.

To assign default cost methods to cost items:
1. In the Cost Accounting Admin task pan, in the Costing Structure Maintenance section, click Unit

Cost Method Assignments, and double-click Default Cost Method Assigment Utility.

2. In the Execute Import: Default Cost Method Assignment Utility dialog, click Execute.

Configuring exceptions to cost itemmethod assignments
After running the Default Cost Method Assignment utility, use the Cost Item Method Assignment utility
to update cost items with exceptions to the department default by cost item and cost pool.
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� Filtering cost items and editing method assignments
When you open the utility, the page does not display any data other than the cost pools and their
corresponding default cost method assignments (located in the first two rows at the top of the page)
until you configure the filter. You filter for cost items to display in the utility by using the following
parameters:

l Method assignment version
l Entity
l Department
l RevCode (optional)
l Start and end service dates

The utility then displays a list of all the individual cost items and their corresponding method
assignments. You can edit the cost item method assignment different ways depending on your needs,
such as assigning a cost method across all cost pools or editing an assignment for one or more specific
cost pools.

You can also view the cumulative amount of all the cost items by hovering your mouse cursor over each
percentage in the Amount % column. This allows you to focus your effort on making assignment changes
to the larger majority of your cost items.
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� Using the Threshold Ruler
The Threshold Ruler provides a quick and easy way to assign methods to multiple cost items based on a
cumulative percentage of revenue. The Threshold Ruler configuration is a part of the filter that allows you
to specify a cumulative percentage of the total revenue based on the cumulative amount or volume.
When you apply the ruler, the page displays a line to show you which cost items above the line are part
of the cumulative percentage.

After identify these cost item, you can then assign a method to the items above and below the line. You
can do this for all of the cost items or specify one or more cost items.

In the following example, the cost items above the linemake up 90% of the total revenue. The user
configures the filter to do the following:

l For the cost items above the line, assign the RCC method to the RN, Tech, and MidLvl cost pools.
l For the cost items below the line, assign the Transaction method to the RN, Tech, and MidLvl cost

pools.
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� Notes regarding cost item assignments
Keep in mind the following when assigning default methods to cost items:

l If a cost item displays with no method assignments, this means that the cost item is not included
in the version you selected in the filter. This can happen if you select a service start and end YRMO
date that covers a wider range of time than themethod assignment version you selected. For
example, if a method assignment version covers threemonths, but you set the service start and
end YRMO time frame for fivemonths, then any of the cost items outside of the threemonth
version dates will display without any methods assigned to them. However, if you assign a
method to these blank assignments, the system will automatically include them in the version
when you save your changes.

l If the cost pool assignment is not applicable, you can assign cost methods for specific entities or
departments.

l If using Direct to Encounter functionality, you must assign a method of RVU at the department or
cost item level for these Direct to Encounter departments.

� Steps to configure cost item method assignments
To configure exceptions to cost item method assignments:

1. In the Guide View, clickMethods and Assumptions > Methods > Cost Methods by Cost Item.
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NOTE: The utility opens in a separate browser window. When the utility first opens, no
information displays other than the Cost Pool and Cost Pool Default Cost Method rows at the
top of the page.

2. In the upper left corner of the page, click the filter icon.

TIP: To keep the filter dialog available, click the thumbtack in the upper right corner of the
dialog. This keeps the dialog displayed while working in the utility.

3. In the Configuration section of the filter, complete the following, as needed:

Option Description

Select Method
Assignment Version

As part of running the Default Cost Method Assignment utility, the
system assigns a version to the cost assignments based on a specific
period of time.

From this drop-down, select the version in which to filter the cost
items.

Select Entity Select the entity.

Select Dept Select the department.

Select RevCode
Filter (optional)

Select a revenue code.

ServiceYRMO Start Select the start date of the service.

ServiceYRMO End Select the end date of the services.

4. To use the Threshold Ruler, in the filter, select the Use Threshold Ruler check box, and do the
following:
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NOTE: For more information, see Using the Threshold Ruler.

Option Description

Cumulative
Percentage of Total

Select a percentage of the total revenue amount or volume to apply
the ruler.

Select Upper Default
Method

Select the cost method to assign to the cost items above the line.

Select Lower Default
Method

Select the cost method to assign to the cost items below the line.

Select Cost Pools to
Apply To

Select one or more cost pools in which to apply the cost method.

Ruler Based On Select whether to base the Cumulative Percentage of Total on
amount or volume.

5. For each appropriate cost item, select the check box in the Edit column, and make any necessary
adjustment to the unit calculation method by doing any of the following:

l To assign the same cost method across all cost pools, from the Assign Cost Method drop-
down, select the cost method.

l To assign a cost pool to one or more specific cost pools, in the cost pool column, select a
method from the drop-down.

TIP: By default, theDescription column is truncated to makemore room for the data
on the page. Click >> in theDescription header column to display more information.

6. After making your changes, in the upper right corner of the page, click Save.

Copying method definitions
Use this utility to create a newmethod definition set by copying an existing method definition set. You
can also use this utility to reset an existing definition by overwriting it with another existing method
definition set.

NOTE: To overwrite an existing method definition, the system deletes the target version set before
inserting the values of the sourcemethod definition set that was selected.

To copy a method definition:
1. In the Cost Accounting Admin task pan, in the Costing Structure Maintenance section, click Unit

Cost Method Assignments, and double-clickMethod Definition Copy Utility.
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2. In the Execute Import: Method Definition Copy Utility dialog, click Execute.

3. In the Variables dialog, configure the following options, and click OK:

Option Description

SourceVersion: The existing method
definition version to copy

Select the method definition version to copy.

TargetVersion: The new method
definition version

Type the version number of the new definition to create.

NOTE: If the target version exists, you can overwrite it using
the OverwriteTarget option below.

OverwriteTarget: Replace target
version if exists

To overwrite the target version method definition with the
new source version, select Yes. If you selectNo, nothing
will happen if the target version method definition already
exists..

Viewing scheduled job results
Processing tasks, such as processing reclasses and method assignment, are performed using Scheduler.
When tasks are processing, the system opens a separate tab that displays the status of the processes,
including the result, the time the job was started, how long it lasted, and the user that ran the job.
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To review the details of a task, click the eye icon in theUser column.

A dialog displays with details about what actions the system performed as part of the task, as shown int
he following example.
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Building Up RVUs
Building Relative Value Units (RVUs) is often a tedious and time consuming task. Additionally, there are
numerous ways and methodologies used for creating RVUs across health service organizations. The RVU
Developer tool is designed to make both the development and themaintenance of RVUs easier and
more efficient. Additionally, it has been designed to support varying levels of detail and to work with any
number ofmethodologies.

The basic concept of building an RVU is to break down the Cost Item into detailed resources with defined
values that, when aggregated, form the relative value at the cost pool level, which are then saved to the
CostRVU table. For example, CPT procedures performed in a clinic can be studied to determine what
resources are used during the procedure. These resources aremapped to the CPT code, forming an RVU
or Cost Component. Each of the resources has a quantity, cost, and frequency of use, which ultimately
drives the basis of the RVU in dollar terms. The resources are grouped by cost pool and then summed to
create the RVUs for the various cost pools, e.g., Labor, Supplies, Equipment, and so on.

You can break down the development of RVUs into discrete activities with corresponding tasks. An
example of this process is outlined, as follows:

NOTE: Generally, labor is theminimal Resource Class used in RVU development while the others are
optional and/or selected for specific departments.

l Activity 1: Determine the departments and the cost Items that need RVUs to be developed.
l Activity 2: Identify and prepare source data for the RVU development process for the Labor

Resource Class and load into the Resource table.
l Activity 3: Identify and prepare source data for the RVU development process for the Supply

Resource Class and Medication Resource and load into the Resource table.
l Activity 4: Identify and prepare source data for the RVU development process for the Equipment

Class and load into the Resource table.
l Activity 5: Identify and prepare source data for the RVU development process for the Other

Resource Class and load into the Resource table. Other resources are often Professional Fees,
Purchased Services, etc.

l Activity 6: Determine the activity level at which the RVUs will be developed, and create activities.
l Activity 7: Determine the frequency of use and the relative value of each resource for each cost

item.
l Activity 8: Review the resulting RVU and save the cost components, along with the RVU.

4
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The following diagram illustrates themain activities and steps in both data preparation and the RVU
development process:

Process Diagram – RVU Development Data Preparation

Process Diagram – RVU Development Process

To build up an RVU:
1. In the Cost Accounting Admin task pane, in the Build RVUs from Components section, double-

click RVU Cost Items.

2. To refresh the data, do one of the following:
l In theMain tab, in theWorkbook Options group, click Refresh Data.

l Click F9.

3. In the Refresh Variables dialog, select the variables to include, and click OK. The RVU Cost Item
workbook displays a list of all your cost items according to the parameters you specified in step 3.
The Equipment RVU Status, Labor RVU Status, and Other RVU Status columns display one of the
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following status types:
l Summary - RVUs that already exist in the CostRVU table (for example, not studied at the

cost component level).
l Detail - Cost components that exist for RVUs.
l No Data - No RVUs created.

NOTE: You must select a value for each variable to populate the workbook.

4. To view the detail build up worksheet for a ResourceClass row, double-click Detail in any of the
three status columns, as shown in the following example:

5. In the workbook for the status column you selected, to add a resource, click the ellipse next to the
Select a resource row.
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NOTE: You can only add ten resources at a time. To add more than ten, add all ten resources,
and then click Save. The resources are added to the database and move to the Existing
Components section at the bottom of the screen. TheNew Component Input section is
cleared so that you can add more resources.

6. In the Choose Value dialog, select a resource from the list, and click OK.
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7. In theQuantity column, type the number or quantity of the resource used for the cost item.
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8. In the Frequency column, type a percentage for how often the resource is used. For example, if
the resource is only used half the time, then enter 50%.

9. In the Conversion Factor column, add the factor needed to convert the cost per unit identified as
the issue cost to a per-unit basis being consumed or used by the for this cost item. For example,
to convert into minutes, then enter a conversion factor to 60, to convert the hourly rate to
minutes per unit.

For example, to convert the average hourly rates loaded into the Resource table from the payroll
data into a cost per minutes. This assumes that the quantity is expressed in minutes. If not, then
you would enter a 60 conversion factor to convert the hourly rate to rate-per-minute. In another
example, a box of 50 items is issued to a floor or department, but the items are consumed one at a
time. In this case, you need to use a 50 conversion factor to ensure the appropriate costs are
calculated as a basis for the RVU calculation.

After you press Enter or Tab to move to the next field, the system displays the actual calculated
costs per unit for the item using the conversion factor and the total costs for the component.

Administrator's Guide 2019.4 Axiom Cost Accounting │ 191



10. To delete the resource from the CostComponent table for the CostItem, in theDelete Flag drop-
down, select Delete.

11. To save your changes to the database, click Save.

NOTE: Any resources marked as Delete are deleted from the database.

Copying RVU versions and cost components
The Copy RVU and Cost Components utility allows you to update existing RVUs and cost components
with new data. This utility creates a second copy of all CostRVUs and cost component. Creating a second
version then allows for the ability to change values and then update the RVUs while leaving existing
version unchanged. Versions for Cost RVUs and cost components refer to the YRMO integer columns in a
YYYYMO format.
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To Creating new RVU and cost component versions:
1. In the Cost Accounting Admin task pane, in the Build RVUs from Components section, double-

click Copy RVUs and Cost Components.

2. In the Execute Import: RVU Copy Utility dialog, click Execute.

3. In the Variables dialog, do the following, and click OK:
l From the SourceYRMO drop-down, select the YRMO to copy the RVU and cost component

data from.
l From the TargetYRMO drop-down, select the YRMO to copy the RVU and cost component

data to.

After copying the RVU version, you can update the values using the RVUMaintenance page. For more
information, see Creating or updating RVU versions.

Running the Cost Resource Detail report
The Cost Resource Detail report lists all of the resources in the Resource dimension table.

To run the Cost Resource Detail report:
1. In the Cost Accounting Admin task pane, in the Build RVUs from Components section, click

Reconciliation Reports, and double-click Cost Resource Detail.

2. In the Refresh Variables dialog, select the variables to include in the report, and click OK.

NOTE: Some variables require you to select a value to populate the report.

The following is an example of this report:
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Running the RVU Component Detail report
The RVU Component Detail report shows each cost item and item type pair, each cost pool developed,
and the components that were built out as well as the cost of each component.

To run the RVU Component Detail report:
1. In the Cost Accounting Admin task pane, in the Build RVUs from Components section, click

Reconciliation Reports, and double-click RVU Component Detail.

2. In the Refresh Variables dialog, select the variables to include in the report, and click OK.

NOTE: Some variables require you to select a value to populate the report.

The following is an example of this report:
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Running the RVU Status report
The RVU Status report displays much of the same information that displays on the RVU Cost Item List
workbook. This report has two views: Summary RVUs and Detail RVUs.

To run the RVU Status report:
1. In the Cost Accounting Admin task pane, in the Build RVUs from Components section, click

Reconciliation Reports, and double-click RVU Status.

2. In the Refresh Variables dialog, select the variables to include in the report, and click OK.

NOTE: You must select a value for each variable to populate the report.

3. To change the view, in theMain ribbon tab, in the Workbook Options group, click Change View,
and select Summary RVUs or Detail RVUs.

The following is an example of the Summary RVUs version of the report:
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Calculating and updating detailed RVUs from cost
components

Use this utility to import data from the Cost Component table and update the RVUs.

NOTE: Updating the RVU information in the CostRVU table is a necessary step after the cost
component information has been added or updated.

To calculate and update detailed RVUs from cost components:
1. In the Cost Accounting Admin task pane, in the Build RVUs from Components section, double-

click Update Detailed RVUs by Cost Component.

2. In the Execute Import: RVU Copy Utility dialog, click Execute.

3. In the Variables dialog, select the YRMO to update, and click OK.

4. After the utility processes are completed, click Close.
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Managing Statistics, Adjustments,
and Reclasses

This chapter includes topics related to configuring and managing statistic accounts, adjustments, and
reclasses.

Creating andMaintaining Statistics
Statistic accounts are used to determine allocation or reclass dollar amounts. Departments that include
the statistic account receive their weighted share of the allocated or reclassed balances from the source
department or account.

TheManual Statistics page allows you to define statistic values by department for existing statistic
accounts in addition to writing statistics into departments for newly created pseudo-accounts.

When a new statistic is created using a pseudo-account of a general statistic account that may not
necessarily exist in a particular department, the input manual statistic writes to the department along
with any related manually input values. The system saves these to the CGL for reference in any reclass or
allocation step.

To view and manage your statistic accounts, in the Setup Guide, click Data Management > Statistics >
Manual Statistics.

TheManual Statistics pages displays a list of all the statistics accounts set up by your organization. To
order a column in ascending order, click the column header until the up arrow displays. To order by
descending, click the column header until the down arrow displays.

5
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Adding or editing a statistic account
To add or edit a statistic account:

1. In the Guide View, click Data Management > Statistics > Manual Statistics.

2. Do one of the following:
l To add a new account, click + Add Statistic Account.
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l To edit an account, select the account to highlight it, and then click the notepad icon .

3. In the Account Name field, type the name or description for the account number.

NOTE: The account number is system generated.
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4. In the spreadsheet, enter statistics in the columns for the departments you want to use the new
account.

NOTE: Themonths that display depends on how your fiscal year is set up in the system. You
can only enter numeric values in themonth columns.

Click the arrow in a column header to sort and/or filter the data in the column. You can also
reference the CGL table while working in this dialog by clicking above the table.

5. After making your changes, do one of the following:

l To save changes to the CGL table and keep the window open to continuemaking changes,
click Apply.

l To save changes to the CGL table and close the window, click Save.

Working with One-Time Adjustments
Axiom Cost Accounting allows you to directly modify account balances within a given department by
posting one-time adjustments. You will most likely use this utility after the Costing General Ledger is
initially loaded.
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To manage one-time adjustments, from the Setup Guide page, click Data Management > External
Financial Data > One-Time Adjustments.

NOTE: Adjustments are not persistent and are overwritten during the next costing period, after the
General Ledger is loaded, so you need to address any adjustments made to correct accounting errors
in the source system. The appropriate adjusted amount is the actual amount to include in the
Costing General Ledger (CGL). When you post an adjustment, the system overwrites the CGL record
for the department and account entered.

Posting one-time adjustments
You can directly modify account balances within a given department in the Costing General Ledger (CGL)
table.

IMPORTANT: Because you changed the CGL table, some existing costing processes may be
invalidated. You may need to run some costing processes again. If you import the GL table again, you
will need to use this process again to make further adjustments.

To post a one-time adjustment:
1. In the Guide View, click Data Management > External Financial Data > One-Time Adjustments.

2. From the Select CGL Year drop-down, select the CGL year to apply the adjustment.

3. In the Select Department(s) field, place your cursor in the field, and type one or more
departments in which to apply the adjustment.
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TIP: The drop-down displays only a limited number of departments. If you don't see the
department you are looking for, continue to type the department number until it displays.
This functionality also applies to the Enter Account(s) field.

4. In the Enter Account(s) field, Place your cursor in the field, and type one or more accounts in
which to apply the adjustment.

5. To display the table in which to enter your adjustments, click Refresh.

6. In the appropriate row(s), enter the replacement amount in each period column.

IMPORTANT: The cells are do not add dollars to the original amount. You must enter an
amount to replace the original. For example, if the original amount is $1,000 and you want to
change it to $1,500, you need to enter $1,500 and not $500.

TIP: To make adding adjustments easier, you can view the CGL table at the same time you are
working in this page by clicking theOpen CGL Table link, located above the table. This opens
the CGL in a separate browser window for you to refer to.

7. After making your changes, click the disk icon to post your changes to the CGL.

Managing reclass definitions
Reclassification is the process ofmoving dollars from one General Ledger location to another. Unlike
overhead allocations that allow you to move only overhead expenses, you can use reclasses to move
expenses, statistics, revenue, deductions, and other dollar types from one department or account to
another. For example, you can take non-patient revenue and reclass it as a negative expense from one
department to another or reclass statistics from one statistical account to another.

Let's say you have a cafeteria in your hospital. You can run a revenue reclass to offset the expenses of the
cafeteria with its revenue, and then run an overhead allocation to redistribute any remaining dollars
across different In Patient departments.

There are three types of reclass definitions you can create:

l Payroll - Reclass payroll dollars from one department to another
l Account - Reclass dollars from specified accounts to spread across accounts in the same or other

departments
l Department - Reclass dollars from specified departments to spread across other departments

Axiom Cost Accounting determines the spread amount by performing the following calculations and
applying a reclass rate to each applicable department or account:

l Sum the total number of statistical accounts
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l Divide the total source dollars from the accounts (the departments you aremoving dollars from)
by the total stats to determine a rate per stat

l Multiple the rate by the total number of stats for each department

In the following example, a hospital reclasses $93,365 of expenses from the Radiology division to spread
them across separate Radiology departments. The system determines theM1 reclass rate by dividing
$93,365 by the key stat of $12,400. This calculates to a reclass rate of $7.53. The system then multiplies
$7.53 by the key stat for each department. The Radiology Diagnostics department receives most of the
expenses with a total of $26,759.

Understanding pseudo accounts
In the cost accounting process, you can apply dollars incurred by one department to other departments
using the Reclasses, Overhead Allocations, or Adjustment processes. For example, applying costs for
inpatient transportation, building maintenance, or marketing to a clinical department.

To reflect these transactions, Axiom Cost Accounting creates pseudo accounts within departments to
offset costs in source departments and write costs to receiving departments. These accounts are created
and stored within Axiom Cost Accounting. For example, when applying inpatient transportation costs to
a clinical department, a pseudo off-set is created in the Transportation department with a negative
balance, and a correlating pseudo account is created in the Clinical department reflecting the allocated
dollars.

Adding, editing, or cloning reclass definitions
The Reclass Definitions page allows you to view and configure reclass definitions, including setting the
order you want the system to process them, and selecting the department or accounts in which to
reclass dollars from and to. You can create a new definition by cloning an existing definition and editing it.

To add, edit, or clone reclass definitions:
1. In the Guide View, click Reclasses and OH Allocations > Reclasses > Reclass Definitions.
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2. To show or hide inactive definitions in the list, click the Show only active definitions check box at
the top of the page. If you unselect the check box, the table displays the inactive definitions
shaded in yellow. Only active definitions include a check mark in the Active column.

3. Do any of the following:
l To add a definition, do one of the following:

o If you are not yet sure in what order to place the new definition, click Add New
Reclass Definition at the top of the page. The system places the definition to the
bottom of the list of active definitions.

o If you knowwhere to place the new definition in the list, select a definition to
highlight it, and click the plus icon. The system places the definition after the
existing definition.

l To edit a definition, select the definition to highlight it, and click the notepad icon.

l To clone a definition, select the definition to highlight it, and click the notepad icon. In
the Edit Reclass Definition dialog, click Clone in the bottom left corner.

4. In the Add New Reclass Definition dialog, select the type of definition to create, and click OK.

5. In the Add/Edit Reclass Definition dialog, complete the following:
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Field Description

Title Title for the definition.

Comment Details for the definition.

Select Entity Select the entity in which to allocate dollars from.

TIP: The entity you select determines the departments and accounts
you choose from further along in the utility.

Use Source Cost
Categories

Do one of the following:

l To create the pseudo account for all of the cost categories for your
target departments, click the toggle to Yes. The system will create
the pseudo account for all of the accounts you select further on in
this utility.

l To create only one pseudo account, click No.

Cost Category If you set theUse Source Cost Categories toggle to No, select the
cost category in which to apply the pseudo account.
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Field Description

Active Do one of the following:

l To activate the definition, click the toggle to Yes.
l To deactivate the definition, click the toggle to No.
For more information regarding this option, see Activating or
deactivating reclass definitions.

1. From
Departments

Select source departments to allocate dollars from by doing the
following:

l To create or use a filter, do the following:
a. Click Use Filter.
b. Click Add Department Filter to open the Filter Wizard.
c. Create or select an existing filter.

l To select from a list of departments, do the following:
a. Click Choose Departments.
b. In the Add Departments dialog, do any of the following:

o To select all of the departments, click Select All.
o To unselect all of the departments, click Select None.
o To search for a specific department, type a department

number or name in the Search box.

c. Click OK.

To preview the filter results, click the spreadsheet icon .

and Accounts Select the account(s) to allocate by doing one of the following:

l To apply the definition to revenue accounts only, select the
Revenue check box.
NOTE: This does not apply to Payroll Reclass definitions.

l To select the accounts, click the funnel icon to use the Filter
Wizard to create or select an account filter (For example,
Account.Type = Expense).

l To preview the filter results, click the spreadsheet icon .

2. Reclass Based On Configure the statistic account(s) in which to reclass by clicking the
funnel icon to use the Filter Wizard to create or select an account
filter. To preview the filter results, click the spreadsheet icon .
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Field Description

3. To Departments Do one of the following:

l To allocate to all the departments based on the criteria selected in
the Allocations Based On section, select All Departments.

l To allocate to specific departments, select Select Department(s),
and click the funnel icon to use the Filter Wizard to create or
select a department filter.

l To preview the filter results, click the spreadsheet icon .

NOTE: This option does not apply to Payroll Reclass definitions
because the reclass is automatically applied to all payroll departments
by default.

6. After you finish making changes, click Save.

7. To preview the definition results, click the spreadsheet icon at the top of the definition
window.

8. To return to the definition, click the notepad icon at the top of the previewwindow.

9. After you finish adding or editing definition(s), review and edit the definition processing order, as
needed.

When you are ready to move the reclass dollars, process the definitions.
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Ordering reclass definitions
Axiom Cost Accounting processes reclass definitions in the order they display on the Reclass Definitions
page. You can place the definitions in any order that you wish. You can also group them by method type
- Payroll, Account, and Department. Even if you decide to group the definitions, you can still edit the
order of the definitions within each group.

IMPORTANT: Reordering definitions can affect the run and validation process for other definitions.

The order in which the definition will run is indicated in the Run Order column. Keep in mind that any
deactivated definitions retain their original locations. So, if you reactivate a deactivated definition, the
system will prompt you to specify whether to put the definition back in its original run order location or
select a new location. For more information, see Activating or deactivating reclass definitions.

If the list only shows activated definitions, you may notice gaps in the Run Order column. Themissing
run order definitions have been deactivated. To view the run order for all definitions, whether active or
deactived, remove the check mark from the Show only active definitions check box at the top of the
page.

To order reclass definitions:
1. In the Guide View, click Reclasses and OH Allocations > Reclasses > Reclass Definitions.

2. Do one of the following:
l To move a definition to a new location on the list, select the definition to highlight it, and

click the arrow icon. In theMove Account Reclass Definition dialog, select the definition
to move the definition after, and click OK.

l To order the definitions by method type, click Reorder by Reclass Method at the top of the
page.

IMPORTANT: Using the Reorder by Reclass Method button means that the system will
remove any custom ordering referenced in the first bullet above. You can reorder the
definitions, if needed, after you group the definitions by method type.
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Activating or deactivating reclass definitions
Instead of deleting a definition, you can simply deactivate it so that the system does not process it. You
can activate it again, as needed, and place the definition in its original run order or select a new run order
position.

� Activating a reclass definition
When you create a new definition, the system activates it by default unless you deactivate it. These steps
apply to any definitions that you want to reactivate.

To activate a reclass definition:
1. In the Guide View, click Reclasses and OH Allocations > Reclasses > Reclass Definitions.

2. To display the deactivated definitions in the list, click the Show only active definitions check box
at the top of the page.

3. Hover your cursor in the Active column, and clickMark Active.
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TIP: You can also activate the definition by clicking the notepad icon, and clicking the
Activate toggle to Yes.

4. In the Activate Reclass Definition dialog, do one of the following:
l To activate the definition in its original run order position, click Activate and set this

Reclass Definition to its original position (Run Order) and re-order the definitions that
follow.

l To activate the definition and place it in a different run order position, click Activate and set
this Reclass Definition to be positioned after the following item. Then, from the drop-
down, select definition to place the definition after.

5. Click OK.

After you finish reactivating definitions, we recommend reviewing and editing the definition processing
order, as needed.

� Deactivating a reclass definition
To deactivate a reclass definition:

1. In the Guide View, click Reclasses and OH Allocations > Reclasses > Reclass Definitions.

2. In the Active column, click the check mark.
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TIP: You can also activate the definition by clicking the notepad icon, and clicking the
Activate toggle to No.

3. In theDeactivate Reclass Definition dialog, review themessage, and click OK to proceed.

4. At the confirmation prompt, click OK.

After you finish deactivating definitions, we recommend reviewing and editing the definition processing
order, as needed.

Deleting reclass definitions
Deleting a definition may affect the run process for other definitions and cause validation errors. We
recommend reviewing the definition order and making any necessary edits before processing the
definitions. For more information, see Ordering reclass definitions.

TIP: You may want to consider deactivating a definition instead of deleting it. For more information,
see Activating or deactivating reclass definitions.

To delete a reclass definition:
1. In the Guide View, click Reclasses and OH Allocations > Reclasses > Reclass Definitions.

2. On theManage Reclass Definitions page, select the definition to highlight it, and click the trash
bin icon .

3. At theDelete Acct Reclass Definition prompt, click OK.
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Processing reclass definitions
When processing reclasses, the system kicks off a job in Scheduler to move dollars according to the
reclass definitions. The system processes reclasses in the order they are listed on the Reclass Definitions
page. For more information, see Ordering reclass definitions.

As part processing reclass definitions, the system automatically places the results in a staging table so
that you can reconcile them and make adjustments accordingly before committing them to the CGL
table. However, you can skip the review step and commit them directly to the CGL table by selecting the
Auto-Commit results to CGL table check box.

To process reclass definitions:
1. In the Guide View, click Reclasses and OH Allocations > Reclasses > Process All Reclasses.

2. Click one of the following reclass methods to process:
l All Methods
l Payroll Methods
l Account Methods
l Dept Methods

l Individual Reclasses - Click Select Individual Reclasses, click the check box next to each
reclass to process, and then click OK.

TIP: Use the Search box to find a specific reclass.
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3. To skip the reconciliation process and commit the results directly to the CGL table, select the Auto-
Commit results to CGL table check box.

4. To start the scheduled job that will process the definitions, click Run Now.

5. At the Information prompt, click OK.

After the job processes, the job results page displays to show you the status of the job. If the job
fails, click the eye icon next to the status field to viewmore information.

NOTE: The system displays the job results page in a separate tab in your browser.

6. To reconcile the processed reclasses, click one of the following reports:
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l View Scheduled Job Results
l ViewDepartment Reconciliation Summary report

NOTE: This report as well as the Distribution Reconciliation report open in theWindows
or Excel Client of Axiom Cost Accounting.

l ViewDistribution Reconciliation report

7. To copy the staged results to the CGL table, click Commit Results.

Validating changes to account reclass rules
The Validation - Reclass Processing by Account report shows the defined Acct and Acct – Revenue reclass
rules. You can use this report prior to processing allocations and after the reconciliation of the loaded
financial data. You can also use it to review and test individual Acct Reclass steps.

The system spreads allocated dollars across many accounts, with each new reclass account inheriting the
traits of the basis accounts. This allows a single account to be spread to several cost accounts. As the
system processes, it creates reclass and reclass offset specific accounts, and concatenates the account
number assigned to the Account Class in the System Account Ranges table into the account, making it
unique.
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The "Reclass From" section populates departments based on the reclass definition department filter.
The dollars to reclass populate in the Amount to reclass and theOffset Amounts sections. The
Reclassed Amounts are spread across the basis, which populates in the lower section of the report.

As the system processes each rule, the distribution amounts save to the departments that have a basis
defined in the step processed. The system also writes an offset to the source department to offset the
original value being distributed.

To validate changes to account reclass rules:
1. In the Cost Accounting Admin task pane, in the Adjustments and Reclasses section, click Reclass

Reconciliation Reports, and double-click Validation - Reclass Processing by Account.
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2. In the Refresh Variables dialog, select the variables to include in the report, and click OK.

Validating changes to department reclass rules
The Validation - Reclass Processing by Department report shows a summarized view of the processed
reclass definitions that you can use to validate that the system has processed the steps and saved them
to the database.

The report shows the reclass definition information for each of the processed rules. The reclass activity
displays as active or inactive in the report. We recommend that you use this report prior to processing
allocations and after the reconciliation of the loaded financial data. You can also use it to review and test
individual reclass steps.

To validate changes to department reclass rules:
1. In the Cost Accounting Admin task pane, in the Adjustments and Reclasses section, click Reclass

Reconciliation Reports, and double-click Validation - Reclass Processing by Department. 

2. In the Refresh Variables dialog, select the variables to include in the report, and click OK.
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The "Reclass From" section populates departments based on the reclass definition department filter. The
dollars to reclass populate in the Amount to reclass and the Offset Amounts sections. The Reclassed
Amounts are spread across the basis, which populates in the lower section of the report.

As the utility processes each rule, the system saves the distribution amounts to the departments that
have a basis defined in the step processed. The system also writes an offset to the source department to
offset the original value being distributed. The reclass account and the offset account are created using
the Reclass Setup Manager and populate in the dimensions as the definitions are created

Validating changes to payroll reclass rules
The Validation - Reclass Processing by Payroll report shows the define Payroll reclass rules. Typically, an
organization sets up only one rule. The payroll reclass definition identifies accounts specific to salaries
and disaggregates the accounts across cost class- or job class-specific statistics.

The system processes all departments in a sequential fashion, with the source department component
of the reclass definition functioning as a multipass filter.

You can use this report prior to processing general reclass rules and after the reconciliation of the loaded
financial data.
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To validate changes to payroll reclass rules:
1. In the Cost Accounting Admin task pane, in the Adjustments and Reclasses section, click Reclass

Reconciliation Reports, and double-click Validation - Reclass Processing by Department.

2. In the Refresh Variables dialog, select the variables to include in the report, and click OK.

The Reclass Source section shows departments based on the reclass definition department filter. The
dollars to reclass populate in the Amount to Reclass and the Reclass Offset sections of the report. The
Reclassed Amounts are spread across the basis, which populates in the lower section of the report.
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As the system processes each rule, the distribution amounts save to the departments that have a basis
defined in the step processed. The system also writes an offset to the source department to offset the
original value being distributed.

The reclass account and the offset account are created using the Payroll Reclass Account Setup report at
implementation.

Discovering variances in reclass and overhead allocation offsets
Use the Reclass and Allocation Distribution Reconciliation report to find variances after you run your
allocation and reclass processing or if there are changes in your GL structure.

To discover variances in Reclass and Allocation Offsets:
1. In the Cost Accounting Admin task pane, in the Adjustments and Reclasses section, click Reclass

Reconciliation Reports, and double-click Reclass and Allocation Distribution Reconciliation.

2. Refresh the data by doing one of the following:

l In theMain ribbon tab, click Refresh Data.

l Pres F9.

3. From the Refresh Variables dialog, do the following:
l From the CGL Year drop-down, select your CGL year.
l From the Select a Specific ReclassType (optional) drop-down, select the ReclassType to view

in the Reclass section of the report.

NOTE: This does not affect the Allocation section of the report.

4. To change the view of the report, in theMain ribbon tab, click Change View, and select one of the
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following:
l All
l Variance Only

You can drill into the Reclass or Allocation rule for the list of the departments impacted by the selected
rule.
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Managing Overhead Allocations
Overhead allocation definitions in Axiom Cost Accounting are used to define the rules and order in which
to move overhead expenses from support departments (Security, IT, Utilities, etc.) to revenue-producing
departments (usually In Patient departments).

Axiom Cost Accounting uses the Step Down method, which allocates costs from one department to
other departments using a sequential process. When setting up the allocation sequence, we recommend
allocating costs starting with themost (based on count) supported departments and working your way
down to the fewest supported departments. Keep in mind that this may not always correlate to the
departments with the highest cost. For example, if an overhead Administration department holds
$500,000 in C-level salaries, you may want to allocate this first since Administration supports the entire
system. On the other hand, a grouping of clinical support departments may hold $1million in cost, but
since they would support a more limited amount of departments (clinical only), you would allocate the
cost after the Administration department.

TIP: Your Kaufman Hall Implementation Consultant can help you set up the allocation definition run
order.

In Axiom Cost Accounting, you manage the allocation definitions and run order in the Allocation
Definitions page. From this page, you can add, edit, and delete definitions as well as reorder the
sequence of the definitions. This page also allows you to validate that definitions do not violate the rules
of other definitions. For example, you may accidentally set up a definition that allocates to the same
department twice. In this case, the system would display a validation error.

Adding, editing, or cloning overhead allocation definitions
The Allocation Definitions page allows you to view and configure overhead allocation definitions,
including setting the order you want the system to process them, and how you want the dollars to be
allocated. You can create a new definition by cloning an existing definition and editing it.

TIP: Make sure to maintain your overhead allocation definitions on a regular basis as departments,
accounts, statistics, and so on are updated in your organization.

6
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To add or edit an overhead allocation definition:
1. In the Guide View, click Reclasses and OH Allocations > Overhead Allocations > Allocation

Definitions.

2. To show or hide inactive definitions in the list, click the Show only active definitions check box at
the top of the page. If you unselect the check box, the table displays the inactive definitions
shaded in yellow. Only active definitions include a check mark in the Active column.

3. Do any of the following:
l To add a definition, do one of the following:

o If you are not yet sure in what order to place the new definition, click Add Allocation
Definition at the top of the page. The system places the definition to the bottom of
the list of active definitions.

o If you knowwhere to place the new definition in the list, select a definition to
highlight it, and click the plus icon. The system places the definition after the
existing definition.

l To edit a definition, select the definition to highlight it, and click the notepad icon.

l To clone a definition, select the definition to highlight it, and click the notepad icon. In
the Edit Allocation Definition dialog, click Clone in the bottom left corner.

4. In the Add/Edit Allocation Rule dialog, complete the following:
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Field Description

Title Title of the definition.

Comment Details of the definition.

Select Entity Select the entity in which to allocate dollars from.

TIP: The entity you select determines the departments and accounts
you choose from further along in the utility.

Use Source Cost
Categories

Do one of the following:

l To assign the definition to all cost categories, click the toggle to
Yes.

l To assign the definition to a specific cost category, click the toggle
to No.

Cost Category If you set theUse Source Cost Categories toggle to No, select the
cost category to apply the pseudo account to.

NOTE: This option is only enabled when you select No in Use Source
Cost Categories.
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Field Description

Active Do one of the following:

l To activate the definition, click the toggle to Yes.
l To deactivate the definition, click the toggle to No.
For more information regarding this option, see Activating or
deactivating overhead allocation definitions.

1. From
Departments

Select source departments to allocate dollars from by doing the
following:

l To create or use a filter, do the following:
a. Click Use Filter.
b. Click Add Department Filter to open the Filter Wizard.
c. Create or select an existing filter.

l To select from a list of departments, do the following:
a. Click Choose Departments.
b. In the Add Departments dialog, do any of the following:

o To select all of the departments, click Select All.
o To unselect all of the departments, click Select None.
o To search for a specific department, type a department

number or name in the Search box.

c. Click OK.

To preview the filter results, click the spreadsheet icon .

and Accounts Select the accounts by clicking the funnel icon to use the Filter
Wizard to create or select an account filter (For example,
Account.Type = Expense). To preview the filter results, click the
spreadsheet icon .

2. Allocate Based On Select the statistic account(s) in which to allocate by clicking the
funnel icon to use the Filter Wizard to create or select an account
filter. To preview the filter results, click the spreadsheet icon .

3. To Departments Do one of the following:

l To allocate to all the departments based on the criteria selected in
the Allocations Based On section, select All Departments.

l To allocate to specific departments, select Select Department(s),
and click the funnel icon to use the Filter Wizard to create or
select a department filter.
To preview the filter results, click the spreadsheet icon .

5. After you finish making changes, click Save.
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6. To preview the definition results, click the spreadsheet icon at the top of the definition
window.

7. To return to the definition, click the notepad icon at the top of the previewwindow.

8. After you finish adding or editing definition(s), we recommend you do the following:
l Order definitions - Axiom Cost Accounting processes overhead definitions in the order they

display in the Allocation Definitions page. After you add or edit a definition, you may need
to reorder the definitions in the list.

l Validate definitions -Make sure to validate definitions to ensure they do not violate the
rules of other definitions. For example, you may accidentally set up a definition that
allocates to the same department twice.
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Ordering overhead allocation definitions
Axiom Cost Accounting processes overhead allocation definitions in the order they display on the
Allocation Definitions page. You can place the definitions in any order that you wish.

IMPORTANT: Reordering definitions can affect the run and validation process for other definitions.

The order in which the definition will run is indicated in the Run Order column. Keep in mind that any
deactivated definitions retain their original locations. So, if you reactivate a deactivated definition, the
system will prompt you to specify whether to put the definition back in its original run order location or
select a new location. For more information, see Activating or deactivating overhead allocation
definitions.

If the list only shows activated definitions, then you may notice gaps in the Run Order column. The
missing run order definitions have been deactivated. To view the run order for all definitions, whether
active or deactivated, remove the check mark from the Show only active definitions check box at the
top of the page.

To reorder overhead allocation definitions:
1. In the Guide View, click Reclasses and OH Allocations > Overhead Allocations > Allocation

Definitions.

2. Select the definition to highlight it, and click the arrow icon .

3. In theMove Allocation Definition dialog, select the definition to move the definition after, and
click OK.

4. Validate the definitions by clicking Validate above the list of definitions.

Administrator's Guide 2019.4 Axiom Cost Accounting │ 226



Activating or deactivating overhead allocation definitions
Instead of deleting a definition, you can simply deactivate it so that the system does not process it. You
can activate it again, as needed, and place the definition in its original run order or select a new run order
position.

� Activating an overhead allocation definition
When you create a new definition, the system activates it by default unless you deactivate it. These steps
apply to any definitions that you want to reactivate.

To activate an overhead allocation definition:
1. In the Guide View, click Reclasses and OH Allocations > Overhead Allocations > Allocation

Definitions.

2. To display the deactivated definitions in the list, click the Show only active definitions check box
at the top of the page.

3. Hover your cursor in the Active column, and clickMark Active.

TIP: You can also activate the definition by clicking the notepad icon, and clicking the
Activate toggle to Yes.
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4. In the Activate Allocation Definition dialog, do one of the following:
l To activate the definition in its original run order position, click Activate and set this

Allocation Definition to its original position (Run Order) and re-order the definitions
that follow.

l To activate the definition and place it in a different run order position, click Activate and set
this Allocation Definition to be positioned after the following item. Then, from the
drop-down, select definition to place the definition after.

5. Click OK.

After you finish reactivating definitions, we recommend reviewing and editing the definition processing
order, as needed.

� Deactivating an overhead allocation definition
To deactivate an overhead allocation definition:

1. In the Guide View, click Reclasses and OH Allocations > Overhead Allocations > Allocation
Definitions.

2. In the Active column, click the check mark.

TIP: You can also activate the definition by clicking the notepad icon, and clicking the
Activate toggle to No.

3. In theDeactivate Allocation Definition dialog, review themessage, and click OK to proceed.

4. At the confirmation prompt, click OK.

After you finish deactivating definitions, we recommend reviewing and editing the definition processing
order, as needed.
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Deleting overhead allocation definitions
Deleting a definition may affect the run process for other definitions and cause validation errors. We
recommend reviewing/editing the definition order and performing a validation after deleting a definition.

TIP: You may want to consider deactivating a definition instead of deleting it. For more information,
see Activating or deactivating overhead allocation definitions.

To delete an overhead allocation definition:
1. In the Guide View, click Reclasses and OH Allocations > Overhead Allocations > Allocation

Definitions.

2. Click the definition to highlight it, and click the trash bin icon .

3. At theDelete Allocation Definition prompt, click OK.

Validating allocation definitions
To prevent over allocation or allocating to the wrong department, Axiom Cost Accounting allows you to
validate definitions by checking that they do not violate the rules of other definitions. For example, you
may accidentally set up a definition that allocates to the same department twice. We recommend that
you run this process each time you add, edit, delete, or reorder definitions.

If the system encounters a validation error, there are several ways it displays:

Administrator's Guide 2019.4 Axiom Cost Accounting │ 229



l Number of errors - A validation error dialog displays the number of conflicts.

NOTE: IfNot-Validated displays next to the Validate button, it means that no definitions have
been validated yet.

l Not Valid message - Next to the Validate button, a X Not Validmessage displays. Also, an X
displays in the Status column for each definition that encounters an error. Click the X to view the
error message.

After you resolve all of the errors, the Allocation Definitions page displays green check marks in the
Status column of all rows and Valid displays next to the Validate button at the top of the page.

NOTE: Validation errors do not prevent Axiom Cost Accounting from processing definitions. It is a
simply a way to indicate potential issues if you run the definition.

To validate allocation definitions:
1. In the Guide View, click Reclasses and OH Allocations > Overhead Allocations > Allocation

Definitions.
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2. On the Allocation Definitions page, click Validate at the top of the page.

3. In the Status column, click the X to view the error message.

4. Edit each definition that encounters a validation error.

5. After you correct each definition, run the validation again until all the errors are resolved.

Processing overhead allocations definitions
The system processes reclasses in the order they are listed on the Allocation Definitions page. For more
information, see Ordering overhead allocation definitions.

To process overhead allocation definitions:
1. In the Guide View, click Reclasses and OH Allocations > Overhead Allocations > Process

Allocations.

2. To skip the reconciliation process and commit the results directly to the CGL table, select the Auto-
Commit results to CGL table check box.

3. To start the scheduled job that will process the definitions, click Run Now.

4. At the Information prompt, click OK.
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After the job processes, the job results page displays to show you the status of the job. If the job
fails, click the eye icon next to the status field to viewmore information.

NOTE: The system displays the job results page in a separate tab in your browser.

5. To reconcile the processed reclasses, click to open the following reports:
l View Scheduled Job Results
l ViewDepartment Reconciliation Summary report

NOTE: This report as well as the Distribution Reconciliation report open in theWindows
or Excel Client of Axiom Cost Accounting.

l ViewDistribution Reconciliation report

6. To copy the staged results to the CGL table, click Commit Results.

Running the Reclass and Allocation Department
Summary report

The Reclass and Allocation Department Summary report summarizes all of the allocations by department
type (indirect, direct, deadend, and all other) to review the impact to the CGL.

To run the Reclass and Allocation Department Summary report:
1. In the Guide View, click Reclasses and OH Allocations > Reclasses > Process All Reclasses. A link

to the report is located in the Reconciliation section of the page.

NOTE: At this time, the report opens in theWindows or Excel Client edition of Axiom Cost
Accounting.
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2. In the Refresh Variables dialog, select the following variables in which to filter the report, and click
OK:

Variable Steps

Select Timeframe Select the timeframe to include in the report.

NOTE: The timeframe can be your costing period or
another period to research issues.

Select Ending Calendar Year and
Month

Select the ending year and month to include in the report.

Select Entity (optional) Select the entity to include.

Themajor points of reconciliation include the following:

l In the rows, the departments are grouped by their Type definition on the DEPT table:
direct, indirect, dead-end, and NA.
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l The columns reflect the type of allocation or reclass operation that was done, with the
result reflected afterward so that the changes in expenses can be tracked through each
operation for each department.

l Double-click on any department row to display the drill report for that department,
showing the details of each inflow and outflow by reclass and allocation rule.

Running the Reclass and Allocation Distribution
Reconciliation report

Run this report to find variances after you process allocation and/or reclass definitions or if there are
changes to your GL structure.

To run the Reclass and Allocation Department Summary report:
1. In the Guide View, click Reclasses and OH Allocations > Reclasses > Process All Reclasses. A link

to the report is located in the Reconciliation section of the page.

NOTE: At this time, the report opens in theWindows or Excel Client edition of Axiom Cost
Accounting.
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2. Refresh the report by clicking Refresh Data in the Main ribbon tab.

3. In the Refresh Variables dialog, do one of the following, and click OK:

l To include only one reclass type, select one from the drop-down.
l To include all of the reclass types, leave the field blank.
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Working with Cost Item Processing
This section includes topics related to processing cost items.

Understanding calculating and assigning cost items
The calculation of unit costs consists of two general categories:

l Direct assignment or calculation of costs based on detailed charge or cost data.
l The allocation of costs based on a spread methodology using a statistic or other basis.

Unit cost calculations need to be processed in a specific order, with direct assignment methods
processed prior to the allocation type ofmethods. Additionally, the relative cost unit method needs to
be processed last, as it relies on the results from other methods to calculate the costs.

� Direct Assignment calculation
The following table describes the Direct Assignment methodologies supported for unit cost calculation:

Method Description

Transaction Microcost Sometimes referred to as Acquisition or Direct Costing. Transaction
Microcost simply means that you can use the cost information that is often
available in a patient care system directly in the costing process. You need
to extract the data from the source system, which may include a surgical or
operating room system, pharmacy system, and so on.

Microcost Sometimes referred to as Standard Costing. Microcost simply means that
you can associate a known cost value directly with the cost item. A
Microcost table stores and assigns the cost to the encounter cost-detail level
when processing this method. The Microcost method is often used for
supply items or other directly contracted service, such as a reference lab
fee for a send-out test.

Reverse Markup A useful method to use to estimate the cost of an item when a chargeable
item’s price is generated based on a markup table and when the specific
cost may not be known using aMicrocost method. This method is only
available for chargeable items with the actual per-unit charge available in
the Cost Detail transaction data.

7
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Important: The Direct Assignment methods listed above can produce results that do not align with your
GL dollars. If there are no remaining cost items to allocate costs to in the cost category that you have
assigned costs to, then a variance to the GL occurs. There are three ways to handle a variance:

1. Use an allocation method to spread a variance to any remaining cost items for the department for
the cost pools.

2. Use a reclass to move any remaining dollars in the department in the cost pool to a new cost pool,
and spread them to a selection of cost items in the department.

3. Ignore the variance and leave it as a variance.

� Spread calculation
The following table describes the Spread methodologies supported for unit cost calculation:

Method Description

Relative Value Units (RVU) An allocation method that depends on a unit of relative value to determine
the items that should receive more cost than others.

Provider RVU An allocation method that uses a relative value unit (RVU) but enables you
to allocate provider expenses (generally salaries) directly to his or her
patients. This is a process that requires general ledger costs so that accounts
are associated with individual providers.

Ratio of Cost to Charges (RCC)
Allocations

Widely used to allocate costs according to the price or charge for the item.

Relative Cost Unit (RCU)
Allocations

A Kaufman Hall term used to denote the Axiom Cost Accounting ability to
map previously calculated cost values as a means of spreading costs without
the need to define and load them as an RVU.

IMPORTANT: When using more than onemethod per cost center or department per cost category,
it is important to process thesemethods in the order indicated above. This ensures that the
allocation methods are used last after more specific methods have been processed. More than one
method per department is made possible by using an offset methodology within each method. An
offset methodology refers to the creation of pseudo-accounts in the CGL that captures the results of
a calculation, and then provides the remaining dollars to be processed by a subsequent costing
process.

Using the Direct to Encounter method
You can allocate departments that do not generate patient revenue but incur expenses in response to
patient activity using Direct to Encounter (D2E).
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D2E allows you to spread costs that were historically allocated as indirect overhead to specific encounters
that utilize the services of that particular department or area. Examples of indirect costs include Patient
Access, Business Office, Radiology Administration, Medical Records, CaseManagement, and Insurance
Pre-Certification departments. D2E spreads these costs as a direct cost rather than an indirect cost to
those selected encounters.

� About pseudo cost items and Direct to Encounter
The system generates and assigns a pseudo cost item to the departments and encounters that have
been identified as D2E departments, along with encounters receiving services from these departments.
This pseudo cost item allows for the allocation of the expenses to those encounters having services in
these D2E departments. The encounters that ultimately receive this allocated cost are identified by a
statistic that dictates the allocation. For example, the Patient Access department may be an inpatient-
only service that touches every inpatient equally. The statistic in this example is a 1 for every inpatient;
the resulting allocation simply takes any inpatient and gives them an equal cost of the Patient Access
department.

TIP: It may not make sense to spread costs equally to encounters for some departments, so it is
important to review each department separately to determine the best method to gather the set of
encounters that will receive the costs. For example, Medical Records requires more effort for
inpatients, emergency room visits, and observation cases than it does for labs and outpatients. The
total charges may be an appropriatemeasure to allocateMedical Records net expenses to all cases
since any registered patient has contact with this department. More effort may be placed, however,
in transcribing for inpatients, emergency room cases, and observation cases, which results in more
cost to cases with higher total charges.

Creating or modifying Direct to Encounter definitions
Direct to Encounter (D2E) is a one-time configuration during the cost design and set up process. If a
department changes or closes, however, you need to review the Direct to Encounter definition for that
department.

The Direct to Encounter Cost Definitions utility displays a list of all the existing D2E definitions, including
the cost item number, cost description, the primary table the definition goes against, volume, and
aggregation method.
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When you create a definition, the system automatically increments the cost item number.

To create or modify Direct to Encounter definitions:
1. In the Guide View, clickMethods and Assumptions > Methods > Direct To Encounter > Direct To

Encounter Definitions.

NOTE: The utility opens in a separate browser window.

2. Do one of the following:
l To create a definition, click + Add New Definition.
l To modify a definition, click the pencil icon next to the cost item number.

Administrator's Guide 2019.4 Axiom Cost Accounting │ 239



3. Use the following table to complete the fields in the dialog:

Field Steps

Department Select the department to associate the definition.

Description Type a description for the cost item.

When you begin using D2E, we recommend that you include D2E in
the description so that you can visually recognize the cost item in
reporting. For example: D2E – 12345 Medical Records

Select Table to Filter Select the table that best suits the allocation (Cost Detail or Encounter).

NOTE: The table you choose impacts the choices in the remaining
drop-downs in the dialog. For example, if you select Cost Detail, you
need to select the correct selection from the Volume Field drop-down
and the Cost Detail Date Proxy drop-down. The dialog will prompt you
to make the correct selections.
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Field Steps

Volume Field Select the best fit for the allocation.

The volume field allows you to select a numerical field on which to
generate the “volume” for each patient’s D2E Cost Item. This volume
will determine what proportion of cost from the pool each patient
receives, so take care that you select a volume proxy that is
meaningful for the distribution of the costs in the department.

Example 1: The volume for allocating the costs of the patient
registration department to patients may use a simple case count on
the Encounter table for the volume, each patient getting an equal
registration share.

Example 2: The volume for allocating the costs of a piece of
equipment from the IT department that is used over the period of a
patient stay may use the length of stay as the volume.

You will notice that there are more selections when using the
ENCOUNTER table. This is because there are more useful numeric
value fields in the ENCOUNTER table. The CHARGE DETAIL table only
has two meaningful volume fields.

Aggregation Method Select one of the following:

l To allocate costs based on an average calculation of the volume
method, select Average.

l To allocate costs based on a count of the volume method, select
Count.

l To allocate costs based on a one time count of the volume method,
select Distinct Count.

l To allocate costs based on the maximum value in the volume
method, selectMaximum.

l To allocate costs based on the minimum value in the volume
method, selectMinimum.

l To allocate costs based on the sum of the volume in the volume
method, select Sum.
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Field Steps

Select Service Date Proxy Because you are creating service dates that do not actually exist, you
need to select a date field to copy to generate meaningful service
dates to match the actual periods of stay for the patients and to align
with the period of costs you are wanting to allocate to those patients.

Do one of the following:

l For the Encounter table filter, for the date range of data to be
utilized to allocate the expenses to the encounter level, select
Admit Date or Discharge Date.

l For the CostDetail table filter, for the date range of data to be
utilized to allocate the expenses to the encounter level, select Post
Date or Service Date.

Define Encounters Create or select an existing filter using the Filter Wizard to capture all
of the patients to whom you wish to assign costs.

4. To preview your changes, click Preview Filter.

NOTE: When you close the preview, the system automatically saves your changes and returns
you to the definition table. To continuemaking edits to the definition you previewed, select
the pencil icon next to the definition name. The preview filter is not meant to use to review
data; it is simply used to help ensure you have captured the correct type of data in the table.

5. After making your changes, click OK.

NOTE: The OK button displays only if you did not preview the definition, and you want to save
your changes.

6. When you are ready, process the definitions.

For example, when allocating Surgery Scheduling to specific encounters utilizing the D2E function, the
basis is by patient count only for those cases who have a charge in the Surgery Department:

l Department to be allocated is Surgery Scheduling.
l Create a cost item for Surgery Scheduling – D2E – 12345 Surgery Scheduling.
l Select Surgery Scheduling from the Department drop-down list.
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l Select the table to filter. Since we are going to use patient count for selected departments, we filter
on the COSTDETAIL table.

l The volume field will be encounter because we are counting encounters.
l The Aggregation Method is DistinctCount because the encounter should be counted only one

time. An encounter may have several charges in this department, so be sure to count the case
only one time.

l Base the selection of encounters on Service Date.
o The filter is the cost center(s) for surgery. This selects only those cases that have at least

one charge in the surgery department(s).

Deleting Direct to Encounter definitions
To delete a Direct to Encounter definition:

1. In the Guide View, clickMethods and Assumptions > Methods > Direct To Encounter > Direct To
Encounter Definitions.

NOTE: The utility opens in a separate browser window.

2. In the Delete column, select the check box for each definition to delete.

3. Click Delete.
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4. When you are ready, process the definitions.

Processing Direct to Encounter definitions
To process Direct to Encounter definitions:

1. In the Guide View, clickMethods and Assumptions > Methods > Direct To Encounter > Direct To
Encounter Definitions.

NOTE: The utility opens in a separate browser window.

2. In the Process column, click the check box next to each definition to process.

3. Click Process.

4. In the Process Settings dialog, complete the following:
a. From the Start YRMO drop-down, select the start year and month of the encounters.

b. From the End YRMO drop-down, select the end year and month of the encounters.

c. To process all of the definitions, select the Process all Definitions check box.
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NOTE: Even though you may have only selected specific definitions from the list, this
check box gives you the option to process all of the existing definitions instead of the
ones you selected. To continue only processing those definitions you selected. Leave
this check box blank, and click Start.

d. Click Start.

Processing advanced Cost Methods
This page allows you to process advanced cost methods, such as Transaction Microcosts, Microcost,
and/or ReverseMarkup costing methods and post the results to the CDCC table.

To process advanced cost methods:
1. In the Guide View, click Process Advanced Cost Methods.

Click image to view full size

2. From the Select a Cost Set drop-down, select a cost set.
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Click image to view full size

3. From the Select a Method Definition Version drop-down, select a method definition version to
process.

4. From the Select Markup Version (Markup Only) drop-down, select a markup version to process.

5. From the Service Start YRMO drop-down, select the YRMO start date.

6. From the Service End YRMO drop-down, select the YRMO end date.

7. In the Processes area, select the processes to run.

8. Click Run Now.

9. In the Information dialog, click OK.

To view the status of the processes, see Viewing scheduled job results.

Calculating unit costs bymethod
The system uses themethod assigned to each cost item for each cost pool to determine which cost
calculations to perform to obtain the total cost per cost item. The Unit Cost Calculations page allows you
to calculate all unit costs based on GL allocations for a cost set and reconcile the results.

To calculate unit costs:
1. In the Guide View, click Unit Cost Calculations.
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2. From the Select a Cost Set drop-down, select a cost set to calculate.

3. In the Select Cost Methods section, select one or more cost methods to use to calculate the cost
items.

NOTE: If themethod you want to use does not display, you need to go to the System
Configuration page to select themethod.

4. Click Run Now.

Assigning unit costs to cost items
This section focuses on moving or assigning calculated costing results from the Cost Results table to cost
detail and encounter-based records.

After calculating unit costs, you run the following processes to place the unit cost values into tables for
reporting used for reconciliation purposes:

1. Apply results to the Cost Detail Category Calculation table

2. Summarize the Cost Detail Category Calculation results

3. Refresh the Department Utilization Summary tables

Applying results to the Cost Detail Category Calculation table
Assigning Cost Item unit level results at the Cost Category level to CostDetail table includes a step to the
CostDetailCategoryCalculation, which is at the encounter and transaction level, using a Compound Key
of EncounterSeq and TransactionID.
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To apply results to the Cost Detail Category Calculation table:
1. In the Guide View, click Cost Assignments > Results to Cost Detail Category.

2. In the Variables section, the default options are already set by default based on your active cost
set. In most cases, you do not need to change these options.

NOTE: The YRMO dates are constrained to the cost set selected in the Select Cost Set drop-
down.

3. Click Run Now.

To view the status of the processes, see Viewing scheduled job results.

Summarizing the Cost Detail Category Calculation results
Use this job to run the following tasks:

l Sums cost detail category to cost detail totals - The Cost Detail Category Cost information is
summarized to the CostDetail table, which does not store cost-category level costs. The CostDetail
table cost information is limited to calculated fields (e.g., subtotals for Direct and Indirect as well as
totals).

l Sums cost detail totals to encounters - The encounter detail cost category results are
summarized to the Encounter, which does not store cost category-level costs. The encounter cost
information is limited to the calculated subtotal and total costs, such as Fixed Direct, Variable
Direct, Total Direct, and so on.

l Sums cost detail category to encounter detail - The Cost Category/Cost Item transaction-level
results from Applying results to the Cost Detail Category Calculation table are summarized to a
second table in this process, EncounterDetailCategoryCalculation. This table stores category level
cost information at the encounter level.
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To summarize the Cost Detail Category Calculation results:
1. In the Guide View, click Cost Assignments > Summarize Cost Detail Categories.

2. In the Variables section, the default options are already set by default based on your active cost
set. In most cases, you do not need to change these options.

NOTE: The YRMO dates are constrained to the cost set selected in the Select Cost Set drop-
down.

3. Click Run Now.

To view the status of the processes, see Viewing scheduled job results.

Refreshing the Department Utilization Summary table
The Department Utilization Summary table is simply a pivot table version of the CDCC to provide easier
reporting.

To apply results to the Cost Detail Category Calculation table:
1. In the Guide View, click Cost Assignments > Department Utilization Summary.
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2. In the Variables section, the default options are already set by default based on your active cost
set. In most cases, you do not need to change these options.

NOTE: The YRMO dates are constrained to the cost set selected in the Select Cost Set drop-
down.

3. Click Run Now.

To view the status of the processes, see Viewing scheduled job results.
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System Administration
This chapter addresses system management features and instructions.

ProcessManagement
Using the Process Management feature, you can define a set of process steps—including assigning
ownership and due dates—and then track the completion of these steps. For example, you could
manage and track an annual rollover process, monthly data updates, or any specialized process such as
cash flow forecasting for financial institutions.

Process management provides the following benefits:
l A documented workflow to complete a particular process in Axiom Cost Accounting. All necessary

steps can be detailed in the process, including steps that happen outside of Axiom Cost
Accounting (for example, preparing a source file for use in an import). Steps can be dependent on
prior steps, or they can be performed in parallel as appropriate.

l Clear ownership of each process step, including due dates. Users who are assigned a step will be
notified of this responsibility, and can view and complete the step within their Process task pane.

l Easy access to features necessary to complete process steps. Each step can be associated with
certain features in Axiom Cost Accounting, so that the user responsible for the step can often
launch the necessary feature directly from the Process task pane and perform the assigned task.

l A permanent audit trail for the process, including who completed a step and when. The process
status details can be viewed while the process is active, and also after the process is complete, so
that there is always a record of the process.

NOTE: In order to manage plan files in a planning process, you must use a special version of process
management known as a plan file process. These processes are defined at the file group level using a
plan file process definition. Plan file processes are dedicated to editing and reviewing plan files
according to a defined set of steps, owners, and due dates. Because plan file processes support
different step types and different features, they are not discussed in this section. This section only
discusses general process definitions.

8
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About process management
Process management can be used to manage and track an Axiom-related process from end to end—
encompassing all aspects of the process, including steps that may need to be completed outside of the
system.

� Defining processes
In order to use process management, you first create a process definition. This file defines the properties
of the process, such as:

l Name and description (for example "Annual Rollover")
l Process owner
l Steps in the process
l Owners and due dates for each step
l Associated files and features for each step
l Notifications to be sent during the process

Example process definition
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The process definition is a file that is stored in the Process Definition Library (or for processes that belong
to a file group, within the file group's Process Definitions folder). The process definition can be
subsequently edited and "activated" as needed, whenever you need to perform and track the process.
When a process is activated, a new incarnation of the process is created to track the details of that
particular process instance. This ensures that you always have a history of each time the process is
performed, including who completed each step in the process and when.

� Performing a process
When you are ready to perform a process, you "activate" or start it. The first step in the process is made
active, and a notification is sent to the assigned step owner (or owners). This default notification gives
the user information such as the process name, the step name and description, and the due date. You
can optionally customize the notifications for a process, and you can disable them if desired.

When a process is active, the process owner and all administrators can see the process in the Process
task pane. Other users only see the process if they are the assigned owner of a step in the process.

Example process task pane for a step owner (non-admin)

The assigned user must perform the task and then mark the step as complete by the designated due
date. For more information, see Step ownership and completing process tasks. If necessary, an
administrator or the process owner can override step ownership and complete the step.

Once the currently active step is complete, the process moves to the next step, and so on until all steps
are complete. Generally speaking, only one step at a time is active in a process. However, there can be
multiple active steps at the same time if a Parallel Subprocess step is used in the process. When the
active step is a parallel subprocess, all sub-steps of the subprocess become active simultaneously and
can be completed in parallel. The subprocess is not completed until all sub-steps are completed. For
more information, see Performing process steps in parallel. TheMultiple Approvals Process Step also
counts as a parallel subprocess.

When all steps in the process are complete, the process instance is automatically completed.
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� Step ownership and completing process tasks
Each step in a process represents a task to be performed, and that step has one or more assigned
owners. When a step becomes active in a process, a task is generated for the assigned owner. This user is
expected to perform the task for that step, and then mark the step as complete by its assigned due date.
This is done using the Process task pane.

If a user is the assigned owner of an active step, the process and the active step display in the Process
task pane (or in a custom task pane that has been configured to show the process task control).

Example active task in task pane

The process task may be an activity that the assigned user performs in Axiom Cost Accounting, such as
running an import, or it may be an activity that the user completes externally, such as obtaining the
source file for the import from another system and saving it to the designated location. The task may be
simply to confirm that the process is ready to continue (an approval step).

The step name and description should be defined so that the assigned user clearly understands what
they are expected to do to complete the task. In some cases, the step may have an associated "action",
such as theOpen report button in the example screenshot above. This is provided as a convenience, so
that the user can easily access features that are related to the task. However, once the file or feature is
open, it is up to the user to decide what to do with that file or feature in order to perform the task. Axiom
Cost Accounting does not perform any validation before allowing a step to be completed; it is up to the
assigned user to determine that the step is complete.

Once the user has completed the task to their satisfaction, they can mark the step as complete by
clicking the button in the task pane. This opens the Process Action dialog, so that the user can confirm
that they want to complete the step, as well as enter any step comments.

This dialog displays slightly differently depending on step type. Most steps will display as follows,
showing a step progression diagram for context:
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NOTE: If the step is part of a Parallel Subprocess, then the step progression diagram is not displayed,
because the process does not continue to the next step until all steps in the subprocess are
complete. The user is simply informed that they are completing the current step.

Certain step types have slightly different step completion behavior. For example:
l If the step is an Approval Process Step, then theMark step as complete button does not display

in the task pane. Instead, the user can click either Approve or Reject. If they click Approve, the
step is completed and the process moves to the next step. If they click Reject, the process is
moved back to the prior step.

l If the step is a Scheduler Process Step, then the step displays in the Process task pane for
information only, because the step will be processed and completed automatically by Axiom Cost
Accounting. However, if the Scheduler job experiences errors, then the user has various options to
restart the job or to manually mark the step as complete if the job does not need to be re-run.

In most cases, the current, next, and prior step owners show in the completion dialog. Prior steps and
their owners only showwhen the task can be rejected back to the prior step. However in some cases, it is
not possible or feasible to show the step owners. For example, if the next step in the process is a
subprocess that may resolve to multiple steps with multiple possible owners, then Axiom Cost
Accounting does not attempt to show the next steps or their owners. Instead it displays the name of the
subprocess and that there will be "(multiple step owners)".
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Once the step is completed, the process no longer displays in the user's Process task pane (unless the
user is also the step owner of the next step). If the user has no active tasks in any processes, then the
Process task pane will be empty for the remainder of the current session, and will not open the next time
the user logs in (unless the user has been assigned a new active task in themeantime). Exceptions are as
follows:

l Process owners see the process in their Process task pane as long as the process is active.
l The Process task pane is visible to administrators as long as any process in the system is active.

If necessary, an administrator or the process owner can mark a step as complete. For example, imagine
that the assigned user already performed the necessary task but then left on vacation before they
marked the step as complete. The administrator can mark the step as complete so that the process can
continue. In this case the process history will reflect both the original assigned owner, and the fact that
the administrator completed the step.

� Performing process steps in parallel
In general, the order of steps in your process definition determines the order in which tasks for the
process can be completed.

When the process is started, the individual steps aremade active in the order they are listed. By default,
each step is dependent on the prior step being completed (sequential steps). So if step 1 is the currently
active step, step 2 is not made active and cannot be completed until step 1 is marked as complete. Once
step 1 is completed, step 2 becomes active, and so on.

However, you may have some steps in your process that are not dependent on each other and can be
completed in any order. These steps are known as parallel steps, meaning they can all be active at the
same time.

To configure parallel steps, you must use a Parallel Subprocess step, and then define the parallel steps
as sub-steps of the subprocess. This tells Axiom Cost Accounting that the sub-steps of the subprocess
can be completed in any order.
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When the Parallel Subprocess step becomes the active step, all sub-steps are also made active. Once all
sub-steps in the subprocess are completed, then the Parallel Subprocess step is automatically marked as
completed, and the process moves to the next step.

Imagine that step 2 of a process is a Parallel Subprocess step, and the subprocess has 5 sub-steps. Once
step 1 is completed, then step 2 becomes active as well as all 5 of its sub-steps. The owners of the sub-
steps can work on these steps and complete them in any order. Once all 5 of the sub-steps are
completed, step 2 is automatically completed, and then step 3 of the process becomes the active step.

NOTE: TheMultiple Approvals Process Step is a special type of Parallel Subprocess. It can only
contain Approval Process Steps as sub-steps, but otherwise its behavior is the same as the Parallel
Subprocess.

� Tracking process status and history
Administrators and process owners can view process status and history at any time. Using the Process
Manager dialog, you can see the status of all active processes or all current processes at-a-glance.

Example Process Manager dialog
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Administrators and process owners can view the details for an active process, to see when each step was
completed and by whom, as well as any comments added by users. You can also perform process
administration tasks within this dialog, such as overriding step ownership, restarting stalled steps, and
stopping the process.

Example process details in the Process Status dialog

Administrators can view the historical details for any process. For example, if you have a process that you
run monthly, you can go back and view the prior month's details, or any amount of history that you
want to retain.

Creating Process Definitions
Using a process definition, you can define the set of steps to bemanaged and tracked as part of a
process, including step order, ownership, associated actions, and due dates.

Process definitions are stored in the Process Definition Library. Access to the definitions is controlled by
the file security settings on the Files tab of security. Only users who need to create and modify the
process definitions need access to these files. Users who are assigned to perform individual steps in the
process do not need access to the definition in order to perform the task or to view the process status.
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NOTE: This topic discusses how to create a general process definition. If you want to manage plan
files in a planning process, then you should use a plan file process definition instead. General process
definitions and plan file process definitions share certain basic settings, but plan file process
definitions are dedicated to plan file process steps, and also support additional features that are
unique to plan file processes.

Process definitions are typically created by administrators, or other power users who are responsible for
administrating parts of the system. The creator of the process definition needs to understand all steps of
the process, who needs to perform each step, and when that step needs to be performed.

Process definitions do not have any impact on the system until they are activated.

To create a new process definition:
1. On the Axiom tab, in the Administration group, clickManage > Processes > Process Definitions.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
theWorkflow group, click Process Management > Process Definitions.

The Axiom Explorer dialog opens, filtered to show the Process Definition Library. If you have access
to the Process Definitions folder for any file groups, those folders also display here.

2. Right-click the Process Definition Library (or a subfolder), then click New > Process Definition. If
you want to create a process definition for a file group, you can right-click the Process Definitions
folder in the file group.

The Edit Process dialog opens. As you are working in this dialog, any validation errors for missing
or invalid settings will display at the bottom of the dialog. You can save the process definition with
configuration errors, however, you will not be able to start the process until all configuration
errors are resolved.

3. In the Process Properties tab, complete the general process settings as desired. For more
information, see:

l Designating the process owner
l Configuring process visibility to step owners
l Process Definition Properties

4. In the Process Steps tab, define the steps for the process.

l To add a step, click Add and then select the type of step to add. New steps are added after
the step that you currently have selected in the list.

However, if the currently selected step supports sub-steps, then the new step is added as a
sub-step. This applies to step types such as Parallel Subprocess. In this case, if you want to
add a new top-level step that comes after the subprocess step, you must click Add After
Current Step and then select the type of step to add.
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l To remove a step, select that step and then click Delete. If the deleted step has child steps,
those steps are removed as well.

l To change the order of steps, you can drag and drop them to different locations in the list.

l To copy a step, select the step and then click Duplicate. You can then modify the copied
step as needed and move it to the desired location in the list.

Steps are performed in the order listed. By default, steps are dependent and sequential—
meaning, each step in the list must be completed before the next step can be done. However, it is
possible to use a Parallel Subprocess to define parallel steps—meaning multiple steps that are not
dependent and can be performed at the same time. The parallel steps are then defined as sub-
steps to the Parallel Subprocess. (Multiple Approvals Process Steps also behave like Parallel
Subprocesses.)

Once you have added a step to the process, you can configure the settings for that step in the
right-hand pane. This includes the display text for the step, the step ownership and due date, and
other properties specific to the step type. You can also configure step-specific notification settings.

For more information on configuring the steps in the process, see the following topics:
l Assigning owners to process steps
l Defining the due date for a process step
l Process step types
l Defining notifications at the step level

TIP: In most cases, you should configure the process-level notification settings on the
Notifications tab before configuring any step-level notification settings. This way the steps will
have access to the inherited process-level settings.

5. In theNotifications tab, complete the notification settings for the process. You can enable or
disable notifications for the process, define the default notification delivery method, and define
default notifications to apply to the steps in the process. For more information, see Configuring
Notifications.

6. Click Apply to save, orOK if you are finished editing.

� Copying an existing process definition
You can create a new process definition by copying an existing definition. To do this, use normal Axiom
Explorer functionality:

l Right-click the definition file in the Process Definition Library, and then select Copy.
l Right-click a folder, and then select Paste to paste a copy of the file. The new file will be named

OriginalFileName - Copy.
l Rename the file, then open the file and change the process definition settings as desired.
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� Creating a general process definition for a file group
You can create general process definitions that belong to a file group. For example, you might use a
general process definition in a file group to document and manage the rollover procedures for the file
group.

General process definitions in file groups have the following special properties:
l The processes are stored in the Process Definitions folder of the file group, instead of in the

Process Definition Library.

l All step types that require a designated file group are automatically associated with the current file
group. There is no option to specify a file group because the current file group is assumed.

l Processes can be copied when the file group is cloned, so that you do not have to create new
processes for cloned file groups.

l The ability to create and edit processes for a file group is reserved for administrators and for users
with the appropriate file access to the Process Definitions folder of the file group (as granted on
the Files tab of the Security Management dialog).

General process definitions cannot be used to manage the plan files in a file group through a defined set
of planning steps. To do that, you must use a plan file process definition. This is a special type of process
definition that can only be created in a file group.

Designating the process owner

Each process definition has a designated owner. The process owner receives all administrative
notifications for the process, and can also:

l Start and stop the process
l Access the Process Status dialog when the process is active
l Move, complete, and regenerate steps

NOTE: Administrators can also perform all of these actions, regardless of whether or not they are the
process owner.

The owner of the process is designated by the Process Owner setting on the Process Properties tab. By
default, the process owner is set to the user who created the process definition. If desired, you can
change the owner to a different user or to a role by clicking Select User or Select Role. If the owner is a
role, then all users in that role are treated as process owners.
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If the designated owner is a non-admin user, then you should make sure that the user has read/write
access to the process definition, so that the user can open and edit the definition as needed, and can
start the process. Once the process has been started, the process will display in the owner's Process task
pane for the duration of the process, and the owner will gain access to the View status link so that they
can perform any necessary administrative functions for the process. Process owners can also access the
Process Manager dialog to perform process management activities for the processes they own.

� Administrative notifications
Notifications are automatically sent to the designated process owner when the following situations
occur:

l The process is started or stopped.
l An error occurs in a process step.

These notifications are system-managed and cannot be disabled or customized. However, you can
designate additional users to receive these notifications.

The Admin Notification Recipients are designated on theNotifications tab. By default, the process
owner is the only recipient of these notifications. To add or remove recipients, click Edit Recipients.

In the Edit Recipients dialog:
l To add a recipient, click Add Recipients>User or Add Recipients> Role to choose a user or role.
l To remove a recipient, select the user or role in the Notification Recipients list and then click

Delete.

The process owner cannot be removed as a recipient. If the designated process owner is a role, then all
users in that role will receive the administrative notifications.
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NOTE: If the user who stopped or started the process is also an administrative notification recipient,
that user will not receive a notification, because that user already knows about the change in process
status. The intent of the started/stopped notifications is to inform interested parties that somebody
else stopped or started the process.

Configuring process visibility to step owners

When you create a process definition, you can specify whether step owners can see all steps in the
process in the Process task pane, or only their current step. This is controlled using the following setting
on the Process Properties tab: Allow step owners to see all steps in the process task pane.

This setting is disabled by default, which means that step owners only have access to the Task View in the
Process task pane. The Task View displays the currently active step as follows:

l The name and details of the currently active step are displayed without any reference to the step
number. However, the user can see the step number in the tooltip.

l The step owner cannot see any other steps in the process, within the Process task pane. When
the user completes the step, they can see the next step in the process. If the step can be rejected
backwards, the user can also see the prior step.

If desired, you can enable this setting, which gives step owners access to the Process View in the Process
task pane. Process View displays the full list of all steps in the process, so that the user can understand
the context of the currently active step within the overall process. Process View is for information only—
users cannot complete steps or launch files / features from Process View. Users can toggle between Task
View and Process View as desired.

The following screenshots show examples of Task View versus Process View, including the toggles to
switch back and forth. If a user does not have permission to see Process View, then the Show process
view toggle does not display.
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Task View

Process View

This setting does not apply to administrators or to process owners. These users always have access
to Process View, regardless of whether this setting is enabled. Process View is the only available view for
these users when they do not have an active task in the process.

Assigning owners to process steps

Each step in a process definition must have a defined owner to perform that step and mark it as
complete. The assigned step owner can be a user or a role.

When a step is made active, the assigned owner is notified that they have a task to complete in the
process (if notifications are enabled for the process and for the step). The owner can view the active task
in the Process task pane, perform actions associated with the task, and then mark the step as complete.

This topic discusses step ownership options for general process definitions. Plan file process definitions
have additional options to assign step ownership, so that each plan file can be assigned a different owner
for each step.

NOTE: When using a Parallel Subprocess or a Multiple Approvals step, ownership assignments are
only made on the child steps. The parent step does not have ownership assignments.

� Assigning owners to individual steps
In the process definition, step owners are assigned on the Process Steps tab, in the Assignments sub-
tab. Select the step for which you want to assign ownership, then use the Assignment Type field to select
the ownership type.
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For steps in general process definitions, the assigned owner can be a user or a role:

Assignment Type Description

User Assign a specific user as the owner of the step. When the step becomes
active, a process task will be generated for the user to complete the step.

Click the Edit button to the right of the Assigned User box to select a
user. You can select any user in the Axiom Cost Accounting system.

NOTE: If most or all of the steps in your process use the same owner, you
can choose to set a default owner at the process level. If you do this, then
you can leave the Assigned User at the step level blank, and that step will
automatically be assigned to the default owner.

Role Assign a role as the owner of the step. When the step becomes active, a
process task will be generated for all users in that role, and any of those
users can complete the step.

Click the Edit button to the right of the Assigned Role box to select a
role. You can select any role in the Axiom Cost Accounting system.

Until a process is active, you can edit step ownership settings as desired. Once a process is active, you
can edit ownership settings for any step that is not already completed. If you change the ownership
settings of an active step, new tasks will be regenerated as needed to reflect the new settings, including
sending new Step Activated notifications (if enabled for the process).

� Defining a default user assignment for the process
If desired, you can specify a default user assignment at the process level. This option is useful when you
have a process wheremost or all of the steps are performed by the same user.

The default user assignment can be set on the Process Properties tab, as theDefault Process
Assignment.
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If an individual step is set to User as the Assignment Type, but no user has been specified, then the step
will use the default assignment. This is indicated in the step properties as follows:

Once a process has been started, the default process assignment cannot be changed. However, you can
still change the owner of any individual steps that have not yet been completed.

� Step ownership and security permissions
For steps in a general process definition, step ownership only grants the ability to mark the step as
completed in the process. It does not grant the user the necessary security permissions to perform any
associated action for the step, and it does not prevent any other user from performing that associated
action. When assigning owners to process steps, you should be sure that the owner has the appropriate
security permissions to perform the associated task for the step.

For example, imagine that the step is "Import actuals data" and the step has been linked to the
GLActuals import utility. If the user has permission to execute that import (as defined in security), then
the user can click Open import for the task in the Process task pane to execute that import. However, if
the user does not have permission to execute the import, then being the step owner does not grant
them the permission. Additionally, if other users have security permissions to execute that import, they
can still do so.

Defining the due date for a process step

Each step in a process definition can have a defined due date. If a step has not been completed by the
due date, then the step becomes overdue. If the active step in a process has become overdue, a warning
displays in the Process task pane and the due date displays in red.

Example display of overdue step
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In the process definition, step due dates are defined per step on the Process Steps tab, in the
Assignments sub-tab.

To define the due date for a step:
1. Click the Edit icon to the right of theDue Date box.

2. In the Choose Date dialog, select one of the following options:
l No Due Date: The step does not have a due date.

l Static Due Date: Select a specific date for the due date. You can select the date from a
calendar.

l Relative Due Date: Specify a number of days to dynamically determine the due date. The
number of days can be relative to the date the process was started (process start date), or
to the date this particular step was started (step start date). For example, the step can be
due 7 days after the process was started, or 7 days after this step was started. By default,
the process start date is used.

Example Choose Date dialog
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3. If you specified a relative due date that is based on the step start date, decide whether or not to
enable Reset relative due date when step is reopened. This option displays underneath theDue
Date field.

By default this option is disabled, which means that the step due date is calculated when the step
is first started, and that due date does not change if the step is later reopened. So if the step due
date is 6/1/2019when the step is first started, and then later the step is reopened on 6/2/2019,
the step due date will remain at 6/1/2019 and the reopened task will be 1 day past due.

If instead you want the step due date to be reset (recalculated) based on the date the step is
reopened, then you should enable this option. Continuing the above example, if the step is
reopened on 6/2/2019 and the due date for the step is configured to be 3 days after the step start
date, the due date for the reopened task will be recalculated to 6/5/2019.

� Changing due dates
You can change the due date of a step at any time if the process is not active. If you have already defined
a due date and now you want to clear it (so that the step has no due date), click theDelete icon to the
right of theDue Date field.

For active processes, you can change the due date of any step that is not already completed. If you
change the due date of an active step, new tasks will be regenerated as needed to reflect the new due
date, including sending new Step Activated notifications (if enabled for the process).

Using the result of a previous step

You can configure a step in a process definition to perform an action on the result of a previous step. This
is intended to support processes where an item is created in one step and then you want to perform one
or more actions on this newly created item.

Currently, this configuration is only supported for processes that use a File Group Process Step with the
Clone File Group action. This is the only step type that officially creates a new item in Axiom Cost
Accounting. Although you can use other process steps to direct step owners to create any kind of item,
the creation is not an official step action and is not tracked by the process.

The typical use case for this configuration is for a rollover process. For example:
l Step 1 uses the Clone File Group action to create a new file group for the new cycle of planning.
l Step 2 creates the plan files for the new file group that was created in Step 1.
l Step 3 processes the plan files for the new file group that was created in Step 1.

For Step 1, you would point the step to an existing file group such as Budget 2019. When the process is
activated, the step owner would perform the cloning process and create a new file group such as Budget
2020. However when setting up the process definition, you can't point Step 2 to the Budget 2020 file
group because it isn't created yet. Instead, you would configure Steps 2 and 3 to use the result of Step 1.

� Configuring a step to use the result of a previous step
When defining a File Group Process Step, do the following to use the result of a previous step:
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1. For File Group Source, select Previous Process Step.

2. For Selected Process Step, click the Browse button to select the step where the file group is
created.

The Select Process Step dialog displays a list of steps that are eligible for selection. If no steps are
eligible, a message informs you of this. Only steps that meet the following criteria are eligible for
selection:

l Must precede the current step.
l Must create a file group using the Clone File Group action.

To continue the example in the previous section, the configuration for Step 2will look like the following:

This means that Step 2will create plan files for the file group that was created in Step 1.

� Tracking the step result in active processes
If a process is configured to use the result of a previous step, then the result of that step must be tracked
within the process. To continue the previous example, when Step 1 is completed the process needs to
know the name of the file group that was created, so that it can pass the name of that file group to Steps
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2 and 3.

When a step owner completes a step where the created file group is used by a subsequent step, then as
part of the completion process they must specify the name of the file group that was created.

This selected file group is then associated with the step. In the Process Action dialog, it is displayed as the
Step Result. If needed, you can change the selected file group here before completing the step, by
clicking Select. However, once the step has been completed, the step result is then fixed and cannot be
changed without reopening the step.

The file group that is specified as the step result will be passed to the subsequent steps that use that
result. The step result is also documented in the process details for future reference.
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Process Definition Properties

This topic is a reference for all properties that can be configured for general process definitions.

� Process Properties tab
This tab defines the basic properties of the process definition.

Item Description

Process Name The name of the process. This name defines:
l The name of the process definition file.
l The process name displayed in process dialogs and web pages, if no separate

display name is defined.

Display Name Optional. The display name of the process. By default, the process name is used
as the display name.

If a display name is defined, then the process displays in process dialogs using
the display name instead of the process name. The process definition file
continues to use the process name.

Description Optional. The description of the process definition. This description displays in
the Process Status dialog.

Process Owner The owner of the process. By default, this is set to the user who created the
process definition, but it can be changed to another user.

The process owner receives all administrative notifications for the process and
can perform all administrative actions for the process (such as starting and
stopping the process, overriding task ownership to mark steps as complete,
and so on).

Configuration Properties
The following configuration properties can be set for the process:
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Item Description

Allow step
owners to see all
steps in the
process task
pane

Specifies whether the assigned step owners can see all steps in the process
when they interact with tasks in the Process task pane.

By default, this option is disabled, which means that step owners only have
access to the Task View in the Process task pane, which shows the currently
active task. If this option is enabled, then step owners gain access to the
Process View, which shows all steps in the process. Users can toggle between
each view.

This setting is only applicable to non-admin step owners. Administrators and
process owners can always see all steps of any process.

Default Process
Assignment

The user to be used as the default step owner if no specific user assignment is
made for a particular step. The default assignment only applies to steps where
the Assignment Type is set to User.

� Process Steps tab
This tab defines the steps for the process. Steps aremanaged in the left-hand pane. Step properties are
defined in the right-hand pane using the following sub-tabs: Step Properties, Assignments, and Step
Notifications.

Step Properties
This sub-tab defines basic properties for the selected step.

Item Description

Display Text The display text for the step.

If left blank, the display text is the step type (for example, "Approval Step" or
"Generic Process Step"). It is strongly recommended to define display text that
clearly identifies the specific purpose of this step.

Description Optional. The description of the step.

You can use this field to further explain the purpose of the step or to provide
additional instruction to the step owner. Users can see the step description in a
tooltip when hovering the cursor over the step in the Process task pane.

Process Step
Configuration

Some step types have additional properties that only apply to that particular
step type. For more information about each step type and its unique
configuration properties, see Process step types.

Assignments
This sub-tab defines ownership assignments and due dates for the selected step. This tab does not apply
to parent Parallel Subprocess or Multiple Approvals steps.
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Item Description

Assignment Type Specifies the type of ownership assignment. The following assignment types are
available:
l User: A specific user will be assigned to the step.
l Role: A specific role will be assigned to the step.

Additional inputs are required, depending on the selected type. For example, if
the type is User, then you must specify the assigned user. For more
information, see Designating the process owner.

Due Date The date when the step must be completed. This can be a specific calendar date,
or the due date can be relative based on a number of days after either of the
following: the date the process was started, or the date this particular step was
started.

The due date can also be left blank if the step does not have a specific due date.
For more information, see Defining the due date for a process step.

Reset relative
due date when
step is reopened

Specifies whether the due date is reset when the step is reopened. This option is
only available if the step uses a relative due date that is based on the step start
date.

By default, the step due date is calculated when the step is started, and that
due date persists if the step is reopened. If instead you want the due date to be
reset (recalculated) based on the date the step is reopened, select this option.

Step Notifications
This sub-tab defines notification properties for the selected step. The settings on this tab are only used if
notifications are enabled at the process level. If notifications have been disabled for the entire process, a
note displays across the top of the tab.

This tab has the following sections:
l Inherited Notifications: Use this section to manage the inherited notifications for this step.

Inherited notifications are notifications defined at the process level. You can optionally enable or
disable the inherited notifications on a per step basis, and you can edit the recipients for this step.

l Custom Notifications: Use this section to manage custom notifications for this step. You can add
new notification types, or you can add custom versions of the inherited notification types.

For more information on customizing notifications for steps, see Defining notifications at the step level.

� Notifications tab
This tab defines email notification settings for the entire process.
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Item Description

Enable Process
Notifications

Specifies whether notifications will be sent for the process. These notifications
are typically sent to step owners, but can also be sent to other recipients.

This option is enabled by default. When this option is enabled, you can also
optionally enable or disable notifications for individual steps, using the Step
Notifications sub-tab for the steps.

If this option is disabled, then no notifications will be sent for the process. Any
step-level notification settings will be ignored.

This setting does not affect administrative notifications, which are always sent
to the process owner (and any other recipients designated in Admin
Notification Recipients).

Default
Notifications

Defines the default notifications to apply to each step in the process. Each
process starts with two notification types by default: Step Activated and Step
Rejected. By default, these notifications are enabled for all eligible steps.

You can define additional default notification types as desired and customize
the existing default notifications. For more information, see Defining default
notifications for a process.

Notification
Delivery

Specifies the default delivery setting for all notifications in this process. Select
one of the following:
l Notification task pane: Display the notification in the recipient's

Notifications task pane.
l Email notification (default): Send the notification by email, using the

recipient's email address as defined in Axiom Security.
l Both notifications: Send the notification by email and display it in the

Notifications task pane.

All notifications defined for the process will use the default delivery setting,
unless you choose to specify a different delivery setting on a per notification
basis. Administrative notifications always use the default delivery setting.

Notification
Email From
Address

Specifies the "from" email address for all notifications sent for the process.

By default, the "from" address is the default "from" address defined for
Scheduler in the system configuration settings (for example,
noreply@axiomepm.com). If desired, you can override this default and type in
a different email address to be used for the process.

Admin
Notification
Recipients

Specifies the recipients of administrative notifications for the process. By
default, the process owner receives all administrative notifications, but you can
designate other users or roles to receive these notifications as appropriate. For
more information, see Designating the process owner.
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Deleting a process definition

You can delete a process definition if it is not active and you no longer need it. Deleting a process
definition will also delete all history for that process, so you should make absolutely sure that the
definition and its history are not needed before you delete it.

To delete a process definition:
1. On the Axiom tab, in the Administration group, go toManage > Process Management > Process

Definitions.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
theWorkflow group, click Process Management > Process Definitions.

The Axiom Explorer dialog opens, filtered to show the Process Definition Library (as well as any file
group Process Definition folders that you have access to, if applicable).

2. Right-click the definition that you want to delete, then click Delete.

You will be prompted to confirm that you want to delete the definition, and warned that all
associated history will also be deleted.

3. At the confirmation prompt, click OK.

The process definition is now deleted.

Process step types
Process management supports various step types to be used for different purposes. This section details
the available step types for general process definitions, and the type-specific settings.

This section does not cover the special step types supported by plan file process definitions.

Approval Process Step

The Approval Process Step is intended to be used for steps where you need the explicit approval of a user
in order to move forward with the process.

� Process behavior
When the Approval Process Step is the active step, the step owner has the following options:

l Approve the process so that it will move to the next step.
l Reject the process so that it will return to the prior step.

The Approval Process Step is the only step type that supports moving the process either forward or
backward; all other steps only have the option to move forward when completed.
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� Step-specific settings
Approval Process Steps in general processes do not have any unique step settings. Only the general step
settings apply.

� Restrictions
Approval Process Steps cannot be sub-steps of a Parallel Subprocess step. Because the sub-steps of a
parallel subprocess can be completed in any order, an approval or a rejection would not make sense in
this context. If you want to approve the steps in a parallel subprocess, then the next step after the
parallel subprocess should be an approval step. In this case, note that if the assigned user rejects the
process to return to the prior step, the entire parallel subprocess will be "reopened" and made active
again.

If you want to enable parallel approval steps (approvals that can occur concurrently instead of
sequentially), then you can use the special Multiple Approvals Process Step. This step works like a parallel
subprocess, however, it is specially designed to handle approval steps only. For more information, see
Multiple Approvals Process Step.

File Group Process Step

The File Group Process Step is intended to be used for steps where you need the user to perform some
kind of action on a file group.

NOTE: This step type is for performing actions on a file group as part of a larger process. If instead
you want to manage plan files through a planning process, use a plan file process.

� Process behavior
When the File Group Process Step is the active step, the step owner has two actions available in the
Process task pane:

l <Action>: The user can click the action link to open a file or perform the action associated with this
step. The text of the action and what it does depends on the selected action for the step. For
example, if the selected action is Process Plan Files, then the link text is "Process Plan Files" and
clicking on it opens the Process Plan Files dialog for the file group.

l Mark step as complete: The user can click on this link to complete the active task.

� Step-specific settings
When configuring a File Group Process Step, complete the following settings in addition to the general
step settings:
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Item Description

File Group
Source

Specify the source of the file group for this step:
l Selected File Group: You will select an existing file group on which to

perform an action.
l Previous Process Step: The file group for this action is created in a previous

process step. You will select the step in the process where this file group is
created.

For example, imagine a process where step 1 clones a file group to create a new
file group, and then step 2 creates plan files for the new file group. In step 1, you
would use Selected File Group to specify the existing file group that you want to
clone. In step 2, you would use Previous Process Step to specify the file group
that was created in step 1.

This step does not apply if the process definition is associated with a particular
file group. In that case, the current file group is assumed.

Selected File
Group

The file group for the step. Click the Select button to select an existing file group.
This option is only available if File Group Source is set to Selected File Group.

This step does not apply if the process definition is associated with a particular
file group. In that case, the current file group is assumed.

Selected Process
Step

The previous step in the process where the file group for this step is created.
This option is only available if File Group Source is set to Previous Process Step.
For more information, see Using the result of a previous step.

Click the Select button to select the step. Only steps that meet the following
criteria are eligible for selection:
l Must precede the current step.
l Must create a file group using the Clone File Group action.

This step does not apply if the process definition is associated with a particular
file group. In that case, the current file group is assumed.
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Item Description

Selected Action The action to perform on the file group:
l Open Plan Files—If the user has one available plan file in the file group, that

plan file will open. Otherwise, the Open Plan Files dialog opens, showing the
user's available plan files.

l Create Plan Files—Opens the Create Plan Files dialog with no special setup;
the user will need to configure it as needed to complete the step.
NOTE: If the file group is an on-demand file group, then this action behaves
like the "Add new file" link in the Open Plan Files dialog. The user can click on
the link to create a new on-demand plan file.

l Clone File Group—Opens the Clone File Group dialog with no special setup;
the user will need to configure it as needed to complete the step.

l Edit File Group—Opens the Edit File Group dialog with no special setup; the
user will need to configure it as needed to complete the step.

l Process Plan Files—Opens the Process Plan Files dialog with no special
setup; the user will need to configure it as needed to complete the step.

The display text and/or description for the step should make it clear to the user
what they are expected to do in order to consider the step complete.

NOTE: The assigned user for the step must have the appropriate security permissions to access the
file group and perform the designated action. The File Group Process Step does not grant any
permissions or elevate any existing permissions.

Generic Process Step

The Generic Process Step can be used for any step that is not covered by the other step types. This step
type has no special behaviors and is not associated with any particular feature in Axiom Cost Accounting.

You might use this step for:
l A task that a user needs to compete outside of Axiom Cost Accounting.
l A task that uses an Axiom Cost Accounting feature for which there is no specific step type.

� Process behavior
When the Generic Process Step is the active step, the step owner can useMark step as complete in the
Process task pane to complete the step.

This step cannot be associated with an action; the assigned user will need to perform the task on their
own. It is important to define the display text and description clearly so that the user understands what
they need to do in order to consider the step complete.
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� Step-specific settings
Generic Process Steps do not have any unique settings. Only the general step settings apply.

Import Process Step

The Import Process Step is intended to be used for steps where you need a user to access an import
utility in Axiom Cost Accounting, whether to edit the import settings and/or execute the import.

� Process behavior
When the Import Process Step is the active step, the step owner has two actions available in the Process
task pane:

l Open import: The user can click this link to access the import according to their security
permissions. The step name and/or description should make it clear to the user what they are
expected to do with the import.

l Mark step as complete: The user can click this link to complete the active task.

� Step-specific settings
When configuring an Import Process Step, complete the following setting in addition to the general step
settings:

Item Description

Selected Import The import utility to associate with this step. Click the folder icon to select the
import.

NOTE: The assigned user for the step must have the appropriate security permissions to access the
import and perform the desired action. The Import Process Step does not grant any permissions or
elevate any existing permissions.

Multiple Approvals Process Step

TheMultiple Approvals Process Step is intended to be used when you want multiple users to approve a
process concurrently instead of sequentially. The difference in approach is as follows:

l For sequential approvals, use several Approval Process Steps in a sequential order. Only one
approval step is active at a time, and that step must be completed before the process moves to
the next approval step.

l For concurrent approvals, use a Multiple Approvals Process Step with two or more Approval
Process Steps as sub-steps. When the parent Multiple Approvals Process Step becomes active,
then all approval sub-steps become active concurrently. All of the sub-steps must be completed
before the process moves to the next step.
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� Process behavior
When theMultiple Approvals Process Step is the active step, then all of its approval sub-steps are also
made active. Owners of the approval sub-steps can complete their steps as appropriate without any
dependencies on the other sub-steps. When all sub-steps are approved by their owners, then the
Multiple Approvals Process Step is automatically marked as complete and the process moves on to the
next step. However, if any of the sub-steps are rejected, then the entire step is rejected and the process
is moved back to the step immediately before theMultiple Approvals Process Step.

� Step-specific settings
The only available step settings for Multiple Approvals Process Steps are display text and description.
These steps do not have owner assignments or due dates. Owner assignments and due dates are
defined individually for each sub-step.

� Restrictions and limitations
l AMultiple Approvals Process Step must have two or more sub-steps. The sub-steps can only be

Approval Process Steps.

l When an owner of a sub-step in a Multiple Approvals Process Step completes a step, the previous
and next steps shown in the Process Action dialog are the top-level steps before and after the
Multiple Approvals Process Step. The other sub-steps do not have an order and therefore are not
shown in relation to the step being approved or rejected.

Parallel Subprocess

The Parallel Subprocess step is intended to be used when you have several steps that are not dependent
on each other, and instead can be performed at the same time (in parallel). The only purpose of this step
is to define a set of sub-steps that can be performed concurrently.

� Process behavior
When the Parallel Subprocess step is the active step, all sub-steps of that subprocess are also made
active. Owners of the sub-steps can complete their steps as appropriate without any dependencies on
the other sub-steps. When all sub-steps of the subprocess aremarked as complete by their owners, then
the Parallel Subprocess step is automatically marked as complete. For more information, see Performing
process steps in parallel.

� Step-specific settings
The only available step settings for Parallel Subprocesses are display text and description. They do not
have owner assignments or due dates. Owner assignments and due dates are defined individually for
each sub-step.
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� Restrictions and limitations
l A Parallel Subprocess must have two or more sub-steps, to define the steps that can be

performed in parallel.

l Approval Process Steps cannot be sub-steps of a Parallel Subprocess. Because the child steps of a
Parallel Subprocess can be completed in any order, an approval or a rejection would not make
sense in this context.

o If you want to approve the steps in a Parallel Subprocess, then the next step after the
Parallel Subprocess should be an Approval Process Step. In this case, note that if the
assigned user rejects the process to return to the prior step, the entire Parallel Subprocess
will be "reopened" and made active again.

o If you want multiple Approval Process Steps to be active simultaneously, then you should
use a Multiple Approvals Step. This is a special type of parallel subprocess that only allows
for approval steps.

l When an owner of a sub-step in a Parallel Subprocess completes a step, they will not see the
previous and next steps in the Process Action dialog. Within the context of the subprocess, all sub-
steps are occurring concurrently and there is no "previous" and "next". However, if a user has the
ability to view all steps of the process in the Process task pane, they can see the overall step
progression there.

Report Process Step

The Report Process Step is intended to be used for steps where you need a user to run a report in Axiom
Cost Accounting. For example, you may want a user to run a report for any of the following reasons:

l Verify data beforemoving on in the process
l Run a save-to-database report utility
l Distribute report packages using File Processing features
l Process alerts

� Process behavior
When the Report Process Step is the active step, the step owner has two actions available in the Process
task pane:

l Open report: The user can click this link to access the report according to their security
permissions. The step name and/or description should make it clear to the user what they are
expected to do with the report.

l Mark step as complete: The user can click this link to complete the active task.

� Step-specific settings
When configuring a Report Process Step, complete the following settings in addition to the general step
settings:
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Item Description

Selected Report The report to associate with this step. Click the folder icon to select a file in the
Reports Library.

Open Form As If the report is form-enabled, then you can specify how the file is opened when
the user opens it from the Process task pane:
l Form in the client(default)
l Form in web browser
l Spreadsheet

This option only displays if the selected report is form-enabled.

NOTE: When using the Axiom Excel Client, Axiom forms will always open in the
user's browser instead of within the application, regardless of this setting.

NOTE: The assigned user for the step must have the appropriate security permissions to access the
report and perform the desired action (such as Allow Save Data to perform a save-to-database). The
Report Process Step does not grant any permissions or elevate any existing permissions.

Scheduler Process Step

The Scheduler Process Step is intended to be used for steps where you want to run a Scheduler job as
part of the process. Unlike other step types, the Scheduler Process Step is an automated step, meaning
that no user intervention is required to run the Scheduler job or to complete the step (assuming no
errors occur).

� Process behavior
When the Scheduler Process Step is made active, Axiom Cost Accounting will automatically place the job
in the Scheduler queue for immediate processing (pending Scheduler thread availability). If the
processing completes successfully, then the step is automatically marked as complete and the process
continues to the next step. Any notifications defined in the job are honored; no additional notifications
are sent.

If the job experiences any errors, or if Axiom Cost Accounting is unable to schedule the job for some
reason, then the step is effectively stalled. However, unlike other stalled steps, if this occurs the assigned
user has several options available in the Process task pane to attempt to resolve the issue:

l View job results: The user can view the job results to troubleshoot the issue. However, note that
the user must have the Scheduled Jobs User permission and at least read-only access to the job
in order to view the job results.

l Restart scheduled job: This option places the job in the Scheduler queue to be run again. This
assumes that the error was the result of some temporary issue which no longer applies, or that
the underlying issue has been addressed and the job is now expected to complete without error.
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l Mark step as complete: This option can be used to ignore the job error and manually complete
the step. This may be appropriate for situations where the job completed with partial success
which is sufficient to consider the step complete, or for cases where the step owner or an
administrator ran the Scheduler job or related utility manually as part of troubleshooting the
original issue, so the job does not need to be run again as part of processing this step.

� Step-specific settings
When configuring a Scheduler Process Step, complete the following settings in addition to the general
step settings:

Item Description

Selected
Scheduler Job

The Scheduler job to associate with this step. Click the folder icon to select the
job.

Although the step is automated, you must still specify an assigned user for the step. The job will run
using the permissions of the assigned user. The assigned user is not required to have any access to
Scheduler or to the specified job, although ideally the user will have this level of permissions in order to
troubleshoot the job results if any errors occur.

Table Process Step

The Table Process Step is intended to be used for steps where you need a user to perform some kind of
administrative action on a table.

� Process behavior
When the Table Process Step is the active step, the step owner has two actions available in the Process
task pane:

l <Action>: The user can click the action link to open a table or perform the action associated with
this step. The text of the action and what it does depends on the Selected Action for the step. For
example, if the Selected Action is Clone Table, then the link text is "Clone Table" and clicking on it
opens the Create Table dialog for table cloning.

l Mark step as complete: The user can click on this link to complete the active task.

� Step-specific settings
When configuring a Table Process Step, complete the following settings in addition to the general step
settings:
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Item Description

Selected Table The table on which to perform the designated action. Click the folder icon to
select a table.

Selected Action The action to perform on the table:
l Clone Table
l Edit Table Data (meaning Open Table in Spreadsheet)
l Edit Table Structure

In all cases, the assigned user will be able to open the associated dialog from the
Process task pane when the step is active. The display text and/or description
for the step should make it clear to the user what they are expected to do in
order to consider the step complete.

If Edit Table Data is the selected action, then you can optionally define a Data
Filter and/or a Row Limit for the task.

Data Filter Optional. Define a data filter to limit the data to be displayed in Open Table in
Spreadsheet. Use the Filter Wizard to create the filter criteria statement.

This setting only applies if Edit Table Data is the selected action.

Row Limit Optional. Enter a number to limit the number of rows to be displayed in Open
Table in Spreadsheet.

This setting only applies if Edit Table Data is the selected action.

NOTE: The assigned user for the step must have the appropriate security permissions to access the
table and perform the designated action. The Table Process Step does not grant any permissions or
elevate any existing permissions.

Configuring Notifications
General processes can send several different types of notifications, all of which can be configured at the
process level and at the step level. These notifications are used to inform or remind users about tasks
they need to perform, or to inform other interested parties about the current step status.

When setting up notifications for a process, you can determine:
l The types of notifications that are sent for the process and for each step
l The recipients of each notification
l The content of each notification
l The delivery method of each notification (email, Notifications task pane, or both)
l Whether notifications are sent at all, for the entire process or per step
l The frequency and timing of reminder notifications
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When defining notifications for a process, you can define default notifications at the process level. These
process-level notifications are inherited by the individual steps in the process. At the step level, you can
choose to enable or disable the inherited notifications as needed, and you can define custom
notifications to be used for that step only.

NOTE: The information in this section does not apply to administrative notifications for a process,
which are system-managed notifications intended to inform the process owner about the general
operation of the process and any errors encountered. For more information about process
ownership and administrative notifications, see Designating the process owner.

Notification types for general processes

The following types of notifications can be sent for a general process in process management:

Notification
Type

Description Available Recipient
Types

Step Activated Notification that is sent when a step is made active.
By default, the notification informs the step owner(s)
that they have a task to perform in the process. You
can customize the default notification as desired.

NOTE: This notification type is not used when a
previously active step is reopened due to an approval
step rejection. Instead, the Step Reopened
notification type is used.

l Task owners
l Any named user or

role
l Process owner

Step Reopened Notification that is sent when a step is reopened, due
to a subsequent approval step being rejected. By
default, the notification informs the step owner that
their task has been reopened. You can customize the
default notification as desired.

l Task owners
l Any named user or

role
l Process owner

Step Rejected Notification that is sent when an approval step is
rejected. This notification type is not configured by
default and is entirely user-definable.

This notification type only applies to approval steps
and multiple approval steps.

NOTE: This notification type is about the step that
was rejected, not about the prior step that was
reopened as a result of the rejection. It is intended to
inform the process owner or other interested parties
about the rejection.

l Previous step
owners

l Any named user or
role

l Process owner
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Notification
Type

Description Available Recipient
Types

Step Completed Notification that is sent when a step is completed.
This notification type is not configured by default and
is entirely user-definable.

l Previous step
owners

l Any named user or
role

l Process owner

Due Date
Reminder

Notification that is sent to remind users of an
upcoming step due date. This notification type is not
configured by default and is entirely user definable,
including the reminder schedule.

l Task owners
l Any named user or

role
l Process owner

Overdue
Reminder

Notification that is sent to remind users of an
overdue step. This notification type is not configured
by default and is entirely user definable, including the
reminder schedule.

l Task owners
l Any named user or

role
l Process owner

NOTE: For more information on the recipient types, see Customizing recipients for process
notifications.

Most of these notification types do not apply to subprocess steps (the parent step of the subprocess).
For example, a Step Activated notification is not sent when a multiple approvals step is made active;
instead the notification is sent for the first sub-step in the subprocess. Similarly, the Due Date Reminder
and Overdue Reminder notification types do not apply to subprocess steps, because these steps do not
have due dates (only the sub-steps do).

The only notification types that apply to subprocess steps are:
l Step Completed: This can be used with any subprocess. It will be sent when all sub-steps in the

subprocess are completed.

l Step Rejected: This only applies to multiple approvals steps. It will be sent when themultiple
approvals subprocess is rejected due to any of its approval sub-steps being rejected.

You can definemultiple instances of the same notification type, at any level of the process. If multiple
notifications apply when a particular step activity occurs (such as when a step is activated), then all
eligible notifications will be sent. For example, you might do this if you want to define different
notification content for different recipients of the notification type.

� Notification design considerations
Keep in mind the following design considerations when defining notifications for a process.
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l Step Activated / Step Reopened - Sending to recipients other than step owners
If you want to send the Step Activated or Step Reopened notification to any recipients other than
the step owners, you should consider creating a second instance of the notification type with text
that is appropriate for the other recipients.

The default text for these notification types assumes that the notification is being read by the step
owners. The text includes statements such as "You have a new task..." and "Please login to Axiom
Cost Accounting to complete your tasks." It may be confusing for process owners or other
recipients to receive this notification because these users do not actually have a new task, they are
just being informed of someone else being assigned a new task. The non-owner recipients should
have a separate instance of the notification type, with text that better reflects the informational
status of the notification, such as: "A new task has been issued for Step 'Import data' in Process
'Rollover'."

l Step Activated / Step Reopened - Delivering to the Notifications task pane
Because the default delivery method is email, the default text for these notifications contains the
sentence "Please login to Axiom Cost Accounting to complete your tasks." If you decide to deliver
notifications to the Notifications task pane instead, this sentence does not apply and should be
removed.

l Step Rejected - Using with multiple approvals steps
If you want to use the Step Rejected notification type with a multiple approvals step, you should
consider at which level you want the notification to be issued. You can enable Step Rejected for
each approval sub-step in the subprocess, which means that the notification will be sent at the
level of the individual sub-step that was rejected. Or, you can enable Step Rejected at the
subprocess level (the parent multiple approvals step), which means that the notification will be
sent for the parent step when any of the sub-steps are rejected.

This choice impacts how the variables are resolved in the notification text and what information is
available to the notification. You can also choose to send both levels of notification, but this is
probably more notifications than necessary for the same event, unless each notification is for
different recipients.

Disabling notifications for a process

By default, each process includes "built-in" notifications intended to inform step owners about new and
reopened tasks in the process. You can define additional notifications and customize the built-in
notifications as needed.

However, if you don't want to send these notifications, then you can disable notifications for the entire
process or for specific steps. If notifications are disabled, then the only way users can learn of their active
tasks is through the Process task pane, or through other custom reports created by your organization.
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� Disabling notifications at the process level
Use the Enable Process Notifications option on the Notifications tab to enable or disable notifications
for the entire process.

l By default, this check box is selected, which means notifications are enabled for the process.
Notifications will be sent according to the notification settings defined for each individual step
(which may include using the inherited process-level notifications).

l If you clear this check box, then notifications are disabled for the process. No notifications will be
sent. TheDefault Notifications section becomes grayed out and cannot be edited. Additionally,
any notification settings made at the individual step level will be ignored.

Notifications disabled for a process

Administrative notifications are always sent and cannot be disabled. For more information on these
notifications, see Designating the process owner.

� Disabling notifications at the step level
If Enable Process Notifications is enabled at the process level, then you can enable or disable
notifications at the individual step level.
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To disable notifications for a particular step, go to the Process Steps tab and then select the desired step.
In the Step Notifications sub-tab, you can enable or disable notifications by type.

l Inherited Notifications: These notifications are inherited from the process-level notifications. To
disable the inherited notifications at the step level, clear the Enabled check box for each
notification.

Inherited notifications disabled for a step

l Custom Notifications: These notifications are defined for the current step. To disable a custom
notification, clear the Enabled check box.

It would be unusual to define a custom notification for a step and then disable it, unless you are
disabling it temporarily for testing purposes or for other transient reasons. If you do not need the
custom notification for the step, you can delete it instead of disabling it.

Any inherited or custom notifications that are disabled for the step will not be sent for that step.

If Enable Process Notifications is disabled at the process level, then any step-level notification settings
are ignored and no notifications will be sent for the process. However, you can continue to edit the step-
level notification settings so that they are configured as you want them in case you later re-enable
notifications at the process level. Awarning message displays across the top of the Step Notifications
sub-tab to inform you when notifications are disabled at the process level.

� Disabling notifications at the subprocess level
It is not possible to disable notifications for all sub-steps of a subprocess. If you want to disable
notifications for a subprocess, you must disable them for each individual sub-step in the subprocess,
using themethodology described in the previous section.

Inherited and custom notifications can also be disabled for the subprocess (parent) step itself, using the
methodology described in the previous section.

Defining default notifications for a process

You can define default notifications at the process level. These notifications are inherited by all eligible
steps in the process, and can be enabled or disabled for those steps.
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Default notifications are best for notifications that you want to use for all or most of the steps in the
process. If many steps use the same notification, then it is easier to define it at the process level rather
than for each individual step. If you don't want a default notification to apply to a particular step, then
you can disable it at the individual step level.

The following steps are eligible to inherit the default notifications defined at the process level:
l Any top-level step that is not a subprocess step can inherit all default process-level notifications.

l Subprocess steps (the parent step of the sub-steps) can only inherit certain notification types from
the default process-level notifications. Notification types that do not apply to subprocess steps
will not be inherited by those steps.

l Sub-steps of parallel subprocesses (including multiple approvals steps) can inherit all default
process-level notifications.

� Built-in default notifications for all processes
By default, all process definitions start with two default notifications at the process level: a Step Activated
notification and a Step Reopened notification.

Built-in default notifications for a process

These built-in notifications are configured as follows:
l Notification recipients are set to task owners.
l Notification delivery is set to use the process-level setting (which by default is email delivery).
l Themessages contain basic details about the process and the current task.

You can use the built-in notifications as is, or you can customize them as desired. All aspects of the
notification are customizable. You can also opt to delete the built-in notifications and create your own
from scratch.

The following screenshots show example default process notifications for a general process definition.
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Step Activated notification

Step Reopened notification

� Adding, editing, and deleting default process notifications
You can add, edit, and delete default process notifications using theNotifications tab of the Edit Process
dialog. Any existing default notifications defined for the process (including the built-in notifications)
display in theDefault Notifications grid.

You can define default process notifications at any time. If the process is already active, any changes
madewill apply to new notifications delivered after that point.

To add a default notification:
1. Click Add Notification, then select the notification type that you want to add. For more

information on the available notification types, see Notification types for general processes.
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2. In the Edit Process Notification dialog, define the properties for the new notification. For more
information, see Notification properties for process definitions. Note the following:

l Most newly added notifications do not have any default recipients. You must add the
desired recipients before the notification is valid for use. The exception is reminder
notification types—these notifications go to task owners by default.

l Newly added notifications do not have any defined message text. You must define this
content before you can save the notification.

3. Click OK to save the notification.

4. You are prompted to choose whether you want the new notification to be enabled in existing
steps by default. Click Yes orNo as appropriate.

NOTE: It is not possible to globally enable the notification for all steps after it is saved. If you
don't enable the notification at this point, you must manually go to each existing step and
enable it as needed.

The notification is added to the grid, and is available to be inherited by all eligible steps. Whether the
notification is enabled in existing steps depends on your Yes/No selection when saving the notification.
Whether the notification is enabled for newly created steps depends on theDefault Enablement setting
for the notification.

To delete a default notification:
l Select the notification in the grid, and then click Delete.

The deleted notification is removed from the process. Any steps that were inheriting the notification can
no longer use it.

To edit a default notification:
l Double-click the notification in the grid. You can also select the notification in the grid and then

click Edit Notification.

Within the Edit Process Notification dialog, you can edit notification properties such as:
l The delivery method for the notification (email, Notifications task pane, or both)
l The urgency of the notification
l The recipients of the notification
l The notification message contents
l The notification reminder schedule (for reminder notification types only)
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Defining notifications at the step level

For each step in a process definition, you can configure notifications as follows:
l You can manage inherited notifications for the step. These are notifications that the step inherits

from the default process-level notifications. Inherited notifications can be enabled or disabled,
and you can optionally add recipients for the current step.

l You can define custom notifications for the step. These notifications only apply to the current
step.

NOTE: If multiple instances of the same notification type apply to a step, then each instance will be
sent when the notification is triggered. For example, if a step has an inherited Step Activated
notification as well as a custom Step Activated notification, then both notifications will be sent
(unless one of the notifications is disabled).

� Manage inherited notifications for a step
You can manage inherited notifications for the individual steps in a process. All steps inherit the default
notifications defined at the process level. You can enable or disable inherited notifications at the step
level, and you can add recipients at the step level.

To manage inherited notifications for a step, go to the Process Steps tab in the Edit Process dialog. Select
the step, then go to the Step Notifications sub-tab. Any existing inherited notifications for the step
display in the Inherited Notifications grid.

l Use the Enabled check box to enable or disable an inherited notification. If enabled, the
notification will be sent for this step; if disabled, the notification will not be sent.

Whether an inherited notification is enabled by default for a step depends on the choices made
when the notification was created at the process level or the subprocess level.
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l To add recipients to an inherited notification, select the notification in the grid and then click Edit
Recipients. For more information, see Adding step-specific recipients to inherited notifications.

The only inherited notification property that can be customized at the step level is the recipients. If you
want to customize the text of an inherited notification for use with a specific step only, then you should
do one of the following (depending on what you want to accomplish):

l Disable the inherited notification and instead create a custom notification of the same type for the
step.

OR

l Leave the inherited notification enabled and create a custom notification of the same type for the
step, but send each notification to different recipients.

Inherited notifications for subprocess steps
Parallel subprocess steps and multiple approvals steps can only inherit certain types of notifications from
the process. This only applies to the parent subprocess step itself. The child steps of the subprocess can
inherit all notification types as normal.

The only notification types that a subprocess step can inherit are:
l Step Completed: When all steps in the subprocess have been completed, the Step Completed

notification will be sent.

l Step Rejected: This notification type only applies to multiple approvals steps. If any of the
approval sub-steps are rejected, the Step Rejected notification will be sent for the parent multiple
approvals step. Note that this type of notification should be defined at either the parent level or
the child level, but not both (unless you want to send each notification to different recipients).

� Define custom notifications for a step
You can define custom notifications for each step in a process. The custom notifications defined at the
step level only apply to that step. If the process is already active, any changes will apply to new
notifications delivered after that point.

To define custom notifications for a step, go to the Process Steps tab in the Edit Process dialog. Select
the step, then go to the Step Notifications sub-tab. Any existing custom notifications defined for the
step display in the Custom Notifications grid.

To add a custom notification:
1. Click Add Notification, then select the notification type that you want to add. For more

information on the available notification types, see Notification types for general processes.

2. In the Edit Process Notification dialog, define the properties for the new notification. For more
information, see Notification properties for process definitions. Note the following:
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l Most newly added notifications do not have any default recipients. You must add the
desired recipients before the notification is valid for use. The exception is reminder
notification types—these notifications go to task owners by default.

l Newly added notifications do not have any defined message content. You must define this
content before you can save the notification.

3. Click OK to save the notification.

The notification is added to the grid, and by default it is enabled for the step. You can disable it if desired,
if you want to temporarily turn off the notification for the step.

To delete a custom notification:
l Select the notification in the grid, and then click Delete.

The deleted notification is removed from the step.

To edit a custom notification:
l Double-click the notification in the grid. You can also select the notification in the grid and then

click Edit Notification.

Within the Edit Process Notification dialog, you can edit notification properties such as:
l The delivery method for the notification (email, Notifications task pane, or both)
l The urgency of the notification
l The recipients of the notification
l The notification message contents
l The notification reminder schedule (for reminder notification types only)

Custom notifications for subprocess steps
You can define custom notifications for parallel subprocess steps and multiple approvals steps. The
process is the same as for normal steps. However, only Step Completed and Step Rejected (for multiple
approvals steps) notifications can be defined for the parent subprocess step. The child steps of the
subprocess can use all notification types as normal.

Customizing notification content for general process definitions

The default Step Activated and Step Reopened notifications for process definitions have default content
that you can use as is, or you can customize it as desired. When defining all other notifications, the
content is entirely up to you—there is no default content.

All notification content is defined in theNotification Message tab of the Edit Process Notification
dialog. To access this dialog, go to theNotifications tab for the process or the Step Notifications tab for
a step, and then add or edit a notification.
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NOTE: If a step has inherited a notification from the process level, the content of that notification
cannot be edited at the step level. You must go to the process level to edit the content of the
inherited notification.

Process management supports a set of process variables that can be used to return process, step, and
task information for use in notification content. For example, you can return the name of the process,
the name of the step, and the due date of the step.

� Notification message sections
Each notification message has two sections—theNotification Subject and theNotification Message
Body. Both sections for the notification must have some content in order to be valid.

The subject is rendered as the email subject line and/or as the notification title in the Notifications task
pane. Themessage body is the body text.

Example notification for a general process definition
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� Process variables
Process variables can be used in all sections of the notification message, although certain variables can
only be used in certain sections. The variables use standard variable syntax in Axiom Cost Accounting—
for example: {StepDueDate}.

Use the Insert variablemenu for the current section to insert a variable into the text. Themenu displays
only the variables that are currently valid for use, based on the current section, the step type, and the
process type. Although you can manually type the variables, it is recommended to use themenu to
ensure that you only use variables that are valid for the current section. When you choose a variable
from themenu, it is displayed in plain text—for example, Due Date for {StepDueDate}.

General variables
The following variables return general information about the process and its steps.

Variable Description Notification
Types

{CompletingUserComment} The comment made by the user who
completed the step.
l This variable resolves to blank if no

comment was entered.
l If the step that was completed was a

parallel subprocess or a multiple approvals
step, then this variable resolves as a list of
sub-steps, completing users, and
comments, such as:

Sub-step 1 name - user name -
comment
Sub-step 2 name - user name -
comment

Step Completed

{CompletingUserName} The name of the user who completed the
step.
l If the step that was completed was a

parallel subprocess or a multiple approvals
step, then this variable resolves as a list of
sub-steps and completing users, such as:

Sub-step 1 name - user name
Sub-step 2 name - user name

Step Completed

{CurrentStepName} Name of the current step. All notification
types
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Variable Description Notification
Types

{CurrentStepDescription} Description of the current step. All notification
types

{CurrentStepNumber} Number of the current step. All notification
types

{DaysPastDue} Number of days past the due date for the
current step.

Due Date
Reminder,
Overdue
Reminder

{DaysTilDueDate} Number of days until the due date for the
current step.

Due Date
Reminder,
Overdue
Reminder

{OwnerFullName} The full name of the current task owner. Step Activated,
Step Reopened,
Due Date
Reminder,
Overdue
Reminder

{NextStepDueDate} The due date of the next step in the process.

l If the next step is a parallel subprocess or a
multiple approvals step, then this variable
resolves as a list of sub-steps and due
dates, such as:

Sub-step 1 name - due date
Sub-step 2 name - due date

l If the completed step was a sub-step of a
parallel subprocess or a multiple approvals
step, and the subprocess is still active,
then this variable resolves to text such as
"N/A - parallel subprocess step is not
complete".

l If the completed step was the last step in
the process, then this variable resolves to
text such as "N/A - the process is
complete".

Step
Completed,
Step Rejected

Administrator's Guide 2019.4 Axiom Cost Accounting │ 298



Variable Description Notification
Types

{NextStepName} The name of the next step in the process.

l If the next step is a parallel subprocess or a
multiple approvals step, then this variable
resolves as follows:

Parallel Subprocess Step Name
(Comma-separated list of sub-step
names)

l If the completed step was a sub-step of a
parallel subprocess or a multiple approvals
step, and the subprocess is still active,
then this variable resolves to text such as
"N/A - parallel subprocess step is not
complete".

l If the completed step was the last step in
the process, then this variable resolves to
text such as "N/A - the process is
complete".

Step
Completed,
Step Rejected

{NextStepOwner} The owner of the next step in the process.

l If the next step is a parallel subprocess or a
multiple approvals step, then this variable
resolves as a list of sub-steps and owners,
such as:

Sub-step 1 name - user name
Sub-step 2 name - user name

l If the completed step was a sub-step of a
parallel subprocess or a multiple approvals
step, and the subprocess is still active,
then this variable resolves to text such as
"N/A - parallel subprocess step is not
complete".

l If the completed step was the last step in
the process, then this variable resolves to
text such as "N/A - the process is
complete".

l If the owner is a role, then this variable
resolves as a comma-separated list of all
owners in the role.

Step
Completed,
Step Rejected
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Variable Description Notification
Types

{PreviousStepName} The name of the previously active step in the
process.
l This resolves to N/A for the first step in the

process when used in Step Activated
notifications.

l If the previous step was the last-completed
step of a parallel subprocess or a multiple
approvals step, then this variable resolves
as follows:

Parallel Subprocess Step Name
(Comma-separated list of sub-step
names)

Step Activated,
Step Reopened

{PreviousSubmitterComment} The comment made by the user who
completed the previously active step.
l This resolves to N/A for the first step in the

process. For other steps, it resolves to
blank if no comment was entered.

l If the previous step was a parallel
subprocess or a multiple approvals step,
then this variable resolves as a list of sub-
steps, submitters, and comments, such as:

Sub-step 1 name - user name -
comment
Sub-step 2 name - user name -
comment

Step Activated

{PreviousSubmitterName} The name of the user who completed the
previously active step.
l This resolves to N/A for the first step in the

process.
l If the previous step was a parallel

subprocess or a multiple approvals step,
then this variable resolves as a list of sub-
steps and submitters, such as:

Sub-step 1 name - user name
Sub-step 2 name - user name

Step Activated
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Variable Description Notification
Types

{ProcessName} The name of the process (display name if
defined, process name if not).

All notification
types

{RecipientFirstName} The first name of the notification recipient. All notification
types

{RecipientFullName} The full name of the notification recipient. All notification
types

{RejectingUserComment} The comment made by the user who rejected
the step (or in the case of On Demand Process
Aborted, the user who aborted the plan file in
the process).
This variable resolves to blank if no comment
was entered.

Step Reopened,
Step Rejected,
On Demand
Process
Aborted

{RejectingUserName} The name of the user who rejected the step
(or in the case of On Demand Process
Aborted, the user who aborted the plan file in
the process).

Step Reopened,
Step Rejected,
On Demand
Process
Aborted

{StepDueDate} The due date for the step. Step Activated,
Step Reopened,
Due Date
Reminder,
Overdue
Reminder

{TaskCount} The count of tasks covered by this
notification.

Step Activated,
Step Reopened,
Due Date
Reminder,
Overdue
Reminder

Other variables
The following variables can only be used in notifications for Report Process Steps.

Variable Description Notification
Types

{LinktoReport} Link to open the specified report for the step. Any notification
type
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Note the following when using the {LinkToReport} variable:
l If the report is form-enabled, then the hyperlink will open the file as a form or as a spreadsheet

depending on the step-level setting Open Form As. For email notifications, if the step is
configured to open the file as a form, then the form will be opened in theWeb Client (browser) in
all cases. For notifications delivered to the Notifications task pane, the option to open the form in
the browser or the desktop client will be honored.

l If the report is not form-enabled, the hyperlink opens the report as a spreadsheet in the user's
default desktop client.

l When the report is opened as a spreadsheet and the notification is sent via email, the hyperlink
uses the same format as hyperlinks generated using GetDocumentHyperlink, including the
differing URL format for systems using SAML or OpenID Authentication.

Customizing recipients for process notifications

When defining the notifications for a process definition, you can customize the recipients for each
notification. You can choose specific users and roles to receive notifications, and you can select defined
classes of recipients such as task owners and the process owner.

� Recipient types
The following recipient types are available for process notifications. Certain recipients are only available
for certain notification types.

Recipient Types Description

Task Owners The notification will be sent to the current task owners for the step.

This recipient type is not available for the Step Completed or Step Rejected
notification types, because once the step is completed it has no current owners.

User Select any named user defined within Axiom Cost Accounting security to send
the notification to that user. This recipient type is available for any notification.

Role Select any named role defined within Axiom Cost Accounting security to send
the notification to all users in that role.

Process Owner The notification will be sent to the process owner. This recipient type is available
for any notification.

Previous Step
Owners

The notification will be sent to the users who completed all previous steps in the
process. This recipient type is only available for the Step Completed and Step
Rejected notification types.

For more information, see Behavior of Previous Step Owners recipient type.

Generally speaking, the Task Owners recipient type is intended to be used when you want to inform a
user that they have a task to complete in the process, or to remind the user that they need to complete
the task. All other recipient types are intended to inform interested users about what is currently going
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on with the process. For example, a process owner may want to receive a notification as each step in the
process is completed, to help them keep tabs on the process. Similarly, theremay be a specific user or
role who is also interested in receiving this information, for the entire process or perhaps for a specific
step.

When using different types of recipients for the same notification type, in most cases you should define
multiple notifications with different text. The text for task owners should be action-oriented (such as
"You have a new task to complete for process Rollover"), whereas the text for interested parties is more
informational ("User jdoe completed step Import Actuals for process Rollover").

� Defining recipients for a notification
When you create or edit a notification at any level of the process, you can specify the recipients on the
Notification Configuration tab of the Edit Process Notification dialog. The Add Recipient list only
shows the recipients that are valid for the current notification type and process type.

Once the notification has been saved, you can see the list of recipients in the notifications grid:
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� Adding step-specific recipients to inherited notifications
When a step inherits a notification from the process level, you have the option of adding recipients for
that step only.

For example, imagine that you want to notify a specific user when a particular step completes. You can
always choose to create a custom notification for that step and send it to that user. However, if an
inherited Step Completed notification is already available to the step, then you can just add the user to
that notification.

To add the user to the inherited notification, select the step and go to the Step Notifications sub-tab.
Select the notification in the grid, then click Edit Recipients.

In the Edit Recipients dialog, you can see the default recipients defined for the inherited notification at
the top of the dialog. You cannot remove any of these recipients, but you can add a recipient for this
step only. In the following screenshot, the user Jane Doewill be included in the notification when this
step is completed.
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l To add a recipient, click Add Recipient and then select the type of recipient to add. Any recipient
types that are already included in the default recipients are not listed here.

l To remove an additional recipient, select the recipient and then click Delete.

Any recipients listed in the Additional Recipients section will receive the notification for this step only.

� Behavior of Previous Step Owners recipient type
The Previous Step Owners recipient type can be used to notify the previous owners of a process about
the status of subsequent process steps. For example, users who completed the previous steps of the
process may want to knowwhen a certain milestone step of the process is completed, or when the final
step of the process is completed. This notification type has some special behaviors depending on the
particular process configuration.

For purposes of determining the users who are considered "previous step owners," only the users who
completed previous steps qualify. Note the following:

l Assigned step owners who did not complete a step are not included as a recipient. For example, if
the owner of a step was a role with three users, only the user who actually completed the step will
receive the notification.

l If a previous step was completed by an administrator or the process owner (overriding step
ownership), then that completing user will receive the notification instead of the assigned step
owner.

l If a previous step was skipped or not completed (due to aMove current step operation), then
that step will not have a completing user to receive the notification.
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If a process definition contains a parallel subprocess (including multiple approvals), the previous step
owners are treated as follows:

l When a sub-step of the parallel subprocess is completed, the other sub-steps in the subprocess
are ignored for purposes of determining previous step owners. This is because the sub-steps of
the parallel subprocess do not have an order, so the concept of "previous" does not apply.
However, the previous step owners of steps completed before the subprocess will receive a
notification.

l When steps after the parallel subprocess are completed, the previous step owners of all sub-steps
of the parallel subprocess will receive a notification.

Setting up schedules for reminder notifications (standard processes)

When defining a Due Date Reminder or Overdue Reminder notification for a process definition, you must
set the schedule for these reminders.

Within the Edit Process Notification dialog, the schedule is defined on the Reminder Configuration tab.
This tab is only present for reminder notifications—all other notifications are triggered by step events
such as step activation or completion.

Example Reminder Configuration tab
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� Due Date Reminder schedules
To decide on the appropriate Due Date Reminder schedule, you should consider the following:

l Howmany days before the due date do you want the reminders to start? This will impact the start
of the schedule.

l Howmany reminders do you want to send / how frequently should the user be reminded? This
will impact the reminder frequency and the end of the schedule.

l Do you want to send a reminder on the due date itself?

If you want to send reminders prior to the due date and on the due date itself, keep in mind that you
may want to use different text for these notifications. For example, when sending reminders before the
due date, you probably want to include text such as: "This is a reminder that your task for Step 'Import
Data' is due in 3 days." If you use the same text on the due date, it will resolve as "due in 0 days"—which
is technically true, but not as clear as saying "this task is due today." You might also want to use stronger
wording in the notification on the due date itself. To do this, you can create two Due Date Reminder
notifications, one to be sent before the due date, and one to be sent only on the due date. Each
notification would have different text, and use a different reminder schedule.

To set the reminder schedule for a Due Date Reminder notification, complete the following settings on
the Reminder Configuration tab:

1. In the Reminder Schedule section, set the start date for the reminder by editing the setting Start _
_ day(s) before process step is due. Enter any number of days before the due date. By default,
this is set to 1 day before the due date.

For example, if the step is due on 1/10/2016 and you set the start date to 3 days before the due
date, then reminders will start on 1/7/2016.

You can specify 0 days as the start date if you only want to send a reminder on the due date itself.

2. In the Reminder Schedule section, set the stop date for the reminder by selecting one of the
following options:

l Until due date (default): Reminders will be sent from the start date until the due date
(including the due date itself).

l Until __ day(s) before process step is due: Reminders will be sent from the start date until
the number of days specified before the due date. By default this is set to 1 day before the
due date.

l Single notification only: The reminder will be sent once, on the start date.

3. In the Reminder Frequency section, select the frequency of the notifications:
l Every __ day(s) (default): The reminder notification will be sent according to the specified

day interval, from the start date to the end date. By default this is set to send a notification
every 1 day, meaning a notification will be sent each day. All days of the week are included
when choosing this option, including Saturday and Sunday.
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l Every weekday: A reminder notification will be sent each weekday (Monday-Friday), from
the start date to the end date. No notifications will be sent Saturday or Sunday.

NOTE: If Every weekday is selected and the configured schedule causes a notification to
fall on the weekend, that notification is simply not sent—it is not moved to the nearest
weekday. This means that some schedule configurations may not send any
notifications if the entire schedule happens to fall on the weekend. Specifically, you
should not select this option if you are only sending a single notification, in case that
single notification falls on the weekend.

4. In the Reminder Time section, select the time of day at which this reminder will be evaluated and
delivered. You can select any hour from 12:00 AM to 11:00 PM. By default, this is set to 5:00 PM.
See How reminder schedules work for more information.

The following table contains some example schedules and the resulting notifications. The frequency is
assumed as every 1 day in these examples.

Example Start Date Stop Date Resulting Notifications

Reminders before and on
the due date

3 days
before

Until due
date

4 - one each on the three days before
the due date, and one on the due
date

Reminders only before
the due date

3 days
before

Until 1 days
before step is
due

3 - one each on the three days before
the due date, none on the due date

Reminder only on the
due date

0 days
before

Single
notification

1 - one on the due date

The frequency impacts howmany of these notifications are ultimately sent. If the frequency is set to
every 2 days in the first example, then only 2 of the 4 eligible notifications will be sent. Similarly if the
frequency is set to weekdays only, then the number of notifications sent depends on howmany of those
days (if any) fall on a weekend.

� Overdue Reminder schedules
To decide on the appropriate Overdue Reminder schedule, you should consider the following:

l Howmany days after the due date do you want the reminders to start?
l Howmany reminders do you want to send / how frequently should the user be reminded?

Of course, at a certain point, if a task is persistently overdue then some other action should be taken.
Your organization may run reports that are intended to inform the process owner about tasks that are
overdue, so that they can take action accordingly. Another option in this case would be to create an
Overdue Reminder notification that goes to the process owner or to other designated users. For
example, your organization may have a rule that if a task is 3 days late, the situation should be escalated
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to the task owner's manager. You could have two Overdue Reminder notifications—one that goes to the
task owners when the task becomes overdue, and another that goes to the process owner when the
task is 3 days late.

To set the reminder schedule for an Overdue Reminder notification, complete the following settings on
the Reminder Configuration tab:

1. In the Reminder Schedule section, set the start date for the reminder by editing the setting Start _
_ day(s) after process step is due. Enter any number of days after the due date. By default, this is
set to 1 day after the due date.

For example, if the step is due on 1/10/2016 and you set the start date to 1 day after the due date,
then reminders will start on 1/11/2016.

2. In the Reminder Schedule section, set the stop date for the reminder by selecting one of the
following options:

l No end date (default): Reminders will be sent from the start date until the step is
completed.

l Until __ day(s) after process step is due: Reminders will be sent from the start date until
the number of days specified after the due date. By default this is set to 1 day after the due
date.

l Single notification only: The reminder will be sent once, on the start date.

3. In the Reminder Frequency section, select the frequency of the notifications:
l Every __ day(s) (default): The reminder notification will be sent according to the specified

day interval, from the start date to the end date. By default this is set to send a notification
every 1 day, meaning a notification will be sent each day. All days of the week are included
when choosing this option, including Saturday and Sunday.

l Every weekday: A reminder notification will be sent each weekday (Monday-Friday), from
the start date to the end date. No notifications will be sent Saturday or Sunday.

NOTE: If Every weekday is selected and the configured schedule causes a notification to
fall on the weekend, that notification is simply not sent—it is not moved to the nearest
weekday. This means that some schedules may not send any notifications if the entire
schedule falls on the weekend. Specifically, you should not select this option if you are
only sending a single notification, in case that single notification falls on the weekend.

4. In the Reminder Time section, select the time of day at which this reminder will be evaluated and
delivered. You can select any hour from 12:00 AM to 11:00 PM. By default, this is set to 5:00 PM.
See How reminder schedules work for more information.

� How reminder schedules work
Reminder notifications are evaluated once per hour using the system Scheduler job
System.ProcessNotifications.
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This job checks all active steps in all active processes to see if these steps have any configured reminder
notifications.

l If a step has reminder notifications, the job checks the due date of that step and the schedule of
those notifications to see if any are eligible to be sent.

l If the notification is eligible to be sent, and the configured reminder time of the notification falls
within the current hour in which the job is running, the notification will be sent.

Under normal circumstances, this setup results in only one reminder being sent per day, for each eligible
step / notification combination. However, a reminder notification could be sent multiple times in a day if
either of the following occurs:

l The reminder time is edited for an active process.
l The schedule for the system job is changed so that the job runs multiple times in an hour (or the

job is manually run again within an hour).

All times for this process are evaluated on the Axiom Application Server. When you select a time, you
select it based on your local time zone (shown next to the selected time for your reference). This selected
time is converted to Coordinated Universal Time (UTC) when it is saved to the server, so that the
reminders will be evaluated relative to your selected local time.

Reminder schedules are only evaluated while the step is active. If the step is completed, rejected, or
aborted, then no reminder notifications will be sent.

Notification properties for process definitions

The following properties can be set for each notification defined in a general process definition.

� Notification Configuration tab
This tab defines general properties for the notification.

Item Description

Display Name Optional. The name of the notification. This name is for use when configuring
notifications for the process; it is not displayed anywhere in the actual
notification to users.

If left blank, the notification type is used as the display name (such as "Step
Activated"). If you havemore than one of a particular notification type, you
should define a unique display name for each to avoid confusion.
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Item Description

Notification
Delivery

Specifies how the notification will be delivered to recipients.

By default, the option Use current process setting is enabled, which means that
the notification will be delivered according to the process-level delivery settings
on theNotifications tab. If you want to override the process-level settings for
this particular notification, then select Use notification-specific setting instead.

IfUse notification-specific setting is enabled, then select one of the following:
l Notification task pane: Display the notification in the recipient's

Notifications task pane.
l Email notification (default): Send the notification by email, using the

recipient's email address as defined in Axiom Security.
l Both notifications: Send the notification by email and display it in the

Notifications task pane.

Notification
Urgency

Specifies the urgency of the notification. Select one of the following:
l Normal Importance: The notification will not be called out as having any

particular importance.
l High Importance: The notification will be flagged as important. In the

Notifications task pane, the notification will display with an exclamation
point. For email notifications, the display depends on the recipient's email
client configuration.

Default
Enablement

Specifies whether the notification will be enabled by default in newly added
process steps that are eligible to inherit the notification. Select one of the
following:
l Enabled by default (default): The notification will be enabled by default in

newly added process steps.
l Disabled by default: The notification will be disabled by default in newly

added process steps.

This setting is only present when defining default notifications for the process. It
does not display for step-specific custom notifications.

This setting does not impact whether a notification will be enabled in existing
steps. When you create a new default notification, you will be prompted to
choose whether you want the new notification enabled in existing steps.

Notification
Recipients

The recipients of the notification. If recipients have already been selected, they
will display in the Notification Recipients box.
l To add recipients, click Add Recipient and then click the type of recipient to

add.
l To delete a recipient, select the recipient in the Notification Recipients box

and then click Delete.
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� Notification Message tab
This tab defines themessage for the notification. All message sections for the notification must have
some content in order to be valid. For more information, see Customizing notification content for
general process definitions.

Item Description

Notification
Subject

Defines the subject line for the notification.

Notification
Message Body

Defines themessage body for the notifications. This text should contain all
necessary task details for the notification.

� Reminder Configuration tab
This tab defines the reminder schedule for the "reminder" notifications. This tab only applies to the
following notification types: Due Date Reminder and Overdue Reminder. For more information, see
Setting up schedules for reminder notifications (standard processes).

Item Description

Reminder
Schedule

Specifies when reminder notifications will start, and how long they will continue.

To specify when reminder notifications will start (the start date):
l For due date reminders, enter the number of days before the due date that

you want reminders to start. By default, reminders start 1 day before the
step is due.

l For overdue reminders, enter the number of days after the due date that
you want reminders to start. By default, reminders start 1 day after the step
is due.

To specify how long reminder notifications will continue (the stop date), select
one of the following:
l Until due date / No end date (default): For Due Date Reminders,

notifications will continue until the due date is reached. For Overdue
Reminders, notifications will continue until the step is completed.

l Until __ day(s) before / after process step is due: Notifications will
continue until the specified number of days before the step is due (for Due
Date Reminders) or after the step is due (for Overdue Reminders). By default
this is set to 1 day.

l Single notification only: The notification will only be sent once, on the
specified start date.
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Item Description

Reminder
Frequency

Specifies the frequency of reminder notifications between the start date and the
stop date. Select one of the following:
l Every X days: A reminder notification will be sent according to the specified

day interval. By default this is set to send a notification every 1 day, meaning
a notification will be sent each day. All days of the week are included when
choosing this option, including Saturday and Sunday.

l Every weekday: A reminder notification will be sent each weekday (Monday-
Friday). No notifications will be sent Saturday or Sunday.

This option does not apply if the notification is set to Single notification only.

Reminder Time Specifies the time of day when reminders will be evaluated and delivered. Select
any hour from 12:00AM to 11:00PM. By default, this is set to 5:00 PM.

Managing Active Processes
Once process definitions have been created, administrators and process owners can perform tasks such
as starting or stopping a process, viewing overall process status and process history, and managing step
status.

Management tasks can be performed from the following locations:
l On the Axiom tab, in the Administration group, go toManage > Process Management > Current

Processes.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
theWorkflow group, click Process Management > Current Processes.

l From the Process task pane, click View status. This is only available for active processes.

You can also start processes and access process details from within the process definition itself.

Starting or stopping a process

A process is only managed by the system if it has been started. Once a process is started, it will remain
active until it is completed or stopped.

NOTE: Only administrators or process owners can start or stop a process.
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� Starting a process
Once you have completed a process definition and you are ready to work on the process, you can start
it. When you start a process, Axiom Cost Accounting does the following:

l Creates a unique process instance to track the process steps and store the process details. Each
activation of a particular process definition is stored separately, so that you can always see the
historical details.

l Activates the first step in the process and creates one or more tasks as appropriate.

l Displays the activated process in the Process task pane. Administrators can see every activated
process; other users will only see the process if they are the process owner or if they have a task
for the currently active step.

To start a process:
1. On the Axiom tab, in the Administration group, clickManage > Process Management > Process

Definitions.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
theWorkflow group, click Process Management > Process Definitions.

This opens the Axiom Explorer dialog, showing the Process Definition Library (and any file group
Process Definitions folders that you have access to). You can also access these definitions from the
Explorer task pane.

2. Open the process definition that you want to start, and then click Start Process in the top right-
hand corner of the dialog.

NOTE: The process definition cannot be started if it contains any missing or invalid settings.
These validation errors will display at the bottom of the dialog if present. You can click the link
to be taken to the tab or step that contains the error. Once all errors are resolved, you will be
able to start the process.

3. At the confirmation prompt, click OK.

The process is now active. Once a process has been started, you can track its progress using the Process
Manager or by clicking the View status link in the Process task pane. For more information, see Viewing
process status and comments.

You can also start processes from the Process Manager dialog. On the Axiom tab, clickManage >
Process Management > Current Processes. In the Process Manager dialog, select Show inactive
processes. Select the process that you want to start, then click Start.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In the
Workflow group, click Process Management > Current Processes.
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� Stopping a process
When you stop a process, all current tasks are deleted and the process status changes from Active to
Aborted. If the process definition is started again later, a new process instance will be created and the
process will start over from the first step. There is no way to restart a particular process instance at the
step it was on when it was stopped.

To stop a process:
1. On the Axiom tab, in the Administration group, go toManage > Process Management >

Current Processes.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
theWorkflow group, click Process Management > Current Processes.

2. In the Process Manager dialog, select the process that you want to stop, and then click Stop.

3. At the confirmation prompt, click OK.

You can also stop processes using the Process Status dialog. From the Process task pane (or a custom
task pane configured to show the process control), click View status. In the Process Status dialog, click
Stop process.

� Completing a process
General processes are automatically completed when all steps in the process are complete. Once a
particular process instance is completed, that same instance cannot be restarted. If the process
definition is started again, a new process instance will be created and the process will start over from the
first step.

Axiom Cost Accounting saves the process details for each activated instance of a process. Administrators
and process owners can always go back and view the available history. For more information on viewing
process history, see Viewing process history.

� Scheduling a process
You can use the Scheduler task Start Process to automatically start a process at a specific point in time.
The schedule can be one-time, or recurring.

If the process is already active when the Scheduler job executes, you can decide what to do with the
current process. You can leave the current process running, or you can stop the current process and
then start a new process.

If you use a recurring schedule to start the process, then the process steps should use relative due dates
so that the due dates will adjust dynamically for each execution. If the due dates are specific calendar
dates, then you must remember to edit the process definition before each scheduled execution for the
new calendar dates.
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Modifying active processes

If a process is not active, you can edit its definition as desired. When a process is active, then certain edits
are not allowed, and other edits have no effect on the active process.

To edit a process definition:
1. On the Axiom tab, in the Administration group, go toManage > Process Management > Process

Definitions.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
theWorkflow group, click Process Management > Process Definitions.

The Axiom Explorer dialog opens, filtered to only show the Process Definition Library.

2. Double-click the process definition that you want to edit.

3. In the Edit Process dialog, make any allowed edits as needed.

If the process is currently active, a warning message displays at the top of the Process Properties
tab.

4. Click Apply to save (orOK if you are finished making edits).

� Disallowed edits for active processes
The following edits cannot bemade to the process definition of an active process, because they would
invalidate the currently active step or the process history:

l Making any edits to the properties of a completed step
l Moving the currently active step to another level
l Deleting the active step

� Editing considerations
All properties of the currently active step can be edited. Note the following:

l If you change the step name, description, or action of the active step, and the current step owner
currently has the Process task pane open, they will need to refresh it in order to see these
changes.

l If you change the step owner or due date of the active step, this will cause the task for the step to
be regenerated with the new information, including sending a new Step Activated notification to
the step owner (if applicable).

l If you add a step to an active parallel subprocess or multiple approvals step, the new step will be
automatically activated in the process when you save the change to the process definition.
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For themost part, any new, deleted, or moved steps should be after the currently active step, so that
they will still be part of the step progression. However, it is possible to add new steps to any point of the
process, delete any steps other than the currently active step, and move any steps (except as noted in
the previous section). You should carefully consider the effect any of these types of changes will have on
the active process beforemaking them. For example:

l If you add a step before the currently active step, then that step will not be part of the progression
unless you move the process back to that step, or unless it is possible for the process to be
rejected back to that step.

l If you move the currently active step to an earlier point in the process, this may result in re-
activating already completed steps as the process moves forward from the currently active step. If
you move the currently active step to a later point in the process, this may result in some steps
never being started.

l If you delete a completed step, that step will no longer display in the process definition or in the
Process Status dialog for the current instance. The only way to view the details of that step would
be to query the Axiom.ProcessEvents table, which would still contain the events for the step
activation and completion.

Viewing process status and comments

Administrators can view the status of all processes at any time. They can view a summary of process
status, and they can view details for each individual process. Any comments added by users when
completing steps are also displayed in these details.

Designated process owners can also view the status of processes that they own.

� Process status summary
The Process Manager dialog shows key information for processes at a glance, such as the current state of
the process and the current step of the process. To access this dialog:

l On the Axiom tab, in the Administration group, clickManage > Process Management > Current
Processes.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
theWorkflow group, click Process Management > Current Processes.

By default, the Process Manager dialog shows active processes only. You can click Show inactive
processes to see all processes. The details displayed are for themost recent instance of the process (the
"current" process).
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Example summary of active processes

From here you can perform actions such as viewing the process details, editing the process definition,
and starting and stopping the process. You can also view process history.

For administrators, this dialog shows all processes. For process owners, the dialog only shows processes
that the user owns.

� Viewing individual process details
To view the details of a specific process from the Process Manager dialog, select the process in the list
and click View Details. Alternatively, administrators and process owners can view the details of an active
process by clicking the View status link in the Process task pane (or in the process definition).

In the Process Status dialog, you can view all of the information about the process, including:
l Status of each individual step, whether it is completed, active, or not yet started
l Properties of each individual step, including step type, assigned owner, due date, and any

associated file or feature
l Details of all step activity, such as when it was made active, when it was completed (and by

whom), and any comments associated with the activity
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Example process details

You can also perform administrative activities for the process from this dialog, such as stopping the
process, performing step actions, completing steps (overriding step ownership), and reactivating stalled
steps.

Moving processes to different steps

Administrators and process owners can move an active process to a different step. There are two
different options for moving a process to a different step. These options are intended to be used for
different circumstances as follows:

l Complete step should be used when you need to override step ownership, but the step should be
completed as normal and the process should move on to the next step. For example, the step
owner may have forgotten to complete the step before leaving for vacation, so they have asked
an administrator to complete it for them.

l Move current step should be used when you need to make administrative adjustments to the
process. When moving a step, the current task is aborted instead of completed, and the target
step is activated. Any steps in between the aborted step and the target step are simply not
started.

These actions can be performed in the Process Status dialog. To open this dialog, click View status for
the process in the Process task pane (or in a custom task pane configured to show the process control).
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The process definition also contains a View status details link to open the Process Status dialog, when
the process is active.

� Completing a step (overriding step ownership)
As necessary, you can override step ownership and mark the active step as completed. The process
history will track both the original ownership assignment and the user who actually completed the step.

For example, imagine that the assigned user for a step performed the necessary task, but forgot to mark
the step as complete before leaving on vacation. In this case, an administrator can mark the step as
complete so that the process can continue.

To do this in the Process Status dialog, select the step that you want to complete, then click Complete
step. If the step is an approval step, then you can click Approve step or Reject step as appropriate.

This opens the same Process Action dialog that you see when completing a step from the Process task
pane, where you can define a comment if desired. When you click OK, the step will be completed just as
if the owner had completed it (including any resulting notifications), except that you will be recorded as
the completing user instead of the owner.
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� Moving to a different step
As necessary, you can move a process from the currently active step to a different step. The ability to
move the current step depends on which step is currently active and whether it is a top-level step or part
of a subprocess:

l If the currently active step is a top-level step, then the process can bemoved to any other top-
level step. If the process is a plan file process definition, then any or all plan files can bemoved to
any other top-level step.

l If the currently active step is a sub-step in a parallel subprocess (including sub-steps of a multiple
approvals step), then you can select the parent subprocess step and choose to move the process
to any other step at the same level. In this case, all subprocess steps are aborted and the process
is moved to the selected step.

To move a step in the Process Status dialog:
1. Select a currently active step (or its parent step) and then clickMove current step.

2. In theMove Current Step dialog, select the step that you want to move to. The dialog only
displays eligible steps as described previously in this section.

3. By default, notifications are not sent to new step owners when moving the current step. If you
want to send notifications as part of themove, then select Send notifications to users affected
by this current step change. If this check box is selected, then you can also optionally enter a
comment to be included in the notification and stored with the process.

If enabled, the notification sent when a step is moved will always be the Step Activated notification
for the target step. Because the currently active step is aborted instead of completed, no Step
Completed notifications will be sent.

4. Click OK to move the step.

The current step is aborted, and the target step is made active.

Fixing common process issues

While a process is active, administrators and process owners may need to address common process
issues such as:

l Regenerating tasks for a stalled step
l Regenerating tasks to reflect changes in the process assignments or security
l Restarting a Scheduler Process Step

These actions can be performed in the Process Status dialog. To open this dialog, click View status for
the process in the Process task pane (or in a custom task pane configured to show the process control).
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The process definition also contains a View status details link to open the Process Status dialog, when
the process is active.

� Regenerating tasks for a stalled step
If an issue occurs that prevents a step from becoming active, the step will stall in the process, and the
process cannot continue.

For example, imagine that the assigned user for step 2 of a process has been disabled or deleted in
security. When step 1 is completed, step 2 cannot bemade active because the assigned user is not
eligible or the user record does not exist. Step 2 then becomes stalled, which causes the overall process
to become stalled.

In this example, if the user was disabled in the system accidentally, you could edit Security to re-enable
the user, and then regenerate the tasks for the step. To do this in the Process Status dialog, select the
stalled step and then click the link in the error message.

Axiom Cost Accounting will attempt to reactivate the step, which causes any associated tasks to be
regenerated. If the task generation is successful, the step will bemade active and the process can
continue as normal.
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NOTE: If instead the step needs a different owner, then you can edit the process definition to assign
a different user. When you save the change to the process definition, the task for that step will
automatically be regenerated for the new owner, and the error state will be removed.

� Regenerating tasks to reflect process or security changes
In certain cases, you may need to regenerate tasks for an active step in order to incorporate changes
made to the process assignments or to security. For example:

l If the owner assignment is an assignment column or an assignment workbook, and the
assignments in the column or workbook have been changed since the step became active.

l If the owner assignment is a role, and themembers of the role have changed since the step
became active.

l If security permission changes have been made that would affect the ownership of the active step.

NOTE: It is not necessary to manually regenerate tasks if you change the assignment type for a step
(for example, from user to assignment column), or change the specifically assigned user or role. In
these cases, the tasks are regenerated automatically when you save the change to the process
definition. In the examples listed above, the process is not aware of the changes made outside of the
process definition, so the process does not know to automatically regenerate the tasks.

To regenerate tasks for a step in the Process Status dialog, select the step and then click Regenerate
tasks.

Amessage box informs you that all current tasks for the step will be deleted and new tasks will be
created. Click OK to continue.

� Restarting Scheduler jobs after errors
If a Scheduler Process Step experiences an error when attempting to run a Scheduler job, then you have
the option to restart the job. You should restart the job if the error was the result of a temporary
condition that no longer applies, or if the underlying condition that caused the error has since been
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addressed and you no longer expect the job to experience any errors. If you are not certain why the job
experienced errors, you can click the View job results link to investigate the issue before restarting the
job.

To restart the job from the Process Status dialog, select the stalled Scheduler step, and then click the link
in the error message. This will remove the error state and place the job in the Scheduler queue again.

Alternatively, you can choose to manually mark the step as complete if the job does not need to be run
again. For example, the job results may have been Partial Success and in this case that may be enough to
consider the step complete. Or, you may havemanually run the job or run the associated activity while
troubleshooting the error, and therefore the job does not need to be run again.

Unlike other error conditions for active processes, the administrator or process owner is not required to
intervene. The step owner also has access to these options within the Process task pane when a
Scheduler job experiences errors, and thereforemay be able to address the issue without requiring
assistance.
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Viewing process history
Each time a process is started, a new process instance is created to track the details of that particular
execution of the process. This ensures that you always have a history of each time the process is
performed, including who completed each step in the process and when. You can retain this history as
long as needed.

Administrators and process owners can view the history for a process. Administrators can view history
for all processes, whereas process owners can only view history for processes they own.
To view the history for a process:

1. On the Axiom tab, in the Administration group, clickManage > Process Management > Current
Processes.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
theWorkflow group, click Process Management > Current Processes.

2. In the Process Manager dialog, select the process for which you want to view the history. If
necessary, select Show inactive processes to display all processes.

When you select a process in the top of the dialog, the bottom of the dialog populates to show
the historical instances for that process.

3. In the Process History section, select the process instance for which you want to view the history,
and then click View Details.

Make sure to click the ViewDetails button that is directly over the Process History section, not the
button that is above the Current Processes section.
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The Process Status dialog opens, displaying the details for the historical instance of that process. In
addition to reviewing the details, you can perform the following actions from this dialog:

l View process definition: Opens a read-only copy of the process definition as it existed at the time
of this historical instance. If desired you can use Save As to "restore" this historical definition as a
new definition.

l Start process: Starts a new instance of the process, using the current process definition. This
option is only available if there is not already an active instance of the process.

If there is already an active instance of the process, a message will display at the top of the dialog
to inform you of this. You can click the link in this message to be taken to the currently active
instance.

� Deleting process history
If you do not need the history of a particular process instance anymore, you can select that instance in
the Process History section and then click Delete . Process history is retained until it is manually
deleted (it does not get automatically purged by the Purge System Data Scheduler job).

If the process definition is deleted, all history for that process is also automatically deleted.

Scheduler Overview
Using Scheduler, you can schedule certain Axiom Cost Accounting tasks to be processed on a Scheduler
server at a specific date and time. For example, you can schedule plan file processing or data imports.

Processing tasks using Scheduler has advantages over manual processing, such as:
l Leverages the server's processing power and frees up your computer's resources.
l Enables recurring scheduling of ongoing tasks.
l Allows tasks to be scheduled during "off hours," during periods of low network and system

activity.
l Allows tasks to be performed in batch, including enforcing task dependencies.

Scheduler processes tasks using jobs. Each job is a scheduled unit that can contain one or more tasks.
The tasks in a job can be processed sequentially or concurrently as appropriate.

Only system administrators and users with the Scheduled Jobs User security permission can access
Scheduler.

About Scheduler
This section contains conceptual information about the Scheduler feature in Axiom Cost Accounting.
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� Scheduler jobs and tasks
The primary unit of Scheduler processing is a job. Each Scheduler job can contain one or more tasks to
be performed as part of that job.

Each Scheduler job defines the following basic properties:
l The tasks to perform for the job and the properties of those tasks
l The schedule of the job, including recurrence (if any)
l The priority of the job
l The notification options for the job

The tasks define the actual activities to be performed by the job, such as importing data or processing
plan files. Some Scheduler tasks correspond to existing features that can also be processed manually
(such as Process Plan Files), while other tasks are Scheduler-specific and can only be processed via
Scheduler. Each task has a unique set of options that are specific to that task and to the activity to be
performed. For more information on the available task types, see Scheduler Task Reference.

The tasks in a job can be processed sequentially or concurrently as appropriate. Tasks can be dependent
on other tasks in the job as needed—for example, you can configure a job so that if a task fails, the job
stops and does not process the next task. Tasks can also be processed iteratively, to perform the same
task repeatedly over a defined set of values.

The Scheduler jobs in your system fall into the following basic categories:
l Client-created: You can create Scheduler jobs as needed to perform tasks in your system.
l System jobs: Axiom Cost Accounting provides a set of system jobs to perform necessary system

tasks.
l Product-controlled: When a product is installed, it may include one or more Scheduler jobs to

support the use of that product. Generally speaking, these jobs should not be changed unless the
product documentation says customization is allowed, or as advised by Kaufman Hall Software
Support.

� How Scheduler jobs are run
Once a Scheduler job has been created, it can be run using any of the following options:

l The job can be scheduled for execution at a future date and time using a scheduling rule.
Scheduling rules can be one-time only, or recurring.

l The job can be run "one time" manually as needed through Scheduler.
l The job can be triggered for execution using an event handler. This allows Scheduler jobs to be

triggered in various ways, such as by clicking a button in an Axiom form.

Scheduler jobs are processed by one or more servers running the Scheduler service. For Cloud Service
systems, the Scheduler service is part of your cloud system and managed by Kaufman Hall Software
Support. For on-premise systems, the Scheduler service is installed on one or more servers in your
environment. The Scheduler service polls the Axiom Application Server periodically to check for any jobs
that are ready to be run. Eligible jobs are then executed on the server, based on their processing priority.
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When a job is executed by Scheduler, it is run using a particular user identity. In order for a job to be
executed successfully, the user must be an active user defined in Axiom Cost Accounting security, and
the user must have the appropriate security permissions to perform the tasks in the job. The user
identity for a job is determined as follows:

l If a job is a system job, then it is run as the system-managed identity of System instead of a user
identity.

l If a job is run by using Run Now, then it is run as the user who placed the job on the schedule.
l If a job is run by an active scheduling rule, then it is run as the job owner. The job owner is the

user who last saved the job.
l If a job is run via an event handler, then the job may be run as either the job owner, or the job

requester (the user who raised the event).

� System jobs
System jobs are automatically created by Axiom Cost Accounting to support necessary system
functionality. Some system jobs are created as part of the initial installation and are intended to run on
an ongoing basis, while other system jobs are created on-demand in response to system events. Only
administrators can edit these system jobs.

System jobs have two defining characteristics:
l System jobs are run using the system-managed identity of System instead of a user identity. The

System identity has full rights to the system as necessary to perform system tasks.

l System jobs are run by the default System Scheduler service. For on-premise systems, this service
is created and started automatically on the Axiom Application Server, and does not require a
separate installation. This service is exclusively for running system jobs.

Cloud Service systems may or may not have a separate System Scheduler service, depending on
the system configuration (as determined by Kaufman Hall Software Support). If your cloud system
does not have a System Scheduler service, then your system jobs are run using the available
Scheduler services for the cloud system.

In the Scheduler dialog (Desktop Client), the System Scheduler service is listed on the Servers tab
using the following naming convention: <ServerName>-System.

If necessary, a product-controlled or client-created job can be flagged as a system job, so that it can be
run using the System identity instead of a user identity. To designate a job as a system job, enableMark
as System Job in theGeneral job properties. The following rules apply to manually-created system jobs:

l Only system administrators can designate a job as a system job.
l The job cannot contain any tasks that are designated as “non-system” tasks. Non-system tasks

are any tasks that might involve spreadsheet processing, such as Process Plan Files.
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� Processing priority for scheduled jobs
Once a job reaches its start time, it is eligible to be processed by Scheduler and joins the processing
queue. For scheduled jobs, the start time is based on the scheduling rule that placed it on the schedule.
For other jobs, the start time is the time that the job was placed on the schedule using Run Once or
triggered by an event handler.

Each Scheduler service has a configured number of threads that are used to process jobs. As a Scheduler
thread becomes available, it takes the next job in the processing queue. The priority of jobs in the
processing queue is determined by the combination of the job's priority category, and its Priority
Elevation setting.

Each job has a priority category, based on how the job execution was initiated. The priority categories
are as follows:

1. Manual: The job was executed manually.

2. Event Handler: The job was executed by a Scheduler event handler.

3. Scheduled Job: The scheduled instance of the job results from an active scheduling rule.

4. Subordinate Job: The job was generated as a subordinate job, from a currently executing job.

Manual jobs are highest priority and are processed first, and subordinate jobs are lowest priority and are
processed last. Within each category, jobs are processed according to their Priority Elevation setting.

For example, imagine that Scheduler has 2 available threads and the following jobs are eligible to be
processed:

Job Priority Category Priority Elevation

A Manual Default

B Event Handler Default

C Scheduled Default

D Scheduled Elevated

l Scheduler will execute jobs A and B first, because those are the highest priority jobs based on their
priority category.

l When the next thread becomes available, Scheduler will execute job D. Although job C may have
entered the queue first, and the two jobs have the same priority category, job D's priority
elevation is set to Elevated so it takes precedence within the category. If instead both jobs were
set to Default, then job C would be executed first if it entered the queue before job D.

l When the next thread becomes available, Scheduler will execute job C.
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NOTE: If a job's Priority Elevation is set to Interrupt, then it is run as soon as it is eligible, regardless
of its priority category and regardless of whether any Scheduler threads are currently available to
process the job. If no Scheduler threads are available, a new one is created to process the job, even if
this temporarily exceeds the number of configured threads for the server.

The Scheduler dialog
The Scheduler dialog is used to create and manage Scheduler jobs.

To access Scheduler:
l On the Axiom tab, in the Administration group, clickManage > Scheduler.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click Scheduler.

The top section of the Scheduler dialog contains a ribbon-style toolbar with two tabs: Job and Service.
l On the Job tab, you can create, run, and edit jobs.
l On the Service tab, you can manage scheduled jobs and view job results.

As you perform actions on the Job and Service tabs, additional tabs are opened in the navigation pane of
the dialog. For example, clicking the Scheduled Jobs button on the Service tab opens the Scheduled
Jobs tab in the navigation pane. You can move between any open tab in the navigation pane, regardless
of which tab is selected in the ribbon. The ribbon updates to show the related commands for the
selected item.
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Example Job tab

Example Service tab

When you right-click a tab in the dialog's navigation pane, you can close or save items as follows:
l For all items, you can Close, Close All, or Close All But This.
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l For jobs, you can Save or Save As. Selecting Save As allows you to save a copy of the job to the
Scheduler Jobs Library in the Axiom Cost Accounting file system.

The Scheduler Jobs Library is also accessible via Axiom Explorer.

Scheduler Job Setup
To perform Axiom Cost Accounting tasks using Scheduler, you must create jobs. Each job can execute
one or more tasks. This section discusses how to set up jobs, including how to schedule jobs for future
execution and how to be notified when a job has been completed.

Managing Scheduler jobs and tasks

Using the Axiom Scheduler dialog, administrators can create and edit Scheduler jobs. To access this
dialog:

l On the Axiom tab, in the Administration group, clickManage > Scheduler.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click Scheduler.

This section discusses how to create, edit, and delete jobs and tasks, not how to manage the Scheduler
queue once jobs have been placed on the schedule. If you need to stop or reschedule a scheduled job,
seeManaging scheduled jobs.

Scheduler jobs are saved as XML files and are stored in the Axiom Cost Accounting file system at
\Axiom\Scheduler Jobs Library.

� Creating a Scheduler job
You can create a new Scheduler job to perform one or more tasks.

To create a new job:
1. In the Scheduler dialog, on the Job tab, click New.

A new tab appears in the navigation pane, labeled New Job. The left-hand side of the job lists
sections for which you can define various job settings. When you click a section name, the settings
for that section display in the right-hand side of the job.

2. In theGeneral section, define general job settings as desired.

For detailed information on the available settings for a job, see Job properties.

3. In the Scheduling Rules section, specify scheduling details for the job.

You can schedule the job for future execution, for one time or on a recurring basis.
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NOTE: If you are always going to run the job manually, and do not need to schedule it for
future execution, then you do not need to define scheduling rules.

For more information, see Defining scheduling rules for a job.

4. In theNotification section, specify email notification options for the job.

You can send email notifications every time the job completes, or only when the job experiences
errors. By default, the job is configured to notify on completion.

For more information, see Setting up email notification for jobs.

5. In the Tasks section, add one or more tasks to the job.

a. On the Job tab of the ribbon, in the Tasks group, click Add. This brings up a list of available
tasks. Select the task that you want to add.

The task is added to the Tasks section, and the settings for the task display in the right-
hand side of the job.

b. Complete the settings for the task as desired.

The Task Control section of the task contains standard task settings, and the Task Details
section contains settings unique to the task type. For more information, see Task Control
properties.

If a required setting is not completed, the setting is highlighted in red and error text
appears in the bottom of the dialog. Make sure to complete all required settings for the
task before saving.

Repeat this process until you have added all desired tasks to the job. Tasks are processed in the
order listed. If you need to change task order, select a task and then clickMove Up orMove
Down.

6. In the Job tab of the ribbon, click Save.

7. At the bottom of the Save As dialog, in the File name box, type a name for the job, and then click
OK.

The job is saved as an XML file in the Scheduler Jobs Library.

If the job was saved with an active scheduling rule, Axiom Cost Accounting determines the next
scheduled date of execution and schedules the job. You can view the job in the Scheduled Jobs list (on
the Service tab of the ribbon, click Scheduled Jobs).
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Advanced job settings
This procedure covers the basic steps of creating a job. Jobs also support the following advanced
options:

l Event handlers: You can create event handlers for the purposes of running the job using the
RunEvent function. This allows users to trigger job execution from within an Axiom file.

l Job variables: You can create job variables and then use those variables within certain job
settings. You can then dynamically pass in values for those variables when using the RunEvent
function to execute the job.

For more information, see Advanced options, Using job variables, and Using RunEvent to execute a
Scheduler job.

� Editing a job
You can edit a job at any time to change job settings, add or remove tasks, change scheduling rules, or
change notification options.

This section describes the general process of opening a job for editing. For more details on the impacts of
editing scheduling rules, see Defining scheduling rules for a job.

To edit a job:
1. In the Scheduler dialog, in the Job tab, click Open.

The Axiom Explorer dialog opens, showing the Scheduler Jobs Library only.

2. Select the job and then click Open.

The job opens in the Scheduler dialog. Make sure the job is the active tab in the navigation pane
(themost recently opened tab is the active tab by default).

3. Edit the job and task properties as desired.

For detailed information on the available settings for a job, see Job properties. For detailed
information on task settings, see Task Control properties.

4. In the Job tab of the ribbon, click Save.

� Deleting a job
Deleting a job removes any scheduled executions of the job from the scheduled jobs list.

To delete a job:
1. In the Scheduler dialog, in the Job tab, click Open.

The Axiom Explorer dialog opens, showing the Scheduler Jobs Library only.

2. Navigate to the job that you want to delete, then right-click the job and select Delete.

You can also delete Scheduler jobs from Axiom Explorer or the Explorer task pane.
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Defining scheduling rules for a job

Once a job has been created, you can run it on demand, or you can schedule it for future execution. Jobs
can be scheduled to be run one time, or on a recurring basis. To schedule a job, you define scheduling
rules for the job.

You can add, edit, and remove the scheduling rules for a job at any time using the Scheduling Rules
section of the job properties. You can also flag a rule as active or inactive. If a job has no scheduling rules,
or if all of its scheduling rules are inactive, then it will not be run unless it is run manually by a user.

If a job is saved with an active scheduling rule, then Axiom Cost Accounting determines the next
scheduled instance of the job and places it in the scheduled jobs list. Once that instance has been
processed, the next scheduled instance is determined and scheduled, and so on. Each time the job is run
using an active scheduling rule, it is run as the current job owner (unless the job is a system job, in which
case it is run as the Scheduler Service System identity).

If a job has multiple active scheduling rules, Axiom Cost Accounting evaluates all of the rules and
schedules a single instance of the job, for the earliest time allowed by the rules. Multiple scheduling rules
do not result in multiple scheduled instances of the job.

NOTE: If a time zone is listed on the Scheduling Rules section of the job, then the defined rules will be
evaluated in the context of that listed time zone. Otherwise, scheduling rules are evaluated in the
context of the local time zone for the Scheduler Server. If necessary, the system configuration setting
SchedulingBehaviorTimezone can be used to specify a particular time zone for evaluating scheduling
rules.

� Adding a Scheduling rule
You can add a scheduling rule to a job to schedule it for future execution, either one time or on a
recurring basis.

If you only plan to run the job manually on demand, then you do not need to create a scheduling rule.

To add a scheduling rule to a job:
1. In the Scheduler dialog, open a job to edit or create a new job.

2. In the left-hand side of the job, select Scheduling Rules.

By default, this area is empty. You must add a rule in order to define scheduling for the job.

3. On the Job tab of the Scheduler ribbon, in the Scheduling Rules section, click Add.

A new row appears in the right-hand side of the job. By default, the new row is active, but does
not have start / end dates or any specific recurrence settings.

4. Complete the following settings within the row as needed:
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Item Description

Active If you want the job to be placed on the schedule as soon as you save the
job with the new scheduling rule, then you should leave this option
checked.

However, if you just want to save your schedule settings but you are not
ready to begin scheduling the job, then you can clear the Active check box
for the rule. The job will not be scheduled until it is saved with an active
scheduling rule.

Starting On

Ending On

Optional. These dates specify the time frame for the scheduling rule. The
starting date defines the earliest point in time that the job can be
scheduled, and the ending date defines the latest point in time that the
job can be scheduled.

If these dates are not defined (left blank), then the job will be perpetually
scheduled according to the rule settings, as long as the rule is active.

If you want to schedule a one-time job, then set the starting / ending
dates to the same date and time.

NOTE: Your system locale determines the format of dates.

Day ofWeek Specify the day(s) of the week that you want the job to be run:
l * (Default): The job will be run on all days within the start / end range.
l 0-6: The job will be run on the specified day or days, where 0 is Sunday

and 6 is Saturday. Use a comma or a hyphen to separatemultiple days
(hyphen if the days are contiguous, commas if not).

For example, you can enter 1,3,5 for Monday, Wednesday, and Friday,
or enter 1-5 for Monday through Friday.

Hours Specify the time of day (hours) that you want the job to be run, in relation
to the specified days:
l * (Default): The job will be run on all hours.
l 0-23: The job will be run on the specified hour or hours, where 0 is

midnight and 23 is 11:00 PM. Use a comma or a hyphen to separate
multiple hours (hyphen if the hours are contiguous, commas if not).

For example, you can enter 0,12 to run at midnight and noon, or enter 0-
12 to run every hour from midnight to noon.
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Item Description

Minutes Specify the time of day (minutes) that you want the job to be run, in
relation to the specified hours:
l * (Default): The job will be run on all minutes (essentially the job is run

continuously, once per minute).
l 0-59: The job will be run on the specified minute or minutes of the

hour, where 0 is the first minute of the hour and 59 is the last minute of
the hour. Use a comma or a hyphen to separatemultiple minutes
(hyphen if the hours are contiguous, commas if not).

For example, you can enter 0,30 to run at the top of the hour and the half
hour, or enter 0-30 to run every minute from the top of the hour to the
half hour.

NOTE: If you specify an hour, then in most cases you should also specify a
minute (such as 0 to run the job at the top of the specified hour). If you
enter an hour but leave theminutes at the default asterisk, then the job
will run every minute in that hour.

If the Active check box for the rule is selected when the job is saved, then Axiom Cost Accounting will
calculate the date and time of the first scheduled execution and will place the job on the schedule.

� Editing a scheduling rule
You can edit a scheduling rule at any time, to toggle between active and inactive, and to change the start
/ end dates and recurrence settings.

NOTES:
l If a pending instance of this job is currently on the schedule, and you edit the scheduling rule,

the pending instance will be updated to match the new schedule.
l If you inactivate a scheduling rule, any currently scheduled instances of the job will be

automatically removed from the schedule.

To edit a scheduling rule:
1. In the Scheduler dialog, open a job to edit or create a new one.

2. In the left-hand pane of the job, select Scheduling Rules.

The defined rules display in the right-hand pane of the job.

3. Make any desired changes directly within the scheduling rules grid.
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� Deleting a scheduling rule
You can delete a scheduling rule at any time. If a job has no active scheduling rules, it will not be
processed unless it is manually run.

To delete a scheduling rule:
1. In the Scheduler dialog, open a job to edit.

2. Select the Scheduling Rules section of the job, and then select the rule that you want to delete.

3. On the Job tab of the Scheduler ribbon, in the Scheduling Rules group, click Remove Selected.

Alternatively, if you want to delete all scheduling rules for the job, click Clear All.

Any jobs in the scheduled jobs queue that were related to the deleted rule(s) are also deleted.

� Scheduling rule examples
The following are some example schedules and the rules used to achieve them:

Schedule Start/End Day of Week Hours Minutes

Weekdays at 11:00
PM

<optional> 1,2,3,4,5 23 0

Every 15minutes <optional> * * 0,15,30,45

Mondays at 11:30 PM <optional> 1 23 30

One time (6/30/2019)
at 1:30 PM
(Option 1)

Start: 06/30/2019 00:00

End: 07/01/2019 00:00

* 13 30

One time (6/30/2019)
at 1:30 PM
(Option 2)

Start: 06/30/2019 13:30

End: 06/30/2019 13:30

* * *

Every Wednesday in
July at noon

Start: 07/01/2019 00:00

End: 08/01/2019 00:00

3 12 0

Continuous <optional> * * *

Setting up email notification for jobs

Scheduler can be configured to send an email notification when a job completes, or when a job has
errors. In order for an email to be sent for a particular job, the following must be set up:

l The job must be configured to send a notification on completion or error. The notification settings
must include valid To and From email addresses (or use system variables).

l The System.SMTPMessageDelivery system job must be configured with a valid SMTP server for
your environment.
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When a job creates an email notification, the notification is first saved to the database. When
notifications are detected in the database, the System.SMTPMessageDelivery system job is triggered to
deliver the notifications.

NOTE: By default, all new Scheduler jobs are configured to send notification on completion, to the
user who created the job. You only need to edit these settings if you want to change the default
settings.

To configure a job to send email notifications:
1. In the Scheduler dialog, open a job to edit or create a new one.

2. In the left-hand side of the job, select Notification.

3. In the Job Notification Level section, select one of the following:

l Send all email notifications: (Default) An email notification is always sent when the job is
executed, regardless of the job status (success, failure, aborted, etc.).

l Send email notification only when the job has errors: An email notification is only sent if
the job experiences errors. If the job completes successfully with no errors, no email
notification is sent.

l None: No email notifications are sent for this job. The only way to check the status of the
job execution is to check the job history.

l Send email notification to different email addresses when the job has errors or
succeeds: This option works the sameway as Send all email notifications, except that a
separate email address can be specified to receive the error notifications.

4. In theNotification Message Content section, complete the following for the notification email:

Item Description

To The email address(es) to receive the notification email. Separatemultiple
addresses with a semicolon.

By default, this is set to notify the user who executed the job, using the
system variable {CurrentUser.EmailAddress}.

When using Send email notification to different email addresses when
the job has errors or succeeds, this user will be notified if the job
completes successfully (including partial success), but not if the job fails.
Job failure notifications are sent to the To (on error) recipients.
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Item Description

From The email address that themessage is sent from. This can be something
like axiomscheduler@company.com, so that the recipient can easily tell
that themessage has been generated by Scheduler.

By default, this is set to the Scheduler "from" email address as defined in
the system configuration settings, using the system variable
{Scheduler.FromEmailAddress}.

NOTE: For installations that are using subsystems, the system variable
{Scheduler.FromEmailAddress}may resolve to a subsystem
administrator email address instead of the Scheduler "from" email
address. For more information, see Using job variables.

Subject The subject of themessage. By default, this is set to "Axiom Scheduler
Notification."

User Message Optional body text for the email. This text is included in addition to the
Scheduler auto-generated text regarding the job status.

If Send email notification to different email addresses when the job has errors or succeeds is
enabled, the following additional options are available:

Item Description

To (on error) The email address(es) to receive the notification email when the job result
is Failed. Separatemultiple addresses with a semicolon.

This user only receives a notification if the job fails. If the job result is
Success or Partial Success, this user will not receive a notification (only the
To user will).

Subject (on
error)

The subject of the job failuremessage. By default, this is set to "Axiom
Scheduler Notification."

Job variables can be used in the notification settings. For more information, see Using job
variables.

When this job is executed, it will generate an email notification according to the defined settings, and
save that notification to the database to await delivery.

Job properties

This topic is a reference for the settings that can be defined for a Scheduler job.

� General
This section defines general settings for the job.
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Item Description

Description Optional. The description of the job.

The job description can also be edited in Axiom Explorer, in the Scheduler Jobs
Library.

Job Restart
Behavior

Specifies whether and how the job should be restarted if it is interrupted prior
to completion. Select one of the following:
l Do not reschedule this job. In this case, you must manually reschedule the

job if it needs to be run before its next scheduled execution.
l Restart the job from the first task. The entire job is run again, even if some

of the tasks were completed successfully before the job was interrupted.
l Resume the job beginning with the first uncompleted task. (Default) The

job resumes and only the uncompleted tasks are run.

A job would be interrupted if the Scheduler server processing it was restarted,
or if the Scheduler service on the server was stopped or restarted, or if the
Scheduler server was disabled from the Servers tab (Service > Servers) of the
Scheduler dialog.

Job Results
Cleanup

Specifies whether historical job results are purged when the job is run.

To purge job results:
1. Select Purge historical job results whenever this job runs.

2. In Number of days to keep results for this job, specify the number of
days to keep when purging results. By default this is set to 0, which
means all job results will be purged except the result for the current job
execution.

A day is counted as 24 hours from the time the cleanup task is executed. So if
you specify 1 day, and the task is run at 11:00 PM on Tuesday, then all results
prior to 11:00 PM Monday are purged.

If this option is not selected, then historical job results remain in the database
until the system's Purge System Data task is run.
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Item Description

Priority Elevation Specifies the priority of the job in the scheduled jobs queue, within the job's
priority category. Select one of the following:
l Default: (Default) This job is run on a "first come, first served" basis. The

total number of jobs that can be run at one time is determined by the
configured number of Scheduler threads for the installation.

l Reduced: The job is designated as a low priority job, and remains at the
bottom of the queue until other jobs with Default and Elevated priority have
been run.

l Elevated: The job is designated as a high priority job, and is moved to the
top of the queue to be run before Default and Reduced priority jobs.

l Interrupt: The job is run immediately, regardless of any jobs currently
waiting in the scheduled jobs queue, and regardless of whether any
Scheduler threads are currently available to run it. If no Scheduler threads
are currently available, a new thread is created, even if this exceeds the
configured thread limit for the installation.

Job execution order also depends on the priority category of a specific job
execution. See Processing priority for scheduled jobs.

Mark as System
Job

Specifies whether the job is run as a system job. Only administrators can edit
this check box.

If this check box is selected, the job is run under the "Scheduler Service" system
identity instead of a user identity, and the job is run by the system Scheduler
server which operates on the Axiom Application Server.

Generally, this check box should only be selected for system "support" tasks
that should not depend on individual user rights. This check box is not available
if the job contains non-system tasks (generally, spreadsheet-related tasks).

For more information, see System jobs.
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Item Description

Put the system
in 'admin only'
mode during this
job

If this option is selected, then the system will be placed into administrator-only
mode at the start of the job, and then placed back into full access modewhen
all tasks are completed (including any sub-jobs). This is the same behavior as
going toManage > Security > System Access and selecting Administrators
Only.

NOTES:
l You should make sure that any jobs using admin-only mode do not overlap.

For example, imagine that job A starts and places the system in admin-only
mode. While job A is still running, job B starts and finishes. If job B also uses
admin-only mode, then when job B finishes the system will be placed back
into full access mode, meaning the remainder of job Awill be processed in
full access mode.

l Any job using admin-only modemust be run by an administrator.

Generally speaking, any job set to run using admin-only mode should be run at
a timewhen no end users will be logged into the system and no other Scheduler
jobs will be running.

� Job Variables
This tab has two sections for job variables:

l In the Job values section at the top of the tab, you can manage user-defined variables for use in
the current job.

To add or remove variables, use the Add, Remove Selected, or Clear All commands in the Job
Variables group of the Job tab. This group is only available when you have selected the Job
Variables section in the left-hand side of the job.

When creating user-defined variables, do not add curly brackets to the variable name. Curly
brackets are only required when you use the variable in a job or task setting.

l In the System defined values section at the bottom of the tab, you can view the system variables
available for use in the job.

You can right-click any variable in this section (user-defined or system-defined) and select Copy variable
name to clipboard. You can then navigate to the setting where you want to use the variable, and then
paste it. The variable will be pasted with the necessary curly brackets.

For more information, see Using job variables.

� Scheduling Rules
Each row in this section defines a scheduling rule for the job. Jobs will be automatically scheduled
according to the settings in this section.
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To add or remove scheduling rules, use the Add, Remove Selected, or Clear All commands in the
Scheduling Rules group of the Job tab. This group is only available when you have selected the
Scheduling Rules section in the left-hand side of the job.

For more information, see Defining scheduling rules for a job.

Item Description

Active Specifies whether the scheduling rule is active. If this check box is not selected,
then the rule is ignored for purposes of scheduling the job.

Starting On Optional. Specifies the earliest date and time for the scheduling rule to take
effect.

If you want the job to run one time only, set Starting On and Ending On dates
to the same date/time.

Ending On Optional. Specifies the expiration date and time for the scheduling rule. Once
this date is past, no further executions will be scheduled for this rule.

Day ofWeek Specifies the day(s) of the week that you want the job to be run:
l * (Default): The job will be run on all days within the start / end range.
l 0-6: The job will be run on the specified day or days, where 0 is Sunday and 6

is Saturday. Use a comma or a hyphen to separatemultiple days (hyphen if
the days are contiguous, commas if not).

Hours Specifies the time of day (hours) that you want the job to be run, in relation to
the specified days:
l * (Default): The job will be run on all hours.
l 0-23: The job will be run on the specified hour or hours, where 0 is midnight

and 23 is 11:00 PM. Use a comma or a hyphen to separatemultiple hours
(hyphen if the hours are contiguous, commas if not).

Minutes Specifies the time of day (minutes) that you want the job to be run, in relation
to the specified hours:
l * (Default): The job will be run on all minutes (essentially the job is run

continuously, once per minute).
l 0-59: The job will be run on the specified minute or minutes of the hour,

where 0 is the first minute of the hour and 59 is the last minute of the hour.
Use a comma or a hyphen to separatemultiple minutes (hyphen if the hours
are contiguous, commas if not).

� Event Handlers
If an event handler is associated with the job, it is listed here. There are two types of event handlers:

l System event handlers, for completing system-triggered tasks.
l User-defined event handlers, for running jobs via RunEvent. See Advanced options.
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To add or remove event handlers, use the Add, Remove Selected, or Clear All commands in the Event
Handlers group of the Job tab. This group is only available when you have selected the Event Handlers
section in the left-hand side of the job.

Item Description

Active Specifies whether the event handler is active or not within the current job. If
inactive, then actions that trigger the event handler will ignore this job.

Event Name The name of the event handler.

Multiple jobs can have an event handler with the same name; all those jobs will
be affected when the event handler is triggered.

Execute As The user identity under which the job will be run when the event handler is
triggered.
l Owner: For system-managed event handlers, the owner is the system

Scheduler identity. For user-defined event handlers, the owner is the user
who last saved the job.

l Requester: For all event handlers, the requester is the user who caused the
event handler to be triggered.

� Notification
This section defines email notification settings for the job. For more information, see Setting up email
notification for jobs.

Job variables can be used in this section. For more information, see Using job variables.

Item Description

Job Notification
Level

Specifies when email notifications are sent for the job. Select one of the
following:
l Send all email notifications (Default)
l Send email notification only when the job has errors
l None
l Send email notification to different email addresses when the job has

errors or succeeds

If anything other than None is selected, then you must complete the remaining
fields.

To The email address(es) to receive the notification email. Separatemultiple
addresses with a semicolon.
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Item Description

To (on error) The email address(es) to receive the notification email when the job fails.
Separatemultiple addresses with a semicolon. Only applies when Send email
notification to different email addresses when the job has errors or succeeds
is enabled.

From The email address to use as the "From" address for the notification email.

Subject The subject text for the notification email.

Subject (on
error)

The subject text for the notification email when the job fails. Only applies when
Send email notification to different email addresses when the job has errors
or succeeds is enabled.

User Message Optional. The body text for the notification email.

Text entered here will be appended to the body text generated by Scheduler.

� Tasks
This section defines the tasks in the job. In the ribbon, task commands are available on the Job tab, in
the Tasks group.

l To add a task, click Add.
l To change the order of tasks, select a task and then clickMove Up orMove Down.
l To delete a task, select the task and then click Remove Selected.
l To delete all tasks, click Clear All.
l To copy a task, right-click the task and then click Copy. You can copy the task within the same job,

or to another open job in the Scheduler window. Right-click any task (or the Tasks section header)
and then select Paste. The job is pasted underneath the job you right-clicked (or at the end of the
list if you right-clicked the Tasks section header).

l To rename a task, double-click the task name to make it editable, and then type the new name.
For example, if you have a job with multiple File Processing tasks, then you may want to edit the
name of each task so that you knowwhich file each task relates to at a glance. (You can also right-
click and select Rename.)

Tasks are processed in the order they are listed in the job. By default, when you add a new task to a job,
it is placed at the bottom of the list. Make sure to move the new job if it should not be processed last.

Tasks can be processed concurrently instead of sequentially if they are configured to be run as a
subordinate job within the parent job.

Each task type has its own unique settings in addition to the standard task settings. For more
information, see Scheduler Task Reference.

� Job Results
Displays historical results for the job. This section is blank if the job has never been run.
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Job results may be purged periodically by using the Job Results Cleanup option for the job, or by the
system Purge System Data task.

NOTE: Users with the Scheduled Jobs User security permission only see results for jobs that they
executed. Administrators see results for all executions.

For more information on job results, see Viewing job results.

Advanced options

Creating event handlers for a job

You can create user-defined event handlers in a job, for the purposes of automatically triggering the job
for execution when the event name is called by another feature. Axiom Cost Accounting supports several
features that can be used to raise an event:

l The RunEvent function and command
l File Group triggers
l The Raise Event Scheduler task

Event handlers are defined by name. Multiple jobs can have an event handler with the same name.
When that event handler is called, it will affect all jobs that contain the event handler with thematching
name.

To create an event handler in a job:
1. In the Scheduler dialog, open a job to edit or create a new job.

2. In the left-hand side of the job, select Event Handlers.

3. On the Job tab of the ribbon, in the Event Handlers group, click Add.

A new event handler is added to the job.

4. Double-click the Event Name field so that the field becomes editable, and then type the desired
event handler name.

For example, if the event handler will be used to trigger Process Plan Files jobs, you might name
the event handler ProcessPlanFiles.

This event name is the name that will be used in features such as RunEvent to trigger this job for
execution.

5. In the Execute As field, select one of the following to determine the user identity that will be used
to run the job when it is executed via the event handler:

l Owner: The job will be run under the identity of the job owner.

The job owner is the user who last saved the job. If you are not sure who the current job
owner is, you can check the Job Variables tab. The current job owner is listed in the System
defined values section.
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l Requester: The job will be run under the identity of the user who triggered the event
handler.

By default, event handlers are set to run as theOwner. You should carefully consider this option
as it may affect whether the job can be run and how the job is run.

For example, if the event handler is set to Requester, but the user who triggered the job does not
have access to the file group specified for a Process Plan Files task, then the task will fail.

This may be the desired outcome—you may want the job to be dependent on the user's rights,
and therefore you should specify Requester. On the other hand, you may want the job to run in
the sameway every time, regardless of the user that triggers the job. In that case you should
specify Owner.

By default, the event handler is set to Active, which means it will be found by any process that triggers
the event handler. If you want to temporarily exclude this job from event handler processing, you can
clear the Active check box.

� Deleting an event handler
If you no longer need an event handler, you can delete it from the job. Select the event handler and then
click Remove Selected. You can also Clear All to remove all event handlers from the job.

Using job variables

You can use job variables within a Scheduler job, to define the value of the variable when the job is run.
Job variables aremanaged in the Job Variables section of the job.

There are two types of variables:
l User-defined variables: You can create a variable and then use it within any job or task setting

that supports variables, but only within that particular job. The primary use for user-defined
variables is to run a job via RunEvent (either the function or the command), and pass in a variable
value at that time.

l System variables: Axiom Cost Accounting provides a number of system variables that can be used
within relevant job and task settings. For example, instead of specifying a "hard-coded" email
address for the job notification, you can use a system variable to specify that whoever ran the job
should receive the notification.

In all cases, to use a variable within a job or task, enter the variable name into the desired setting,
enclosed in curly brackets. For example: {variable}

TIP: If you want to use a variable in a job, you can right-click the variable and then select Copy
variable name to clipboard. Navigate to the setting where you want to use the variable, and then
paste it into the setting (the curly brackets are added automatically).
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At the job level, variables can be used in any of theNotification Message Content settings in the
Notification tab. At the task level, in general, variables can be used in any task field that accepts typed
user input.

When the job is run, the variable values used for the job display in the job results under Job Values, and
also in the email notification (if applicable).

� User-defined variables
User-defined variables are created in the Job Variables tab. You define the name of the variable (without
brackets), and if desired, define a default value for the variable.

When the job is run, the user-defined variable will be replaced with a value as follows:
l If the job was scheduled using RunEvent (function or command), and RunEvent sent a name /

value pair that matches the name of the job variable, that value is used.

l If the job was scheduled as a result of a file group trigger, and the trigger has a defined variable
that matches the name of the job variable, that value is used. Multiple values are returned as a
comma-separated list.

l If the job contains a Process Document List task or a Process Plan Files task with a defined post-
processing variable that matches the name of a job variable, that value is used after that task has
been processed.

l Otherwise, the default value defined in the Job Variables tab is used.

If the value is blank, then the job or task setting using the variable will be evaluated as blank. If the
setting cannot be blank, then an error will result when the job is executed.

� System variables
The available system variables are listed at the bottom of the Job Variables tab. Most of these variables
relate to user names and addresses, for use within the job notification settings.

When the job is run, the system variable is replaced with the applicable system value.

The following values are available:
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Variable Description
{CurrentUser.EmailAddress}

{CurrentUser.LoginName}

{CurrentUser.FullName}

Returns the current user's email address,
login name, or full name.

The current user is the user identity under
which the job is currently being run.
Generally, this is the user who executed the
job. If the job was executed via an event
handler and the event handler is set to
owner, then the current user will be the job
owner.

{JobOwner.EmailAddress}

{JobOwner.LoginName}

{JobOwner.FullName}

Returns the job owner's email address, login
name, or full name.

The job owner is the user who last saved the
job.

{Scheduler.ConfiguredFromEmailAddress} Returns the system's default "from" address,
as defined in the system configuration
settings.

{Scheduler.FromEmailAddress} This returns a value as follows:
l If the current user belongs to a

subsystem, this returns the subsystem
administrator's email address.

l If the current user does not belong to a
subsystem, this returns the default
configured "from" address.

{CurrentSubsystem.AdminEmailAddress} Returns the email address of the subsystem
administrator for the subsystem that the
current user belongs to.
l If the subsystem has multiple

administrators, the email is sent to the
first administrator.

l If the user belongs to multiple
subsystems, the first returned subsystem
for the user will be used. No specific logic is
applied to determine the "correct"
subsystem for any particular job.

l If the user does not belong to a
subsystem, then no email address is
returned.
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Variable Description
{EventHandler.EventName} Returns the name of the event handler that

caused the job to be scheduled, if applicable.
Otherwise the variable returns blank.

{NotificationAddress} Returns the notification address defined for
the plan codes that triggered a Scheduler job.

This variable only applies when the job is
executed as a result of a file group trigger, and
only if the optional notification address
settings are defined for the file group.
Otherwise, no email address is returned.

{Task.CurrentIterationValue}

{Task.IterationNumber}

Returns the current iteration value and the
current iteration number. These variables
only apply when using the Iteration feature
for a task.

For more information, see Using iterative task
processing.

Processing tasks in parallel

Each Scheduler job can havemultiple tasks. By default, each task in the job is processed sequentially, in
the order that the tasks are listed in the job.

If desired, you can configure tasks so that they are processed concurrently (in parallel) instead of
sequentially. If appropriate, this may speed up the processing of the job.

� Configuring tasks for parallel processing
In order to process tasks in parallel, the tasks must be configured to run as subordinate jobs (sub-jobs).
To do this, edit the following settings in the Task Control section for each task:

l Select Create a Subordinate Job for this Task.
l Ensure that the following setting is not selected:Wait for all Subordinate Jobs to complete

before proceeding to the next Task.

In the following example, if all four tasks are configured to be run as subordinate jobs, then they can be
run in parallel (depending on the available Scheduler threads).
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Scheduler task configured to run as a subordinate job to enable parallel processing

� How parallel processing works
When a task is configured to execute as a subordinate job, then it is not processed within the "parent"
job. Instead, a sub-job is created for the task. The sub-job joins the Scheduler queue and is eligible for
processing according to the normal Scheduler processing rules. For more information, see Processing
priority for scheduled jobs.

For example, imagine that you have a job with four tasks, and these tasks are not dependent on each
other. If you use the default settings, Scheduler takes the first task in the list and starts processing. The
second task is not started until the first task is complete, and so on.

If instead you configure each task as a sub-job, then when the "parent" job is processed, it will create
four sub-jobs. If two Scheduler threads are available for processing, then two of the sub-jobs are
processed at the same time. If four Scheduler threads are available, then all four sub-jobs are processed
at the same time. Once all of the sub-jobs are complete, the parent job is completed, and its status
reflects the overall status of all of the sub-jobs.

If tasks are dependent on each other, then you should not process them as sub-jobs, or you should use
theWait setting as appropriate. For example, imagine that the first four tasks in the job can be run in any
order, but the fifth task must be processed last. In that case, you can configure the first four tasks to run
as sub-jobs, but on the fourth task you must enableWait for all Subordinate Jobs to complete before
proceeding to the next Task. This will cause Scheduler to wait for all sub-jobs to finish before it proceeds
to the fifth, final task.

In the following example, the file processing tasks are configured as sub-jobs so that they can be run in
parallel. The last file processing task is configured to wait, so that all of the file processing tasks will be
finished before the file collection task begins.
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Scheduler task configured to wait for all subordinate jobs to complete

Using iterative task processing

You can configure a Scheduler task to use iterative processing, so that the task is repeated multiple times
using a designated list of values. Each iteration of the task uses a different item in the list, until all items
have been processed.

When you enable iterative processing for a task, you define the list of values by specifying a table column
and an optional filter. The task will then be processed for each unique item in the table column. You can
reference the column values within the task properties by using a built-in Scheduler job variable. As each
iteration of the task is processed, the variable is replaced with the column value for the current iteration.
Using this approach, the task can dynamically change for each iteration.

For example, you may have an import that you want to perform for four different entities in your
organization. The import configuration is exactly the same except that the source file or query is different
for each entity. If the import uses entity as a variable, then you can set up a single import task and
configure it to iterate over the list of entities. Each iteration uses a different entity name or code, which
you can pass into the import variables so that the import uses the correct source file or query for the
current entity.

� Enabling iterative processing
Iterative processing is enabled in the Task Control properties of the task. Select the task within the
Scheduler job, then click Task Control to expand that section. Any task can use iterative processing,
though it is more useful for certain task types such as Import ETL Package.

Complete the following properties in the Iteration section of the Task Control properties.
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Item Description

Iterate this Task Specifies whether iterative processing is enabled for the task. If enabled,
then the task will be performed N times, where N is the number of unique
items in the specified iteration column. Job variables can be used to apply
the current iteration value and iteration number to the task.

Create a Subordinate
Job for each iteration

Specifies whether each iteration is processed as a separate subordinate
job. By default, this is disabled, which means that all iterations are
processed sequentially within the overall subordinate job created to
process the iterations.

If enabled, then each iteration is processed as a separate subordinate job,
enabling concurrent execution ofmultiple iterations. This option should
only be enabled if the order of iteration processing is not important.

Column The column that contains the values to iterate over. Use Table.Column
syntax to specify the column. Multiple-level lookups can be used.

For example, if you specify Dept.Region, then the task will be processed
once for each unique region value in the column (after applying any filter
to limit the list of values).

Group By Optional. By default, the group by column is the same as the iteration
column, so that the task is processed once for each unique value in the
iteration column. However, if needed, you can specify a different grouping
level.

You can use any column or columns that would be valid as the "sum by"
level for an Axiom query, where the primary table is the table specified for
the iteration column.

Order By Optional. By default, the values are sorted based on the iteration column,
in ascending order. You can specify a different sort column, or use the
same sort column but change the order to descending.

The sort order is ascending unless the keyword desc is used to specify
descending order. For example:

Dept.Dept desc

Filter Optional. A filter criteria statement to limit the list of values for the iterative
processing. You can use any filter that is valid against the source table (the
table of the iteration column).

When iterative processing is enabled for a task, the iterations are always processed within a subordinate
job. Therefore, enabling the Task Control option of Create a Subordinate Job for this Task is
unnecessary.
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If your job has multiple tasks, and you want the tasks after the iterative task to wait for all iterations to
complete before executing, then you must enable the following Task Control option for the iterative task:
Wait for all Subordinate Jobs to complete before proceeding to the next Task.

� Configuring the task to change for each iteration
In order for the Scheduler task to apply the current iteration value to each iteration, you must use the
built-in iteration variables within the task. These variables are job variables, and can be used like any
other job variable. The following variables are available:

Variable Description
{Task.CurrentIterationValue} Returns the current value from the iteration list.
{Task.IterationNumber} Returns the number of the current iteration.

To continue the previous example, imagine that you are setting up an import for iterative processing by
entity. To define the list of entities, you set up the Iteration settings in the Task Control section like the
following:

This example will iterate over the list of entities in the Entities column, limited to only those entities
where the Costing column is set to True. If this resolves to 4 entities, then the task will be processed 4
times, once for each entity.

The import is configured with a variable {Entity}, which it uses to process the correct entity source file.
In order to pass the current task iteration value to the import variable, you can use the job variable
{Task.CurrentIterationValue} in the import task settings. For example:
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When the first iteration is performed, the {Task.CurrentIterationValue}will be resolved as
Entity_1, so the import will be processed using Entity_1 as the value for the {Entity} import variable.
For the second iteration, the value Entity_2will be used, and so on. Using this approach, the import will
be processed for all entities in the iteration column.

Conditionally processing tasks in a job

You can configure a task so that it is only processed if a particular condition is met. This feature is
configured in the task settings, in the Task Control section, under Process task only if the value of this
expression is true.

To enable conditional processing, you must specify a logical expression that will resolve to either true or
false when the job is executed. If true, then the task is processed as normal. If false, then the task is
skipped.
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The logical expression is evaluated using an IF function on the Scheduler server as follows:

=IF(Expression, 1, 0)

You can enter any expression that would be valid in an IF function. You can use Excel functions, Axiom
functions, and Scheduler job variables in the expression. If you use a job variable, it must be placed in
quotation marks unless you expect the variable value to be resolved and evaluated as a number.

If the task is not processed because the condition resolves to false, this is not considered a failed task. If
there are other tasks in the job, they will be processed. If you want an entire job to be conditional, you
can do either of the following:

l Repeat the condition in each individual task settings. Keep in mind that the condition will be
evaluated for each individual task, which means that if it is possible for the condition to change in
between tasks, some tasks might be processed while others aren't.

l Use the condition on a Raise Event task that then triggers another job for processing. For more
information, see Raise Event task.

� Examples
The following are some example expressions for conditional processing:

GetData("Process","FG='2012 Budget'","SystemStatus")=1

If this GetData function returns 1, the expression resolves to true and the task is processed. If not, it is
false and the task is skipped.
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AND("{EventHandler.EventName}"="ProcessPlanFiles",{Dept}=1000)

If this job was triggered for execution by the ProcessPlanFiles event handler, and if the job variable Dept
resolves to 1000, then this expression is true and the task is processed. Note that in the first part of the
expression, the event handler variable will return a string value so it must be placed in double quotation
marks. In the second part of the expression, the department variable will return a number so it is not
placed in quotation marks.

AND(Day(Now())<=7,Weekday(Now())=2)

This expression will return true if it is the first Monday of themonth, otherwise it will return false.

Using RunEvent to execute a Scheduler job

Using RunEvent, you can trigger the execution of a Scheduler job from various contexts, such as within
Axiom files, task panes, or Axiom forms. There are two different versions of RunEvent:

l RunEvent function: The RunEvent function can be used in Axiom files to trigger the execution of a
Scheduler job from a spreadsheet.

l RunEvent command: The RunEvent command can be used in task panes or Axiom forms to trigger
the execution of a Scheduler job.

Both the function and the command work in the sameway and take the same parameters. Some
limitations apply depending on the context where RunEvent is being used.

All of the information necessary to run the job is contained within the RunEvent function or command. It
is assumed that an administrator (or a power user with the necessary rights) sets up the desired jobs
within Scheduler, and then sets up RunEvent in the appropriate context so that end users can trigger it.

The end user who triggers the job using RunEvent does not need to have any Scheduler security
permissions. The job itself can be configured to run using the permissions of the job owner or using the
permissions of the end user who triggered the job (the requester). If the job is run as the requester, then
the end user must have the appropriate permissions to the files impacted by the job (for example to the
target file for File Processing, or to the target file group and plan files for Process Plan Files).

NOTE: You can also use the Raise Event Scheduler task to trigger the execution of a Scheduler job
from a different Scheduler job. This works in a similar manner as the RunEvent features.

� Setting up a Scheduler job for RunEvent
All uses of RunEvent require the same job setup in Scheduler:

l The job that you want to execute via RunEvent must already be created within Scheduler. When
setting up the job, consider items such as the notification settings. Do you want the notifications
to go to the user that executed the job, or to the job owner, or both?
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l The job must contain an event handler that will be used to trigger the job execution. When
creating the event handler, consider whether you want the job to run as the job owner, or as the
requester (the user who clicks on the RunEvent function). This may impact email notifications and
determines the user rights under which the job will run.

For more information, see Advanced options.

l Optionally, the job can use variables. Variable values can be defined in the RunEvent function or
command and passed to the job. You would do this if aspects of the job need to be dynamic; for
example, if you want to use a different filter depending on which user is running the job or based
on a user selection in the file. For more information see the Variable example section below.

� Setting up RunEvent
Regardless of the context, RunEvent uses the following properties to trigger Scheduler jobs:

l The event handler name that identifies the Scheduler job(s) to trigger for execution.
l An optional confirmation message to present to the user before proceeding with the event. Not

available when using the command within an Axiom form.
l An optional success message to present to the user after the event has been raised.
l If variables are being used, one or more variable names and values to pass to the Scheduler job.

This is available in all contexts, however, task panes do not currently support the ability to
determine the variable values dynamically.

The following shows an example RunEvent function for use in an Axiom file:

=RunEvent("Click here to process plan files","ProcessPlanFiles","You are
about to process plan files for the "&C3&" region. Do you want to
continue?",,"filter = "&C4)

The first parameter defines the display text for the function, while the second parameter specifies the
event handler name. In this example we have also defined a custom confirmation message for the user
and a variable value to pass a filter to the job. The following screenshot shows the function in the
spreadsheet:
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The next screenshot shows a RunEvent command set up on a Button component for an Axiom form. You
can see the same event name and the filter variable also being read from a sheet location.
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� User experience
The user experience for RunEvent depends on the context and whether you are using optional custom
messages.

l The user starts the process by doing one of the following:
o Double-clicking the RunEvent function in the spreadsheet.
o Clicking the Button component that is configured for RunEvent in the Axiom form.
o Double-clicking the RunEvent item in the task pane.

l A confirmation prompt displays to the user, asking them to confirm that they want to proceed.
The user can click Yes to proceed, orNo to cancel. Default text is used if no custom text is defined
in the RunEvent properties.

NOTE: This step does not apply when executing RunEvent from an Axiom form. The Axiom
form context does not support a confirmation message. However, you can configure the
Button component to display a confirmation message before executing the RunEvent
command.

l Axiom Cost Accounting checks all Scheduler jobs to see if any contain an active event handler with
the same name as specified within the RunEvent properties. If any are found, they are added to
the schedule to be processed as soon as possible, depending on Scheduler thread availability and
any higher-priority jobs in the queue.

It is important to note that RunEvent triggers job execution based on the event handler, not
based on specific jobs. If multiple jobs contain an event handler with the specified name, then all
of those jobs will be scheduled.

If variable values are defined in the RunEvent properties, those values are passed to the job. If a
variable specified in the RunEvent properties is not used in the job, it is ignored.
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l A confirmation message displays to the user as follows:
o If no jobs were found that contained the specified event handler, the user is notified that

no jobs were found.

o If jobs were placed on the schedule, the user is notified that the specified event was
scheduled. Default text is used if no custom text is defined in the RunEvent properties.

NOTE: If executing RunEvent from an Axiom form, this message displays in the bottom left
corner of the form, not in a separatemessage dialog.

When the job is finished processing, email notifications are sent according to the settings in the job.

� Variable example
When using RunEvent to execute a Scheduler job, you can pass a variable value to the job. For example,
imagine that you want to execute a Process Plan Files job, and you want to send a filter value to the job.

Step 1: Set up the variable in the job
The first step would be to create a job variable in the job, and then use the job variable in the filter
setting.

Example job variable

NOTE: In this case, we have defined a default value for the filter variable (1=0) that does not result in
any plan files. This is because we do not want to process any plan files unless a filter is provided by
RunEvent. If we left the default value blank, that would mean all plan files would be processed if no
filter was provided by RunEvent.
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Example use of variable in job settings

For more information on Scheduler job variables, see Using job variables.

Step 2: Configure RunEvent to use the Variable
Now that the job is set up to use the filter variable, you must configure RunEvent to pass in a value for
that variable. If you are using the RunEvent function in an Axiom file, you use the following syntax within
the function parameters:

variablename=variablevalue

These name / value pairs can be placed in the RunEvent function starting in the fifth parameter of the
function. If you have two name / value pairs to pass to the job, you can use the fifth and sixth
parameters, and so on.

For example, to pass the filter DEPT.Region='North' to the job, the RunEvent function would be
constructed as follows:

=RunEvent("Double-click to process plan
files","ProcessPlanFiles",,,"filter=dept.region='North'")

More likely, you would be reading the variable value from another place in the sheet, so the function
would look something like:

=RunEvent("Double-click to process plan
files","ProcessPlanFiles",,,"filter="&C4)

Where the filter value is read from cell C5.

When the job is executed by use of this RunEvent function, the value DEPT.Region='North'will be
placed in the Plan File Filter box of the Process Plan Files task, and the job will be run using that filter.
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When using RunEvent in an Axiom form, the variables and their values are defined in the Event Variables
section. In this context you place the name of the variable in the left-hand box, and then in the right-
hand box you enter the cell reference (in brackets) where the variable value will be read.

The Event Variables section is also present when configuring RunEvent for use in a task pane, however in
this context the only option is to "hard-code" the values in the RunEvent properties.

Run another Scheduler job from within a Scheduler job

Scheduler jobs have two ways to run another Scheduler job:
l Raise Event task: This task uses an event handler name to trigger one or more Scheduler jobs for

execution. The jobs triggered by the event handler are run independently from the job containing
the Raise Event task.

l Run Scheduler Job task: This task runs a specified Scheduler job as a subordinate job within the
current "parent" job. Essentially, the tasks in the target job are run within the parent job, which
means that other tasks in the parent job can reference the results of those tasks.

The decision of which task to use depends on several factors, but themost important is whether the
Scheduler jobs are independent or dependent. If the first job is dependent on the execution of the
second job, then you must use the Run Scheduler Job task. When the Raise Event task is used, the
triggered jobs are run independently.

The following chart details some comparison points between the two tasks:

Comparison Raise Event Run Scheduler Job

Can pass variables to target job Yes Yes

Can execute target job as requester or owner Yes No

Can wait for target job to complete before
continuing

No Yes

Can use results of target job in subsequent tasks No Yes

� Using the Raise Event task
The Scheduler Raise Event task is typically used when you need to trigger another job for execution once
the current job is complete. The Scheduler job(s) triggered by the event handler are added to the
schedule and then executed independently from the current job. For example, you might place the Raise
Event task at the end of the task list, so that all tasks in the current job must complete successfully
before the Raise Event task is run.
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Because the jobs triggered by the event handler are run independently, you cannot perform additional
tasks in the current job that depend on the results of the triggered jobs. The current job will not wait for
the triggered jobs to be run.

Event handlers can be configured to run a job as either the job owner or as the requester (meaning the
user that triggered the event). This allows some additional flexibility in how the triggered jobs are run.
For example, you may want to trigger a job that needs to be run using administrator permissions. As
long as the event handler is configured to run as job owner (and the owner is an administrator), then
that triggered job will always have the necessary permissions, regardless of the user who is running the
job with the Raise Event task.

� Using the Run Scheduler Job task
The Run Scheduler Job task is typically used when you need to run another job and then perform
additional tasks once that job is complete. Because the target job is run as a subordinate job within the
"parent" job, the parent job can wait for the "child" job to complete before it continues processing tasks.
Later tasks in the parent job can reference the results of the completed child job, such as querying data
saved from the child job, processing plan files created by the child job, and so on.

Keep in mind that it is not possible to stop processing tasks in the parent job based on the general
success or failure of the child job. Although Scheduler jobs automatically stop processing if a task fails,
the task in this case is just the Run Scheduler Job task. As long as the child job can be successfully added
to the Scheduler queue for processing, the Run Scheduler Job task will report success. If needed, you can
use the option Process task only if the value of this expression is true to detect whether a subsequent
task in the parent job should be processed. For example, if you know that the child job saves a particular
value to the database, you can check for the existence of that value to determine whether to process a
task. For more information on using this option, see Conditionally processing tasks in a job.

The child job is run using the same user permissions as the parent job. The user running the parent job
must have the appropriate permissions to complete all tasks in both the parent job and the child job.

� Chaining multiple Scheduler jobs
You can "chain" multiple Scheduler jobs together using either approach. For example, you may have
three Scheduler jobs that you want to run, in a particular order.

You can placemultiple Run Scheduler Job tasks in a parent job, where each task triggers a separate job.
Because these tasks run as subordinate jobs, and the parent job can wait for each child job to complete,
it is easy to run the jobs in order. However, if you want to stop processing the jobs if one fails, there is no
built-in way to do that (as discussed in the previous section). You would need to set up the Run
Scheduler Job tasks to run or not based on a condition, where the condition tests some result from the
previous job.

To chain jobs using Raise Event, the last task in each job can be a Raise Event task. Each job will perform
its tasks and then trigger the next job in the chain. When using this approach, the chain automatically
stops if failure occurs, because if a task in the job fails then the job stops and will not proceed to the
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Raise Event task. The disadvantage of this approach is that the jobs cannot also be run separately, unless
you manually disable the Raise Event tasks or configure the Raise Event tasks to not run based on a
condition.

Running a job
If a job is saved with an active scheduling rule, then the job is automatically placed on the schedule to be
run according to that rule. Each time the job is run according to the rule, it is run as the current job
owner (unless it is a system job, in which case it is run as the System identity).

However, you can also choose to run a job manually. If you run a job manually, the job is added to the
Scheduled Jobs list with a start time of now, to be processed according to its job priority settings. The
job will be run using your user identity (again, unless it is a system job).

Running a job manually does not impact any scheduled executions of the job as determined by
scheduling rules. For example, if a job is scheduled to be run at 10:00 PM tonight, and you run the job
manually at 2:00 PM, the job will still be run as scheduled at 10:00 PM.

To manually run a job:
1. In the Scheduler dialog, in the Job tab, click Open.

The Axiom Explorer dialog opens, showing the Scheduler Jobs Library only.

2. Select the job and then click Open.

The job opens in the Scheduler dialog. Make sure the job is the active tab in the navigation pane
(themost recently opened tab is the active tab by default).

3. In the Job tab of the ribbon, click Run Once.

A confirmation message informs you that the job has been placed on the schedule.

NOTE: When you click Run Once, any unsaved changes to the job are automatically saved. This save
will designate you as the job owner (if you are not already the job owner).

Managing scheduled jobs
The Scheduled Jobs tab of the Scheduler dialog displays all jobs that are scheduled to be processed or
are in process. This includes scheduled jobs, jobs executed manually via Run Now, and jobs that were
triggered for execution via an event handler.

By default, this list displays when you first open Scheduler. If you have changed the view in the dialog,
you can return to it by clicking the following:

l On the Service tab, in the Service View group, click Scheduled Jobs.
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If a job has a scheduling rule with a recurring schedule, only the first scheduled execution appears in the
list. For example, if you have a job that is scheduled to run once a month for a year, you will not see all
twelve scheduled executions in the list—you will only see the first scheduled execution. Once that
instance has been run, the scheduling rule is re-evaluated and the next scheduled execution appears in
the list.

In this tab, you can:
l Stop a scheduled execution. If you do not want a scheduled instance to be run, right-click the

item and select Remove from Schedule. This not only removes the scheduled instance, it also
inactivates the associated scheduling rule for the job (if applicable). If you want future scheduled
instances of the job to proceed, you must edit the job to re-enable the scheduling rule.

l Abort an in-process job. If a job is already running and you want to stop it, right-click the item
and select Abort Working Job. This will immediately abort the job regardless of what it is currently
doing. Keep in mind that depending on the type of job and its stage in the process, this may result
in side-effects such as files remaining locked or incomplete processing. No notifications will be sent
for the aborted job. Generally, this action should be reserved for situations where a job has
gotten "stuck" or was started in error.

l Reschedule an execution. To change the scheduled start date/time of a scheduled instance, right-
click the item and then select Reschedule Start Time. The Start Time field in the grid is now
editable, and you can type in a new date and/or time.

l Refresh the list. On the Service tab, in the Actions group, click Refresh. New scheduled jobs will
be added to the list, and Status and Due Inwill be updated appropriately.

NOTE: Users with the Scheduled Jobs User security permission can only modify jobs that they
placed on the schedule. Jobs scheduled by other users are visible, but are grayed out and unavailable
for editing. Administrators can view and edit all scheduled jobs.

� Scheduled job information
The following information displays for each scheduled job:

Item Description

ID The system-generated ID for the job execution. Each scheduled execution of a job
has a unique ID. Job results are listed by execution ID.

Job The name of the job.

User The user identity that the job will be run as. If the job is a system job, the user is
System.

This is typically the name of the user who placed the job on the schedule, but not
always (for example, when using an event handler that is set to run as the job owner
instead of as the requester).
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Item Description

Status Job status is either Pending (waiting to be executed) orWorking (currently being
executed).

Server If a job is currentlyWorking, then the server executing the job is listed here.
Otherwise, this column is blank.

Priority The priority category for the job:

1. Manual: The job was executed manually.

2. Event Handler: The job was executed by a Scheduler event handler.

3. Scheduled Job: The scheduled instance of the job results from an active
scheduling rule.

4. Subordinate Job: The job was generated as a subordinate job, from a
currently executing job.

The priority category determines how jobs are evaluated for processing order, in
conjunction with the job's Priority Elevation setting. Manual jobs are highest
priority, and subordinate jobs are lowest priority. For more information, see
Processing priority for scheduled jobs.

Start Time The start time of the job. The job is eligible for immediate execution if the start time is
now or passed. Jobs may not be executed right at the start time if no Scheduler
threads are currently available to execute the job, or if other eligible jobs have higher
priority.

If the job is on the schedule due to a scheduling rule, the start time is based on the
scheduling rule. If the job was manually executed via Run Now or triggered by an
event handler, the start time is the time the execution was initiated.

Due In The length of time until the job is due to be processed. For example, if the job is
scheduled to run at noon and it is currently 11:50 AM, then the job is due to be run in
10minutes.

This column is intended to make it easy to see when a job will be run, without
needing to calculate it based on the start time.

Viewing job results
Once a job has been run, you can view the results in the Scheduler dialog. Job results can tell you:

l Whether the job processed successfully or failed
l The process steps performed by the job, if it was successful
l The error message for the job, if it failed
l The date/timewhen the job started processing and how long it took to process
l The Scheduler server that processed the job
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NOTE: Users with the Scheduled Jobs User security permission can only see job results for jobs that
they executed. Administrators can see job results for all jobs.

To view results for all jobs:
l On the Service tab, in the Service View group, click Job Results.

The Result History tab opens, listing a summary of results for all jobs that have started or finished. If you
want to seemore specific details for a particular job execution, double-click it. This opens the related job
to the Job Results section, where you can viewmore details such as the specific error message for a failed
execution.

TIP: Alternatively, you can open a job directly, and go to the Job Results section to view results for
that job only.

� System job results
By default, system job results are hidden in the Result History tab. System jobs such as the SMTP
message delivery job run frequently, and can easily fill up the result history screen, making it difficult to
find results for user-initiated jobs.

If you want to view results for system jobs, you can do one of the following:
l At the bottom of the Result History tab, clear theHide system jobs check box.
l Open the system job directly, and view its job results within the job. For example, you can go to

the Scheduled Jobs tab and double-click the System.SystemDataPurge job to view all results for
that job.

� Purging job results
Over time, the job result history can get quite large, so it is recommended to purge the result history
periodically. There are two ways to purge result history:

l Each job can be configured to purge its own prior result history when it is run (Job Results
Cleanup). This setting is located in theGeneral section of the job properties. For more
information, see Job properties.

l The System.PurgeSystemData system job purges result history whenever it is run (by default,
once per hour).

When you purge job results, you specify a number of days of history to be kept. For example, you may
always want to keep 5 days' worth of job history, and purge any results older than that.
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Scheduler Task Reference
Each Scheduler task in a job has two sections of task properties:

l Task Control: Common task properties that apply to all task types. For more information, see
Task Control properties.

l Task Details: Properties specific to the current task type. For more information, see the topics for
each individual task type.

The following task types are available:

Task Description

Active Directory
Import

Import users from Active Directory into Axiom Cost Accounting. This task
adds new users, and can also disable users that no longer exist in the
Active Directory domain.

Collect Worksheets Collect worksheets from multiple files into a single file.

Copy On Demand
Plan Files

Copy plan files from one on-demand file group to another.

Create Plan Files Create new plan files (same as the Create Plan Files utility for file groups).

Echo Task Test the Scheduler server. This task sends a message to the Scheduler
server and asks it to send themessage back.

Execute Command
Adapter

Execute a command from the Command Library.

Execute SQL
Command

Run a SQL statement on an Axiom database.

Export ETL Package Export data to an external database, using an export utility defined in the
Exports Library.

File Processing Perform file processing actions on a report. You can use the report's native
file processing settings, or override the settings.

Import ETL Package Import data into Axiom Cost Accounting, using an import utility defined in
the Imports Library.

Process Document
List

Process any set of Axiom files—for example, driver files or report utilities.
The task calculates and saves the files, and can also refresh Axiom queries
and save data to the database.

Process Plan Files Process plan files (same as the Process Plan Files utility for file groups).

Process Template List Process a template file. The task runs designated Axiom queries, time-
stamps the queries, and saves the template.

Purge System Data Purge old Scheduler results and system temp tables.

Raise Event Trigger another Scheduler job for execution, using a named event handler.
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Task Description

Run Scheduler Job Run another Scheduler job as a subordinate job.

SMTP Message
Delivery

Deliver email notifications resulting from Scheduler jobs.

Start Process Start a process definition for Process Management.

Update Indexes and
Constraints

Update the indexes and constraints in your Axiom Cost Accounting
database.

Task Control properties

The following task properties are available for all Scheduler task types. To edit these properties, select the
task in the Scheduler job, then expand the Task Control section.

Item Description

Skip this Task If selected, the task will not be run when the job is processed.

By default, this option is not selected, which means this task will be run.

Process task only if
the value of this
expression is true

Optional. Enter a logical expression to conditionally process this task
depending on whether the expression resolves to true or false at the time
the job is executed. If true, the task is processed as normal. If false, the
task is skipped.

The logical expression is evaluated by the Scheduler server using an IF
function. The expression can be any statement that would be valid within
an IF function. You can use Excel functions, Axiom functions, and
Scheduler job variables in the expression. If you use a job variable in the
expression, you must place the variable in double quotation marks unless
you expect it to be resolved and evaluated as a number.

For more information, see Conditionally processing tasks in a job.

If this Task fails,
continue executing
subsequent Tasks

If selected, the job will continue processing even if this task fails.

By default, this option is not selected. If a task in a job fails, the job is
canceled and no further tasks are processed.

Create a Subordinate
Job for this Task

If selected, this task will be processed as a subordinate job to the current
job.

Selecting this check box enables concurrent processing of different tasks, if
the option toWait for all Subordinate Jobs to complete before
proceeding to the next Task is not selected.

NOTE: This option is not available for Process Plan File tasks.
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Item Description

Wait for all
Subordinate Jobs to
complete before
proceeding to the
next Task

If selected, the job will wait for any subordinate jobs to complete before
moving to the next task.

If this check box is not selected, and the option Create a Subordinate Job
for this Task is selected, then tasks can be processed concurrently instead
of sequentially.

This check box is selected by default for Plan File Refresh and File
Processing tasks. For other task types, this option is not selected by
default.

Workbook processing
engine to use

This option should always be set to Axiom Web Engine. Use of Excel for
processing on the Scheduler server is no longer supported.

If any tasks in the job involve spreadsheet processing, the spreadsheets
are processed using the same spreadsheet emulation engine used by the
Windows Client.

Override Log Level for
this Task

By default, Scheduler jobs perform logging at the same level that is
specified for the application. If necessary, you can override the logging
level for a particular task, so that it always runs at a specified logging level.
You may want to do this if you encounter performance issues for tasks
that generate a lot of logged messages.

To do this, select the check box forOverride Log Level for this Task, then
select the desired logging level from the drop-down list.

NOTE: This option is only available for File Processing tasks.

Iteration
This section can be used to optionally enable iterative processing for the task. For more information, see
Using iterative task processing.

Item Description

Iterate this Task Specifies whether iterative processing is enabled for the task. If enabled,
then the task will be performed N times, where N is the number of unique
items in the specified iteration column. Job variables can be used to apply
the current iteration value and iteration number to the task.
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Item Description

Create a Subordinate
Job for each iteration

Specifies whether each iteration is processed as a separate subordinate
job. By default, this is disabled, which means that all iterations are
processed sequentially within the overall subordinate job created to
process the iterations.

If enabled, then each iteration is processed as a separate subordinate job,
enabling concurrent execution ofmultiple iterations. This option should
only be enabled if the order of iteration processing is not important.

Column The column that contains the values to iterate over. Use Table.Column
syntax to specify the column. Multiple-level lookups can be used.

For example, if you specify Dept.Region, then the task will be processed
once for each unique region value in the column (after applying any filter
to limit the list of values).

Group By Optional. By default, the group by column is the same as the iteration
column, so that the task is processed once for each unique value in the
iteration column. However, if needed, you can specify a different grouping
level.

You can use any column or columns that would be valid as the "sum by"
level for an Axiom query, where the primary table is the table specified for
the iteration column.

Order By Optional. By default, the values are sorted based on the iteration column,
in ascending order. You can specify a different sort column, or use the
same sort column but change the order to descending.

The sort order is ascending unless the keyword desc is used to specify
descending order. For example:

Dept.Dept desc

Filter Optional. A filter criteria statement to limit the list of values for the iterative
processing. You can use any filter that is valid against the source table (the
table of the iteration column).

Active Directory Import task

This task imports users from Active Directory groups into Axiom Cost Accounting security. For more
information on using Active Directory integration with Axiom Cost Accounting, see the Security Guide.

This task has three tabs of settings: Source Directory, Notification, and Preview Import.

NOTE: The user running this task must be an administrator or have the Administer Security
permission.
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For Cloud Service systems, the Active Directory Import task can import users from your local Active
Directory by use of the Axiom Cloud Integration Service. If you have a remote data connection that is
enabled for user authentication, this task will use that connection when the job is executed by Scheduler.

� Source Directory tab
On this tab, you specify the domain to import from and the groups to import.

Item Description

Domain or
Server

Select either Domain or Server to specify the source domain for the import.
l If you select Domain, enter the name of the domain.
l If you select Server, enter the name of the domain controller server.

The server option is available in case you are not currently logged into the
source domain, and your current domain does not have access to the source
domain. In this case, you must use domain credentials in order to access the
source domain.

Only one domain can be selected per import task. If you want to import users
from multiple domains into an Axiom Cost Accounting system, then you must
createmultiple import tasks.

Credentials Specifies the credentials to use when accessing Active Directory for the import.
Select one of the following:
l Use process credentials: (Default) Use the credentials of the network service

account for Axiom Scheduler Server (on-premise installations) or Axiom
Cloud Integration Service (Cloud Service systems).

l Specify domain credentials: Enter the credentials of a specified domain User
and Password. This option is required if you identified the source domain
using the server name instead of the domain name.

Never Enable
Users

Specifies whether the import enables imported users as part of the process:
l If unchecked (default), then newly imported users are enabled as part of the

import. Additionally, any existing imported users who have been changed to
disabled are re-enabled.

l If checked, then newly imported users are not enabled as part of the import.
A security administrator must modify the security settings after the import is
complete to enable the new users. Existing imported users retain their
current enabled status.
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Item Description

Groups to
import

The Active Directory groups for which members will be imported into Axiom
Cost Accounting Security.
l Click Add to select from a list of groups for the specified domain. If the

specified domain name is not valid or if Axiom Cost Accounting cannot
connect to it, then an error will result when attempting to add groups.

l If you need to remove a group, select the group and click Remove.

RoleMapping Click this button to map Active Directory groups to Axiom Cost Accounting
security roles and to user types. If a mapping exists for a group, then when
users are imported for that group they are automatically assigned to the
mapped role. You can map each group to multiple roles.

In the Role Mapping dialog, click Add mapping (the plus icon) to add a role
mapping. Then complete the following:
l In theDirectory Group column, select the Active Directory group to be

mapped.
l In the Axiom Role column, select the role to be assigned to users in that

group. If you want to map the group to more than one role, add another
mapping row. You can select None if the users should not be assigned to any
role.

l In theUser Type column, select the license type for the imported users. The
default license type is Standard.

If no mappings are defined for a group, then users in that group are not
assigned to any roles when they are imported, and the user type is set to
Standard.

To remove a role mapping, select themapping in the grid and then click Remove
mapping (the X icon). If users have already been imported using this role
mapping, removing themapping will not remove the users from the role in
subsequent imports.

NOTE: If a user belongs to multiple imported Active Directory groups, and the
groups do not have the same assigned user type, then the user will be assigned
one of the user types.

� Notification tab
On this tab, you specify users to be notified when changes aremade in Axiom Cost Accounting Security
due to the import.

Type in one or more email addresses to be notified. Separatemultiple addresses with a semi-colon. For
example:

jdoe@axiomepm.com;jsmith@axiomepm.com
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When the import task is run, if any users are created or modified in the Axiom Cost Accounting system,
an email notification will be sent to the addresses specified here. The email summarizes the changes
made. This email notification is independent of any job-level notification settings (which notify based on
overall job completion or failure).

We recommend setting up this task-level notification to send emails to the security administrator(s)
responsible for maintaining the security settings in Axiom Cost Accounting, so that he or she can define
security settings for newly added users, validate changes made to existing users, and perform any other
follow-up tasks.

Scheduler job variables can be used in this setting.

� Preview Import tab
On this tab, you can preview the import results to test that the import is set up as desired.

To preview the results, click Preview. Axiom Cost Accounting processes the import task but does not
actually make the changes to the system. Instead, the tab displays a summary of the changes that would
result.

The preview shows a list of users that would be added, changed, or disabled.

NOTE: The preview is always executed locally, even for Cloud Service systems. The remote data
connection to the Cloud Integration Service is only used when the task is executed by Scheduler.

Collect Worksheets task

This task collects sheets from multiple source workbooks and combines them into a single target
workbook. You can then save the target workbook to a specified file location, and/or email the
workbook.

NOTE: This task is primarily intended for backward-compatibility only. Themain method of
performing a file collect operation is to use the file processing feature with the File Processing
Scheduler task. For more information on setting up a file collect report using file processing, see the
Axiom File Setup Guide.

Typically, this task would be used at the end of a job with multiple File Processing tasks, to take the
results of those tasks and collect them into a single workbook.

Administrator's Guide 2019.4 Axiom Cost Accounting │ 376



Item Description

Save or Email
Workbook

Specifies the delivery option for the target workbook. Select one of the
following:

l Save Workbook: The target workbook is saved to the specified output
folder.

l Email Workbook: The target workbook is emailed to the specified recipients.
The file is not saved anywhere on the file system.

l Save and Email Workbook: The target workbook is both saved and emailed.

� Target Workbook
Complete the following settings to define the target workbook:

Item Description

Output Folder The folder location where the target workbook will be saved (if you are saving
the workbook). Click the folder icon to select a folder location, or type a folder
location.

If the specified folder does not already exist, Axiom Cost Accounting attempts to
create it.

Job variables can be used in this setting.

Output File
Name

The name of the target workbook. Job variables can be used in this setting.

File Type The file type of the target workbook. Select XLS, XLSX, or XLSM.

NOTE: PDF displays as an option, but it is not supported in this context.

� Email Settings
This section only applies if you are emailing the target workbook. The "From" address is always the
Scheduler default From address (as defined in the system configuration settings).

Item Description

To Enter the email addresses to receive the target workbook via email. Separate
multiple addresses with a semicolon.

Subject Line The subject line for the email.

Body Text The body text for the email.
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� Source Workbooks
In this section, you specify one or more source workbooks from which to collect worksheets. Workbooks
are identified by folder location. Within a folder location, you can specify one or more workbooks by
name, or by using wildcards, or by using *.* to collect all workbooks at the location.

All sheets in each source workbook will be collected. Ideally, you will be collecting from workbooks that
only contain relevant sheets (for example, no blank "Sheet2," etc.), and where the sheets have unique
names. If multiple workbooks have sheets with the same name, the sheets will be incremented by
number in the target workbook.

To add a workbook, click the Add button. In the Edit Workbooks Source dialog,
complete the settings as described below, then click OK to add the workbook to the
list.

To remove a workbook, select the workbook in the list and then click the Remove
button. Only one workbook can be selected at a time.

To change the order of workbooks, select the workbook in the list and then click the
arrow buttons to move the workbook up or down. Source workbooks are processed
in the order they are listed in the grid.

Item Description

Folder Path The folder location of the source workbook(s). Click the folder icon to select a
folder location.

NOTE: The Folder Path location must be accessible by the Scheduler service
user account. If you specify a network folder location using the Browse button,
the location is automatically entered as a UNC path. If you specify a C: drive
location, that will be evaluated as the C: drive of the Scheduler server.

Job variables can be used in this setting.

Workbooks The workbooks from which you want to collect worksheets, within the specified
folder path.

l Specify *.* if you want to collect all files in the folder path.
l Specify individual file names to collect from specific files. Separatemultiple

file names with semicolons.

You can use wildcards (* or ?) to specify groups of files that share naming
conventions. For example: North*.xls to collect all XLS files where the file
name starts with "North".

Only files with the following file types are valid to be collected: XLS, XLSX, XLSM.
If you are using wildcards, thematches must be valid file types, or else the task
will fail with an error.

Job variables can be used in this setting.
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Once you have saved a source workbook location, you can edit it by double-clicking the row.

Copy On Demand Plan Files task

This task copies on demand plan files from one file group to another. It performs the same actions as the
Copy On Demand Plan Files command in the Command Library.

This is an advanced feature and should only be used if it is the only way to achieve the desired
population of plan files between two related file groups. It is the responsibility of the solution designer to
ensure that the copied plan files will behave as expected in the target file group. For example, the plan file
must be designed to dynamically save to the appropriate tables and columns within the context of the
new file group.

The Copy On Demand Plan Files task uses two tabs to define the properties of the task.
l Options: Defines the options to be used for the copy operation
l Plan Files: Specifies the plan files to copy

� Options tab
The following options are available on the Options tab. Note that all of these options can be changed
dynamically by using system variables.

Item Description

Source File
Group

The file group to copy plan files from. Click the folder icon to select a file group.
You can select any on-demand file group, or any file group alias that currently
points to an on-demand file group.

Destination File
Group

The file group to copy plan files to. Click the folder icon to select a file group. You
can select any on-demand file group, or any file group alias that currently points
to an on-demand file group.

Keep original
plan file creator

Specifies whether the plan file creator for the copied plan files is set to the same
creator as the original plan files. By default, this option is enabled.

If this option is disabled, then the plan file creator for the copied plan files is set
to the user identity used by the Scheduler job when it is run.
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Item Description

Use default
template

Specifies whether the copied plan files have the option to adopt the default
template of the new file group. This is primarily intended to be used when
copying plan files to a file group that uses virtual, form-enabled plan files, so
that the copied plan files can be converted to virtual files and use the new
template.
l If disabled (default), then the target file group must contain copies of the

original templates that were used to create the plan files from the source file
group. If these templates are not present, then the copy process will fail.

l If enabled, then the copied plan files will be assigned a template as follows:
o If the target file group contains copies of the original templates that were

used to create the plan files from the source file group, the copied plan
files use those templates.

o If the target file group does not contain copies of the original templates,
the copied plan files use the default template specified for the target file
group in the file group properties.

If the target file group does not contain copies of the original templates and
does not have a designated default template, then the copy process will fail.

Copy plan file
attachments

Specifies whether plan file attachments are copied to the target file group when
a plan file is copied. By default, this option is enabled.

If this option is disabled, then plan file attachments will not be copied to the
target file group.
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Item Description

Save plan files
after copy

Specifies whether the new plan files are processed and saved in the target file
group after the copy is performed. This is intended to perform a save-to-
database within the context of the new file group. By default, this option is
disabled.

If you enable this option, then after the plan files are copied to the new file
group, they are opened, refreshed, and saved (including a save-to-database).
The refresh includes all active Axiom queries where Refresh during document
processing is enabled.

Regardless of whether this option is enabled, if it is ever intended to save the
copied plan files in the target file group, then they must be designed so that
they save data to the appropriate tables after being copied.

NOTES:
l If Process with Utilities is enabled for the target file group, then utility

processing is performed instead of normal processing. The default data
source is used.

l If you enable this option but also specify a Copy data utility, then the new
plan files are not processed and saved. Instead, the designated utility file is
processed for each new plan file.

Copy data utility Optional. Specifies a utility file to process for each copied plan file. You can select
any file in the Utilities folder of the target file group, or a file in the Reports
Library.

The primary purpose of this option is to handle copying virtual plan files
between file groups. Because the plan files are virtual, no data exists in the file
itself and therefore saving the new plan file will not populate data for the new
file group. Instead, you should create a utility file that queries in the necessary
data for the original plan file, then saves the necessary data for the new plan file
to the appropriate tables for the new file group. Reserved document variables
are available to return information in the utility file such as the old plan file code
and the new plan file code.

For more information, see Copy data utility.

NOTE: Save plan files after copymust be enabled in order to specify a copy
data utility. If a utility is specified, then the new plan files are not saved and
instead the utility file is processed for each new plan file.

Default Values Optional. This section can be used to apply default values to any columns in the
target plan code table, when the new record is created in the target file group.
For more information, see Defining default values.
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� Plan Files tab
On the Plan Files tab, specify the plan files from the source file group that you want to copy to the target
file group. There are three different options that you can use to specify the plan files: Choose from list,
Use filter, and All.

Themost common option when copying plan files using Scheduler is to define a filter. You can
dynamically copy a subset of designated plan files using the filter. If the Scheduler task is triggered by
using RunEvent, you can pass in the filter from the source of the RunEvent (such as an Axiom form).

Copy a filtered set of plan files
To use a filter to copy a subset of plan files, select Use Filter. When the Scheduler task is executed, Axiom
Cost Accounting will process only the plan files that meet the filter. You can specify the filter directly, or
use a job variable.

To specify the filter, click the Filter Wizard button. You can also manually type a filter criteria statement
into the filter box. The filter must use the plan code table of the source file group, or a lookup table. For
example: CapReq2018.Transfer=1, where CapReq is the plan code table.

Once you have entered a filter, you can click Refresh plan file list to show the plan files that currently
match the filter. The refresh feature is intended to help you determine whether you have defined the
filter correctly.

If you want to set the filter dynamically, you can use the Filter system variable to override the filter
defined in the task. This is intended for use when running Scheduler jobs via RunEvent. If a variable value
is specified when triggering the event, such as the value CapReq2018.CapReq IN (45,67,98) , then
that filter statement is used to determine the plan files to be copied instead of the filter defined in the
task.

Copy all plan files
To copy all plan files, select All. When the Scheduler task is executed, Axiom Cost Accounting will copy all
plan files in the file group (except for those hidden via the Show on List column). This is not a common
use case for the copy feature, but can be used if needed.

Copy selected plan files
To copy certain plan files, select Choose from list, and then select the check boxes for the plan files that
you want to copy. When the Scheduler task is executed, Axiom Cost Accounting will copy only the
selected plan files. This is not a common use case for the copy feature, but can be used if needed.

NOTE: This option is not available when using a file group alias as the source file group for the task.
This is because the alias could change to point to any file group, which could result in a different list of
plan files.
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� Defining default values
When the copy action is performed, the columns for the new record are populated as follows:

l If a value has been defined for a column in theDefault Values section, that value is used.
l Otherwise, the value from the original record in the source file group is used. This only occurs if

the column names match in the source and target tables, and if the column in the target table is a
compatible data type to accept the copied value.

If a column exists in the source table but not the target table, that value is ignored and does not cause an
error. If a column exists in the target table but not in the source table, then it is only populated during
the copy action if a default value has been defined. If the target table contains columns with lookup
relationships, those columns must be populated with valid values (either from the original record or by
using default values) or else the copy action will fail.

To define default values for the new records:
l Click the plus button to add a new column/value pair to theDefault Values section.

l In the left-hand box, type the name of the column in the target plan code table. For example:
SourceID. Do not use Table.Column syntax.

l In the right-hand box, type the value to be placed in this column. You can enter a "hard-coded"
value, or you can enter the name of a column from the source plan code table in brackets to use
the value from that column. For example, [CapID]. The column reference is only necessary if you
want the source column value to be placed in a column that has a different name than the source
column. If the columns have the same name, the value will be copied automatically as noted
previously in this section.

For both the column name and the value, you can use file group variables via a file group alias. Axiom
Cost Accounting looks up the current target of the alias, and finds the current value of the designated
variable within that file group. Built-in variables and custom variables can both be used. To reference a
variable, use the following syntax:

{FileGroupAliasName.VariableName}

For example: {CP_CurrentYear.FileGroupYear} returns the file group year for the file group
that is currently the target of the CP_CurrentYear alias.

Scheduler job variables can also be used in the column name and in the value.

� Overriding task settings using system variables
All of the settings for the Copy On Demand Plan Files task can be overridden using system variables. This
is intended for use when the task is being triggered by RunEvent (such as from within an Axiom form),
and you want to pass in variable values to determine how the task is run.

The variable names for this task are as follows:
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Variable Description

CopyDataSourceFileGroupID Overrides the Source File Group. Must be set to a valid file group ID.
File group names or alias names cannot be used.

CopyDataTargetFileGroupID Overrides theDestination File Group. Must be set to a valid file
group ID. File group names or alias names cannot be used.

CopyDataUtilityPath Overrides the Copy data utility. Must be set to a valid document
path in Axiom Cost Accounting.

Filter Overrides the Plan File Filter to specify the plan files to copy. Must
be set to a valid filter criteria statement.

KeepOriginalPlanFileCreator Overrides the option Keep original plan file creator. Must be set to
a valid Boolean value (True/False).

UseDefaultTemplate Overrides the option Use default template. Must be set to a valid
Boolean value (True/False).

CopyPlanFileAttachments Overrides the option Copy plan file attachments. Must be set to a
valid Boolean value (True/False).

SavePlanFilesAfterCopy Overrides the option Save plan files after copy. Must be set to a
valid Boolean value ( True/False).

To override task properties using these variables:
l Add the variables that you want to use to the Job Variables tab. For example, if you want to

override the source and target file groups, the copy data utility, and the plan file filter, then add
those variables to the Job Variables tab. You do not need to add a variable name if you do not
plan to override it.

Example Job Variables tab to override certain settings for the copy task

You do not need to define a default value for the variable. If the value is blank, then the setting
defined in the task is used. The corresponding task property will only be overridden if the variable
has a defined value.

l You do not need to add the variables to the task properties. The variables automatically overwrite
the task properties if they have defined values.
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l When configuring RunEvent, define values for the variables as needed. For example, you could
have a form where you allow the user to select the source and target file group for the copy
action. Based on the user's selected file group names, you can use the GetFileGroupID function to
determine the IDs for those file groups. You can then pass those IDs as variable values for the
variables CopyDataSourceFileGroupID and CopyDataTargetFileGroupID.

Example RunEvent properties to pass certain variable values to the copy task

� Plan file process considerations
If the target file group has an active plan file process, the new plan file is started in that process as part of
the plan file creation. The process initiator for the plan file is set as follows:

l If the plan file process has a designated Process Initiator Column, the user listed in that column is
the process initiator.

l If the plan file process does not have a Process Initiator Column, or the column value is blank,
then:

o If Keep original plan file creator is enabled for the command, then the original plan file
creator is the process initiator.

o Otherwise, the user performing the copy operation is the process initiator.

Administrator's Guide 2019.4 Axiom Cost Accounting │ 385



� Copy data utility
If a Copy data utility is specified, this processing is performed as follows:

l The selected plan files are first copied to the new file group. If the plan files are virtual, then the
placeholder document records are copied instead of physical plan files.

l The utility file is opened once before processing begins. Any data lookups or Axiom queries that
are configured to refresh on open are executed at that time.

l The utility file is then iteratively processed for each new plan file as follows:
o Document variables are set in the utility, and the workbook is calculated.
o Axiom queries set to Refresh during document processing are refreshed.
o A save-to-database is executed.

The utility file is not closed and reopened for each new plan file. All processing occurs within the same file
session, similar to when performing multipass file processing.

The following reserved document variables are available to the utility file, to be returned using
GetDocumentInfo. These variables return necessary information about the copied plan files and the
source and target file groups.

Variable Description

SourceFileGroupID The ID of the source file group. You can use this ID in functions such as
GetFileGroupVariable—for example, to return the name of the data table
to query from the source file group.

SourcePlanCode The plan code of the original plan file from the source file group. You can
use this code to filter Axiom queries to return data for the original plan file.

TargetFileGroupID The ID of the target file group. You can use this ID in functions such as
GetFileGroupVariable—for example, to return the name of the data table
to save data to for the target file group.

TargetPlanCode The plan code of the new plan file in the target file group. You can use this
code to save data for the new plan file.

For example, GetDocumentInfo("Variable","SourceFileGroupID") returns the ID of the source
file group.

Create Plan Files task

This task creates plan files for a file group. It works the sameway as the Create Plan Files utility that is
available from the file group menu.

This task has two tabs of settings in the Task Details area: General and Plan Files.
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NOTE: If you are using Create Plan Files to create new on-demand plan files, those plan files will be
automatically started in the designated Plan File Process for the file group. This only applies when
creating a brand new plan file. If an existing plan file is overwritten, its process status will be left as is.

� General tab
The following settings are available on the General tab:

Item Description

Select File Group The file group for which plan files will be created. You can select any file group or
file group alias.

NOTE: If you select an alias, then you cannot select individual plan files on the
Plan Files tab. Only theUse Filter and All options are supported for use with
aliases. This is because the alias could change to point to any file group, which
could result in a different list of plan files.

Overwrite
existing plan
files?

By default, this option is not selected, which means that existing plan files will
not be overwritten, even if the plan file is selected to be created.

If selected, existing plan files will be overwritten.

� Plan Files tab
On the Plan Files tab, specify the plan files that you want to create. This tab lists all plan codes that you
have the right to access. (If a plan code has been set to False in the designated Show On List Column for
the plan code table, then it is not available in this list.)

You can create plan files in any of the following ways:
l Create all plan files: To create all plan files, select All. This will cause all plan files to be created, for

all existing and future plan codes.

Alternatively, you can select Choose from list and then select the check box in the column header,
causing all plan codes to be selected, but then the list of plan codes is fixed and will not adjust for
any future changes. For example, if you add a new department in the future, that new
department will only be created by this task if you use the All option.
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l Create selected plan files: To create certain plan files, select Choose from list and then select the
check boxes for the desired plan codes.

To find the plan files you are looking for, you can sort, filter, and group the list using standard
Axiom grid features. You can show additional columns and hide columns by right-clicking in the
column header. If you have filtered the list, you can select the check box in the header to select
only the plan codes that currently display in the dialog.

NOTE: This option is not available when using a file group alias as the selected file group for
the task. This is because the alias could change to point to any file group, which could result in
a different list of plan files.

l Create a subset of plan files using a filter: To use a filter to create a subset of plan files, select
Use filter, and then type a filter into the filter box. You can also use the Filter Wizard to build the
filter. The filter must use the plan code table or a reference table that the plan code table links to.
For example: DEPT.Region='West'.

Once you have entered a filter, you can click Refresh plan file list to show only those plan codes
that currently match the filter. This feature is to help you determine whether you have defined the
filter as intended. The filter will be applied to the list of plan codes when the Scheduler job is
processed, so if changes have been made to the plan code table since then, the actual list of plan
files processed will reflect those changes.

You can also use a job variable for the filter. For example, you can define a job variable named
"filter" and then place the text {filter} in the filter box. This is intended for use when running
Scheduler jobs by using the RunEvent function. If a value is specified in the RunEvent function,
such as "Filter=dept.region='west'", then that filter will be used in place of the {filter} variable
to determine the list of plan files to be created.

NOTE: If you use a variable, and you leave the default value for that variable blank within the
Job Variables tab, then all plan codes will be created if no value is passed by the RunEvent
function (or if the value is invalid). You may want to define a default filter that results in no
values (such as 1=0), so that plan files are only created if a valid filter value is passed.

IMPORTANT: For all of these options, theOverwrite existing plan files option on the General tab
determines whether all selected plan files are created, or only the plan files that do not already exist.

Echo task

This task is used for testing purposes only, to check whether a Scheduler server is running and
operational. The task sends a message to the Scheduler server, and asks it to send themessage back (an
"echo"). If successful, themessage displays in the job results. No other action is performed.
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Item Description

Message to Echo Themessage to send to the Scheduler server for testing.

Job variables can be used in this setting.

Sleep Time The time to pause in between message echoes, in seconds. Scheduler will echo
themessage once, then wait the specified sleep time, then echo themessage
again.

Execute Command Adapter task

This task executes a selected command from the Command Library.

� Task properties
This task has one property named Command Name that specifies the command to execute.

To select a command to execute:
1. Click Edit Command.

2. In the Shortcut Properties dialog, click the browse button [...] to the right of the Shortcut Target
box.

3. In the Axiom Explorer dialog, select the desired command from the Command Library, then click
Open.

This returns you to the Shortcut Properties dialog. The selected command is now listed in the
Shortcut Target box, and the Shortcut Parameters section displays the parameters for the
command.

4. Complete the Shortcut Parameters for the command as needed. The available parameters
depend on the selected command.

You can later edit the shortcut parameters or select a different command by clicking Edit Command.

Execute SQL Command task

This task runs a SQL statement on an Axiom database. If needed, you can also use this task in a user-
defined job to run any valid SQL statement on an Axiom database.

NOTE: The SQL statement in this task will be run as the Axiom database user, regardless of which
user executes the job.

This task has the following settings:
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Item Description

Source Axiom
Database

Select the database on which to run the SQL statement:
l Current system database: The database for the current system.
l Current audit database: The corresponding audit database for the current

system.

SQL Command
Text

Enter any valid SQL statement to be run against the specified database.

To validate the syntax of the SQL statement, click the Check SQL syntax button
. Axiom Cost Accounting sends the statement to your database server to see

if the statement can be parsed, resulting in either a success message or an error
message.

Job variables can be used in the SQL statement. The Check SQL syntax button is
not available if the statement uses variables.

Export ETL Package task

This task exports data from Axiom Cost Accounting to an external database (same as executing an export
from the Exports Library).

This task has one setting, Select ETL Export Package. This is the name of the export package to process.
You can select any export that is defined in the current system.

File Processing task

This task performs file processing on a specified report file or file group utility. The file must already be
enabled for file processing. You can use the file processing settings that are already in the file, or you can
override any setting.

The following settings must be completed for the task:

Item Description

File to Process The report to process for the task. Click the Browse button to open the Axiom
Explorer dialog, and then select a report to process.

Only one report can be selected for each File Processing task. If you want to
process multiple reports, you can add multiple File Processing tasks to the
Scheduler job.

TIP: Once the file is selected, only the file name displays in the task. If you want
to know the folder location of the selected file, hover your cursor over the field.
The folder location is listed in the tooltip.
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Item Description

Process
Multipass

Specifies whether the report will be run using multipass processing.
l If this option is selected, multipass processing is performed. This is

equivalent to selecting File Output > File Processing > Process File
Multipass.

l Otherwise, multipass processing is not performed and multipass settings do
not display in the task. This is equivalent to selecting File Output > File
Processing > Process File.

NOTE: If you select Process Multipass, but the file does not have any defined
multipass settings, then you must override the blank multipass settings for the
file and define them in the equivalent of "advanced mode." If you want to use
"basic mode" settings (specify only a source column and Axiom Cost Accounting
automatically completes the rest of the settings for you), then you should edit
the file to define the basic modemultipass settings so that they can be inherited
by the task.

Enable iterative
calculation while
processing

Specifies whether iterative calculations are enabled for the file during
processing. In most cases you will leave this option disabled.

If this option is selected, then iterative calculations are enabled for the file
during the Axiom query refresh process. The iterative calculation settings are
fixed at a maximum of 100 iterations and a maximum change value of .001.

For more information on iterative calculations, see theMicrosoft Excel Help.

� Advanced options
This section only displays if multipass processing is enabled for the task, and the task uses settings that
are eligible for parallel processing. Click on the down arrow next to the title to expand the section and
view the options.

Parallel processing for file processing tasks is performed based on multipass passes. With certain task
settings, multiple passes can be separated into sub-jobs, which can then be processed at the same time
(in parallel). This can improve the performance of the task.

For example, imagine that you aremultipass processing a file by department. If the task is processed
sequentially, then the task would process Dept 100 and finish it, then move to Dept 110 and finish it, etc.
When parallel processing is used instead, Depts 100-199 can be separated into one sub-job, Depts 200-
299 into another sub-job, etc. Because the sub-jobs are processed in parallel, multiple departments are
processed at the same time, so the overall task can completemore quickly.
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Item Description

Maximum
Parallel Jobs

Themaximum number of subordinate jobs to run in parallel. The default
number is 4.

This is the total number of sub-jobs that can be run at the same time for this
task. Ultimately the number of sub-jobs that are run in parallel depends on the
number of Scheduler threads that have been configured for use at your
organization, and the number of Scheduler threads that are currently available
(threads that are not processing other higher-priority jobs).

Processing Batch
Size

The number ofmultipass passes to include in each sub-job at a time. The
default number is 10 for eligible snapshot and export processes, and 7000 for
eligible save-to-database processes (save once at end).

Passes are determined based on themultipass list of items. For example, if you
are processing by department (DEPT.DEPT), then each department is a separate
pass. If the batch size is set to 10, then each sub-job would process 10
departments at a time.

In most cases, the default settings are sufficient. If you are experiencing lengthy
processing times and want to optimize performance, you can adjust this setting
as follows: divide the number of passes by the number of available Scheduler
threads. For example, if there will be 100 passes and there are 4 Scheduler
threads, set the batch size to 25.

NOTES:
l For save processes, only "save once at end" processes are eligible for parallel processing. In

this case, the records to be saved to the database are extracted after each pass to a central
temporary table. Once all passes are complete, then all records are saved to the database
from the temporary table. Save processes where data is saved directly after each pass are not
eligible, because these processes may depend on sequential processing.

l There is no way to disable parallel processing if the task is eligible; however, you can adjust the
parallel processing settings if desired.

� File processing settings
Once you have selected a file to process, the file processing settings from that file display within the task
as read-only. You can leave the settings as they are, or you can override any setting.

l To override a setting, select theOverride check box to the right of the setting. The setting
becomes editable, and you can change it. The change only applies to the file processing task—the
setting remains unchanged within the file.
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l If you override a setting, make sure that any related settings make sense in the context of the
change. For example, if File Generation is set toMultiple Output Files, and you override it to be
Single Output File, then you should also check the Sheet Names setting to make sure that you
will end up with unique sheet names within the file.

NOTE: If the target file for the task uses File Collect or Batch processing, then it is not possible to
override the settings on the File Collect Configuration Sheet or the Batch Control Sheet.

For more details on file processing settings, see the Axiom File Setup Guide.

Note the following about specific settings for the task:
l TheOutput Folder location must be accessible by the Scheduler service user account. If you

specify a network folder location using the Browse button, the location is automatically entered as
a UNC path. If you specify a C: drive location, that location will be evaluated as the C: drive of the
Scheduler server.

l If the file processing type is Print, the Scheduler server(s) must be configured to access the
specified printer. This may require the assistance of your IT department.

Job variables can be used in any file processing setting that accepts a typed user input.

� Batch variables
If the file has defined batch variables, you can specify variable values to be used for the file processing
task. When the task is executed, any specified variable values are temporarily placed within the file,
within the designated cell for that variable value. The file can be set up to use the variable value in some
way during processing.

Item Description

Variable Names The names of the variables, as defined in the File Processing Control Sheet for
the source file. If no names are listed, then no variables are defined in the file.

Variable Values The variable values to be placed within the file when the file processing task is
executed.

Job variables can be used in the batch variable settings. For example, a job variable can be used as the
value for a batch variable.

Import ETL Package task

This task imports data into Axiom Cost Accounting (same as executing an import from the Imports
menu).
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NOTE: If the import package is configured to Ignore lookup and key errors, then if errors are found
the execution status of the job will be Partial Success. This will trigger an email notification if the job is
configured to notify only on error.

Item Description

Select ETL
Import Package

The import package to process. You can select any import that is defined in the
current system.

Source Filename The path and name of the source file. This option only applies in the following
situations:

l The import is configured to pull data from a source file (instead of a database
table).

l The import is configured to prompt the user for the source file during
execution.

If the import is configured to always use the same source file, then that file
displays for reference in the Source Filename box, but it is grayed out and
cannot be changed.

Job variables can be used in this setting.

Package
Variables

Specifies values for any variables used in the import package.

Variables are listed in the right-hand side of the grid. Use the drop-down list next
to the variable name to select from the defined set of choices, or type in a value.

Job variables can be used in this setting.

Process Plan Files task

This task processes plan files in a file group. It performs the same actions as the Process Plan Files utility
available from the file group menu.

The Process Plan Files task uses several tabs to define different options. The available tabs and the
options on those tabs depend on the selected Processing Mode on theOptions tab.

l Options: Defines the overall processing mode and processing options
l Plan Files: Specifies the plan files to process
l Axiom Queries: Specifies which Axiom queries to run in plan files (only applies to Normal

Processing)
l Utilities: Specifies which data source to use for utility processing (only applies to Process with

Utilities)
l Processing Variables: Defines variables to pass into plan files from Scheduler, and to Scheduler

from plan files
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� Options tab
The following options are available on the Options tab:

Item Description

Processing Mode Select the type of processing to perform:
l Normal Processing: Plan files are opened, refreshed, and saved. You

can configure which actions occur.
l Process with Utilities: A list of utilities is iteratively processed per plan

file. Utilities are opened, refreshed with data for each plan code, and
saved. This is primarily intended for processing form-enabled plan files
with embedded forms.

l Update Persistent Plan Files: Update existing plan files for text,
formatting, or formula fixes. This is an advanced feature.

l Process with Custom Utility: Plan files are processed using a custom
utility provided by Kaufman Hall Software Support. This is an advanced
feature.

The default processing mode is Normal Processing. However, if the file
group has been configured so that utility processing is the default
processing mode for that file group, then Process with Utilities is selected
by default.

Select File Group The file group for which plan files will be processed. You can select any file
group or file group alias.

NOTES:
l If you select a file group alias, then you cannot select individual plan

files on the Plan Files tab. Only theUse Filter and All options are
supported for use with aliases. This is because the alias could change to
point to any file group, which could result in a different list of plan files.

l File group scenarios are not available on the list cannot be processed
via Scheduler.

Advanced Options:
Worker Batch Size

Optional. Specifies the number of plan files to be processed in each batch.
The batch size must be a number between 10 and 100.

By default this is left blank, which means that the batch size is
automatically calculated based on the number of plan files to be processed
divided by the total number of threads on all enabled Scheduler servers.
Generally speaking, you should not customize this setting unless you are
advised to by Axiom Cost Accounting Support.

NOTE: Each batch of plan files is processed by a subordinate job. These
subordinate jobs are automatically created for the Process Plan Files task
and are processed in parallel, dependent on the number of Scheduler
threads that are available at any one time.
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Options for Normal Processing mode
If Normal Processing is the selected processing mode, the following additional options are available on
the Options tab:

Option Description

Save document
after processing

Specifies whether plan files are saved during processing. This option is selected
by default.

This option does not cause a save-to-database to be performed—that option
must be selected separately.

NOTES:
l If this option is not selected, then the utility will open the file as read-only

and will not attempt to acquire the document lock before processing.
l If the file group uses virtual plan files, this option does not apply because the

plan files cannot be saved. However, if the option is enabled, Axiom Cost
Accounting will attempt to acquire the document lock before processing,
which is not necessary. This option should not be enabled when processing
virtual plan files.

Run Save To
Database on
plan files after
processing

Specifies whether a save-to-database is performed in plan files during
processing. This option is selected by default.

This option does not cause the file itself to be saved—that option must be
selected separately. It is not required to save the file in order to perform a save-
to-database.

Create a plan file
restore point
before
processing

If selected, then a plan file restore point will be created before processing
begins. This option is not selected by default.

Restore points can be used to restore plan files to the state they were in before
changes weremade.

NOTE: If the file group uses virtual plan files, this option does not apply. Plan
files are not saved and therefore restore points are irrelevant.

Options for Process with Utilities
If Process with Utilities is the selected processing mode, there are no additional options on the Options
tab.

Plan files are not saved when using Process with Utilities, and plan file restore points are not created.
When using this mode, the processing is being performed in the utility files, not in the plan files, so it is
not necessary to save the plan files. Additionally, in most cases the plan files used with this mode are
virtual form-enabled plan files, so the save and restore options are irrelevant.
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Options for Update Persistent Plan Files
IfUpdate Persistent Plan Files is the selected processing mode, the following additional option is
available on the Options tab:

Option Description

Report File Click the Browse button to select the report file that is configured with the
PlanFileReconfig_ControlSheet. This file must be saved in the Reports Library.

This control sheet contains the settings that will be applied to plan files during
processing.

Plan files are always saved when using this processing option, and plan file restore points are always
created before processing. A save-to-database is not performed in this mode, so if you need to save
data, you should process plan files using Normal Processing after you have verified the results of the plan
file update.

Options for Process with Custom Utility
If Process with Custom Utility is the selected processing mode, the following additional options are
available on the Options tab:

Item Description

Report File Click the Browse button to select theMicrosoft Excel spreadsheet file that
contains the VBA custom utility. The file must be saved in the Reports Library.

VBAModule Select the VBA module to run as part of this utility. The drop-down list shows
the VBA modules available in the selected file.

VBA Function Select the VBA function to run as part of this utility. The drop-down list shows
the VBA functions available in the selected module.

Plan files are always saved when using this processing option, and plan file restore points are always
created before processing. A save-to-database is not performed in this mode, so if you need to save
data, you should process plan files using Normal Processing after you have verified the results of the
custom utility processing.

� Plan Files tab
On the Plan Files tab, specify the plan files that you want to process. There are three different options
that you can use to specify the plan files: Choose from list, Use filter, and All. You should use the option
that corresponds to howmany plan files you want to process—all plan files, or a subset of plan files. If
you want to process a subset of plan files, you can select individual files to process or you can use a filter
to define the subset.
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NOTES:
l If a plan file is locked by another user when the task is executed, then processing for that file

will fail. Failures are noted in the result history for the job.

l If a plan file has not yet been created for a particular plan code, then that plan code will not
display in this list and will be ignored when processing. Scheduler does not support creating
plan files as part of the Process Plan Files task (you must use the separate Create Plan Files
task for this purpose).

l If the file group uses a Show on List column, then any plan code that is set to Falsewill not
display in the plan file list and will be ignored when processing.

Process all plan files
To process all plan files, select All. The list of all plan files is generated each time the Scheduler task is
executed, so that if new plan files have been added then those new plan files will be included in the
processing (the reverse is also true if any plan files have been removed).

Alternatively, you can select Choose from list and then select the check box in the column header,
causing all current plan codes to be selected. However, in this case the list of selected plan codes is fixed
and therefore will not automatically adjust for any future changes.

Process selected plan files
To process certain plan files, select Choose from list, and then select the check boxes for the plan files
that you want to process. When the Scheduler task is executed, Axiom Cost Accounting will process only
the selected plan files.

To find the plan files you are looking for, you can sort, filter, and group the list using standard Axiom grid
features. You can show additional columns and hide columns by right-clicking in the column header. If
you have filtered the list, you can select the check box in the header to select only the plan files that
currently display in the dialog.

NOTE: This option is not available when using a file group alias as the selected file group for the task.
This is because the alias could change to point to any file group, which could result in a different list of
plan files.

Process a filtered set of plan files
To use a filter to process a subset of plan files, select Use Filter. When the Scheduler task is executed,
Axiom Cost Accounting will process only the plan files that meet the filter.

You can use the Filter Wizard to create the filter, or you can manually type a filter criteria statement into
the filter box. The filter must use the plan code table or a lookup table. For example: DEPT.Region='US
West'where Dept is the plan code table.
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Once you have entered a filter, you can click Refresh plan file list to show the plan files that currently
match the filter. The refresh feature is intended to help you determine whether you have defined the
filter correctly.

You can also use a job variable for the filter. For example, you can define a job variable named "filter" and
then place the text {filter} in the filter box. This is intended for use when running Scheduler jobs via
RunEvent. If a variable value is specified when the event is triggered, such as the value
dept.region='west', then that filter statement will replace the {filter} variable and will be used to
determine the list of plan files to be processed.

NOTE: If you use a variable, and you leave the default value for that variable blank within the Job
Variables tab, then all plan codes will be processed if no value is passed by the RunEvent function.
You may want to define a default filter that results in no values (such as 1=0), so that plan files are
only processed if a valid filter value is passed.

� Axiom Queries
On the Axiom Queries tab, select the queries that you want to run in the plan files. By default, all listed
queries are selected. This tab only applies when using Normal Processingmode.

If you do not want to run a particular query, you can clear the check box. You can select or clear
individual check boxes, or you can use the check box in the header to select or clear all queries currently
displayed in the list. You can sort, filter, and group the list using standard Axiom grid functionality.

Example Axiom Queries tab

The list of Axiom queries is based on the source templates that were used to create the plan files. Only
Axiom queries that meet the following criteria are eligible for selection:

l Active is set to On, or the setting uses a formula.
l Refresh during document processing is set to On.

Administrator's Guide 2019.4 Axiom Cost Accounting │ 399



If a query uses a formula for the Active setting, this means the query is dynamic and may or may not be
run, depending on how the formula resolves in each plan file to be processed. When a particular plan file
is processed, each selected query will be evaluated based on the current settings in that plan file. If both
Active and Refresh during document processing areOn for that plan file, then the query will be run. If
either or both settings areOff for that plan file, the query will not be run. You can tell whether a query is
dynamic or not by looking at theDynamic column in the query list.

If a query is not selected on this tab, then that query will not be run in any plan files during processing,
regardless of whether Active or Refresh during document processing are enabled in the plan file.

The plan file selection on the Plan Files tab affects the Axiom query list as follows:
l If you have selected individual plan files, then only the eligible queries for the source templates of

the selected plan files are shown.
l If you have selected All or Use Filter, then all eligible queries for all used templates are shown. If

the file group has templates that have not been used to create any plan files, then those
templates are not included in the list.

The listed queries are identified by template, worksheet, and query name. The following additional
properties are also listed for each query:

l Refresh On Open: Indicates whether the Axiom query is configured to refresh automatically when
the file is opened. This is for information purposes only, to help you determine whether the query
needs to be included in the processing. The Refresh on Open status is ignored by Process Plan
Files—if the query is selected it will be run along with the other selected queries, and if it is not
selected it will not be run.

l Dynamic: Indicates whether the query is dynamically enabled. Truemeans that the query uses a
formula for the Active setting.

NOTE: If a query is listed on this tab but it is grayed out and unavailable for selection, that means
that although the query is active (either directly or dynamically), the query is not eligible to be run
using Process Plan Files (because the setting Refresh during document processing is set to Off). This
query is listed for your information only, so that you understand the query cannot be run as part of
the process.

� Utilities tab
On theUtilities tab, select the ProcessPlanFileUtilities data source to use during processing. This data
source determines which utility files are processed and the processing order. This tab only applies when
using Process with Utilitiesmode.
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Example Utilities tab

For each template listed, use theUtilities Data Source field to select the data source to use for plan files
created from that template.

l If the template only has one data source, that data source is selected.
l If the template has multiple data sources, then the data sourcemarked as the default data source

is selected by default. If desired, you can use the drop-down list to select a different data source.

When plan files are processed, Axiom Cost Accounting reads the specified data source in each plan file to
determine the utilities to be processed for that plan file.

The plan file selection on the Plan Files tab affects the Utilities list as follows:
l If you have selected individual plan files, then only the templates used to create the selected plan

files are shown.
l If you have selected All or Use Filter, then all used templates are shown. If the file group has

templates that have not been used to create any plan files, then those templates are not included
in the list.

� Processing Variables
This tab can be used to define variables to pass into plan files before processing begins, and to pass
variables back to the Scheduler job after processing has been performed. This tab is optional and is only
used in special situations.

Pre-Processing Document Variables
This section can be used to pass document variables into plan files before processing. This can impact the
processing of plan files if the files are configured to use the variable values in someway.

For each pre-processing document variable, you can specify a variable name and a variable value. The
plan files must be set up with GetDocumentInfo functions that return the values for the specified
variables.
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To add a variable, click the Add button to add a row to the list. Complete the settings
for the variable as described below.

To remove a variable, select the variable in the list and then click the Remove button.
Only one variable can be selected at a time.

To edit the variable settings, double-click the applicable cell to make the cell contents editable. When you
are finished editing, you can press the Enter key or Tab key to exit the cell, or click outside of the cell.

Item Description

Variable Name The name of the variable. Do not enclose the variable name in curly brackets
(you are not using the variable here, you are defining its value).

Variable Value The value of the variable. The value can be a "hard-coded" value, or it can be a
job variable that will be resolved at time of processing.

If you use a job variable to define the value, the job variable must be enclosed
in curly brackets.

Pre-Processing Workbook Variables
This section can be used to pass values into plan files before processing. This can impact the processing
of plan files if the files are configured to use the values in someway.

For each pre-processing variable, you can specify a workbook location to place the value, and the value
to be placed.

Item Description

Workbook
Location

The location in the workbook for the value to be placed. Any existing value in
this location will be overwritten for the duration of the processing. If the file is
saved as part of the processing, then the value will be saved in the file.

The location can be specified using SheetName!CellRef syntax (for example:
Report!A13), or by using a named location in the file.

Formula The value to be placed in the specified workbook location. The value can be a
"hard-coded" value, or a formula, or a job variable that will be resolved at time
of processing.

If the value is a formula, the formula is placed into the target cell and calculated
in the plan file. The formula can be any formula that would be valid within a
spreadsheet in the Axiom client. This includes using Excel functions and Axiom
functions. The formula can also use job variables, which will be resolved before
placing the formula in the target cell.
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The specified location and value will apply to all plan files being processed by the task. If you are going to
use pre-processing variables, the location should be predefined in the template and therefore available
to all plan files built using that template. If the plan files will be built using multiple templates, then all
templates should be set up with the same designated location, or you should set up separate processing
tasks based on template type.

Post-Processing Workbook Variables
This section can be used to pass a value from plan files back to the Scheduler job after processing has
been performed. This can impact the processing of subsequent tasks in the job if those tasks are
configured to use the value in someway.

For each post-processing variable, you can specify the location in the workbook to find the value, and
the job variable to use that value.

NOTE: If this task processes multiple plan files, the resulting variable value will be from the last file
that was processed.

Item Description

Workbook
Location

The location in the workbook to find the value to be passed to Scheduler. This
value will become the value for the assigned job variable for the duration of
executing the current job (unless a later process within the same job overwrites
the value for the same job variable).

The location can be specified using SheetName!CellRef syntax (for example:
Report!A13), or by using a named location in the file.

Job Variable The job variable that you want to use the value in the specified workbook
location. Do not enclose the variable name in curly brackets (you are not using
the variable here, you are simply referencing the variable name).

If the job variable does not already exist in the job (on the Job Variables tab),
then it will be created. However, in most cases you will want the variable to be
already set up with a default value, so that the job does not have validation
errors that prevent saving.

The specified location and job variable will apply to all plan files being processed by the task. If you are
going to use post-processing variables, the location should be predefined in the template and therefore
available to all plan files built using that template. If the plan files will be built using multiple templates,
then all templates should be set up with the same designated location, or you should set up separate
processing tasks based on template type.

Even though the task may process many plan files, only the job variable value from the last-processed
plan file will be used. The plan files must be set up so that all plan files result in the same value after
processing, or else your results will vary depending on which plan file was the last file to be processed.
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Process Document List task

This task processes a user-defined set of documents. The process operation always calculates the files. In
addition, you can opt to run Axiom queries in the files, process alerts in the files, and then perform a
save-to-database and/or save the files.

You can process any Axiom-managed Excel files by using this task. The primary intent of the task is to
process files such as driver files or report utilities. For example, you may be using Axiom queries and
GetData functions in your driver files that need to be updated regularly. Rather than opening, refreshing,
and saving each driver file, you can use this task to define the set of files and schedule processing.

NOTES:
l Generally speaking, plan files should not be processed using this task. Instead, the Process

Plan Files task should be used.

l This task does not perform file processing actions on the file. File processing can be set up for
report files and driver files, and can be used to perform actions such as file delivery, using
standard or multipass processing. If you want to perform file processing using Scheduler, use
the File Processing task.

� Documents to process
Specify the documents to be processed when the task is run. Documents are processed sequentially in
the order listed.

To add a document, click the Add button. In the Axiom Explorer dialog,
select the file or files that you want to add, and then click Open.

To remove a document, select the document in the list and then click the
Remove button. Only one document can be selected at a time.

To change the order of documents, select the file in the list and then click
the arrow buttons to move the file up or down.

Only Axiom-managed Excel files are valid to be processed in the task.

Selecting a document using a file group alias
You may want to specify the document to process using a file group alias, so that the task does not have
to bemanually updated after rolling over to a new file group for a new year of planning. When you are
selecting a document in the Axiom Explorer dialog, you can expand the file group alias to see all of the
files in the current target of the alias.

For example, in the following screenshot, the file group alias Current Budget is expanded. Because the
alias currently points to the file group Budget 2018, the folders and files under the alias are from Budget
2018. When you select a file or folder, you can see the real file path in the top of Axiom Explorer.
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Selecting a document to process using a file group alias

When you select a document underneath an alias, the file path is written using alias syntax, so that the
Scheduler task will look for the document within the current target of the alias. This path is visible in the
tooltip that displays when you hover your cursor over a selected document.

File path using file group alias syntax

When the file group alias is updated to point to a new file group, the Scheduler task will use the file in the
new file group automatically. If the file does not exist in the new file group, the task will fail with an error.

� Processing Options
By default, both options are selected. Axiom queries are refreshed before the save-to-database occurs.

If neither option is selected, then the files are calculated and then saved.
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Item Description

Perform all enabled
Axiom Queries in
selected workbooks

If this option is selected, then all eligible Axiom queries in all selected files
will be refreshed when the task is run. This option is selected by default.

NOTE: In order to be eligible for processing, the query must be active, and
Refresh during document processingmust be enabled.

Enable iterative
calculation while
processing

Specifies whether iterative calculations are enabled for the file during
processing. In most cases you will leave this option disabled.

If this option is selected, then iterative calculations are enabled for the file
during the Axiom query refresh process. The iterative calculation settings
are fixed at a maximum of 100 iterations and a maximum change value of
.001.

For more information on iterative calculations, see theMicrosoft Excel
Help.

Save document after
processing

If selected, then files will be saved after processing. This option is selected
by default.

This option does not cause a save-to-database to be performed—that
option must be selected separately.

NOTE: If this option is not selected, then the utility will open the file as
read-only and will not attempt to acquire the document lock before
processing.

Run Save To Database
on plan files after
processing

If selected, then a save-to-database will be performed after processing.
This option is selected by default.

This option does not cause the file itself to be saved—that option must be
selected separately. It is not required to save the file in order to perform a
save-to-database.

Process alerts in
selected workbooks

If selected, then alerts in the file will be processed. The file must contain an
Alert Control Sheet and one or more alerts must be defined in the file.

If Axiom queries are enabled for processing as well, the queries will be run
before alerts are processed.

� Pre-Processing Document Variables
This section can be used to pass document variables into the target files before processing. This can
impact processing if the files are configured to use the variable values in someway, such as to filter an
Axiom query.

For each pre-processing document variable, you can specify a variable name and a variable value. The
target file must be set up with GetDocumentInfo functions that return the values for the specified
variables.
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To add a variable, click the Add button to add a row to the list. Complete the settings
for the variable as described below.

To remove a variable, select the variable in the list and then click the Remove button.
Only one variable can be selected at a time.

To edit the variable settings, double-click the applicable cell to make the cell contents editable. When you
are finished editing, you can press the Enter key or Tab key to exit the cell, or click outside of the cell.

Item Description

Variable Name The name of the variable. Do not enclose the variable name in curly brackets
(you are not using the variable here, you are defining its value).

Variable Value The value of the variable. The value can be a "hard-coded" value, or it can be a
job variable that will be resolved at time of processing.

If you use a job variable to define the value, the job variable must be enclosed
in curly brackets.

The following example screenshot defines the value for the document variable Dept. The value is defined
using the value of a Scheduler job variable {Dept}. A value for Dept can be passed into the Scheduler
job when the job is started, and then passed into the target file using the document variable.

� Pre-Processing Workbook Variables
This section can be used to pass values into the file before processing. This can impact processing if the
files are configured to use the values in someway. For each pre-processing variable, you can specify a
workbook location to place the value, and the value to be placed.

NOTE: The specified value will be placed in all files listed to process. Therefore, unless all files are set
up to use the same location and the sameway of deriving the value, you will need to create a
separate Process Document List task for each file. If you are not using pre-processing variables, then
this does not matter.
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To add a variable, click the Add button to add a row to the list. Complete the settings
for the variable as described below.

To remove a variable, select the variable in the list and then click the Remove button.
Only one variable can be selected at a time.

To change the order of variables, select the variable in the list and then click the
arrow buttons to move the variable up or down.

To edit the variable settings, double-click the applicable cell to make the cell contents editable. When you
are finished editing, you can press the Enter key or Tab key to exit the cell, or click outside of the cell.

Item Description

Workbook
Location

The location in the workbook for the value to be placed. Any existing value in
this location will be overwritten for the duration of the processing. If the file is
saved as part of the processing, the value will be saved in the file.

The location can be specified using SheetName!CellRef syntax (for example:
Report!A13), or by using a named location in the file.

Formula The value to be placed in the specified workbook location. The value can be a
"hard-coded" value, or a formula, or a job variable that will be resolved at time
of processing.

If the value is a formula, the formula is placed into the target cell and calculated
in the target file. The formula can be any formula that would be valid within a
spreadsheet in the Axiom client. This includes using Excel functions and Axiom
functions. The formula can also use job variables, which will be resolved before
placing the formula in the target cell.

� Post-Processing Workbook Variables
This section can be used to pass a value from the file back to Scheduler after processing has been
performed. This can impact the processing of subsequent tasks in the job if those tasks are configured to
use the value in someway. For each post-processing variable, you can specify the location in the
workbook to find the value, and the job variable to use that value.

NOTES:
l If this task processes multiple documents, the resulting variable value will be from the last

document processed.

l If the task is run as a sub-job, then the post-processing variable is not passed back to the
"parent" job. The task must be executed as a regular task within the job in order to pass the
variable value back to the job.
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To add a variable, click the Add button to add a row to the list. Complete the settings
for the variable as described below.

To remove a variable, select the variable in the list and then click the Remove button.
Only one variable can be selected at a time.

To change the order of variables, select the variable in the list and then click the
arrow buttons to move the variable up or down.

To edit the variable settings, double-click the applicable cell to make the cell contents editable. When you
are finished editing, you can press the Enter key or Tab key to exit the cell, or click outside of the cell.

Item Description

Workbook
Location

The location in the workbook to find the value to be passed to Scheduler. This
value will become the value for the assigned job variable for the duration of
executing the current job (unless a later process within the same job overwrites
the value for the same job variable).

The location can be specified using SheetName!CellRef syntax (for example:
Report!A13), or by using a named location in the file.

Job Variable The job variable that you want to use the value in the specified workbook
location. Do not enclose the variable name in curly brackets (you are not using
the variable here, you are simply referencing the variable name).

If the job variable does not already exist in the job (on the Job Variables tab),
then it will be created when the job is executed. However, in most cases you will
want the variable to be already set up with a default value, so that the job does
not have validation errors that prevent saving.

Process Template List task

This task processes a user-defined list of file group templates. During processing, any Axiom queries with
Refresh during template processing enabled are executed and time-stamped, and then the template
files are saved.

The primary purpose of this task is to enable use of time-stamped Axiom queries with virtual plan files.
Because virtual plan files are re-created from template each time they are accessed, Axiom queries
cannot be time-stamped within the plan files. Virtual plan files can use the time stamp from the template,
but under normal circumstances, Axiom queries are not time-stamped when they are run in templates.
However, when Axiom queries are run during template processing, the Last refresh time for the query is
updated, which means that the queries can be configured to only run if the primary table has changed.

To use this task to enable time-stamped Axiom queries for virtual plan files, do the following:
l In the template, enable Refresh only if primary table changed since last refresh and Refresh

during template processing for the Axiom queries that you want to be time-stamped.
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l In Scheduler, create a job with a Process Template List task and add the template to the task.
Define a scheduling rule for the job as appropriate. For example, you might want the template to
be processed nightly.

When the template is processed, the designated Axiom queries will be run if the primary table has
changed, and the time stamps are updated. When a virtual plan file that uses this template is opened,
the queries will not be run again if the primary table has not changed.

This task should only be used to process Axiom queries that meet the requirements of time-stamped
queries.

� Templates to process
Specify the templates to be processed when the task is run. Templates are processed sequentially in the
order listed. If you havemultiple templates to process (in the same or different file groups), you can run
them all in the same task.

To add a template, click the Add button. In the Axiom Explorer dialog,
select the file or files that you want to add, and then click Open.

To remove a template, select the file in the list and then click the Remove
button. Only one file can be selected at a time.

To change the order of templates, select the file in the list and then click the
arrow buttons to move the file up or down.

Normal template behavior rules apply during processing. For example, save-to-database and action
codes are not run in templates. The only exception to normal template behavior during this task is that
any executed Axiom queries will be time stamped.

Selecting a template using a file group alias
You may want to specify the template to process using a file group alias, so that the task does not have
to bemanually updated after rolling over to a new file group for a new year of planning. When you are
selecting a template in the Axiom Explorer dialog, you can expand the file group alias node to see all of
the files in the current target of the alias.

For example, in the following screenshot, the file group alias Current Budget is expanded. Because the
alias currently points to the file group Budget 2018, the folders and files under the alias are from Budget
2018. When you select a file or folder, you can see the real file path in the top of Axiom Explorer.
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Selecting a template to process using a file group alias

When you select a template underneath an alias, the file path is written using alias syntax, so that the
Scheduler task will look for the template within the current target of the alias. This path is visible in the
tooltip that displays when you hover your cursor over a selected template.

File path using file group alias syntax

When the file group alias is updated to point to a new file group, the Scheduler task will use the file in the
new file group automatically. If the file does not exist in the new file group, the task will fail with an error.

Purge System Data task

The Purge System Data task is intended to clean up old data in your system, to help keep your system
running efficiently.

NOTE: Scheduler automatically creates a system job for this task (System.SystemDataPurge), which
administrators can edit as needed.
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This task purges the following data when it is run:
l Scheduler job result history
l Scheduler and system email notifications
l System temp table data
l Audit history
l Alerts

For each category of data, you can specify a number of days of data to keep when the task is run. All
results older than the specified number of days will be deleted. Note that 0 days means that no data is
purged for that category.

Section Item Description

Scheduler
Results

Number of days to keep
result history

The number of days of job result history to keep
when the task is run. By default, this is set to 15
days.

SMTP Messages Number of days to keep
delivered messages and
attachment data

The number of days of delivered message data
to keep when the task is run. By default, this is
set to 15 days.

Temporary
Tables

Number of days to keep
temp table data

The number of days of temp table data to keep
when the task is run. By default, this is set to 15
days.

Audit History Number of days to keep
system history

The number of days of system audit history to
keep when the task is run. By default, this is set
to 15 days.

"System history" encompasses all audit data—
including prior document versions and deleted
documents—except table audit data.

Table History Number of days to keep
table history

The number of days of table audit history to
keep when the task is run. By default, this is set
to 15 days.

Table audit data is tracked for tables where
Audited is set to True.

Alerts Number of days to keep
alerts

The number of days of alerts to keep when the
task is run. By default, this is set to 60 days.

Job variables can be used in all of these settings.
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Each purge routine in the task is limited to purging a specific number of rows at a time (50000). If the
number of rows to be purged exceeds this limit, then the excess data is retained until the next time the
task is run. If you notice data in the database that you expected to be purged, most likely the amount of
data to be purged exceeded the limit, and the data will be purged next time the task is run.

� Other purged data
This task also cleans up the following items in your system:

l Deleted columns. When a column is deleted from a table in Axiom Cost Accounting, the column is
immediately deleted from the associated view (which prevents it from being accessed in the
system), but it remains in the base table. This task finishes the process of removing obsolete
columns from the base tables.

l Orphaned user folders. If the system contains any user folders that do not match up with existing
users, these folders are deleted. Although user folders are deleted when a user is deleted from
security, orphaned user folders can result from other processes, such as migrating a system
between different management databases.

These items are not associated with any specific task settings; the delete process is performed whenever
the task is executed.

Raise Event task

The Raise Event task can be used to trigger other Scheduler jobs for execution, using a named event
handler. This task has one required setting:

Item Description

Event Name Enter the name of the event that you want to raise for execution. This name
must match a defined event handler name in one or more other Scheduler jobs.

When this task is run, it looks for any jobs that contain the specified event
handler name. These jobs are added to the schedule and are eligible to be
processed immediately, depending on Scheduler thread availability and any
other higher-priority jobs already in the queue.

Event Variables
This section can be used to pass variables into the jobs triggered by the event handler. If the jobs are
configured to use the variables, these values can impact how the jobs are processed.

To add a variable, click the Add button to add a row to the list. Complete
the settings for the variable as described below.

To remove a variable, select the variable in the list and then click the
Remove button. Only one variable can be selected at a time.
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For each variable, you can specify a variable name and a variable value. To edit the variable settings,
double-click the applicable cell to make the cell contents editable. When you are finished editing, you can
press the Enter key or Tab key to exit the cell, or click outside of the cell.

Item Description

Variable Name The name of the variable. Do not enclose the variable name in curly brackets
(you are not using the variable here, you are defining its value).

Variable Value The value of the variable. The value can be a "hard-coded" value, or it can be a
job variable that will be resolved at time of processing.

If you use a job variable to define the value, the job variable must be enclosed
in curly brackets.

Run Excel Macro task

This task runs an Excel macro on an Axiom file.

NOTE: This task is no longer supported because it requires Excel processing on the Scheduler server.
It is still available on the task list, but cannot be executed.

Please contact Axiom Cost Accounting support if you need assistance with this task.

Item Description

Workbook Path The path and name of the file to run themacro on.

You can click the Browse button to navigate to the file.

Macro Name The name of themacro to run.

Macro
Arguments

If themacro takes arguments, you can enter the argument values here.

Click Add to add an argument, Remove to delete the selected argument, or
Clear to clear all arguments.

Job variables can be used in all of these settings.

Run Scheduler Job task

This task runs a specified Scheduler job as a subordinate job within the current job. The job containing
the Run Scheduler job task is the parent job, and the target job for the task is the child job.

By default, the parent job waits until the child job is complete before continuing to the next task in the
parent job. This means that tasks after the Run Scheduler Job task can be reference the results of the
child job. For example, the child job may perform a save-to-database. The subsequent tasks in the
parent job can access the data saved by the child job.
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� Task Control options
When you create the Run Scheduler Job task, the options in the Task Control section are pre-set as
follows:

l The option Create a Subordinate Job for this Task is grayed out. This is because the target job is
always run as a subordinate job.

l The optionWait for all Subordinate Jobs to complete before proceeding to the next Task is
enabled by default. This means that tasks after the Run Scheduler Job task can be dependent on
the target job and reference the results of that job. If you disable this option, then the parent job
will continue to the next task in the job immediately after creating the subordinate job—it will not
wait for the subordinate job to complete.

Keep in mind that it is not possible to stop processing tasks in the parent job based on the success or
failure of the child job. Although Scheduler jobs automatically stop processing if a task fails, the task in
this case is just the Run Scheduler Job task. As long as the child job can be successfully added to the
Scheduler queue for processing, the Run Scheduler Job task will report success. The ultimate success or
failure of that child job is not reported back to the parent job—the parent job only knows when the child
job is started and then stopped.

If needed, you can use the option Process task only if the value of this expression is true to detect
whether a subsequent task in the parent job should be processed. For example, if you know that the
child job saves a particular value to the database, you can check for the existence of that value to
determine whether to process the task. For more information on using this option, see Conditionally
processing tasks in a job.

� Target Scheduler job
In the Task Details section, use the Browse button to select the target Scheduler Job. You can select any
job that you have access to in the Scheduled Jobs Library.

When the Run Scheduler Job task is executed, it creates one or more subordinate jobs as needed to
execute the tasks in the target Scheduler job. As long asWait for all Subordinate Jobs to complete
before proceeding to the next Task remains enabled in the Task Control options, the parent job waits
for all subordinate jobs to be completed beforemoving on to the next task in the parent job.

NOTE: The user executing the job does not need to have security access to the target Scheduler job
for Run Scheduler Job. It is assumed that if the user can execute the parent job, the user should be
able to execute the target job.
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� Child Job Values
If the target job for the Run Scheduler Job task has defined job variables, those variables and their
default values are listed in this section. The default values are determined as follows:

l If the parent job and the child job have a variable with the same name, the default value is the
value defined in the parent job. This value will be passed to the child job and used when the child
job is run.

l Otherwise, the default value is the value defined in the child job.

To override a variable value, select theOverride check box and then click inside theOverride Value field
to enter a value. You can enter a hard-coded value or use a job variable from the parent job. Enter the
variable name in curly brackets to use that variable's value as the override value.

For example, imagine that both the parent job and the child job have a variable of {Dept}. In the parent
job, the value of {Dept} is set to 20000, and in the child job the value is set to 40000. The Run Scheduler
Job task will display the parent value of 20000 as the default value, and that value will be used when the
child job is executed.

Now imagine that the parent job has a variable of {StartDept} set to 20000, and the child job has a
variable of {Dept} set to 40000. In this case, the Run Scheduler Job task will display the value of {Dept}
as defined in the child job (40000). If you want to use the parent job value for {StartDept} instead,
then you must select the Override check box and enter {StartDept} as the Override Value. Now the
value of {Dept} in the child job will be overridden and set to 20000.

SMTP Message Delivery task

This task delivers email notifications for Scheduler jobs.

NOTE: Scheduler automatically creates a system job for this task (System.SMTPMessageDelivery),
which administrators can edit as needed.

Item Description

Server name The server name of the SMTP email server.

Port number The port number for the SMTP email server. By default, the port is 587, but you
can specify a different port number if needed.

Server requires
authentication

Select this check box if the SMTP email server requires authentication.

If selected, type a Username and Password.
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Item Description

Test Mode Specifies whether the task is run in test mode. If this check box is selected, the
task verifies that it can successfully connect to the SMTP server to send email
notifications, but no emails are actually sent.

For the System.SMTPMessageDelivery job, new systems are automatically set
to test mode. If you restore a database, the restore process also sets the
system job to test mode. You must disable test mode before any emails will be
sent.

Start Process task

This task starts a process for Process Management. You can use this task to automatically start a process
at a specific point in time, including recurring schedules (such as to automatically start a monthly
process).

This task can be used to start a generic process definition or a plan file process definition.

Item Description

Process to start The process definition to start. Click the Browse button to select the process
definition file.

You can select any process definition in the Process Definition Library or in a file
group Process Definitions folder.

Restart process if
it is already
running

Specifies whether the Scheduler task will restart the process if it is already
running, or if the process will be left as is.
l Select this option if you want to start the target process regardless of

whether it is already running. The current process instance will be aborted
and a new process instance will start over at step 1. This option is selected by
default.

l Clear this option if you want to leave the existing process instance running.
In this case, the Scheduler task will take no action if the target process is
already running.

Scheduler tasks for database maintenance

Scheduler provides several built-in tasks that are intended for databasemaintenance. By default, these
tasks are included in the System.IndexMaintenance job, which runs regularly to maintain your database.
However, these tasks can also be added manually to jobs as needed to perform additional database
maintenance.

The following databasemaintenance tasks are available:
l Rebuild Database Indexes task
l Update Database Statistics task
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l Update Indexes and Constraints task

All of these tasks are predefined versions of the Execute SQL Command task. You can use the Source
Axiom Database field to specify whether the task is executed against the system database or the audit
database.

For the SQL Command Text, the actual SQL code used by each task is generated automatically by Axiom
Cost Accounting when the task is executed. This ensures that the tasks always use themost current SQL
code for each task as defined by Axiom Cost Accounting.

Security
All users of Axiom Cost Accounting must be defined within Security. Within Security, you can:

l Manage users and roles
l Control user access by file group
l Control user access to data in the database
l Control user access to specific features
l Control user access to data imports
l Control user access to files and folders
l Specify files to open on system startup

Security Overview
Using Axiom Cost Accounting Security, you can create users and roles, and assign access rights. This
section explains how security is applied in Axiom Cost Accounting.

Users can be created manually within Axiom Cost Accounting, or you can import them from Active
Directory. Once a user account is created, you must define the permissions for that user, at the user level
or at the role level (or both). The security permissions determine which files, features, and data that the
user can access within the Axiom Cost Accounting system.

The following users can access and manage security:
l Users designated as a system Administrator. Administrator users have full rights to all areas of the

system, including security.

l Users who are granted the Administer Security permission. Administer Security users have full
rights to security, except for a few features which are limited to administrators-only.

l Users who are assigned as a Subsystem Admin for a subsystem. Subsystem administrators can
manage users and roles within the subsystem.
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� Users and roles
To streamline security settings, you can define a number of roles, and then assign users to those roles.
Users inherit the security settings defined for their assigned roles. Additionally, Axiom Cost Accounting
provides a built-in Everyone role, for security settings that apply to all users.

Systems with installed products may also have roles that are designed for use with the product. These
roles are product-controlled and delivered with the product. For example, a system with the Capital
Planning product may have roles for Capital Planning Admin and Capital Planning User. You can assign
users to these roles based on the level of permissions they need to the product.

The specific way that security settings are inherited depends on the type of setting. Generally, roles grant
permissions, they do not deny permissions. For more information, see How role settings are applied to
users.

� Authentication behavior
There are several options to authenticate users into Axiom Cost Accounting. The basic authentication
type is Axiom Prompt authentication, which means that users will be prompted for an Axiom user name
and password each time they want to access Axiom Cost Accounting.

If desired you can use an integrated authentication option instead, which means that users are
authenticated based on certain supported external credentials—such as the user's Windows domain
credentials or LDAP credentials. These options are typically enabled and configured during the
installation of Axiom Cost Accounting. For more information, see Axiom Cost Accounting can integrate
with your organization's existing network security. You can:.

� Security subsystems
If desired, you can create security subsystems and assign users to subsystems. Subsystems allow you to:

l Define a maximum level of permissions for a subset of users. Any user that is assigned to the
subsystem cannot be granted rights that exceed the subsystem rights.

l Assign a user as a subsystem administrator, so that the user can manage security permissions for
the users and roles that belong to the subsystem.

In systems with installed products, subsystems are used to control access to specific products. These
subsystems are product-controlled and delivered with the product. For example, you may have
subsystems for Capital Planning and Budget Planning. You can assign users to subsystems based on the
specific products they should be able to access.

For more information, see Security Subsystems.
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The Security Management dialog
All security settings for Axiom Cost Accounting are controlled in the Security Management dialog. To
access this dialog:

l On the Axiom tab, in the Administration group, clickManage > Security > Security Manager.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click Security > Security Manager.

Only users with the following permissions can access the Security Management dialog:
l System administrators
l Users with the Administer Security permission
l Users assigned as a subsystem administrator

� Viewing users, roles, and subsystems
Users, roles, and subsystems are listed in the left-hand side of the dialog. To switch between items, select
one of the radio buttons at the top of the dialog. By default, users are displayed.
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l You can sort the user list by last name, first name, and login name. To change the sort, select the
desired option from the Sort By list. By default, the list is sorted by last name.

l To search for a particular user, role, or subsystem, type the name into the search box at the top of
the list. To clear the search, click the Clear filter icon to the right of the search box. Note that
this will search the user's login name as well as first and last name.

l To show or hide users by their enabled status, use the Enabled and Disabled check boxes. By
default, both check boxes are selected which means that all users are shown (enabled and
disabled).

When a user, role, or subsystem is selected in the list, the settings for that item display in the right-hand
side of the dialog, organized by tabs.

TIP: You can double-click on any user, role, or subsystem name listed in the Assigned Users /
Assigned Roles / Assigned Subsystems sections to open that record.

NOTE: Subsystems are optional in systems without installed products. Subsystem features are only
available if you have enabled them using the system configuration settings.

� Editing security
Changes made in the Security Management dialog are reflected in "real-time" within the dialog. If a
required setting is missing, a validation message appears in the bottom left of the dialog. You can click on
themessage to be taken to the applicable setting. This issuemust be resolved before you can save any
changes.

At any time you can save changes by clicking Apply (to leave the dialog open) orOK (to close the dialog).
In most cases, changed security permissions will be effective within seconds of being saved; the user
does not need to log out and log back in before changes are applied.

� Effective permissions
Several tabs of the Security Management dialog, such as the File Groups tab and the Tables tab, display
the effective permissions for the user. This is the permission that the user has after applying all of the
relevant security settings, including inherited role permissions, subsystem restrictions, and
administrator permissions. This allows you to understand exactly what permission the user has.

For example, if you select a table type or a table in the Tables tab, the Configured Permissions section
displays what permissions have been granted at the user level, and the Effective Permissions section
displays the actual access rights of the user. In the following example screenshot, although the user
herself has no configured access to the table type, her effective permission is full access. This means that
either the user is assigned to a role with full access to the table type, or the user has been granted
administrator rights. You can see exactly which rights contribute to the effective permissions by clicking
the Show Details link.
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Example effective permissions

As edits aremade in the dialog, those changes are reflected in the effective permissions immediately. For
example, if you grant a user permission to Administer Imports, and then switch to the Files tab, the
effective permissions for the Imports Library will reflect that the user has full permissions to all imports,
even though the change has not yet been saved.

Managing Users and Roles
All users of Axiom Cost Accounting must be defined within security. Users can be assigned access rights
on an individual basis, and/or they can be assigned to specific roles and inherit the rights of the role.

The total number of active users that can be defined for your implementation depends on your license
agreement with Kaufman Hall. If you have any questions, please contact Kaufman Hall Software Support
for assistance.

The total number of available licenses and currently active users are displayed in the upper right-hand
corner of the Security Management dialog. This area also displays the total number of users who have
been granted administrator rights. For example: 20 of 25 licenses in use, 3 admins.
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NOTE: In addition to the Security Management dialog, you can also manage users and roles in bulk
via a spreadsheet interface. For more information, see Bulk edit of security.

Managing users

Using the Security Management dialog, you can create new users, edit existing users, and delete users.
To access this dialog:

l On the Axiom tab, in the Administration group, clickManage > Security > Security Manager.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click Security > Security Manager.

To work with users, make sure that Users is selected in the top left-hand corner of the dialog. To save
changes, click Apply (orOK if you are finished editing security settings).

NOTE: Subsystem administrators can only work with users that belong to their assigned subsystem.
The user list is filtered to only show these users.

� Creating users
You can create a new blank user, or you can clone the settings of an existing user. If you clone a user, all
of that user's settings are copied to the new user, except for unique personal information (name, email,
login, password).

To create a user, click one of the following buttons located underneath the user list:
l To create a new blank user, click Create user .
l To clone an existing user, select that user in the list and then click Clone user .

The new user is added to the list. You can define the security settings for the new user as desired,
including assigning the user to one or more roles.

If you are a subsystem administrator, then all users that you createmust belong to a subsystem. If you
are an administrator for only one subsystem, then any new users are automatically added to that
subsystem. If you are an administrator for multiple subsystems, then the user is automatically assigned
to one of the subsystems—you can later change the assignment as needed.

� Editing user properties
To edit user properties, select a user from theUsers list, then make any changes to that user. Changes to
user settings are applied to that user when the changes are saved.
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� Deleting users

IMPORTANT: If a user has made any changes to the system or data, deleting the user will have
implications on auditing. In order to comply with SOX, HIPAA, and other protocols for standard
security practices, it is strongly recommended to disable existing user records instead of deleting
them. Generally speaking, a user record should only be deleted if it is newly created and has not been
used.

To delete a user, select a user from theUsers list, then click Delete user . You are prompted to confirm
that you want to delete the user.

If you delete a user, that user is removed from Axiom Cost Accounting security entirely. Alternatively,
you can disable a user if you want to keep the user record, but prevent the user from accessing Axiom
Cost Accounting. On theGeneral tab, clear the Enabled check box.

When a user is deleted, the user's associated user folders in \Axiom\Axiom System\User Folders
are also deleted (such as My Favorites and My Documents) .

NOTE: Only Axiom Support users can delete other Axiom Support users.

Managing roles

Using the Security Management dialog, you can create new roles, edit existing roles, and delete roles. To
access this dialog:

l On the Axiom tab, in the Administration group, clickManage > Security > Security Manager.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click Security > Security Manager.

To work with roles, select Roles in the top left-hand corner of the dialog. To save changes, click Apply (or
OK if you are finished editing security settings).

NOTE: Subsystem administrators can only work with roles that belong to their assigned subsystem.
The role list is filtered to only show those roles.

� Creating roles
You can create a new blank role, or you can clone the settings of an existing role. If you clone a role, all of
that role's settings are copied to the new role, including assigned users.

To create a role, click one of the following buttons located underneath the role list:
l To create a new blank role, click Create role .
l To clone an existing role, select that role in the list and then click Clone role .
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The new role is added to the list. You can define the security settings for the new role as desired, and you
can assign users to the role.

If you are a subsystem administrator, then all roles that you createmust belong to a subsystem. If you
are an administrator for only one subsystem, then any new roles are automatically added to that
subsystem. If you are an administrator for multiple subsystems, then the role is automatically assigned
to one of the subsystems—you can later change the assignment as needed.

� Editing roles
To edit a role, select a role from the Roles list, then make any changes to that role. Changes to role
settings are applied to users who are assigned to that role when the changes are saved.

� Deleting roles
To delete a role, select a role from the Roles list, then click Delete role . You are prompted to confirm
that you want to delete the role.

A role cannot be deleted if users are assigned to it.

TIP: If you have a role that you want to delete and many users are assigned to it, you can delete it
using the Open Security in Spreadsheet feature. The users will be automatically updated to remove
the role assignment. For more information, see Bulk edit of security.

Assigning users to roles

Each user in security can be assigned to one or more roles to define the user's security permissions.
Generally speaking, the permissions of each assigned role are combined with any user permissions to
result in themost permissive set of rights available to the user. There are some exceptions; for more
information see How role settings are applied to users.

Users can be assigned to roles from the user record or from the role record. Users have an Assigned
Roles section that lists their assigned roles. Roles have an Assigned Users section that list their assigned
users.

To assign roles to a user from the user record:
1. In the Security Management dialog, select the user.

2. On theGeneral tab, in the Assigned Roles section, click the Add button .

3. Use the Assign Roles dialog to assign one or more roles to the user:
l Use the Add and Remove buttons to move role names between Available Roles and

Assigned Roles. All roles listed in the Assigned Roles box will be assigned to the user.

l You can also double-click role names to move them between the boxes.

4. When you have finished assigning roles, click OK to close the Assign Roles dialog, and then Apply
orOK to save the changes to the user record.
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To assign users to a role from the role record:
1. In the Security Management dialog, select the role.

2. On theGeneral tab, in the Assigned Users section, click the Add button .

3. Use the Assign Users dialog to assign one or more users to the role:
l Use the Add and Remove buttons to move user names between Available Users and

Assigned Users. All users listed in the Assigned Users box will be assigned to the role.

l You can also double-click user names to move them between the boxes.

4. When you have finished assigning users, click OK to close the Assign Users dialog, and then Apply
orOK to save the changes to the role record.

How role settings are applied to users

Axiom Cost Accounting supports role-based security. Each user can be assigned to one or more roles,
and that user inherits the security settings defined for those roles. This topic explains how role-level
rights are inherited by individual users.

In general, role rights are additive. Users are granted themost permissive set of rights among their own
personal security settings and any roles that they are assigned to. Roles are intended to grant
permissions, not deny permissions.

Role inheritance works slightly differently for different areas of security, as detailed in the following
sections. When configuring security settings for a user, be sure to review the Effective Permissions
section that is available in most areas of the dialog. This section displays the user's effective permissions
after taking into account all applicable factors, including role inheritance, subsystem restrictions, and
administrator status.

NOTE: If subsystems are being used, then role inheritance works in the sameway, but users'
effective permissions are limited by the subsystem's maximum permissions. For more information,
see Security Subsystems.

� Permissions
The Permissions tab of security defines access rights for specific Axiom Cost Accounting features. By
default, users inherit security permissions from any roles that they are assigned to. However, you can
override role inheritance for a user on a per permission basis.

If a permission is set to inherited, then the user is granted themost permissive set of rights among any
roles the user is assigned to. For example, imagine the following settings for the Browse Audit History
permission:

User Inherited

Role1 Unchecked

Role2 Checked
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If the user is assigned to both Role1 and Role2, then the user inherits the permission and can access the
audit history for the system.

If instead you select to Override a permission for a user, then that permission is no longer inherited from
roles. The user is granted or denied the permission based on whether the Permission box is checked for
the user.

The following screenshot shows what the Permissions tab looks like in all possible states:

Example Permissions tab

In this screenshot, the example permissions are treated as follows:
l Administer Announcements: Inherited from role. The Budget Process role grants this permission

to the user, so the Permission check box shows as checked, and the role name is listed in the
details to the right.

l Administer Axiom Explorer: Inherited from role. None of the roles that the user belongs to
currently grant this permission, so the Permissions check box shows as unchecked.

l Administer Exports: The Override check box is checked, so the user does not inherit this
permission from any roles. The Permission check box is not checked, so the user does not have
this permission.

l Administer File Groups: The Override check box is checked, so the user does not inherit this
permission from any roles. The Permission check box is also checked, so the user has this
permission.

� Startup documents
The Startup tab of security specifies files to open when a user starts Axiom Cost Accounting, such as the
home page, task panes, and ribbon tabs. Users inherit startup files from roles in addition to their own
individually assigned startup files.

Each user can have only one home page. If a user has an individually assigned home page, that file will be
used and any role settings are ignored. Otherwise, the user will inherit the home page from a role. If no
home page is assigned, the default home page is used.
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For more information about startup file inheritance, see Assigning startup files (Startup tab), and review
the section for the applicable type of startup file.

� File groups
The File Groups tab of security defines access rights for plan files in file groups. For file groups, you can
configure role inheritance to be handled in a variety of ways. You can specify that role settings are
combined with user settings, or that role settings are inherited independently from user settings, or that
role settings are ignored entirely and not inherited.

For more information and examples of how role file group permissions apply to users, see Understanding
role inheritance options for file group permissions.

� All other areas
For all other areas of Security, the user inherits themost permissive set of rights among their own
personal security settings and any roles that they are assigned to. This applies to the Tables tab and the
Files tab.

For example, imagine the following access level settings for a report folder:

User Read-Only

Role1 None

Role2 Read/Write

If the user is assigned to both Role1 and Role2, then the user has Read/Write access to that report folder,
because that is themost permissive set of rights available to the user.

Each tab has an Effective Permissions section where you can view the rights that the user will be granted
after taking into account role inheritance, administrator status, and folder inheritance (where applicable).

NOTES:
l For table access, if both the user and a role have filtered access, the filters are concatenated

using OR. So if a user has a table filter of DEPT.Region='North' and a role the user is
assigned to has a table filter of DEPT.Region='South', then that user's full filter is:

DEPT.Region='North' OR DEPT.Region='South'

That user has access to data for either the North or South regions.

l For table access, you can choose to ignore role inheritance. If this option is enabled for a user,
then any applicable role access settings for the table are not inherited (including the Full
Access setting) and the only filter applied is the user's filter.
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Granting administrator-level permissions

In Security, users can be designated as a system administrator, by enabling the Administrator option on
theGeneral tab.

System administrators have full rights to all features and all data for the system. Although you can
configure security settings for administrators, such as to define file access or table filters, these settings
will be overridden as long as the Administrator check box is enabled for the user. The Effective
Permissions will reflect the user's full access.

� Administrator-only features
Administrators have access to all features and files in the current Axiom Cost Accounting system. While
non-admin users can be granted access to many features and files, some features are only available to
administrators:

l The ability to make another user a system administrator
l The ability to lock non-admin users out of the system, and the ability to log into a locked system
l The ability to restore a deleted file
l The ability to modify system configuration settings using Save Type 4, or using the System

Configuration page in the AxiomWeb Client
l Access to Scheduler administration features in the Scheduler dialog (such as viewing all job

history, managing system jobs and event handlers, managing Scheduler servers, and managing
remote data connections)

l Access to system folders in Axiom Explorer (therefore, any file management for system files that
cannot be done using system utilities can only be done by administrators)

l Access to certain underlying file group folders such as the Plan Files folder, Plan File Attachments
folder, and the Calc Method Libraries folder

l Access to theDeveloper > Toolsmenu on the Axiom Designer ribbon (though some of the
features on this menu are available elsewhere without the administrator restriction)

l Access to the technical administration features in the AxiomWeb Client, such as: Reset Services,
Rebuild Table Views, System Logs, and Update License

l Ability to create and edit imports that use the current Axiom database as the source data

� Security access for non-administrators
If you want a user to be able to access and edit security settings, but you do not want to make the user
an administrator, there are two options:

l You can give the user the Administer Security permission. Users with this permission can add,
edit, and delete users, roles, and subsystems, and can access security tools such as System Access
and Logged in Users.
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l If you are using subsystems, you can assign a user as a subsystem administrator. Users with this
permission can edit the security settings for users that belong to the subsystem, and can also
create and delete users within the subsystem. For more information, see About subsystems.

These users do not have access to the Administrator check box in Security. They cannot make
themselves or any other user an administrator.

The Everyone role

The Everyone role is a built-in role for each Axiom Cost Accounting system. The purpose of this role is to
define security settings that apply to every user in the system. All users automatically belong to the
Everyone role.

The Everyone role has the following default settings:
l Document reference tables.When a new document reference table is created, the Everyone role

is automatically granted full read access to that table. This permission grants all users the right to
query the data in document reference tables. In most cases, this is the desired level of rights. If
you have some particular document reference tables that you do not want every user to have
access to, then you can do one of the following:

o Modify the Everyone role to remove access to those tables, and instead grant access
directly to specific users and roles.

OR

o Leave the Everyone role at the default of full access, and instead modify certain users to
ignore role inheritance for that table.

l On-demand file groups.When a new on-demand file group is created, the Everyone role is
automatically granted the Create New Records permission for that file group. Effectively, this
means that any user who also has access to plan files in the file group will also have permission to
create new plan files. If you do not want this behavior—meaning that you want some users to be
able to access plan files in the file group without being able to create new plan files—then you can
remove the permission from the Everyone role and instead grant it to individual users and roles as
needed.

l Startup task panes. By default, the Everyone role is configured to open the Explorer and Process
task panes on startup, as non-closeable task panes. You can modify the Everyone role to remove
any of these task panes, and instead grant access directly to specific users and roles (or do not
grant access to anybody, if you do not want to use these task panes at all). Only the Explorer task
pane will open automatically for all users; the Process task pane only displays when it is relevant
to the user.

NOTE: In systems with installed products, your Everyone role may have been modified to not
open these task panes on startup, and instead open different task panes.

Administrator's Guide 2019.4 Axiom Cost Accounting │ 430



l Startup ribbon tabs. By default, the Everyone role is configured to open the Axiom and Axiom
Designer ribbon tabs on startup.

o The Axiom ribbon tab shows for all users and provides the default menu for the Desktop
Client. You should not remove this tab from the Everyone role unless you have created one
or more custom ribbon tabs that you plan to assign to the necessary users and/or roles
instead.

o The Axiom Designer ribbon tab is limited to administrators only. You can modify the
configuration of the startup file so that it displays to other users, or you can remove it from
the Everyone role and instead grant access directly to specific users and roles (or do not
grant access to anybody, if you do not want to use the ribbon tab at all).

NOTE: In systems with installed products, your Everyone role may have been modified to not
open these task panes on startup, and instead open different task panes.

If desired, you can modify the Everyone role to grant additional rights to every user. Any right granted at
the Everyone level will be inherited by every user, except for rights that have been overridden at the user
level. Subsystem restrictions, if applicable to the user, still apply.

Note the following about the Everyone role:
l The Everyone role cannot be renamed or deleted. The security settings for the role can be

modified in either the Security Management dialog or by using Open Security in Spreadsheet.

l Users cannot be explicitly assigned to the role, nor can they be removed from the role. All users
permanently belong to this role.

l The Everyone role is not recognized by GetSecurityInfo("InRole") or when querying security tables
via Axiom query. It is assumed that all users belong to the role; therefore it is not listed as a role
assignment.

Configuring Security Settings
Security settings for users, roles, and subsystems are organized by tabs in the Security Management
dialog. The following tabs are available:

Tab Description

General Define general settings such as name and email, as well as role assignments and
system access.

Permissions Set permissions for individual features.

File Groups Set access rights for file groups.

Tables Set access rights for tables.

Files Set access rights for files in the Axiom Cost Accounting file system. This includes
reports, imports, task panes, and Scheduler jobs.

Startup Specify certain files to open automatically on system startup.
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Defining user properties (General tab)

The following settings are available for users on theGeneral tab.

� User Details
Each user has the following general properties:

Item Description

First Name

Last Name

The user's first and last name.

This information can be referenced by using the function GetUserInfo.

Email The user's email address. This address is used to send user notifications, such as
for process management.

This information can be referenced by using the function GetUserInfo.

License Type The user's license type. By default, users are Standard users unless a different
user type is selected. Standard users have the potential to access any feature or
file in Axiom Cost Accounting, limited by their security permissions.

In addition to standard users, the following user types are available:
l Axiom Support users are intended to allow Axiom Cost Accounting

consultants and support representatives to log into your system as part of
requested support activities or contracted consulting work. Any user
accounts assigned to this license typemust log in using Axiom Prompt
authentication, and must acknowledge that they are Axiom representatives
when they log into the system.
NOTE: Once a user has been assigned an Axiom Support license, that license
can only be removed by another Axiom Support user.

l Viewer users allow for view-only access to Axiom Cost Accounting. Viewer
users can access files as read-only, but they cannot save files or data, and
they cannot otherwise perform "change actions" on the files (such as
submitting a plan file for process management). Viewer users also cannot
perform any administration functions.
Security permissions for viewer users can be set as normal, but any settings
above read-only access to files will be ignored. The Effective Permissions will
note that the user is being limited due to the Viewer license. However, if you
switch the user to a Standard license, the settings will be honored.

The number of users that can be created and assigned to each license type
depends on your Axiom Cost Accounting license.
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Item Description

Authentication Themethod used to authenticate the user for access to Axiom Cost Accounting.
By default, new users will be assigned to your installation's configured
authentication mode; however, this can be changed on a per user basis as
needed.
l Axiom Prompt: Select this option if you want the user to be authenticated

by using their Axiom Cost Accounting user name and password. You would
use this option if your installation is not configured to enable an external
authentication method, or if you are using an external authentication
method but you want to create a user who can log in directly.

l Windows User: Select this option if you want the user to be authenticated
based on their Windows credentials. This option is only valid if your
installation is configured to enableWindows Authentication. For more
information, see Using Windows Authentication.

l LDAP Prompt: Select this option if you want the user to be authenticated via
your LDAP directory. This option is only valid if your installation is configured
to enable LDAP Authentication. For more information, see Using LDAP
Authentication.

l OpenID: Select this option if you want the user to be authenticated using an
OpenID provider. This option is only valid if your installation is configured to
enable OpenID Authentication. For more information, see Using OpenID
Authentication.

l SAML: Select this option if you want the user to be authenticated using a
SAML identity provider. This option is only valid if your installation is
configured to enable SAML Authentication. For more information, see Using
SAML Authentication.

l Unspecified: This option exists to support backwards-compatibility for
systems upgraded from older versions. Upgraded users may be assigned to
it, but it cannot be selected otherwise. If you have users assigned to this
option, we recommend changing their assignment to the appropriate
authentication type.
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Item Description

Login The user's login name.

If the user's authentication type is anything other than Axiom Prompt, then the
user's login namemust match the user's login name for the designated
authentication source (for example, it must match the user's Windows login
namewhen using Windows Authentication). See the information on the
appropriate authentication type for login name requirements.

For Windows Authentication only, you can validate that the login name
matches a user name in one of the allowed domains by clicking the Validate
icon to the right of the box. Amessage box will let you knowwhether the
namewas found or not. This feature is only available ifWindows Authentication
is enabled and at least one valid domain name has been specified as an allowed
domain.

This information can be referenced by using the function GetUserInfo.

Password The user's Axiom Cost Accounting password. Click the ... button to the right of
the box to set or change the user's password. All users must have a non-blank
password.

Users can change their own password later from within the application.

NOTES:
l By default, Axiom Cost Accounting enforces a basic set password rules. If

desired, you can disable these rules and allow any password. See Enabling
password rules.

l The Password setting only displays for Axiom Prompt users. For all other
authentication types, a randomly generated password will be created for the
user and cannot be changed. Users cannot log in with this randomly
generated password; they can only log in using their specified authentication
type.

If you are an administrator and you need to log into Axiom Cost Accounting as
another user in order to test that user's security settings, you do not need to
know that user's password. For more information, see Testing user security.

Enabled Specifies whether the user can access Axiom Cost Accounting. If this check box is
not selected, the user cannot log into any Axiom Cost Accounting system.

NOTE: System administrators cannot disable other system administrators. The
Administrator permission must be removed before the user can be disabled.
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Item Description

Locked Out If a user has become locked out of the system due to exceeding the configured
number of failed login attempts, then the system will automatically select this
check box. You can clear the lockout by clearing this check box.

This setting only displays if you havemanually configured a lockout threshold.
For more information, please contact Axiom Support.

If an administrator becomes locked out, and no other administrator accounts
are available to clear the lockout, the Axiom SoftwareManager can be used to
reset the administrator's password and clear the lockout.

Administrator Specifies whether the user has administrator-level permissions. If this check box
is selected, then the user has access to all features and data in the current
system. For more information, see Granting administrator-level permissions.

NOTE: This check box only displays to users who have the Administrator
permission. In other words, a user cannot make themselves an administrator,
they have to be granted the right by a user who is already an administrator.

Directory Sync
Enabled

Specifies whether the user will be synched with Active Directory the next time an
Active Directory import is performed. This is enabled by default.
l If enabled, then the user will be synchronized with Active Directory according

to the settings in the Scheduler task for the import. For more information
about how this import and synchronization occurs, see HowActive Directory
user synchronization works.

l If disabled, then the user will not be affected by the Active Directory import,
even if the user namematches a user name in the import.

NOTE: This check box only displays if Active Directory import has been enabled
for your system.

� Assigned Roles
Users can be assigned to one or more roles. If the user is already assigned to roles, those roles are listed
here.

l To add a user to a role, click Add . In the Assign Roles dialog, you can select roles for the user.
l To remove a user from a role, select the role in the list and then click Remove .

Role assignments can bemadewhen editing either the user or the role. Any changes made in one area
are automatically applied to the other area.

NOTE: The Everyone role is not listed in the Assigned Roles box. All users belong to the Everyone role
and cannot be removed; therefore it is not listed as a role assignment.

For more information, see How role settings are applied to users.
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� Assigned Subsystems
This section only displays if subsystems are enabled for your system. See Security Subsystems.

If you are using subsystems, you can optionally assign the user to one or more subsystems. If the user is
already assigned to subsystems, those subsystems are listed here.

l To add a user to a subsystem, click Add . In the Assign Subsystems dialog, you can select
subsystems for the user.

l To remove a user from a subsystem, select the subsystem in the list and then click Remove .

IMPORTANT: If you remove a user from a subsystem, that subsystem's maximum permission limit
will no longer apply to that user.

Subsystem assignments can bemadewhen editing either the user or the subsystem. Any changes made
in one area are automatically applied to the other area.

NOTE: If you are a subsystem administrator, then all users that you have access to must belong to a
subsystem. If you are an administrator for only one subsystem, then any new users you create are
automatically added to that subsystem. If you are an administrator for multiple subsystems, then
the user is automatically assigned to one of the subsystems; you can change the assignment as
needed.

Configuring role properties (General tab)

The following settings are available for roles on theGeneral tab.

� Role Details
Each role has the following general properties:

Field Description

Name The name of the role.

NOTE: The name of the built-in Everyone role cannot be changed.

Description A description of the role. The description is for the administrator's use only, to
help explain the purpose of the role.

� Assigned Users
Multiple users can be assigned to a role. If the role already has assigned users, those users are displayed
here.

l To add a user to the role, click Add . In the Assign Users dialog, you can select users to add to
the role.

l To remove a user from the role, select the user in the list and then click Remove .
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Role assignments can bemadewhen editing either the user or the role. Any changes made in one area
are automatically applied to the other area.

NOTE: This section is not available when editing the built-in Everyone role. All users belong to the
Everyone role and cannot be removed.

For more information, see How role settings are applied to users.

Configuring feature permissions (Permissions tab)

On the Permissions tab of the Security Management dialog, you can specify which features a user or role
has access to. The Permissions tab works slightly differently depending on whether you are defining
rights for a user or a role.

NOTE: If you are defining permissions for a subsystem, see Defining maximum permissions for
subsystems.

� Setting permissions for users
For users, each permission has three available settings:

l Inherited: The permission is not set for the user. The permission is grayed out and the text
"inherited from role" appears to the right of the permission name. If the user is assigned to a role,
this permission can be inherited from the role.

l Denied: If theOverride check box is selected, but the Permission check box is not selected, this
means that the user explicitly does not have access to the feature. The user will not inherit the
permission from any roles.

l Allowed: If theOverride check box and the Permission check box are selected, this means that
the user explicitly has access to the feature, regardless of any role settings.

By default, all user permissions are left unset and are inherited from any role assignments. If you want to
override role inheritance and explicitly set a permission for the user, then you must select theOverride
check box and then leave the permission unchecked (to deny the permission) or checked (to allow the
permission).
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NOTES:
l When a permission is inherited from a role, it displays the effective permission for the user.

For example, if a user is assigned to a role that has the Administer Imports permission, and
that permission is eligible for inheritance, then the check box for that permission displays as
grayed out and selected. The name of the role from which the permission is inherited is also
listed. For example:

l If a user has administrator rights to the system, that user has all permissions. In this case, the
permissions list is grayed out and cannot be edited, and all permissions display as selected.
The text "user is an admin" displays next to the permission names.

l If the user belongs to a subsystem, and the subsystem settings do not allow a particular
permission to be granted to users in the subsystem, then the permission is grayed out and
cannot be edited. The text "disallowed by subsystem" (including the subsystem name)
displays next to the permission name.

� Setting permissions for roles
For roles, the Permission box for each permission is either checked or unchecked. If a permission is
checked for a role, then users who have that permission set to "inherited" will inherit rights to that
permission when they are assigned to that role.

� Permissions
The following permissions are available:

Permission Description

Administer
Announcements

The user has rights to create, edit, and delete announcements and
announcement categories. The user must have access to a form-enabled file
with an Announcements component in order to use this permission.
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Permission Description

Administer
Axiom Explorer

The user has rights to access Axiom Explorer (Administration > Manage >
Axiom Explorer). The user's other security permissions determine what folders
they can viewwithin this dialog and what actions they can perform on them.

NOTE: This permission has no impact on the availability of the Explorer task
pane. Any user can use the Explorer task pane.

Administer
Exports

The user has rights to create exports in the Exports Library.

The user must also have read/write permissions to at least one folder within the
Exports Library (as configured on the Files tab), or else they will have no place to
save their created exports. Execute permissions are also managed on the Files
tab.

Administer File
Groups

The user has general administrative rights to all file groups. The user can:
l Create and delete file groups
l Edit file group settings
l Clone file groups
l Manage scenarios for file groups
l Manage restore points for file groups
l Manage categories for file groups
l Manage file group aliases
l Use the Delete Plan Files command to delete any plan file from an on-

demand file group

NOTE: Generally speaking, this permission does not grant access to any files
within the file groups, such as plan files, templates, and drivers. The user must
be granted access to these files separately if the user is expected to manage or
use these files. There are two exceptions: the user can delete any on-demand
plan file using Delete Plan Files, and the user can restore any plan file when
using restore points.

Administer
Imports

The user has rights to create imports (Administration > Manage > Imports).

The user must also have read/write permissions to at least one folder within the
Imports Library (as configured on the Files tab), or else they will have no place
to save their created imports. Execute permissions are also managed on the
Files tab.

Administer
Locked Items

The user has rights to remove locks on documents, tables, and save data locks.

The list of locked items is limited to the files and tables that the user has some
level of access to. The user cannot see or unlock items that the user does not
have access to.
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Permission Description

Administer
Picklists

The user can administer picklist tables using theWeb Client TableManager. The
user can create new picklist tables. For existing picklist tables, the user can edit
table properties and delete tables (as long as the user has at least read-only
permission to the table, otherwise the table does not display in the table
manager).

Administer Picklist users do not gain access to the table administration features
in the Desktop Client.

Administer
Security

The user has rights to access and edit security settings (Administration >
Manage > Security > Security Manager) for the current system. The user can
also access security-related tools such as System Access and Logged in Users.

The Administrator check box is not available to users with this permission.

Administer
Tables

The user has general table administration permissions. The user can:
l Create and delete tables
l Edit table structure
l Open tables using Open Table in Spreadsheet
l Use other table utilities available on the table administration menu

(Administration > Tables > Table Administration

The user's read and write filters (as set on the Tables tab) are honored for
purposes of viewing and saving table data.

Administer Task
Panes

The user has rights to create and edit task panes and ribbon tabs, as allowed by
the user's folder / file access rights defined for the Task Panes Library and the
Ribbon Tabs Library (as set on the Files tab).

Administer
Updates

The user has rights to download and apply updates to the Axiom Cost
Accounting installation (Administration > Manage > Software Updates and the
equivalent Web Client page).

Administer
Workflow

The user has rights to manage workflows using theWorkflowManager
(Administration > Manage > Workflow). This permission is restricted based on
file group access rights (meaning, the user can only manage workflows for file
groups that the user has rights to access).

NOTE: This permission is only visible in systems where the system configuration
setting EnableLegacyWorkflowEngine is set to True. This should only be the
case in older systems that have not yet had the opportunity to migrate their
existing workflows to plan file processes.
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Permission Description

Browse Audit
History

The user has rights to view audit history for the system (Administration >
Manage > Audit History and the equivalent Web Client page).

NOTE: Users with this permission can see audit records for all changes, including
changes made to tables that the user does not otherwise have access to. Use
caution in granting this permission.

Remove
Protection

The user has rights to remove workbook and worksheet protections (Advanced
> Protect > Workbook andWorksheet), for any Axiom file that the user can
access.

NOTE: Alternatively, you can grant unprotect rights for individual report files
and folders on the Files tab, or for plan files on the File Groups tab.

Scheduled Jobs
User

The user has rights to access the Scheduler dialog for the purposes of working
with scheduled jobs.

The user can create jobs, edit jobs, run jobs, and delete jobs, as allowed by the
user's folder and file access rights defined for the Scheduled Jobs Library (as
configured on the Files tab of Security). For example, you might create a sub-
folder for each user and only grant the user rights to that folder.

The user can view the results of jobs that the user has executed. Other job
history is not available to the user.

The user cannot manage Scheduler servers, edit system jobs, or use other
Scheduler administration features.

NOTE: Generally speaking, task-level security is not applied to users with this
permission, within the context of Scheduler. However, file-level rights are
enforced. For example, the user can create and/or run a Process Plan Files task
within a Scheduler job, even if the user does not have the Process Plan Files
permission. But within that task, the user can only process file groups and plan
files that the user otherwise has access to.

User Documents
Folder Access

The user has rights to theMy Documents folder in their My Files section.

The user can save files to My Documents. The user has read/write access over
any file saved to this area. Typically this permission is only granted to power
users who may need a place to save their own "personal" reports or an area to
temporarily save "in progress" files.

Administrators can access any user's My Documents folder. Other users cannot
access it.

NOTE: If a user has this permission and then later it is removed, the user's
existing My Documents folder is not deleted; it is simply hidden from the user in
Explorer dialogs. If desired, an administrator can delete the folder in
\Axiom\Axiom System\User Folders.
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NOTE: If a user does not have rights to a feature, themenu item associated with that feature does
not show on that user's ribbon tabs or other applicable areas.

Configuring file group permissions (File Groups tab)

On the File Groups tab of the Security Management dialog, you can manage user access to plan files and
to file group features. On this tab, you can specify the following:

l Which plan files a user can access
l The level of access to those plan files (read-only or read/write)
l What features are available in those plan files (such as saving data or inserting calc methods)
l Which file group administration features the user can access (such as Create Plan Files or Process

Plan Files)

NOTES:
l The settings on this tab do not apply to administrators. Administrators have access to all plan

files and all file group features.
l If you are defining permissions for a subsystem, see Defining maximum permissions for

subsystems.

IMPORTANT: This tab does not control access to other files in a file group, such as templates, drivers
and utilities. To give users access to these files, use the Files tab.

File group permissions

The settings on the File Group tab define permissions for each file group. The left-hand side lists the
available file groups for the system. When you select a file group in the list, you can define the security
settings for the user or role using the two sub-tabs on the right-hand side.

l File Group: Manage access to file group administration features such as Create Plan Files and
Process Plan Files. This tab can be ignored for most end users.

l Plan Files: Manage access to plan files. It is necessary to configure access on this tab if you want
the user to have any access to plan files in the file group.
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Example File Groups tab, configuring permissions to plan files

File groups are listed by display name, followed by the file group code in parentheses. If the name of the
file group is different than the display name, that name is also displayed in the parentheses.

The Effective Permissions section displays the full permissions of the user, taking into account any
inherited role rights and other settings such as administrator rights.

NOTE: If a non-admin user has no effective permissions for a file group (either on the File Groups tab
or on the Files tab), then that user cannot see the file group in Axiom Explorer, the Axiom ribbon tab,
and other lists of file groups.

� File Group tab
Use the File Group tab to configure user access to administration features for the file group. This tab is
optional and can be ignored for most end users.

To grant a user access to one of these features, select the check box. By default, all check boxes on this
tab are not selected, which means the user does not have access to any of these features.
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Item Description

Modify File
Group

This permission grants general administrative rights to the file group. The user
can:
l Edit the file group settings
l Clone the file group
l Manage scenarios for the file group
l Manage restore points for the file group

Create Plan Files The user can create plan files for the file group, using the Create Plan Files
feature. This permission is limited to those plan files where the user has
read/write access, as defined in the File Groups tab of Security.

This permission also grants access to the Copy Plan Files feature for standard
file groups, which can be used in certain specialized configurations to copy plan
files from one file group to another. In this case the user must have read/write
access and Create Plan Files permission to the target file group.

NOTE: If the file group is an on-demand file group, then users do not need this
permission in order to create new plan files "on demand." Instead, users need
the Create New Records permission.

Create New
Records

The user can create new plan files for the on-demand file group. This process
includes creating a new identity record in the plan code table and then creating
a plan file for that record using either its assigned template or by copying an
existing plan file (when using the Clone selected item feature). This permission
only applies to on-demand file groups.

By default, this permission is automatically enabled on the Everyone role when
a new on-demand file group is created. This means that any user with at least
Read-Only access to plan files in this file group will also have the ability to create
new plan files. (This includes plan file permission sets with the potential to be
elevated to read-only access or higher, due to the Interacts with Process
Management permission.) If you do not want all users with access to the file
group to be able to create new plan files, then you can remove the permission
from the Everyone role and instead grant it to individual users and roles.

Process Plan
Files

The user can process plan files for the file group, using the Process Plan Files
feature. This permission is limited to plan files where the user has at least read-
only access, as defined in the File Groups tab of Security.

The user can run Axiom queries and save data as part of the process, but the
user can only save the file if they have read/write access to it.
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Item Description

Run Axiom
Queries

The user can refresh Axiom queries in plan files, using the Refresh feature.

By default, non-admin users cannot use the Refresh feature in plan files. If you
have a plan file design where users should be able to refresh the queries in the
file as needed, then you should enable this permission.

NOTES:
l This permission does not apply to "refresh on open" Axiom queries, or to

queries run using the RunAxiomQueryBlock function. These queries will
always run, regardless of whether the user has this permission.

l This permission does not apply to form-enabled plan files (when viewed as
an Axiom form). Axiom queries in form-enabled plan files will refresh
according to the standard form refresh behavior, regardless of whether the
user has this permission.

Manage Calc
Methods

The user can perform all management activities for calc method libraries in the
file group, including adding new calc methods, editing calc methods, deleting
calc methods, as well as use any other calc method features available on the CM
Librarymenu. The user can also insert or change calc methods in any file group
files that the user has access to, and can override any calc method controls.

� Plan Files tab
Use the Plan Files tab to configure user access to plan files for the file group. Each plan file permission set
defines the following: 

l The plan files that the permission set applies to (all plan files or a filtered subset)
l The permissions to be applied to those plan files (such as: access level, ability to save data, and

calc method permissions)
l The role inheritance to be applied to the permission set (none, combine, or independent)

Users can havemultiple permission sets per file group—for example, to define read/write access to one
set of plan files and read-only access to another set of plan files. These permission sets can be configured
for the user directly or inherited from one or more roles. Roles can only have one defined permission set
per file group.

You can add, edit, and delete permission sets as follows:
l To add the first permission set for a user or a role, click Add a Permission.
l To add an additional permission set for a user, click the plus icon .
l To edit a permission set, double-click it. You can also select it and then click the edit icon .
l To delete a permission set, select it and then click the delete icon .
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NOTES:
l If a user has no configured permission sets, the user will inherit role permissions using

independent inheritance. Each role's permissions will be inherited as a separate unit. For more
information on role inheritance behavior for file groups, see Understanding role inheritance
options for file group permissions.

l If a user has multiple configured permission sets, only the first permission set displays in Open
Security in Spreadsheet.

When creating or editing a permission set, the Plan File Permission dialog opens. Within this dialog, you
can configure all permissions relating to this permission set.

Item Description

File access level The level of access that the user or role has to the plan files covered by this
permission set. Select from one of the following:
l No Access: The user or role has no access to plan files.

The No Access option is intended to be used in conjunction with Interacts
with Process Management and/or with Combine role inheritance. You can
define other permissions for the plan files, and those permissions will apply
when the user's access level is elevated due to process management, or
combined with another permission set to result in a higher level of access.

l Read Only: The user or role has read-only access to plan files.
l Read/Write: The user or role has read/write access to plan files in the file

group.

NOTES:
l The ability to save data to the database from within a file is controlled

separately, using the Allow Save Data permission.
l If you are using process management with this file group, select the level of

access that you want the user to have when they are NOT the current stage
owner. For example, you may want the user to have no access if they are not
the stage owner, or read-only access. If Interacts with Process Management
is enabled, then process management will "elevate" user permissions as
appropriate so that they can complete process tasks.

l If the file group uses virtual plan files and read/write access is granted, then
the file opens as if it were read/write, but the ability to save the file is
suppressed.
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Item Description

Allow Save Data Select this check box if you want the user or role to be able to save data to the
database from the plan files covered by this permission set.

NOTES:
l If you are using process management to manage access to plan files, you do

NOT need to select this option. As long as Interacts with Process
Management is enabled, the plan file process will "elevate" the user's
permissions as needed, including the ability to save data to the database.
Generally you would only enable Allow Save Data for a user if you want the
user to be able to save the data at all times, regardless of process step
ownership.

l If a user has Read Only access and Allow Save Data, then the user will be
able to save data to the database but not save changes to the file. Generally
this configuration would only be used with form-enabled plan files. Users
with this combination of rights can save data from the file at any time,
regardless of whether the file is locked to another user.

l In most cases, this option is only selected if the user also has Read/Write
access to the file group, so that file changes and data changes can be saved
in sync.

Allow Calc
Method Insert

Select this check box if you want the user or role to be able to insert calc
methods into plan files.

This option enables or disables the user's overall ability to insert calc methods.
Within individual templates/plan files, calc method controls can be used to
further control which calc methods can be inserted and where they can be
inserted.

It is valid to select this option even if the user has No Access or Read Only
access to plan files, if the user's access will be elevated by process management
or combined with another permission set. It is also valid to insert calc methods
in read-only plan files when using form-enabled plan files.

NOTE: This setting does not apply if the user has been granted theManage Calc
Methods permission. Users with this permission can perform any calc method
action in any plan file that they have access to within the file group.
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Item Description

Allow Calc
Method Change

Select this check box if you want the user or role to be able to change
methodologies in the plan file by overwriting one calc method with another.

This option enables or disables the user's overall ability to change calc methods.
Within individual templates/plan files, calc method controls can be used to
further control which calc methods can be used to overwrite and where
overwrite is allowed.

It is valid to select this option even if the user has No Access or Read Only
access to plan files, if the user's access will be elevated by process management
or combined with another permission set.

NOTE: This setting does not apply if the user has been granted theManage Calc
Methods permission. Users with this permission can perform any calc method
action in any plan file that they have access to within the file group.

AllowUnprotect Select this check box if you want the user or role to be able to unprotect the
worksheet and workbook within plan files. If enabled, the user will have access
to the Protect toggles in the Advanced group on the Axiom ribbon.

This option should only be granted in special situations. Normally, end users are
not allowed to unprotect plan files.

Allow Sheet
Assistant

Select this check box if you want the user or role to see the Sheet Assistant.
Generally, you should only expose the Sheet Assistant if the user is expected to
edit file settings, including Axiom query settings.

Enabling this permission also has the following impacts:
l The user has access to the Control Sheet. The Control Sheet is hidden by

default in plan files but the user can unhide it via the Sheet Assistant.
l The Drilling Control Sheet will not be hidden if the user has the Sheet

Assistant permission.
l If the user has read/write permission and the Sheet Assistant permission,

then the user can enable forms for the file and can see the Form Assistant
and Form Control Sheet.

l The Data Source Assistant is also available if the Sheet Assistant is available.

If this check box is not selected, then the user cannot see the Sheet Assistant or
the other related items as described above.

This option should only be granted in special situations. Normally, end users are
not allowed to edit settings in plan files.
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Item Description

Allow File
Processing

Select this check box if you want the user or role to be able to perform file
processing on the file. If selected, then the user has access to file processing
features, including the File Processing button on themenu and the File
Processing task pane. The related control sheets will also be visible to the user.

If this check box is not selected, then the user cannot perform file processing
actions and cannot see the related menu items, task panes, or control sheets.

This option should only be granted in special situations. Normally, end users do
not perform file processing in plan files.

Apply settings to Select one of the following to determine the plan files that this permission set
applies to:
l All Plan Files: The configured permissions apply to all plan files in the file

group.
l Filtered Plan Files: The configured permissions apply to a subset of plan files

in the file group, as defined using a filter. For more information on defining a
plan file filter, see Defining plan file filters.

Interacts with
Process
Management

This option specifies whether this permission set interacts with plan file
processes in process management (or the legacy workflow feature). It is enabled
by default for users, and disabled by default for roles.

Enabling this option has the following effects, for plan files covered by this
permission set:
l When a user is a step owner in a plan file process, their plan file permissions

will be "elevated" as needed to complete the current process task. For
example, the user will be elevated to Read/Write and Allow Save Data for an
Edit Plan File step. If this option is not enabled, then the user's permissions
will be left as is, which may result in the user being unable to complete the
process task.

l If the ownership assignment is through a role, enabling this option tells the
process to consider this permission set when evaluating which role members
should be step owners. If this option is not enabled, then this permission set
will be ignored by the plan file process.

Settings for users only
The following settings apply only to users, not to roles. These settings specify how the user will inherit file
group rights from any roles that the user is assigned to. For more information, see Understanding role
inheritance options for file group permissions.
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Item Description

Role Inheritance Specify how the user will inherit file group permissions from roles:
l None: The user will not inherit file group permissions from roles. Only the

user's configured permissions will be applied. Role permissions will be
ignored.

l Combine: The user's permissions and any role permissions will be combined,
so that the user will be granted themost permissive set of rights among all
the plan file access settings. Using the Role(s) setting, you can specify
whether this applies to all roles that the user belongs to, or only a specific
role.

l Independent (default): The user will inherit permissions from roles, but the
user's configured permissions and the role's inherited permissions will be
applied separately. Using the Role(s) setting, you can specify whether this
applies to all roles that the user belongs to, or only a specific role.

Role(s) Select which roles the role inheritance settings apply to. This setting only applies
if the role inheritance is set to Combine or Independent.
l If you select (all roles), then the specified inheritance settings apply to all

roles that the user belongs to. This is the default setting.
l If you select a particular role, then the specified inheritance settings apply to

only that particular role. If the user belongs to other roles, and those other
roles are not selected in additional file group permission sets for the user,
then those role permissions are ignored.

� Defining plan file filters
To define a filter to control access to plan files, select the Filtered Plan Files option and then use the
Filter Wizard to construct the filter. (You can also type a filter directly into the filter box.) The filter
must be based on the plan code table for the file group, or on a reference table that the plan code table
links to. When using the Filter Wizard, the wizard only displays the eligible tables.
After defining a filter, you can validate it by clicking the Validate filter button . This check is to ensure
that the filter syntax is valid. You can test to make sure that a file group filter is operating as you expect
by logging in as the user (or as a user assigned to the role) and checking to see which plan files display in
theOpen Plan Files dialog for the file group.

Filter variables can be used in plan file filters, to set a filter that is based on a user's login name (see
example below) or on another related user property. This is useful to be able to set a filter at the role
level, yet resolve the filter dynamically for each user in the role. For more information, see Filter
variables.
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NOTE: You can leave the filter blank only if you are using Combine role inheritance. This assumes
that either the user or the role has a filter that will apply after the permissions are combined. If the
filter remains blank after inheritance, then the user will have no access to plan files.

Example filters
DEPT.Dept IN (200,400)

This example limits the user to accessing plan files for departments 200 and 400.

DEPT.Region='North'

This example limits the user to accessing plan files for departments assigned to the North region.

DEPT.Owner='{CurrentUser.LoginName}'

This example limits the user to accessing plan files for departments that are assigned to that user (by the
presence of the user's login name in the Owner column). This type of filter would most likely be set on a
role, so that the filter could be set once yet resolve dynamically for each user in the role. For example, for
user JDoe, this filter would resolve as DEPT.Owner='JDoe'.

Configuring plan file security for use with plan file processes

This section provides basic guidelines for setting user permissions when you intend to use a plan file
process (process management) with the file group. There aremany nuances to file group security
settings and how they can interact with plan file processes, especially if you are using advanced security
configurations such as multiple permission sets for plan files or the combine option for role inheritance. If
you need assistance in determining the best configuration for your system, please contact Axiom Cost
Accounting Support.

NOTE: The same guidelines apply if you are using the legacy workflow feature instead of process
management.

The Interacts with Process Management setting for plan files is the key security permission for use with
plan file processes. Enabling this option for a plan file permission set has the following effects:

l When the user is a step owner in an active plan file process, their plan file permissions will be
"elevated" as needed to complete the current task. For example, the user will be elevated to
Read/Write and Allow Save Data for an Edit Plan File step in a process. If this option is not
enabled, then the user's permissions will be left as is, which may result in the user being unable to
complete the task.

l If the ownership assignment is through a role, enabling this option tells the process to consider
this permission set when evaluating which role members should be step owners. If this option is
not enabled, then this permission set will be ignored by the process.
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� Example user permissions for use with a plan file process
The first step in configuring plan file permissions for use with a process is deciding what level of
permissions that you want the user to have when the user is not a process step owner. This is the user's
base level of security permissions that they will always have. As long as Interacts with Process
Management is also enabled, the process will elevate the user's permissions to the appropriate level
when the user is a step owner.

NOTE: All of the example permission sets below assume that the user's plan file filter includes the
plan file where the user is assigned as a step owner. The user must have a configured or inherited
permission set that includes this plan file. The plan file process cannot not grant permissions to plan
files, they can only elevate existing permissions to those files.

No Access If you want a user to have no access to the plan file when the user is not a
process step owner, then set the permissions as follows:
l File Access Level: No Access
l Allow Save Data: Unchecked
l Interacts with Process Management: Checked

When the user is a step owner, the process will elevate the user's permissions as
appropriate.

Read-Only Access If you want a user to have read-only access to the plan file when the user is not a
process step owner, then set the permissions as follows:
l File Access Level: Read-Only
l Allow Save Data: Unchecked
l Interacts with Process Management: Checked

When the user is a step owner, the process will elevate the user's permissions as
appropriate.

Full Access If you want a user to have full edit rights to the plan file when the user is not a
process step owner, then set the permissions as follows:
l File Access Level: Read/Write
l Allow Save Data: Checked
l Interacts with Process Management: Checked (if ownership comes via role

assignment)

If the user will be directly assigned as a step owner, then it is not required to
enable Interacts with Process Management because the user already has the
full permissions that could be granted by the process. However, if the user's
ownership comes through a role assignment, then you must enable Interacts
with Process Management to signal that this user should bemade one of the
step owners.
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These permissions can be set at the user level, or at the role level, or at some combination of the two (if
using Combine role inheritance). All other plan file permissions can be enabled or not as appropriate for
the user. In some cases those other permissions will only be relevant when the user's access level has
been elevated by the process. For example, if the user has No Access plus Allow Calc Method Insert,
then the ability to insert calc methods is only relevant when the user is a step owner (because otherwise
they will be unable to see or open the plan file).

� Enabling Interacts with Process Management at the user level
When creating new permission sets for users, Interacts with Process Management is enabled by default.
It is recommended to leave this option enabled for users. Generally speaking, you should only disable
the option if both of the following apply:

l The user already has the necessary permissions for process step ownership.

AND

l The user does not need to be granted ownership via a role.

You can also disable the option if you want to ensure that the user's permissions are never impacted by a
plan file process (for this permission set). However, even if you do not plan to use a plan file process with
the file group, it is still recommended to leave Interacts with Process Management enabled, in case you
change your mind in the future. The option has no effect if the file group has no plan file processes.

� Enabling Interacts with Process Management at the role level
When creating new permission sets for roles, Interacts with Process Management is disabled by default.
You should consider whether to enable the option or leave it disabled, based on how you are granting
permissions to users and how you are assigning step owners. Keep in mind the following:

l If ownership assignments aremade through a role, then users who belong to the role must have
permission to the plan file and Interacts with Process Management enabled in order to be a step
owner. However, these permissions can come from any permission set for the user; they do not
need to be granted through the role used as the ownership assignment.

l If these plan file permissions are granted at the user level (or inherited by the user through a
different role) then there is no need to enable Interacts with Process Management for the role
that will be used as the assignment.

l However, if the role being used as the assignment is also the primary means by which users are
granted plan file permissions, then Interacts with Process Management should be enabled for
the role so that users inherit that setting as well.

Generally speaking, if the only purpose of the role is to define a pool of users for process ownership
assignments, then you should leave the option disabled and instead rely on the individual user
permissions to determine the ultimate step ownership.
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NOTE: It is not required to enable this permission for a role in order to assign the role as a step owner
in a plan file process. The assigned role simply defines the pool of users that are available to become
step owners; the role itself is not required to have any particular permissions.

Understanding role inheritance options for file group permissions

Role inheritance for file group permissions is handled differently than in other areas of Security. For each
set of permissions defined for a user on the File Groups tab, you can specify whether role permissions
are inherited and how they are inherited.

File group permissions have three different role inheritance options:
l None
l Combine
l Independent

By default, if no file group permissions are configured for a user, the role inheritance is set to
independent. This means that users will inherit file group settings from all roles that they are assigned to,
but those inherited settings will be applied independently instead ofmerged.

The following sections explain how each role inheritance option works.

� No inheritance
TheNone option means that no role inheritance applies. Role settings are ignored for this particular
permission set. If the user only has one permission set, then role settings are ignored entirely (for
settings on the File Groups tab).

The following is an example of how file group settings are treated with no inheritance, assuming that the
user belongs to the role:

File Group Settings User Configured
Settings

Role Configured
Settings

User Effective
Permissions

File Access Level Read Only Read/Write Read Only

Allow Save Data Unchecked Checked Unchecked

Allow Calc Method Insert Checked Checked Checked

Allow Calc Method Change Unchecked Checked Unchecked

Apply settings to Filtered Plan Files:

DEPT.Region='North'

Filtered Plan Files:

DEPT.Region='South'

Filtered Plan Files:

DEPT.Region='North'

In this example, the role settings are ignored, and the user has only his or her configured permissions.
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� Combine inheritance
The Combine option means that the user's permissions are combined with role permissions. The user is
granted themost permissive rights as defined for either the user or the role, on a per permission basis.

The following is an example of how file group settings are treated with combine inheritance, assuming
that the user belongs to the role:

File Group Settings User Configured
Settings

Role Configured
Settings

User Effective
Permissions

File Access Level Read Only Read/Write Read/Write

Allow Save Data Unchecked Checked Checked

Allow Calc Method Insert Checked Checked Checked

Allow Calc Method Change Unchecked Checked Checked

Apply settings to Filtered Plan Files:

DEPT.Region='North'

Filtered Plan Files:

DEPT.Region='South'

Filtered Plan Files:

(DEPT.Region='North')
OR
(DEPT.Region='South')

In this example, the user and role permissions are combined, and the user is granted themost
permissive set of rights available for each individual setting.

When you select combine inheritance, you can choose to combine with all roles that the user is assigned
to, or to combine with a specific role. For example, imagine that the user belongs to role A and role B,
and the permissions are as follows:

File Group Settings User Configured
Settings

Role A Configured
Settings

Role B Configured
Settings

File Access Level Read Only Read/Write Read Only

Allow Save Data Unchecked Checked Unchecked

Allow Calc Method Insert Checked Checked Unchecked

Allow Calc Method Change Unchecked Checked Unchecked

Apply settings to Filtered Plan Files:

DEPT.Region='North'

Filtered Plan Files:

DEPT.Region='South'

Filtered Plan Files:

DEPT.Country='France'

In this case, the effective permissions of the user depend on whether the combine inheritance is set to all
roles, or to a specific role:
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File Group
Settings

Combine: All Roles Combine: Role A Combine: Role B

File Access Level Read/Write Read/Write Read Only

Allow Save Data Checked Checked Unchecked

Allow Calc Method
Insert

Checked Checked Checked

Allow Calc Method
Change

Checked Checked Unchecked

Apply settings to Filtered Plan Files:

(DEPT.Region='North') OR
(DEPT.Region='South')
OR
(DEPT.Country='France')

Filtered Plan Files:

(DEPT.Region='North')
OR
(DEPT.Region='South')

Filtered Plan Files:

(DEPT.Region='North') OR
(DEPT.Country='France')

When combined with all roles, the user is granted themost permissive set of rights across all of the roles.
When combined with only one of the roles, the second role is effectively ignored. Unless the user has
another set of permissions that allows inheritance from the second role, the user will not inherit any file
group settings from the second role.

� Independent inheritance
The Independent option means that the user inherits permissions from roles, but the role permissions
are applied independently from the user's configured permissions. The user and role permissions are not
merged, as they are when using the combine option. The user effectively has two sets of permissions:
one set based on the user's configured permissions, and one set based on the role's inherited
permission. Additionally, if the user belongs to multiple roles, each role's permissions are inherited
independently from each other (assuming that the independent inheritance is set to apply to "all roles").

The following is an example of how file group settings are treated with independent inheritance,
assuming that the user belongs to the role:

File Group Settings User Configured
Settings

Role Configured
Settings

File Access Level Read Only Read/Write

Allow Save Data Unchecked Checked

Allow Calc Method Insert Checked Checked

Allow Calc Method Change Unchecked Checked

Apply settings to Filtered Plan Files:

DEPT.Region='North'

Filtered Plan Files:

DEPT.Region='South'
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In this example, the user's effective permissions are the same as the user configured permissions and the
role configured permission, except applied separately. When the user accesses a plan file that belongs to
the North region, it will be read only, and the user will not be able to change calc methods. When the
user accesses a plan file that belongs to the South region, it will be read/write, and the user has all of the
other plan file permissions as defined for the role.

If there is any overlap between the two independent permissions, then the user will be granted themost
permissive set of rights for the area of overlap only. In the above example the filters cannot overlap, but
imagine that the user and role filters were instead something like the following:

User Filter: DEPT >= 5000 and DEPT < 6000

Role Filters: DEPT >= 4000 and DEPT < 6000

In this case, the role permissions alone would apply to any departments from 4000 up to 4999. Where
the permissions overlap, for departments 5000 to 5999, the user and role permissions would be
combined.

NOTE: If you use independent inheritance with a specific role instead of all roles, that configuration
blocks inheritance from all other roles unless the user has another permission set that allows the
inheritance from the other roles.

� Multiple permission sets
For each file group, a user can havemultiple sets of permissions that apply to the plan files in that file
group. This allows you to define different permissions for different subsets of files. For example, you
might want to give a user full read/write access to plan files belonging to the North region, but only read
access to plan files belonging to the South region. In this case, you can create two sets of permissions for
the user.

If a user has multiple permission sets, each permission set has its own role inheritance settings. For
example, you may want to define filters at the user level, but define other access rights at the role level,
as shown in the following example:

File Group Settings User Configured
Settings (Set 1)

Role A Configured
Settings

User Effective
Permissions
(Combine: Role A)

File Access Level None Read/Write Read/Write

Allow Save Data Unchecked Checked Checked

Allow Calc Method Insert Unchecked Checked Checked

Allow Calc Method Change Unchecked Checked Checked

User Permission Set 1, Combine: Role A
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File Group Settings User Configured
Settings (Set 1)

Role A Configured
Settings

User Effective
Permissions
(Combine: Role A)

Apply settings to Filtered Plan Files:

DEPT.Region='North'

Filtered Plan Files:

<Blank Filter>

Filtered Plan Files:

DEPT.Region='North'

File Group Settings User Configured
Settings (Set 2)

Role B Configured
Settings

User Effective
Permissions
(Combine: Role B)

File Access Level None Read Only Read Only

Allow Save Data Unchecked Unchecked Unchecked

Allow Calc Method Insert Unchecked Checked Checked

Allow Calc Method Change Unchecked Unchecked Unchecked

Apply settings to Filtered Plan Files:

DEPT.Region='South'

Filtered Plan Files:

<Blank Filter>

Filtered Plan Files:

DEPT.Region='South'

User Permission Set 2, Combine: Role B

The ability to definemultiple permission sets with separate inheritance settings is a very flexible feature,
able to meet a wide variety of security needs. When using multiple permission sets, keep in mind that it
is possible to configure settings that cancel out or contradict the settings of another set.

For example, if you configure one permission set with no role inheritance, and then you configure a
second permission set with independent inheritance, then the no inheritance setting on the first set is
pointless (since you are already independently inheriting all role settings from the second set). On the
other hand, it can bemeaningful to have no inheritance on the first permission set, and then combine
inheritance on the second permission set (for either all roles or a specific role). Make sure that you
understand the purpose of each permission set, and check the effective permissions section for the user
to ensure that permissions are being inherited as intended.

Configuring table permissions (Tables tab)

On the Tables tab of the Security Management dialog, you can manage user access to tables. You can
control what data a user can query from a table (read access), and what data a user can save to a table
(write access).

Administrator's Guide 2019.4 Axiom Cost Accounting │ 458



Table access can bemanaged at the table level and at the table type level. By default, users have the
following permissions:

l All table types, and stand-alone data tables and reference tables, start at "no access" for both read
and write. You must configure access to these table types and tables on a per user or role basis. If
access is defined for a table type, then any tables added to the table type will automatically inherit
that access.

l All document reference tables are automatically set to full read access, via the Everyone role.

NOTES:
l If a user is an administrator, the settings on this tab are ignored. Administrators can access

data in all tables.
l If you are defining permissions for a subsystem, see Defining maximum permissions for

subsystems.

Understanding table permissions

This section explains how the table access settings in Security work.

� Read access and write access
Each table and table type can have read access permissions and write access permissions.

l Read access defines what data a user can query from a table—for example, via a GetData function
or by running an Axiom query. For each table or table type, a user can have no read access, full
read access, or filtered read access.

l Write access defines what data a user can save to a table. For most users this means via a Save
Type 1 process set up in a plan file or a report, but it also applies to Open Table in Spreadsheet (if
the user has access to it). For each table or table type, a user can have no write access, full write
access, or filtered write access.

NOTE: Table write access does not apply to document reference tables (Save Type 3).
Document reference tables can only be created and edited via a source document; therefore
the ability to write data to the table is controlled by the user's access rights to the source
document. Also, write access is ignored for import packages—if the user has execute rights to
an import, then they can save the imported data to the specified destination table, regardless
of their write access to that table.

By default, the write access for a table or table type is set to the same level as the read access. If that is
the desired level of access, then you only need to configure the read access; the write access will be
automatically set. You can see this inheritance for the write access in the Effective Permissions box after
you set the read access.

However, if you want differing levels of read and write access for a table or table type, then you must
select the Specify custom write access check box, and then configure the specific write access.
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For example, imagine the following settings for the table GL2019:

If the read access is set to... And the write access is set to... The user's permission is...

Full Access (Default) Read: Full Access

Write: Full Access

Filter: DEPT.Region='North' (Default) Read: DEPT.Region='North'

Write: DEPT.Region='North'

Full Access Specify custom write access:

Filter: DEPT.Region='North'

Read: Full Access

Write: DEPT.Region='North'

Full Access Specify custom write access:

Filter: <Blank Filter>

Read: Full Access

Write: No Access

No Access Specify custom write access:

Full Access

Read: No Access

Write: Full Access

NOTES:
l For reference tables, the read access settings are only applied when the reference table is

queried directly—for example, when viewing the reference table using Open Table in
Spreadsheet, or when the reference table is the primary table of an Axiom query. The read
access settings defined on a reference table are not applied when queries aremade against a
data table that joins to the reference table.

Therefore if you want to restrict access to data, the filter must be defined on the data table or
its table type. For example, if you want to restrict a user to only viewing planning data for the
North region, then you must define that filter on the data table or the table type, not on the
DEPT reference table.

l Read filters are not applied to data that already exists in a spreadsheet. For example, when the
administrator runs the Process Plan Files utility to process Axiom queries in plan files, the plan
files are populated with data according to the administrator's data rights. When individual
users open these plan files, they see all of the data that was populated into the spreadsheet.
The read filters of the individual users would only be applied if the users processed Axiom
queries by using the Refresh feature. If you would like to limit data access in plan files, you can
consider dynamically hiding sheets that you do not want particular users to access.

l Keep in mind that just because a user has write access to a table, it does not mean that the
user actually has themeans to save any data. For example, in order for a user to save data to a
table from a plan file, the user must have access rights to the plan file, and the permission to
save data from the file, and the file must be configured to save data to the table. If a user does
not have access to files and/or features that facilitate saving data to the database, then the
user cannot save any data, regardless of his or her write access permissions.
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� How table type access and table access combine
Tables inherit any rights set at the table type level, and then combine that access with any rights set at
the table level, resulting in themost permissive set of rights for the table.

l If a table type is set to full or filtered access, then all tables in that table type inherit the full or
filtered access. You cannot "override" the table type setting at the table level to deny access to a
specific table in the table type. You can set individual tables to havemore permissive access than
the table type, but not less permissive.

l If desired, you can leave the table type access unset, and instead configure access at the table
level. The user will be granted whatever access is set at the table level.

l If access filters are set at both the table type level and the table level, the filters are concatenated
using OR (meaning the filters are combined to result in themost permissive set of rights for the
table).

For example, imagine a table type of GL, which contains a table named GL2019:

If the table type GL is
set to...

And the table GL2019 is
set to...

The user's permission is...

Full Access No Access (nothing is
configured)

Full Access

Full Access DEPT.Region='North' Full Access

No Access (nothing is
configured)

DEPT.Region='North' DEPT.Region='North'

DEPT.Region='South' Full Access Full Access

DEPT.Region='South' DEPT.Region='North' (DEPT.Region='South') OR
(DEPT.Region='North')

Tables that do not belong to a table type only have their individual table access rights.

� Table visibility to users
If a user does not have any read access to a table, then that table will not display in lists of tables
throughout the system, such as in the Sheet Assistant, or the Filter Wizard. Table Library folders and
table types will only display if the user has read access to at least one table within the folder or the table
type. (Exception: if the user has the Administer Tables permission, then that user will see all Table Library
folders and table types for the purposes of creating new tables.)

Table permissions

The settings on the Tables tab define access for each table or table type. The left-hand side of the tab lists
the available tables in the system, organized by table type. Tables that do not belong to a table type are
listed under (No Type). When you select a table or a table type in the list, you can configure the security
settings for the user or role within the Configured Permissions section in the right-hand side of the tab.
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Example Tables tab

The Effective Permissions section displays the full permissions of the user for the selected item, taking
into account any rights inherited from the table type or a role, and other settings such as administrator
rights or subsystem restrictions. Make sure to check this section to ensure that users are being granted
rights as you expect.

Because table permissions can be set at any point in the treeview, it can be difficult to later tell which
items have been configured. To change the view to only show items with configured permissions, select
the check box for Show configured items only. If the treeview is blank after selecting this check box, this
means that the user or role has no configured permissions.

NOTE: By default, the Everyone role grants all users full read access to document reference tables.
Any changes made to document reference tables in the Tables tab will not apply to users unless you
modify the Everyone role to remove full access (or unless you configure the user to ignore role
inheritance for that table).

� Read access settings
The following settings apply to all tables and table types, to define read access to data. By default, the
write access is automatically set to the same level as the read access. If that is the desired level of access,
then you do not need to do anything further to configure write access for a table or table type.
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Item Description

Full access

(Full read access)

Select this check box if you want the user or role to have full access to the table
or table type.

By default, this check box grants full read and write access. If you want to
configure write access separately, then you must enable the separate option to
Specify custom write access. Selecting that option exposes additional settings
for write access, and renames this check box to Full read access.

NOTE: If you are defining access for a table that belongs to a table type, and full
access has already been granted at the table type level, then this check box is
effectively ignored. However, the setting will be stored at the table level and
could apply in the future if the table type access is ever changed, or if the table is
removed from the table type. Be sure to check the Effective Permissions
section of the dialog to see what level of access is being granted due to
inheritance.

Filter

(Read filter)

If you want the user or role to have filtered access to the table or table type,
specify the filter. For example:

l ACCT.Acct>10000 restricts the user to only accessing data for accounts
over 10000.

l DEPT.Dept=100 restricts the user to only accessing data for department
100.

l DEPT.Region='North' restricts the user to only accessing data for
departments assigned to the North region.

By default, the filter applies to both read and write access. If you want to
configure write access separately, then you must enable the separate option to
Specify custom write access. Selecting that option exposes additional settings
for write access, and renames this option to Read filter.

NOTE: If you are defining a filter for a table that belongs to a table type, the filter
will be concatenated to the table type filter using OR. If full access has been
granted at the table type level, then the table level filter is effectively ignored.
However, the filter will be stored for the table and could apply in the future if the
table type access is ever changed, or if the table is removed from the table type.
Be sure to check the Effective Permissions section of the dialog to see what
level of access is being granted due to inheritance.
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To define a filter for a table or table type, type the filter into the Filter box, or use the Filter Wizard .
Note the following:

l If the filter is for a table type, the filter should be based on key columns that are common to all
tables in the table type (using either the key column itself, or a column in the lookup table that the
key column links to). For example, if the GL table type has two required key columns, ACCT and
DEPT, then you can create a table type filter that uses one or both of these columns, or one that
uses grouping columns in the associated reference tables. Filters using any other columns may be
invalid.

l If the table type has required columns, then any filter defined must be based on those required
columns. If the required columns do not have lookups, then no valid filters can be defined.

l When selecting key columns in the Filter Wizard, the Filter Wizard automatically uses the lookup
column in the reference table instead of the column in the data table. For example, if you select
the column Acct in the GL2019 data table, the filter wizard automatically uses ACCT.ACCT in the
filter (instead of GL2019.ACCT).

After defining a filter, you can validate the filter syntax by clicking the Validate filter button .

IMPORTANT: If you define a write filter on a reference table, then any columns used in the filter must
also be included in the save definition when saving to that table using Save Type 1. For example, if
the table is DEPT and the filter uses DEPT.Region, then the Region column must be included in the
save definition in order for the user to save data.

� Write access settings
The following settings only apply if you want to configure write access at a different level than the read
access.

NOTE: Write access settings do not apply to document reference tables. Document reference tables
are only created and edited via a source document; therefore the ability to write data to the table is
controlled by the user's access rights to the document.

Item Description

Specify custom
write access

Select this check box if you want to configure write access at a different level
than the read access.

When this check box is selected, two additional settings become available in the
dialog to set the write access: Full write access andWrite filter.

If you want the user to have no write access to the table, then select this check
box and ignore the other write access settings. If Full write access is unchecked
andWrite filter is blank, then the user has no write access.
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Item Description

Full write access Select this check box if you want the user or role to have full write access to the
table or table type.

NOTE: If you are defining access for a table that belongs to a table type, and full
access has already been granted at the table type level, then this check box is
effectively ignored. However, the setting will be stored at the table level and
could apply in the future if the table type access is ever changed, or if the table is
removed from the table type. Be sure to check the Effective Permissions
section of the dialog to see what level of access is being granted due to
inheritance.

Write filter If you want the user or role to have filtered write access to the table or table
type, specify the filter. For example:

l ACCT.Acct>10000 restricts the user to only saving data for accounts over
10000.

l DEPT.Dept=100 restricts the user to only saving data for department 100.
l DEPT.Region='North' restricts the user to only saving data for

departments assigned to the North region.

NOTE: If you are defining a filter for a table that belongs to a table type, the filter
will be concatenated to the table type filter using OR. If full access has been
granted at the table type level, then the table level filter is effectively ignored.
However, the filter will be stored for the table and could apply in the future if the
table type access is ever changed, or if the table is removed from the table type.
Be sure to check the Effective Permissions section of the dialog to see what
level of access is being granted due to inheritance.

To define a filter for a table or table type, type the filter into the Filter box, or use the Filter Wizard .
Note the following:

l If the filter is for a table type, the filter should be based on key columns that are common to all
tables in the table type (using either the key column itself, or a column in the lookup table that the
key column links to). For example, if the GL table type has two required key columns, ACCT and
DEPT, then you can create a table type filter that uses one or both of these columns, or one that
uses grouping columns in the associated reference tables. Filters using any other columns may be
invalid.

l If the table type has required columns, then any filter defined must be based on those required
columns. If the required columns do not have lookups, then no valid filters can be defined.

l When selecting key columns in the Filter Wizard, the Filter Wizard automatically uses the lookup
column in the reference table instead of the column in the data table. For example, if you select
the column Acct in the GL2019 data table, the filter wizard automatically uses ACCT.ACCT in the
filter (instead of GL2019.ACCT).
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After defining a filter, you can validate the filter syntax by clicking the Validate filter button .

IMPORTANT: If you define a write filter on a reference table, then any columns used in the filter must
also be included in the save definition when saving to that table using Save Type 1. For example, if
the table is DEPT and the filter uses DEPT.Region, then the Region column must be included in the
save definition in order for the user to save data.

� Other table permissions
The following permissions can also be defined for tables and table types:

Item Description

Open Table in
Spreadsheet

This option specifies whether the user can view the table in Open Table in
Spreadsheet, and at what level of access. Select one of the following:
l None (default): The user cannot view the table in Open Table in Spreadsheet.
l Read-Only: The user can view the table as read-only in Open Table in

Spreadsheet.
l Read/Write: The user can view the table as read/write in Open Table in

Spreadsheet.

Granting this permission gives the user access to the Table Library, so that the
user can launch Open Table in Spreadsheet for the table.

This permission does not apply to document reference tables. Document
reference tables cannot be opened via Open Table in Spreadsheet.

This permission can only be assigned if the user has read or read/write
permission to the table data (either configured on the user or inherited from a
role). If the user inherits Open Table in Spreadsheet permission from a role but
does not have any corresponding access to table data, then the permission will
be ignored. If the user is granted read/write access to Open Table in
Spreadsheet but only has read access to the table, then the spreadsheet access
will be limited to read-only.
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Item Description

Allow changing
table structure

Select this check box if you want the user to be able to edit the table structure
and table properties. If selected, then the user can open the Edit Table dialog
for the table. The user can add, modify, and delete table columns, as well as
modify other table properties.
Granting this permission gives the user access to the Table Library, so that the
user can launch Edit table structure for the table.

By default this option is not selected, which means the user cannot edit the
table structure or table properties.

This permission does not apply to document reference tables. The table
structure of document reference tables is controlled via the source file.

This permission can be granted regardless of whether the user has access to the
table data.

Ignore role
inheritance

Select this check box if you do not want the user to inherit table access settings
from a role (including the Everyone role).
l If selected, then only the user's individual settings will be used to determine

access to data in the table or table type.
l If this check box is not selected, then the user will be granted themost

permissive set of rights among the user's configured settings and any roles
that the user belongs to. If both the user and a role have filtered access,
then the filters are concatenated using OR.

� Restricting access to document reference tables
By default, all users have full read access to document reference tables, via the Everyone role. In most
cases this is the desirable level of access. However, in some cases you may need to restrict access to a
subset of users. To restrict access to a document reference table, you must do the following:

l In the Everyone role, clear the Full Access check box for the table. Now no non-admin users have
access to the table.

l For each individual user or role that you want to grant full or filtered access to the table, modify
the table access settings as desired.

TIP: Alternatively, you could leave the Everyone role at full access, and then modify specific users to
Ignore role inheritance for the table. Those users would then have no access to the table.

Write access settings do not apply to document reference tables. Document reference tables are only
created and edited via a source document; therefore the ability to write data to the table is controlled by
the user's access rights to the document.
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NOTE: If you have restricted access to a document reference table created by a driver file, keep in
mind that your security changes will not be cloned when the file group is cloned. This is because the
table itself is not cloned; the driver file is. If you want to apply the same changes to the new table
created by the new driver file, then you will need to manually configure access to this table after
processing the drivers for the new file group.

Configuring file access (Files tab)

On the Files tab of the Security Management dialog, you can control access to files in the Axiom Cost
Accounting file system. The following areas can be controlled:

l The Reports Library
l The Data Diagrams Library
l The Filter Library
l The Imports Library and the Exports Library
l The Process Definitions Library
l The Scheduler Jobs Library
l The Task Panes Library
l The Ribbon Tabs Library
l Certain supporting files for file groups: Templates, Drivers, Utilities, and Process Definitions

NOTES:
l File permissions do not apply to users with administrator rights. Administrators always have

full access to all files.
l File permissions must be defined within the Security Management dialog. The bulk editing tool

Open Security in Spreadsheet does not support configuring file and folder permissions.
l If you are defining file permissions for a subsystem, see Defining maximum permissions for

subsystems.

� Configuring file permissions
The left-hand side of the Files tab displays the available folders and files. When you select a folder or a file
in the list, you can define the security settings for the user or role within the Configured Permissions
section in the right-hand side of the tab.
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Example Files tab

File permissions can be set at the folder level and at the file level. By default, all sub-folders and files
underneath a parent folder inherit the rights of the parent folder, unless rights are explicitly set for the
sub-folder or file.

You can set permissions at the library level and then override those permissions for specific sub-folders
and files as needed, or you can set permissions for specific sub-folders and files only.

By default, each user or role has no access to any files or folders on this tab. You must define file
permissions for each user or role.

To configure permissions to a file or folder:
1. Select the file or folder in the treeview, and then select Configured Permissions.

If this check box is selected for a sub-folder or a specific file, the sub-folder or file will no longer
inherit any permissions set for the parent folder. You can clear the check box, and the sub-folder
or file will once again inherit permissions from the parent folder.

2. Select the applicable permission options as desired.

Each type of file (reports, import, etc.) has slightly different security settings that can be defined
on this tab. For more information on the file-specific options, see the detailed sections.
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If a new folder or file is added to any library, a user will have access to it if the folder or file is placed
underneath an existing parent folder that the user has rights to. For example, if a user has rights to the
entire Reports Library, that user will have access to any new folders and files added to the Reports
Library. If a user only has rights to a specific sub-folder in the Reports Library, that user will have access to
new folders and files added to that sub-folder.

The Effective Permissions section displays the full permissions of the user, taking into account any
inherited role rights, and other settings such as administrator rights. This section also takes into account
rights that are inherited from a parent folder.

NOTE: Because file permissions can be set at any point in the treeview, it can be difficult to later tell
which items have been configured. To change the view to only show items with configured
permissions, select the check box for Show configured items only. If the treeview is blank after
selecting this check box, this means that the user or role has no configured permissions.

� Reports Library
The following permissions can be set for files in the Reports Library:

Option Description

Access Select one of the following:
l No Access: The user or role cannot access the folder or file.
l Read Only: The user or role has read-only access to the folder or file.

Users with read-only access to reports can open and refresh reports, but
cannot save changes. If read access is set at the folder level, users cannot
save new reports to that folder.

l Read/Write: The user or role has read/write access to the folder or file.
If the item is a file, the user can save changes to the file. If the item is a folder,
the user can also save new files to the folder, create sub-folders, and delete
and rename files and folders.
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Option Description

Show in Explorer Select this check box if you want the file to display in the Explorer task pane and
other "Explorer views" of the file library (such as Axiom Explorer, libraries
displayed on the ribbon menu, and libraries displayed when saving files). This
check box becomes selected by default when you assign an access level of Read
Only or higher.

If this check box is cleared, and the user has Read Only access or higher, then
the file does not display in Explorer views but the user can still open the file if the
user has access to a feature that indirectly opens the file. This includes features
such as custom drilling, GetDocument functions, and file shortcuts in task panes
and ribbon tabs. The idea is that the user never needs to directly open the file
from a folder structure, but the user needs access to the file in order to use
these other features.

If the user's access level is No Access, then this setting is ignored.

For example, you might clear this check box for the target report of a custom
drill. The user only needs to be able to access this report when performing a
custom drill on the source file. Displaying the file in the Reports Library would
just clutter the list of files because the user never needs to open the file from
that location.

NOTE: The Reports Library dialog (accessible from Reports > All Reports) does
not honor this permission. If a user has at least read-only access to a report, it
will show in this dialog, regardless of the Show in Explorer permission.

Allow Save Data Select this check box if you want the user or role to be able to save data to the
database for the folder or file. If a report is set up to use Save Type 1, 3, or 4, the
user will be able to save data to the database.

If this check box is not selected, then the user cannot save data to the database
from the report.

NOTE: If a user has Read Only access and Allow Save Data, then the user will be
able to save data to the database but not save changes to the file. Note that
users with this combination of rights can save data from the file at any time,
regardless of whether the file is locked to another user.
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Option Description

AllowUnprotect Select this check box if you want the user or role to be able to remove workbook
and/or worksheet protection for this folder or file.

Users with this permission can use the Advanced > Protect options on the
ribbon to remove workbook or worksheet protection from Axiom files.

IMPORTANT: If you enable this permission at the folder level, then the user will
be able to unprotect any file that they save to the folder (assuming that the user
has read/write access to the folder).

NOTE: This setting is ignored for users with the Remove Protection permission
on the Permissions tab; those users can remove protection for any file.

Allow Sheet
Assistant

Select this check box if you want the user or role to see the Sheet Assistant.
Generally, you should only expose the Sheet Assistant if the user is expected to
edit file settings, including Axiom query settings.

Enabling this permission also has the following impacts:
l The user has access to the Control Sheet. If the Control Sheet is hidden in

the document, the user can make it visible by double-clicking any field name
in the Sheet Assistant.

l If the user has read / write permission and the Sheet Assistant permission,
then the user can enable forms for the file and can see the Form Assistant
and Form Control Sheet.

l The Drilling Control Sheet, if present in the file, is not hidden if the user has
the Sheet Assistant permission.

l The Data Source Assistant is also available if the Sheet Assistant is available.

If this check box is not selected, then the user cannot see the Sheet Assistant or
the other related items as described above.

Allow File
Processing

Select this check box if you want the user or role to be able to perform file
processing on the file. If selected, then the user has access to file processing
features, including the File Processing button on themenu and the File
Processing task pane. The related control sheets will also be visible to the user.

If this check box is not selected, then the user cannot perform file processing
actions and cannot see the related menu items, task panes, or control sheets.

NOTE: If a user does not have access to any report files or folders, then the Reports menu item does
not display on themenu, and the user cannot create reports.

� Filter Library
The following permissions can be set for files in the Filter Library:

Administrator's Guide 2019.4 Axiom Cost Accounting │ 472



Option Description

Access Select one of the following:
l No Access: The user or role cannot access the folder or filter.
l Read Only: The user or role has read-only access to the folder or filter.

Users with read-only access to saved filters can load those filters into the
Filter Wizard for use. If read access is set at the folder level, users cannot
save new filters to that folder.

l Read/Write: The user or role has read/write access to the folder or filter.
If the item is a filter, the user can save changes to the filter. If the item is a
folder, the user can also save new filters to the folder, create sub-folders,
and delete and rename filters and folders.

Show in Explorer Select this check box if you want the file to display in the Explorer task pane and
other "Explorer views" of the file library (such as Axiom Explorer, libraries
displayed on the ribbon menu, and libraries displayed when saving files). This
check box becomes selected by default when you assign an access level of Read
Only or higher.

If this check box is cleared, and the user has Read Only access or higher, then
the file does not display in Explorer views but the user can still open the file if the
user has access to a feature that indirectly opens the file. This includes features
such as custom drilling, GetDocument functions, and file shortcuts in task panes
and ribbon tabs. The idea is that the user never needs to directly open the file
from a folder structure, but the user needs access to the file in order to use
these other features.

If the user's access level is No Access, then this setting is ignored.

� Scheduler Jobs Library

NOTE: Users must also have the Scheduled Jobs User permission (on the Permissions tab) in order
to access any files in the Scheduler Jobs Library.

The following permissions can be set for files in the Scheduler Jobs Library:
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Option Description

Access Select one of the following:
l No Access: The user or role cannot access the folder or file.
l Read Only: The user or role has read-only access to the folder or file.

Users with read-only access to Scheduler jobs can open jobs and can
manually execute jobs, but cannot save changes. If read access is set at the
folder level, users cannot save new jobs to that folder.

l Read/Write: The user or role has read/write access to the folder or file.
If the item is a file, the user can save changes to the file. If the item is a folder,
the user can also save new files to the folder, create sub-folders, and delete
and rename files and folders.

Show in Explorer Select this check box if you want the file to display in the Explorer task pane and
other "Explorer views" of the file library (such as Axiom Explorer, libraries
displayed on the ribbon menu, and libraries displayed when saving files). This
check box becomes selected by default when you assign an access level of Read
Only or higher.

If this check box is cleared, and the user has Read Only access or higher, then
the file does not display in Explorer views but the user can still open the file if the
user has access to a feature that indirectly opens the file. This includes features
such as custom drilling, GetDocument functions, and file shortcuts in task panes
and ribbon tabs. The idea is that the user never needs to directly open the file
from a folder structure, but the user needs access to the file in order to use
these other features.

If the user's access level is No Access, then this setting is ignored.

For example, you might clear this check box if a user needs to be able to open a
Scheduler job from a shortcut in a task pane, but otherwise the user does not
need to be able to browse to it in the Scheduler Jobs Library.

� Exports Library
The following permissions can be set for files in the Exports Library:
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Option Description

Access Select one of the following:
l No Access: The user or role cannot open the folder or file (however, they can

execute the export, if they have the separate Execute permission).
l Read Only: The user or role has read-only access to the folder or file.

Users with read-only access to exports can open export files to view the
settings, but they cannot edit the settings.

l Read/Write: The user or role has read/write access to the folder or file.
If the item is a file, the user can save changes to the file. If the item is a folder,
the user can also save new files to the folder, create sub-folders, and delete
and rename files and folders.
NOTE: Read/write access to the Exports Library does not allow the user to
create exports. Export creation is controlled by the Administer Exports
permission on the Permissions tab.

Execute Select this check box to give the user execute permissions to the folder or file.
Users with execute permissions can run the export.

NOTE: Table read permissions are honored for export packages. When the user
executes the export, the user's permission to the table will determine the
eligible data to export. If the user does not have access to the table at all, then
no data will be exported.
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Option Description

Show in Explorer Select this check box if you want the file to display in the Explorer task pane and
other "Explorer views" of the file library (such as Axiom Explorer, libraries
displayed on the ribbon menu, and libraries displayed when saving files). This
check box becomes selected by default when you assign an access level of Read
Only or higher.

If this check box is cleared, and the user has Read Only access or higher, then
the file does not display in Explorer views but the user can still open the file if the
user has access to a feature that indirectly opens the file. This includes features
such as custom drilling, GetDocument functions, and file shortcuts in task panes
and ribbon tabs. The idea is that the user never needs to directly open the file
from a folder structure, but the user needs access to the file in order to use
these other features.

For example, you might clear this check box if a user needs to be able to execute
an export from a shortcut in a task pane, but otherwise the user does not need
to be able to browse to it in the Exports Library.

NOTE: If a user has Execute permissions but No Access to the export file, then
you should select this check box if you want the export to display in the Export
Library. When using this configuration, the user can double-click the file to open
the Execute dialog only. If, however, the user will only execute the export from
links in a task pane or other predefined links, then you can leave this option
cleared.

NOTE: The export access permission and the execute permission are independent. A user can have
no access to an export file but still be given execute permissions. Similarly, a user can have read/write
access to the export settings, but not be able to execute it.

� Imports Library
The following permissions can be set for files in the Imports Library:
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Option Description

Access Select one of the following:
l No Access: The user or role cannot access the folder or file (however, they

can execute the import, if they have the separate Execute permission).
l Read Only: The user or role has read-only access to the folder or file.

Users with read-only access to imports can open import files to view the
settings, but they cannot edit the settings.

l Read/Write: The user or role has read/write access to the folder or file.
If the item is a file, the user can save changes to the file. If the item is a folder,
the user can also save new files to the folder, create sub-folders, and delete
and rename files and folders.
NOTE: Read/write access to the Imports Library alone does not allow the
user to create new imports. The user must also have the Administer
Imports permission on the Permissions tab.

Execute Select this check box to give the user execute permissions to the folder or file.
Users with execute permissions can run the import.

NOTE: Table write permissions are ignored for import packages. If a user has
execute rights to an import, then the imported data will be saved to the
configured destination table, regardless of the user's write access to that table.

Show in Explorer Select this check box if you want the file to display in the Explorer task pane and
other "Explorer views" of the file library (such as Axiom Explorer, libraries
displayed on the ribbon menu, and libraries displayed when saving files). This
check box becomes selected by default when you assign an access level of Read
Only or higher.

If this check box is cleared, and the user has Read Only access or higher, then
the file does not display in Explorer views but the user can still open the file if the
user has access to a feature that indirectly opens the file. This includes features
such as custom drilling, GetDocument functions, and file shortcuts in task panes
and ribbon tabs. The idea is that the user never needs to directly open the file
from a folder structure, but the user needs access to the file in order to use
these other features.

If the user's access level is No Access, then this setting is ignored.

NOTE: If a user has Execute permissions but No Access to the import file, then
you should select this check box if you want the import to display in the Import
Library. When using this configuration, the user can double-click the file to open
the Execute dialog only. If, however, the user will only execute the import from
links in a task pane or other predefined links, then you can leave this option
cleared.
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NOTES:
l The import access permission and the execute permission are independent. A user can have

no access to an import file but still be given execute permissions. Similarly, a user can have
read/write access to the import settings, but not be able to execute it.

l The Import Errors folder is system-maintained and therefore does not display in this dialog.
You cannot manually grant or deny access to this folder or the error files within it; access is
automatically granted based on access to the import that generated the error.

l If an import uses an Axiom database as its source, then non-administrators cannot view or
edit that import regardless of their access rights granted here. However, non-administrators
can execute the import if they have that permission.

� Task Panes Library
The following permissions can be set for files in the Task Panes Library:

Option Description

Access Select one of the following:
l No Access: The user or role cannot access the folder or file.
l Read Only: The user or role has read-only access to the folder or file.

Users with read-only access to task panes can view and use task panes but
cannot save changes. If read access is set at the folder level, users cannot
save new task panes to that folder.

l Read/Write: The user or role has read/write access to the folder or file.
If the item is a file, the user can save changes to the file. If the item is a folder,
the user can also save new files to the folder, create sub-folders, and delete
and rename files and folders.
NOTE: Users must also have the Administer Task Panes permission (on the
Permissions tab) in order to create or edit task panes.
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Option Description

Show in Explorer Select this check box if you want the file to display in the Explorer task pane and
other "Explorer views" of the file library (such as Axiom Explorer, libraries
displayed on the ribbon menu, and libraries displayed when saving files). This
check box becomes selected by default when you assign an access level of Read
Only or higher.

If this check box is cleared, and the user has Read Only access or higher, then
the file does not display in Explorer views but the user can still open the file if the
user has access to a feature that indirectly opens the file. This includes features
such as custom drilling, GetDocument functions, and file shortcuts in task panes
and ribbon tabs. The idea is that the user never needs to directly open the file
from a folder structure, but the user needs access to the file in order to use
these other features.

If the user's access level is No Access, then this setting is ignored.

For example, you might clear this check box if a user needs to be able to open
an associated task pane for a file, but otherwise the user does not need to be
able to open the task pane from the Task Panes Library.

NOTES:
l Task panes can contain shortcuts to various files and system features. The ability of a user to

open a file or use a feature from the task pane depends on the user's permission for that file or
feature.

l Users do not need to have access permission to a task pane in order to open it at startup. If a
user is assigned a task pane on the Startup tab of security, it will always open as read-only at
startup, regardless of the user's access permission.

l By default, the Axiom ribbon tab does not contain any command to open task panes. If a user
has rights to a file in the Task Panes Library, then in order to see and open this file manually
the user must have access to either the Explorer task pane or the Axiom Explorer dialog, or
you must include access to the task pane within another custom task pane or ribbon tab file
that is assigned as a startup file to the user. For example, you might create a custom task pane
that includes a link to the Task Panes Library, and if a user has file access rights to any task
panes they could be launched from this location. Users only gain access to theManage > Task
Panesmenu item if they have the Administer Task Panes security permission.

� Ribbon Tabs Library
The following permissions can be set for files in the Ribbon Tabs Library:
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Option Description

Access Select one of the following:
l No Access: The user or role cannot access the folder or file.
l Read Only: The user or role has read-only access to the folder or file.

Users with read-only access to task panes can view ribbon tab files but
cannot save changes. If read access is set at the folder level, users cannot
save new ribbon tab files to that folder.

l Read/Write: The user or role has read/write access to the folder or file.
If the item is a file, the user can save changes to the file. If the item is a folder,
the user can also save new files to the folder, create sub-folders, and delete
and rename files and folders.
NOTE: Users must also have the Administer Task Panes permission (on the
Permissions tab) in order to create or edit task panes.

Show in Explorer Select this check box if you want the file to display in the Explorer task pane and
other "Explorer views" of the file library (such as Axiom Explorer, libraries
displayed on the ribbon menu, and libraries displayed when saving files). This
check box becomes selected by default when you assign an access level of Read
Only or higher.

If this check box is cleared, and the user has Read Only access or higher, then
the file does not display in Explorer views but the user can still open the file if the
user has access to a feature that indirectly opens the file. This includes features
such as custom drilling, GetDocument functions, and file shortcuts in task panes
and ribbon tabs. The idea is that the user never needs to directly open the file
from a folder structure, but the user needs access to the file in order to use
these other features.

If the user's access level is No Access, then this setting is ignored.

This setting does not havemuch use for ribbon tab files because ribbon tabs are
typically configured as startup files for end users, and end users do not need
access permission to be able to open the file at startup.
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NOTES:
l Users do not need to have access permission to a ribbon tab in order to open it at startup. If a

user is assigned a ribbon tab on the Startup tab of security, it will always open as read-only at
startup, regardless of the user's access permission.

l In general, there is no need to grant end users access to the Ribbon Tabs Library unless the
user needs to be able to create and edit ribbon tabs. If a user opens a ribbon tab file directly
from the Ribbon Tabs Library, it will always open in the editor, not in the application ribbon.
There is no way to open a ribbon tab file on demand and have it display in the application
ribbon.

� Process Definition Library
The following permissions can be set for files in the Process Definition Library:

Option Description

Access Select one of the following:
l No Access: The user or role cannot access the folder or file.
l Read Only: The user or role has read-only access to the folder or file.

Users with read-only access to the file can open the process definition from
the Explorer task pane and view the settings.

l Read/Write: The user or role has read/write access to the folder or file.
If the item is a file, the user can save changes to the file. If the item is a folder,
the user can also save new files to the folder, create sub-folders, and delete
and rename files and folders.
Users with read/write access cannot start or stop the process, they can only
edit the process definition settings.
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Option Description

Show in Explorer Select this check box if you want the file to display in the Explorer task pane and
other "Explorer views" of the file library (such as Axiom Explorer, libraries
displayed on the ribbon menu, and libraries displayed when saving files). This
check box becomes selected by default when you assign an access level of Read
Only or higher.

If this check box is cleared, and the user has Read Only access or higher, then
the file does not display in Explorer views but the user can still open the file if the
user has access to a feature that indirectly opens the file. This includes features
such as custom drilling, GetDocument functions, and file shortcuts in task panes
and ribbon tabs. The idea is that the user never needs to directly open the file
from a folder structure, but the user needs access to the file in order to use
these other features.

If the user's access level is No Access, then this setting is ignored.

For example, you might clear this check box if a user needs to be able to open a
process definition from a shortcut in a task pane, but otherwise the user does
not need to be able to browse to it in the Process Definition Library.

� Data Diagrams Library
The following permissions can be set for files in the Data Diagrams Library:

Option Description

Access Select one of the following:
l No Access: The user or role cannot access the folder or file.
l Read Only: The user or role has read-only access to the folder or file.
l Read/Write: The user or role has read/write access to the folder or file.

If the item is a file, the user can save changes to the file. If the item is a folder,
the user can also save new files to the folder, create sub-folders, and delete
and rename files and folders.
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Option Description

Show in Explorer Select this check box if you want the file to display in the Explorer task pane and
other "Explorer views" of the file library (such as Axiom Explorer, libraries
displayed on the ribbon menu, and libraries displayed when saving files). This
check box becomes selected by default when you assign an access level of Read
Only or higher.

If this check box is cleared, and the user has Read Only access or higher, then
the file does not display in Explorer views but the user can still open the file if the
user has access to a feature that indirectly opens the file. This includes features
such as custom drilling, GetDocument functions, and file shortcuts in task panes
and ribbon tabs. The idea is that the user never needs to directly open the file
from a folder structure, but the user needs access to the file in order to use
these other features.

If the user's access level is No Access, then this setting is ignored.

For example, you might clear this check box if a user needs to be able to open a
data diagram from a shortcut in a task pane, but otherwise the user does not
need to be able to browse to it in the Data Diagrams Library.

� File Groups
The following permissions can be set for certain files and folders in file groups. Each file group is listed
separately in this section, with sub-folders for Templates, Drivers, Utilities, and Process Definitions.

NOTE: Permissions cannot be set at the file group level and inherited by the folders. Each folder must
be configured separately.

Option Description

Access Select one of the following:
l Hidden: The user or role cannot access the folder or file.
l Read Only: The user or role has read-only access to the folder or file.

Users with read-only access to files can open and refresh those files, but
cannot save changes. If read access is set at the folder level, users cannot
save new files to that folder.

l Read/Write: The user or role has read/write access to the folder or file.
If the item is a file, the user can save changes to the file. If the item is a folder,
the user can also save new files to the folder, create sub-folders, and delete
and rename files and folders.
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Option Description

Show in Explorer Select this check box if you want the file to display in the Explorer task pane and
other "Explorer views" of the file library (such as Axiom Explorer, libraries
displayed on the ribbon menu, and libraries displayed when saving files). This
check box becomes selected by default when you assign an access level of Read
Only or higher.

If this check box is cleared, and the user has Read Only access or higher, then
the file does not display in Explorer views but the user can still open the file if the
user has access to a feature that indirectly opens the file. This includes features
such as custom drilling, GetDocument functions, and file shortcuts in task panes
and ribbon tabs. The idea is that the user never needs to directly open the file
from a folder structure, but the user needs access to the file in order to use
these other features.

If the user's access level is No Access, then this setting is ignored.

For example, you might clear this check box if a user needs to be able to open
the file from a shortcut in a task pane, but otherwise the user does not need to
be able to browse to it in the Explorer task pane.

Allow Save Data Select this check box if you want the user or role to be able to save data to the
database for the folder or file. If a file is set up to use Save Type 1, 3, or 4, the
user will be able to save data to the database.

If this check box is not selected, then the user cannot save data to the database
from the report.

NOTES:
l If a user has Read Only access and Allow Save Data, then the user will be

able to save data to the database but not save changes to the file. Note that
users with this combination of rights can save data from the file at any time,
regardless of whether the file is locked to another user.

l This permission is ignored for template files and does not apply to process
definitions. Save-to-database processes do not run within file group
templates.
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Option Description

AllowUnprotect Select this check box if you want the user or role to be able to remove workbook
and/or worksheet protection for this folder or file.

Users with this permission can use the Advanced > Protect options on the
ribbon to remove workbook or worksheet protection from Axiom files.

IMPORTANT: If you enable this permission at the folder level, then the user will
be able to unprotect any file that they save to the folder (assuming that the user
has read/write access to the folder).

NOTES:
l This setting is ignored for users with the Remove Protection permission on

the Permissions tab; those users can remove protection for any file.
l This setting does not apply to process definitions.

Allow Sheet
Assistant

Select this check box if you want the user or role to see the Sheet Assistant.
Generally, you should only expose the Sheet Assistant if the user is expected to
edit file settings, including Axiom query settings.

Enabling this permission also has the following impacts:
l The user has access to the Control Sheet. If the Control Sheet is hidden in

the document, the user can make it visible by double-clicking any field name
in the Sheet Assistant.

l If the user has read / write permission and the Sheet Assistant permission,
then the user can enable forms for the file and can see the Form Assistant
and Form Control Sheet.

l The Drilling Control Sheet, if present in the file, is not hidden if the user has
the Sheet Assistant permission.

l The Data Source Assistant is also available if the Sheet Assistant is available.

If this check box is not selected, then the user cannot see the Sheet Assistant or
the other related items as described above.

NOTE: This setting does not apply to process definitions. Also, control sheets
are not hidden in template files.

Allow File
Processing

Select this check box if you want the user or role to be able to perform file
processing on the file. If selected, then the user has access to file processing
features, including the File Processing button on themenu and the File
Processing task pane. The related control sheets will also be visible to the user.

If this check box is not selected, then the user cannot perform file processing
actions and cannot see the related menu items, task panes, or control sheets.

NOTE: This setting does not apply to process definitions.
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� File permission examples
The following examples use the Reports Library, but the concept of folder inheritance applies to all files
on the Files tab.

If a user has read/write access to the Reports Library, that user can access and save files anywhere in the
library, unless a different level of access is explicitly set for a sub-folder or a file. For example:

Sub-folders and files inherit the rights defined for the parent folder, unless permissions are explicitly set
for the sub-folder or file. When you select a sub-folder or file in the folder tree, you can tell if it is
inheriting permissions by whether the Configured permission check box is selected. If this check box is
not selected, then the folder or file is inheriting permissions, and you can view the inherited permissions
in the Effective Permissions section.
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NOTE: The effective permissions also take into account role inheritance and administrator rights (if
applicable). Therefore, the sub-folder or file might show a different level of permissions than its
parent folder, if it is inheriting from a role.

If rights are set at the library level, but you want to set a different level of rights for a specific folder or file,
select Configured permission for that folder or file and define the desired level of rights. In the following
example, the user has read/write access to the Reports Library, but no access to theUtilities sub-folder.
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Note that if the user was assigned to a role that had access to the Utilities folder, then the user would be
granted that level of access even though the folder is explicitly hidden for the user. Users are granted the
highest level of file permissions allowed by their user rights and assigned roles. You cannot override role
inheritance for report file access.

It is also possible to grant a user access to a file or folder, but hide that file/folder in the user's Explorer
task pane and other "Explorer views." In the following example, theDrilling sub-folder contains drill
target files. The user needs read-only access to the files in order to perform the drill, but otherwise the
user never needs to open the files directly or see the files in their Reports Library. By clearing the Show in
Explorer option, this folder and its files will not display to the user.
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Assigning startup files (Startup tab)

On the Startup tab of the Security Management dialog, you can specify which files to open automatically
when a user logs into the system. You can also configure certain startup options.

Startup files are assigned using the following categories:
l Home Page: You can assign an alternate home page for a user or role.
l Task Panes: You can assign custom task panes to open on startup.
l Ribbon Tabs: You can assign custom ribbon tabs to open on startup.
l Other Documents: You can assign additional reports (regular or form-enabled) to open on

startup.

NOTE: Startup files are stored by document ID. If you subsequently change the name of a startup file
or move it to a different location, the startup configuration will still work. If the file is deleted, the
startup item will simply be ignored; it will not cause an error on startup.

Startup files only apply when using the Excel Client or theWindows Client, with one exception: if the
assigned home page is an Axiom form, that page will also display as the user's home page when accessing
forms in theWeb Client.
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Example Startup tab

Assigning home pages

You can optionally assign home pages on a user or role basis. If a home page is specified in Security, this
file will be used instead of the default files in the Startup folders. You can use any Axiom report (including
web reports and Axiom forms), or any normal Excel file stored in the Reports Library.

You can assign each user or role a "global" home page to be used in all clients. You can also override this
assignment to show a different home page in the Desktop Client (Excel Client or Windows Client).

The home page is always opened as read-only. The user does not need to be granted permissions to the
file in order to open it on startup.

To assign a home page to a user or role:
1. On the Startup tab of the Security Management dialog, click the [...] button to the right of either

of the following fields:
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Item Description

Home Page This "global" home page is used in all clients, unless a Desktop Client Home
Page is also specified.

If you want this home page to display in theWeb Client, the selected file
must be web-enabled (either an Axiom form or a web report). If the file is
not web-enabled, then the assignment will be ignored for purposes of the
Web Client.

Desktop Client
Home Page

This home page is used in the Desktop Client only (Windows Client or Excel
Client), overriding the Home Page assignment.

The Shortcut Properties dialog opens so that you can select a file.

2. To specify the file, click the [...] button to the right of the Shortcut Target box. In the Choose
Document dialog, select the desired file from the Reports Library, then click OK.

3. Once the file has been selected, specify any of the following optional Shortcut Parameters:

Item Description

Axiom Tab
Name

An alternate name to display on the file tab. By default, the tab name is
"Home".

Quick Filter AQuick Filter to apply to the file. The Quick Filter must be a valid filter
criteria statement. Once the file is opened, users can clear the filter using
the Quick Filter option on the ribbon.

NOTE: Queries in the target file must be configured to refresh on open, in
order for the filter to be applied to the data when the file is opened.

This option does not apply to web reports.

Non-closeable Specifies whether the user can close the file once it has been opened.

By default, this is not enabled, which means the file is closeable. If a user
closes the home page, they can reopen it using the Show Home button on
the default Axiom ribbon tab.

You might enable this option if you have defined a custom ribbon tab for
end users that does not contain the ShowHome button. This ensures that
users will always have access to the home page by preventing them from
closing it.

View As Form Select this option to open the report as an Axiom form. This option only
applies if the report is form-enabled.

4. Click OK.

The selected file displays in theHome Page box.
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You can change the home page assignment at any time, or remove the assignment by clicking the delete
button.

� Home page priority order
When a user logs into an Axiom Cost Accounting client, their home page is determined using the
following priority order. If the first item on the list is defined, then that file is used, otherwise the next
item on the list is used, and so on.

Desktop Client (Excel and Windows)
1. Security-assigned home page at the user level

2. Security-assigned home page for a role the user belongs to (excluding the Everyone role)

NOTE: If a user belongs to multiple roles, and more than one role has an assigned home page,
the home page of the "first" role is used (determined alphabetically by role name).

3. Security-assigned home page for the Everyone role

Axiom Cost Accounting first cycles through items 1-3 looking for a Desktop Client Home Page
assignment. If no assignment is found, Axiom Cost Accounting cycles through items 1-3 again, this
time looking for a Home Page assignment. If no security home page is found, Axiom Cost
Accounting continues to the next item.

4. Default home page in the Axiom System directory
l In theWindows Client, Axiom Cost Accounting checks \Startup\Home\Windows
Client first, then moves on to \Startup\Home.

l In the Desktop Client, Axiom Cost Accounting checks \Startup\Home\Excel Client
first, then moves on to \Startup\Home.

If no valid home pages are found for the Desktop Client, a blank spreadsheet is used.

Web Client
1. Product-assigned home page

This item only applies in systems with installed products. If a product area in theWeb Client has a
designated home page, that home page takes precedence over all other home page assignments.
When the user logs into theWeb Client, they see the home page for their default product area.

2. Security-assigned home page at the user level

3. Security-assigned home page for a role the user belongs to (excluding the Everyone role)

NOTE: If a user belongs to multiple roles, and more than one role has an assigned home page,
the home page of the "first" role is used (determined alphabetically by role name).
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4. Security-assigned home page for the Everyone role

For theWeb Client, only theHome Page assignment is considered for items 1-3. TheDesktop
Client Home Page is ignored. The Home Page assignment must be a web-enabled file in order to
be used as theWeb Client home page. If no valid assignment is present in Security, Axiom Cost
Accounting continues to the next item.

5. Default home page in the Axiom System directory

In theWeb Client, Axiom Cost Accounting checks \Startup\Home\Web Client for a web-
enabled file, and uses that file as the home page if present. The \Startup\Home directory is
ignored in this case, even if the file in that directory is web-enabled. If no valid home page is
present in the Axiom System directory, Axiom Cost Accounting continues to the next item.

6. Default Web Client home page provided by Axiom Software

This page displays the user's notifications and web favorites. This built-in page is only used as the
home page if no other home page assignment is found.

Assigning startup task panes

You can assign one or more custom task panes to display automatically when a user logs into the
system. Typically, these settings are defined at the role level rather than at the user level—either on the
Everyone role to display for all users, or on your organization's defined roles.

Users do not need to have file permissions to access the task panes that are designated to open on
startup. Because of this, in most cases you should use theNon-Closeable option to specify that the task
pane cannot be closed. This will ensure that the task pane is always available to the user. Otherwise, the
user could close the task pane and then have no way to open it again, because they do not have access
to the file itself.

Users inherit any task panes defined for roles that they are assigned to, in addition to their own assigned
task panes. Task panes are opened in the following order:

l Task panes defined for the Everyone role, in the order specified on the Everyone role
l Task panes defined for roles (multiple roles sorted in alphabetical order), in the order specified for

the role
l Task panes defined for the user, in the order specified for the user

If a single task pane is listed in more than one place, it is only opened once, the first time it is listed.
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NOTES:
l The startup task pane settings do not control the display of system-controlled task panes such

as the Sheet Assistant or File Processing. These task panes display dynamically when they are
relevant to the current context, if the user has the appropriate rights.

l By default, the Everyone role is configured to open the following built-in task panes on
startup: Explorer and Process. These task panes are not system-controlled; if desired you can
change their security settings or remove the task panes entirely. For more information, see
the discussion on built-in task panes and ribbon tabs in the System Administration Guide.

To assign startup task panes to a user or role:
1. On the Startup tab of the Security Management dialog, click the plus button at the top of the

Task Panes box.

The Shortcut Properties dialog opens.

2. To specify the task pane, click the ... button to the right of the Shortcut Target box. In the Choose
Document dialog, select the desired task pane from the Task Panes Library and then click OK.

3. Once the task pane has been selected, specify any of the following optional Shortcut Parameters:

Item Description

Axiom Tab
Name

Define an alternate tab name for the task pane (by default, the tab name is
the file name).

Non-closeable Select this option to prevent the user from closing the task pane.

This option should be selected for startup task panes if users do not
otherwise have access to the task pane. Most end users are not granted
access to the Task Panes Library and therefore they only see task panes
that are configured to open on startup. In this case, if the user closes the
task pane, they will have no way to reopen it (other than to exit the
system and then log in again). Preventing users from closing the task pane
ensures that it will always be available.

4. Click OK. The selected file displays in the Task Panes box.

You can repeat this process for as many custom task panes that you want to assign to the user or role.

Once one or more task panes have been assigned, you can modify the assignments as follows:
l To adjust the order ofmultiple assigned task panes, select the task pane that you want to move

and then use the arrow buttons to move it up or down.
l To delete an assigned task pane, select the task pane in the list and then click theDelete

button.
l To edit the shortcut parameters of an assigned task pane, double-click the task pane in the list to

reopen the Shortcut Properties dialog.
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Assigning startup ribbon tabs

You can assign one or more custom ribbon tabs to display automatically when a user logs into the
system. Typically, these settings are defined at the role level rather than at the user level—either on the
Everyone role to display for all users, or on your organization's defined roles.

Keep in mind that just because a ribbon tab is opened at startup does not necessarily mean it will display
to the user. You can configure certain ribbon tab options that further control the display. For example,
you can specify that a particular ribbon tab only displays if the user is an administrator, or if the current
file is a plan file. These options make it easier to configure a ribbon tab for the Everyone role, yet still
dynamically control the display so that only the users who need the ribbon tab can see it.

Users do not need to have file permissions to access the ribbon tabs that are designated to open on
startup. Startup is the only time that ribbon tabs can be opened in the ribbon, so in general there is no
reason to give end users file permissions to these files except for the small handful of users who need to
create and edit the ribbon tabs.

Users inherit any ribbon tabs defined for roles that they are assigned to, in addition to their own
assigned ribbon tabs. Ribbon tabs are opened in the following order:

l Ribbon tabs defined for the Everyone role, in the order specified on the Everyone role
l Ribbon tabs defined for roles (multiple roles sorted in alphabetical order), in the order specified for

the role
l Ribbon tabs defined for the user, in the order specified for the user

Custom ribbon tabs display before (to the left of) any Excel ribbon tabs. In the case of theWindows
Client, custom ribbon tabs display before the Home tab.

If a single ribbon tab is listed multiple times, it is only opened once, the first time it is listed.

NOTE: By default, the Everyone role is configured to display two built-in ribbon tabs: Axiom and
Axiom Designer. These ribbon tabs are not system-controlled; if desired you can change the security
settings for these tabs, customize the tab contents, or remove the tabs entirely. For more
information, see the discussion on built-in task panes and ribbon tabs in the System Administration
Guide.

To assign startup ribbon tabs to a user or role:
1. On the Startup tab of the Security Management dialog, click the plus button at the top of the

Ribbon Tabs box.

The Shortcut Properties dialog opens.

2. To specify the ribbon tab, click the ... button to the right of the Shortcut Target box. In the Choose
Document dialog, select the desired ribbon tab from the Ribbon Tabs Library and then click OK.

3. Once the ribbon tab has been selected, specify any of the following optional Shortcut Parameters:
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Item Description

Axiom Tab
Name

Optional. Define an alternate tab name for the ribbon tab (by default, the
tab name is the file name).

Requires Admin Select this check box if the ribbon tab should only be visible if the user is an
administrator.

In general, this option is only used if you are assigning a ribbon tab for the
Everyone role, but you want to limit the display to administrators.

Requires Sheet
Assistant

Select this check box if the ribbon tab should only be visible if the user has
Sheet Assistant permission to the current file.

This option can be used to dynamically display a ribbon tab that contains
tools appropriate for file designers. Keep in mind that the ribbon tab will
dynamically show and hide as the user changes the current file (assuming
the user only has Sheet Assistant permission to certain files).

Visible for doc
type

Optional. Select a document type if the ribbon tab should only be visible
when the current file is a certain type of file. You can specify Plan File,
Template, or Report. By default, this option is set to All, which means the
ribbon tab displays for all file types (assuming it is otherwise eligible to
display).

If you specify a document type, keep in mind that the ribbon tab will
dynamically show and hide as the user switches between different
documents. This may be confusing to the user if the ribbon tab is not very
obviously designed for a particular document type.

4. Click OK. The selected file displays in the Ribbon Tabs box.

You can repeat this process for as many custom ribbon tabs that you want to assign to the user or role.

Once one or more ribbon tabs have been assigned, you can modify the assignments as follows:
l To adjust the order ofmultiple assigned ribbon tabs, select the ribbon tab that you want to move

and then use the arrow buttons to move it up or down.
l To delete an assigned ribbon tab, select the ribbon tab in the list and then click theDelete

button.
l To edit the shortcut parameters of an assigned ribbon tab, double-click the ribbon tab in the list to

reopen the Shortcut Properties dialog.

Assigning other startup documents

You can assign other documents to open automatically when a user logs into the Axiom Cost Accounting
Desktop Client. These documents are opened in addition to the home file. You can select any Axiom
report (including web reports and Axiom forms) or any normal Excel file stored in the Reports Library.
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There is no limit on the number of files that can be opened at startup, however, many files or large files
may slow performance and cause delays starting Axiom Cost Accounting.

If a document is assigned to open on startup, then it will always open on startup as read-only, regardless
of the user's file permissions for that document. The user does not need to have permission to access
the file otherwise.

Users inherit any documents defined for roles that they are assigned to, in addition to their own assigned
documents. Documents are opened in the following order:

l Documents defined for the Everyone role, in the order specified on the Everyone role
l Documents defined for roles (multiple roles sorted in alphabetical order), in the order specified for

the role
l Documents defined for the user, in the order specified for the user

If a single document is listed in more than one place, it is only opened once, the first time it is listed. Note
that the home page is always the first document opened.

To assign other startup documents to a user or role:
1. On the Startup tab of the Security Management dialog, click the plus button at the top of the

Other Documents box.

The Shortcut Properties dialog opens.

2. To specify the document, click the ... button to the right of the Shortcut Target box. In the Choose
Document dialog, select the desired file from the Task Panes Library and then click OK.

3. Once the document has been selected, specify any of the following optional Shortcut Parameters:

Item Description

Axiom Tab
Name

An alternate name to display on the file tab. By default, the tab name is
the file name.

If the file is an Axiom form or a web report, then this tab name is only used
when launching theWindows Client, and causes the file to open within the
application instead of the browser.
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Item Description

Quick Filter AQuick Filter to apply to the file. The Quick Filter must be a valid filter
criteria statement. Once the file is opened, users can clear the filter using
the Quick Filter option on the ribbon.

NOTE: The target file must be refreshed in order for the filter to be applied
to the data. One or both of the following settings should be enabled in the
file:

l Refresh all Axiom functions on open (if the file uses functions to
return data instead of an Axiom query)

l Refresh data on file open (for the applicable Axiom queries)
This option only applies to Axiom spreadsheet reports and Axiom forms.

Non-closeable Specifies whether the user can close the file once it has been opened.

By default, this is not enabled, which means the file is closeable. You may
want to enable this option if users do not otherwise have access to the file.
In this case, if the user closes the file, they will have no way to reopen it
(other than to exit the system and then log in again). Preventing users
from closing the file ensures that it will always be available.

You would only do this if the file is something that users need to see
throughout their session. If the file is simply informational and users don't
need to see it again once they have viewed it, then you probably want to
let users close the file.

View As Form Select this option to open the report as an Axiom form. This option only
applies if the report is form-enabled.

4. Click OK. The selected file displays in theOther Documents box.

You can repeat this process for as many additional documents that you want to assign to the user or
role.

Once one or more documents have been assigned, you can modify the assignments as follows:
l To adjust the order ofmultiple assigned documents, select the document that you want to move

and then use the arrow buttons to move it up or down.
l To delete an assigned document, select the document in the list and then click theDelete

button.
l To edit the shortcut parameters of an assigned document, double-click the document in the list to

reopen the Shortcut Properties dialog.
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NOTE: When a user launches the Excel Client, any web-enabled startup documents other than the
Home file will be opened in the browser instead of within the Excel Client. In theWindows Client, if
you define an Axiom Tab Name for the web-enabled document, it will open within the application
instead within the browser.

Assigning startup options

You can configure startup options that impact howAxiom Cost Accounting displays when a user logs in.
These options are listed at the bottom of the Startup tab of the Security Management dialog,
underneath the assigned startup files. You can set these startup options at the user level or at the role
level.

Currently there is only one startup option that can be set:
l Show Formula Bar At Start

If this option is enabled, then the formula bar automatically shows when a user logs into the Axiom Cost
Accounting Excel Client or theWindows Client. If this option is disabled, then the formula bar is hidden.

Users can still toggle the formula bar shown or hidden using the Formula Bar check box on the Axiom
ribbon tab. This startup option simply determines the initial state of the formula bar when the user logs
in; it does not prevent the user from changing that state later.

By default, all users are set to show the formula bar at start, via the Everyone role. If you want to change
this behavior, you have several options:

l You can override the behavior for specific users by clicking theOverride check box and then
clearing the check box for Show Formula Bar At Start. This means that the formula bar will be
hidden at start for this user.

l You can clear the Show Formula Bar At Start check box for the Everyone role, and then set the
option as desired for specific users and roles.

NOTE: It is not possible to leave the option enabled for the Everyone role and then override it by
role. If you want some roles to show the formula bar and others to hide it, then you must disable the
option on the Everyone role and then enable or disable it as appropriate for your other roles.

This setting is always enabled for admin users and cannot be disabled. However, for admin users only,
Axiom Cost Accounting will remember the last state of the formula bar and apply that on startup,
disregarding this setting.
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Security Subsystems
Security subsystems allow you to define groups of users to bemanaged as a distinct "subset" of users
within the system. Using subsystems, you can:

l Define a group of users to belong to the subsystem and be limited to a certain maximum level of
permissions. When you create a subsystem, you are essentially drawing a permissions boundary
that users who belong to the subsystem cannot cross.

l Assign one or more subsystem administrators who can manage security for the users that belong
to the subsystem. This allows you to give certain users the right to manage other users'
permissions, without needing to grant them full administrator rights or even full security
administration rights.

Subsystems are not an alternative to roles. Roles grant permissions as a group; roles cannot be used to
deny permissions or to grant user management rights. Subsystems are intended for situations where
you need to create independently-managed user groups that work within the same system but only
need access to specific defined areas of that system. Roles can then be used to grant permissions within
the limits of the subsystem.

NOTE: Subsystems are optional in systems without installed products. Subsystem features are only
available if you have enabled them using the system configuration settings.

About subsystems

Subsystems are used to create distinct groups of users who need to be restricted to a certain maximum
level of access. When you create a subsystem, you define:

l Themaximum permissions for the subsystem. Using the standard security permission settings,
you specify themaximum level of permissions that any user who belongs to this subsystem can
have.

l The users who belong to the subsystem. The permissions for these users cannot exceed the
subsystem maximum permissions. Roles can also optionally belong to a subsystem, and will be
limited to the subsystem maximum permissions.

l The subsystem administrators. Subsystem administrators can access Axiom Cost Accounting
security for purposes ofmanaging users and roles that belong to the subsystem.

For example, imagine that your organization has three different facilities, and you budget for all of these
facilities within the same Axiom Cost Accounting system. Each facility has a set of users, and you want to
limit those users to a specific set of plan files and reports. You also want to allow the financemanager of
each facility to control the user rights for their facility, but you do not want to make them full system
administrators.
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Example system with subsystems

You could use subsystems for this configuration as follows:
l Create a subsystem for each of the facilities. You can assign existing users to the subsystem,

and/or the subsystem administrator can create users for the subsystem.

l Within each subsystem, specify themaximum level of user rights for that facility. This would
include plan file access filters to restrict the set of plan files in a file group, and folder permissions
for the Reports Library (for example, each facility might have their own folder in the Reports
Library, and you would grant each subsystem permission to only the appropriate folder).

l Within each subsystem, assign the facility's financemanager as the subsystem administrator. That
user could then manage the rights for each user in the subsystem, including granting the users
rights to the necessary plan files and reports (either individually or by using roles). The users can
have a lower level of rights than what is allowed by the subsystem, but they cannot have a higher
level.

Each user can belong to one or more subsystems. If a user belongs to multiple subsystems, the limits for
each subsystem will be applied independently (in other words, using OR to concatenate the restrictions
where applicable instead of AND).

In systems with installed products, subsystems are used to control access to specific products. These
subsystems are product-controlled and delivered with the product. For example, you may have
subsystems for Capital Planning and Budget Planning. You can assign users to subsystems based on the
specific products they should be able to access.

About subsystem administrators

When a user is assigned as a subsystem administrator, that user can access security for the purposes of
managing users and roles that belong to the subsystem.
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Subsystem administrators are not administrator-level users. The behavior is similar to being granted the
Administer Security permission, except that the subsystem administrator can only work with users and
roles within the subsystem.

Subsystem administrators can do the following:
l Create, edit, and delete users and roles within the subsystem. The subsystem administrator can

also assign existing users to the subsystem.

l Assign roles to users in the subsystem. The users can be assigned to subsystem-specific roles or to
"global" roles (roles that do not belong to any subsystem).

l Remove locks held by users in the subsystem. This applies to document and table locks, and save
data locks, where the subsystem administrator has some level of access to the locked item.

l Use Log in as selected user to test the permissions of any user in the subsystem by logging in as
that user. (Note that if a system administrator is assigned to the subsystem, the subsystem
administrator cannot log in as that user.)

Subsystem administrators cannot edit the subsystem settings, except to assign users and roles to the
subsystem. It is assumed that the subsystem is created by a system administrator (or delivered as part
of an installed product), and then the subsystem administrator simply manages the users and roles
within that predefined framework.

The subsystem administrator can be any user. The subsystem administrator may belong to the
subsystem as a user if desired, but that is not a requirement. If the subsystem administrator is also a
member of the subsystem, then the subsystem administrator can edit his or her own user permissions,
but overall those permissions are restricted by the limits of the subsystem.
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Example Security dialog for a subsystem administrator

About subsystems and roles

Subsystems can be used in conjunction with roles. You can assign a user to a subsystem, and then assign
the user to one or more roles to grant security permissions. These permissions are then limited by the
subsystem boundaries.

There are two ways that you can use roles with subsystems:
l You can assign subsystem users to "global" roles, meaning standard roles that don't belong to a

subsystem. These roles can contain users that belong to any subsystem. The role permissions are
inherited "as is" by the user and then the user's effective permissions are restricted by their
assigned subsystem.

l You can assign a role to a subsystem, and then assign users in the subsystem to the role. In this
case, only users who also belong to the subsystem can belong to the role. Also, the role
permissions are restricted by the assigned subsystem before the user inherits the permissions.
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Subsystem-specific roles are recommended if users may belong to multiple subsystems, due to the small
but crucial difference in how role inheritance and subsystem restrictions interact. Also, subsystem
administrators can create and edit subsystem-specific roles, which provides the subsystem administrator
with greater control over the use of roles with their subsystem users. When using global roles,
subsystem administrators can only assign users to the role, they cannot edit the role or see the role's
permissions.

� Role inheritance and subsystems
If each user only belongs to one subsystem, then there is no difference in the effective permissions when
users inherit permissions from global roles or from subsystem-specific roles. However, if a user can
belong to multiple subsystems, then the effective permissions can vary depending on which type of role
is used.

To illustrate this difference, consider the following plan file filter settings for a file group:

User configured permission: No Access

Role configured permission: All Plan Files

Subsystem maximum permission: DEPT.Facility=5

In this configuration, it doesn't matter whether the role is global or whether it belongs to the subsystem.
In both cases, the user will ultimately be restricted to plan files that are assigned to Facility 5. If the role is
global, then the subsystem restriction of Facility 5 will be applied to the user after the role inheritance. If
the role belongs to a subsystem, then the Facility 5 restriction will be applied to the role before the
permissions are inherited. Either way, the end result of the effective permission is the same.

Now consider what can happen if the role is global and the user belongs to two subsystems instead of
just one:

User configured permission: No Access

Role configured permission: All Plan Files

Subsystem 1maximum permission: DEPT.Facility=5

Subsystem 2maximum permission: All Plan Files

In this configuration, the user inherits the permission from the global role before the subsystem
restrictions are applied to the user. So the user's starting permission is All Plan Files. Because the user's
multiple subsystem restrictions are combined using OR, the ultimate subsystem restriction is
Dept.Facility=5 OR All Plan Files (which effectively means no restriction—the combined subsystem
maximum permission allows access to all plan files). Together with the inherited role permission, this
means the user has access to all plan files.
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The organization may have intended the user to have access to all plan files. The user belongs to
Subsystem 2 and that subsystem allows access to all plan files, so it is a valid result if the user is assigned
to a role that grants access to all plan files. However, a potential issuemay arise if the role assignment
was made by the Subsystem 1 administrator. This subsystem administrator may not know that the user
also belongs to Subsystem 2 and/or may not know that Subsystem 2 has a maximum permission of All
Plan Files. The Subsystem 1 administrator can only consider the impact of his or her subsystem's
restrictions, which would limit the user to plan files from Facility 5. The granting of all plan files via the
Subsystem 2maximum permission may be unintentional.

So if subsystem administrators aremanaging role assignments and users can belong to multiple
subsystems, the only way to ensure that permissions are limited by each respective subsystem is to use
subsystem-specific roles instead of global roles. For example, consider the following configuration where
the user belongs to multiple subsystems and is assigned to subsystem-specific roles:

User configured permission: No Access

Role configured permission (Subsystem 1): All Plan Files

Role configured permission (Subsystem 2): No Access

Subsystem 1maximum permission: DEPT.Facility=5

Subsystem 2maximum permission: All Plan Files

Now the role filters are limited by the subsystem restrictions before the user inherits permissions from
the roles. This gets resolved as follows:

l Subsystem 1 role permission of All Plan Files is restricted by the Subsystem 1maximum
permission of Dept.Facility=5. The user can access only those plan files that belong to Facility 5.

l Subsystem 2 role permission of No Access needs no further resolution—the user is not granted
access to any plan files via this subsystem.

l So even though the user's combined subsystem restriction is the same as in the previous
example, this is no longer an issue because the role permissions are restricted by their respective
subsystems before being inherited by the user. In this case this means the user is only granted the
plan file access from the Subsystem 1 role, meaning the user only has access to plan files for
Facility 5.

Now imagine the same permissions except that the role configured permission for Subsystem 2 is
Dept.VP='Smith' instead of No Access. Now the user's effective permission is as follows:

(DEPT.VP='Smith') OR (DEPT.Facility=5)

This means the user can access any plan files from Facility 5, and any plan files where the assigned
VP is Smith.
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Managing subsystems

Using the Security Management dialog, you can create new subsystems, edit existing subsystems, and
delete subsystems. To access this dialog:

l On the Axiom tab, in the Administration group, clickManage > Security > Security Manager.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click Security > Security Manager.

To work with subsystems, select Subsystems in the top left-hand corner of the dialog.

NOTE: Only administrators and users with the Administer Security permission can create, edit, and
delete subsystems. Subsystem administrators are limited to viewing theGeneral tab of the
subsystem only, for purposes of assigning existing users to the subsystem.

Security dialog with subsystems enabled

To save changes, click Apply (orOK if you are finished editing security settings).
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� Creating subsystems
You can create a new blank subsystem, or you can clone the settings of an existing subsystem. If you
clone a subsystem, all of that subsystem's settings are copied to the new subsystem, except for assigned
users.

To create a subsystem, click one of the following buttons located underneath the subsystem list:
l To create a new blank subsystem, click Create subsystem .
l To clone an existing subsystem, select that subsystem in the list and then click Clone subsystem

.

The new subsystem is added to the list. You can define the settings for the new subsystem as desired,
and you can assign users and roles to the subsystem. You can also assign a user as a subsystem
administrator, to manage the users within the subsystem.

For more information on completing subsystem settings, see:
l Defining subsystem properties (General tab)
l Defining maximum permissions for subsystems

� Editing subsystems
To edit a subsystem, select a subsystem from the Subsystems list, then make any changes to that
subsystem. Changes to subsystem settings take effect when the changes are saved.

� Deleting subsystems
To delete a subsystem, select a subsystem from the Subsystems list, then click Delete subsystem .
You are prompted to confirm that you want to delete the subsystem.

A subsystem cannot be deleted if users are assigned to it.

Defining subsystem properties (General tab)

The following settings are available for subsystems on theGeneral tab.

� Subsystem Details
Each subsystem has the following general properties:

Item Description

Name The name of the subsystem.

Description A description of the subsystem.
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� Subsystem-Specific Roles
Multiple roles can be assigned to a subsystem. If the subsystem already has assigned roles, those roles
are displayed here.

It is not possible to assign roles from the subsystem record. Roles can be assigned to subsystems from
the role record, using the Subsystem box. SeeManaging subsystem roles.

� Assigned Users
Multiple users can be assigned to a subsystem. If the subsystem already has assigned users, those users
are displayed here.

Subsystem assignments can bemadewhen editing either the user or the subsystem. SeeManaging
subsystem users.

� Subsystem Admins
One or more users can be assigned as a subsystem administrator. Only administrators and users with
the Administer Security permission can assign or remove a subsystem administrator. Subsystem
administrators do not see this section when they view the subsystem record.

l To assign a user as a subsystem administrator, click Add . In the Assign Users dialog, you can
select one or more users to add as a subsystem administrator.

Assigning a user as a subsystem administrator does not automatically add the user to the
subsystem. Subsystem administrators are not required to belong to the subsystem. However, if
you want the user to also belong to the subsystem, then you must separately assign the user to
the subsystem.

l To remove a user as a subsystem administrator, select the user in the list and then click Remove
. You can select and removemultiple users at once.

Subsystem administrators can access the Security Management dialog for the purposes ofmanaging
users for the subsystem. Subsystem administrators do not otherwise have administrator-level
permissions. For more information on subsystem administration rights, see About subsystem
administrators.

Defining maximum permissions for subsystems

When defining security settings for a subsystem, you are defining themaximum permission that any
user who belongs to the subsystem can have. Users are not granted these permissions by the
subsystem; they are restricted to having this level of permission or less. Generally this means that you
must define themaximum desired settings on each tab of the dialog, or else no users in the subsystem
can have access to the features controlled by that tab.
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You can imagine the subsystem permissions as defining an outer boundary of user rights. Users that
belong to the subsystem can be assigned to roles and can be granted individual permissions as normal.
Any user permissions that fall within the subsystem boundary will be given to the user. Any user
permissions that fall outside of the subsystem boundary will be ignored.

At minimum, you must define settings on the following tabs:
l File Groups tab, to specify which file groups the subsystem can access and themaximum allowed

access.
l Tables tab, to specify which tables the subsystem can access and themaximum allowed access.
l Files tab, to specify which folders and files the subsystem can access and themaximum allowed

access. In most cases this will include defining access permissions to reports. Optionally, you can
grant access to scheduler jobs, task panes, and imports.

If users in the subsystem will not need any special permissions, then you can ignore the Permissions tab.
Otherwise, you must define themaximum allowed access on that tab.

NOTES:
l If a user belongs to more than one subsystem, then the allowed permissions in one

subsystem may exceed the permissions allowed in another subsystem. In this case the
permissions "boundary" is the combination of the subsystems, where the user is granted the
more permissive boundary (not restricted to the less permissive boundary). In this
circumstance, you may find it useful to use subsystem-specific roles to grant permissions to
users instead of "global" roles.

l If a system administrator is assigned to a subsystem, the administrator permission takes
precedence over the subsystem limitation. Subsystem limitations do not apply to system
administrators.

� Permissions tab
Select the check boxes for the permissions that you want to be available to users in the subsystem.

For example, if you know that some users in the subsystem need to have access to Scheduler, then you
must select the Scheduled Jobs User permission for the subsystem. The users' individual permissions
and role inheritance will determine which users in the subsystem actually have the Scheduled Jobs User
permission.

If no users in the subsystem need to have any of these permissions, then you can leave the entire tab
unchecked.

NOTE: In most cases, you should not select the Administer Security permission for a subsystem. If a
subsystem user is granted this permission, they will be able to manage all users and roles in the
system, not just the subsystem users and roles. Subsystem administrators do not need to be
granted this separate permission in order to manage the users in the subsystem.
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� File Groups tab
For subsystems, you can define a single permission set for each file group. This maximum permission set
will be applied against all permission sets defined for the user and inherited from the user's roles. If no
permission set is defined for a file group, then the subsystem does not allow access to that file group.

If you want the users in the subsystem to be able to access plan files in a particular file group, then you
must create a permission set and configure it as follows:

l Set the file access level to the highest level that you need to make available to users in the
subsystem. Typically this means setting the access to at least Read-Only. You must also specify
whether the subsystem has access to Allow Save Data, Allow Calc Method Insert, and Allow
Calc Method Change. Remember that if you are using process management to manage access to
plan files, then you do not need to select Allow Save Data because the plan file process will
automatically elevate user permissions as necessary.

NOTE: The setting Interacts with Process Management is not available to subsystem
permissions. There is no way to disable process interaction at the subsystem level.

l Apply the permission settings to themaximum group of plan files that you need to make available
to users in the subsystem.

You must either select All plan files or specify a plan file filter. For example, if you specify a filter
such as DEPT.Facility=5, then users in this subsystem can only access plan files for facility 5.
Any user or role permission that falls outside of that filter is ignored.

If the subsystem has a plan file filter, and a user in the subsystem is assigned a plan file filter (either
individually or via a role), then the subsystem filter and the user filter are concatenated using AND.
This restricts the user to only accessing files that match both the user filter and the subsystem
filter. For example, if the subsystem filter is DEPT.Facility=5 and the user filter is
DEPT.VP='Jones', then the user can only access plan files that are assigned to VP Jones AND
which belong to facility 5.

NOTE: The Create New Recordsmaximum permission is enabled by default for on-demand file
groups. This is set automatically on the subsystem whenever a new on-demand file group is created.
Also, when you create a new subsystem, this permission is automatically set for any existing on-
demand file groups. This behavior is to enable the default permissions for on-demand file groups,
which are automatically set to allow creating new records via the Everyone role.

� Tables tab
If you want the users in the subsystem to be able to access data in particular tables, then you must
define access for the table (at either the table or table type level).
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When granting access, you must define themaximum level of access needed for the subsystem. For
example, if some users in the subsystem need full access to the GL table type, but other users need
filtered access, then you must set the GL table type to full access. The users' individual rights and role
inheritance will determine their actual level of rights within this boundary.

If a subsystem has a table filter, and a user in the subsystem is assigned a table filter (either individually
or via a role), then the subsystem filter and the user filter are concatenated using AND. This restricts the
user to only accessing data that matches both the user filter and the subsystem filter. For example, if the
subsystem filter is DEPT.Facility=5 and the user filter is DEPT.VP='Jones', then the user can only
access data for VP Jones within facility 5.

NOTE: The default maximum permission for document reference tables is full access. This is set
automatically in the subsystem whenever a new document reference table is created. Also, when you
create a new subsystem, themaximum permission is automatically set for any existing document
reference tables. This behavior is to enable the default permissions for document reference tables,
which are automatically set to full access via the Everyone role.

� Files tab
If you want users in the subsystem to be able to access a particular folder or file, then you must define
access to those folders / files.

NOTE: Remember that users do not need to be granted access to files that are configured as startup
files. If the user or role is assigned a file to open on startup, that file will be opened as a startup file,
regardless of whether the subsystem allows access to that file.

Remember that subfolders and files will inherit any permission set at a "parent" folder level (unless
permission is explicitly set for the lower level). For this reason, the effective permissions section displays
for the subsystem, so that you can select a folder or file and see any inherited permissions for that item.

Where applicable, you should attempt to specify permissions at a level that accommodates ongoing
folder and file additions. For example, if each subsystem will have its own reports folder and that is the
maximum access required, then you can define access for just that folder. If the subsystem needs access
throughout the Reports Library, then you most likely want to define themaximum access at the Reports
Library level (perhaps also explicitly blocking access to certain subfolders and files). The users' individual
rights and role inheritance will determine their actual level of rights within this boundary.

� Example
This example illustrates how subsystem maximum permissions limit users who are assigned to the
subsystem.

The following screenshot shows file group maximum permissions for a subsystem named Facility 5. For
file group Budget 2020, the subsystem is limited by the following filter: DEPT.Facility=5. Users who
belong to this subsystem can only access plan files that are assigned to Facility 5.
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Subsystemmaximum permissions

Subsystem settings do not grant any permissions; they only define a maximum boundary of
permissions. Therefore users assigned to the subsystem must also be assigned to roles or be granted
their own individual security permissions. Imagine that some users belonging to the Facility 5 subsystem
are also assigned to the Facility 5Managers role. This role grants access to all plan files within file group
Budget 2020.

Role permissions
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Although the role grants access to all plan files, the subsystem is limited to DEPT.Facility=5. The users in
the subsystem cannot have greater permission than what is allowed by the subsystem (assuming the
users only belong to one subsystem). Therefore the effective permission for this user is DEPT.Facility=5.

User effective permissions once roles and subsystems are applied

Managing subsystem roles

You can create new roles for a subsystem, and you can assign existing roles to a subsystem. When a role
belongs to a subsystem, the role permissions are restricted by the subsystem boundaries, and all users
in the role must also belong to the subsystem.
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When assigning subsystem users to roles, you can use the subsystem roles or you can use "global" roles
(that do not belong to the subsystem). For more information on the difference in behavior, see About
subsystems and roles.

The subsystem settings should be completed before assigning any roles (unless the roles do not contain
any users yet), to ensure that all desired subsystem restrictions are in place before any subsystem users
log in.

� Assigning a role to a subsystem
When you create or edit a role, you can assign it to a particular subsystem. Use the Subsystem drop-
down list on theGeneral tab to assign the role to a subsystem.

l This assignment can only bemade on the role record. The Subsystem-Specific Roles section on
the subsystem record is for information only; assignment changes cannot bemade there.

l Only administrators and users with the Administer Security permission can assign an existing role
to a subsystem. If the role already has assigned users who do not belong to the subsystem when
the role is assigned to the subsystem, then a validation error displays in the Security Management
dialog. All users in the role must belong to the subsystem in order to assign the role to the
subsystem.

l Subsystem administrators can create new roles for the subsystem. When a subsystem
administrator creates a new role, it is automatically assigned to the subsystem when it is created.
If the subsystem administrator manages multiple subsystems, then the role's subsystem
assignment can be changed to any of those subsystems.

l Only administrators and users with the Administer Security permission can remove a role from a
subsystem. Click the Remove button to clear the assigned subsystem.

Managing subsystem users

You can create new users for a subsystem, and you can assign existing users to a subsystem. When a
user belongs to a subsystem, the user's permissions are limited according to the subsystem boundaries.
Users can belong to multiple subsystems.

The subsystem settings should be completed before assigning any users, to ensure that all desired
subsystem restrictions are in place before any subsystem users log in.
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If the subsystem feature is enabled, then all non-administrator users must be assigned to a subsystem. If
a user does not belong to a subsystem, then that user will be blocked from logging in (unless the user is
an administrator, a subsystem administrator, or a user with theManage Security permission). This
requirement is intended to help ensure that all non-administrator users have a subsystem limit applied
to their security permissions.

� Assigning existing users to a subsystem
Administrators and users with the Administer Security permission can assign existing users to a
subsystem from either the user record or the subsystem record. Any changes made in one area are
automatically applied to the other area.

l From the subsystem record, on theGeneral tab, click the Add button in the Assigned Users
section to add a user to the subsystem.

l From the user record, on theGeneral tab, click the Add button in the Assigned Subsystems
section to assign the user to a subsystem.

Subsystem administrators can assign existing users to a subsystem, but only from the subsystem record.
This is because subsystem administrators cannot see user records for users that do not already belong
to the subsystem.

� Creating new users for a subsystem
Subsystem administrators can create new users for use in a subsystem. When the new user is created,
the user is automatically assigned to the subsystem.

If the subsystem administrator manages multiple subsystems then one of those subsystems will be
assigned at random when the user is created. Once the user has been saved, the subsystem
administrator can edit the user to change the subsystem assignment as needed.

When creating a new user, administrators and users with the Administer Security permission must save
the new user before they are able to assign the user to a subsystem. The Assigned Subsystems box is
not editable until the user has been saved.

� Removing a user from a subsystem
Administrators, users with the Administer Security permission, and subsystem administrators can
remove a user from a subsystem. This can be done from either the user record or the subsystem record.

l From the subsystem record, on theGeneral tab, select one or more users in the Assigned Users
section and then click the Remove button.

l From the user record, on theGeneral tab, select one or more subsystems in the Assigned
Subsystems section and then click the Remove button.
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If a non-admin user is removed from all subsystems, then that user will no longer be able to log into
Axiom Cost Accounting. The user must be assigned to a subsystem or granted administrator-level
permissions before they are able to log in again.

Bulk edit of security
You can manage users, roles, and subsystems in bulk by using theOpen Security in Spreadsheet
feature. You can edit, add, and deletemultiple users, roles, and subsystems simultaneously within a
spreadsheet interface.

Only users with access to security can use this feature: administrators, users with the Administer
Security permission, and subsystem administrators. The spreadsheet is limited as appropriate
depending on the user's rights.

The following items cannot be edited in the spreadsheet interface; you must use the Security
Management dialog for these items:

l File and folder access to any Axiom library (settings defined in the Files tab)
l Startup documents (settings defined in the Startup tab)

� Opening security in a spreadsheet
To manage security in a spreadsheet:

1. On the Axiom tab, in the Administration group, click Security > Open in Spreadsheet.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click Security > Open in Spreadsheet.

TheOpen Security in Spreadsheet dialog opens.

2. At the top of the dialog, specify how you want users and roles presented in the spreadsheet:
l Horizontally (default): Users, roles, and subsystems are displayed horizontally across

columns. The security settings are displayed in rows.
l Vertically: Users, roles, and subsystems are displayed vertically down rows. The security

settings are displayed in columns.

3. Optional. If you want to limit the security settings that display in the spreadsheet, modify the
check boxes in the Select items to include section.

For example, you might only want to work with a particular file group or table type. General user
and role properties (such as name, email, etc.) are always included in the spreadsheet.

Clear the check boxes for any items that you do not want to display in the spreadsheet. You can
select or clear items by major category (File Groups, Tables, etc.), or you can expand themajor
categories to select or clear the individual items (such as individual file groups).
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4. Optional. If you want to filter the users that display in the spreadsheet, select the Filter users
check box. By default, the spreadsheet displays all users, roles, and subsystems for the current
system.

If Filter users is checked, you can specify the following options to filter users:

Item Description

Include users
who are

Select the following options to include those users in the spreadsheet:

l Enabled users
l Disabled users
By default, both options are selected, which means that both enabled and
disabled users will be included in the spreadsheet.

If both options are cleared, then only roles (and subsystems, if applicable)
will be included in the spreadsheet.

Include users in
these roles

If you want to only view users that belong to specific roles, select the check
boxes for those roles. You can also choose to view users who do not
belong to any roles. You can use the Select All and Clear All links to select
or clear all roles.

This selection also limits the role records that will be included in the
spreadsheet.

Include users
from these
subsystems

If you want to only view users that belong to specific subsystems, select
the check boxes for those subsystems. You can also choose to view users
who do not belong to any subsystems. You can use the Select All and
Clear All links to select or clear all roles.

This also limits the subsystem records that will be included in the
spreadsheet.

This option only displays if subsystems are enabled for your system.

Selections from multiple categories will be combined. For example, if you select role Finance and
subsystem 5, then the spreadsheet will contain all users that are in either the Finance role or
subsystem 5 (not users who only belong to subsystem 5 and the Finance role).

5. Click OK.

The spreadsheet opens with the selected security options.

Example security spreadsheet (horizontal orientation)
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� Editing existing records
To edit the settings for a user, role, or subsystem, make changes directly in the spreadsheet. See the
following section Security settings in the spreadsheet interface for more information on editing settings
within the spreadsheet interface.

NOTE: You cannot edit user login names or role and subsystem names within the spreadsheet
interface. If the name is changed, it will be saved as a new record, and the existing record will be
unchanged.

For subsystem administrators, only users and roles that belong to their assigned subsystems are
brought into the spreadsheet. Subsystem settings are not brought into the spreadsheet.

� Adding new records
You can add new users, roles, and subsystems within the spreadsheet interface.

To add a new user, type the new user's login name in an empty cell in row 1 or column A (depending on
the spreadsheet orientation), and then complete the desired security settings for that user. Note the
following:

l Last name, first name, and email address are required for new users. If these items are blank, a
save error will result. Other user properties such as license type and authentication type will use
the same default values as when adding a new user in the Security Management dialog.

l You can type a password or leave the password blank. If left blank, the user will be assigned a
randomly generated password.

To add a new role, type the role name in an empty cell in row 1 or column A (depending on the
spreadsheet orientation), prefixed by "role:". For example, type role:MyRole. If the name is not
prefixed by "role:", then it will be interpreted as a user login name. Note the following:

l No other settings are required to save a role.
l To assign users to the new role within the spreadsheet interface, you must add the role name to

each individual user. There is no option to add users directly to the role record, like you can within
the Security Management dialog.

NOTE: Adding subsystems works the sameway as adding roles, except the subsystem namemust be
prefixed by "subsystem:". For example, subsystem:MySubsystem.

When adding new users, roles, or subsystems to the spreadsheet, all settings must be typed (or copied
and pasted from other records). Drop-down lists are only available when editing existing records. For
more information on the valid inputs for the settings, see the following section Security settings in the
spreadsheet interface.

Users who are subsystem administrators can only create new users and roles. The new users and roles
must be assigned to their subsystem.
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� Deleting records
You can delete users, roles, and subsystems within the spreadsheet interface. To delete a user or role,
set Delete to Yes.

NOTE: When editing security in a spreadsheet, you can delete a role or a subsystem regardless of
whether any users are assigned to it. The users will be updated to remove the assignment.

Users who are subsystem administrators can only delete users and roles that belong to their subsystem.

� Saving changes
To save changes made in the spreadsheet:

l On the Axiom tab, in the File Options group, click Save.

A confirmation prompt lists the number of users, roles, and subsystems that you are about to update,
create, or delete.

Settings are validated before the save occurs. If errors are found, they are displayed in the Save Errors
pane. Any errors must be resolved before the save can occur.

After a successful save, you will be prompted to refresh the spreadsheet to bring in themost recent data.

� Security settings in the spreadsheet interface
The following is a reference for completing or editing security settings via the spreadsheet interface.

NOTES:
l If an item is not explicitly discussed here, its input is the same as in the Security Management

dialog. This section only discusses items that are completed differently than in the Security
Management dialog.

l Most check boxes in the Security Management dialog correspond to TRUE (checked) and
FALSE (unchecked) in the spreadsheet interface. Any deviations are noted in the following
table.
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For more information on the purpose of each security setting, see Security settings for users, roles, and
subsystems are organized by tabs in the Security Management dialog. The following tabs are available:.

Item Description

Login, role, or
subsystem

The user's login name, the role's name, or the subsystem's name.

Role names must be prefixed by role:. Subsystem names must be prefixed by
subsystem:. For example, to create a role named Finance, type
role:Finance.

If users have been imported from Active Directory, those user names are
prefixed with the Active Directory domain. For example: Corporate\JDoe.

NOTE: You cannot rename existing records using the spreadsheet interface. If a
name is changed, it is interpreted as a new record.

Delete Select Yes if you want to delete the record. Otherwise, leave the default ofNo.

General This section works the sameway as the Security Management dialog, with the
following exceptions:
l Role assignments: For users, you can view and edit the list of roles that the

user is assigned to. Each role name is separated by a semicolon. (The same
thing applies to subsystem assignments if subsystems are enabled.)

l User assignments: For roles, you cannot view or edit the list of assigned
users in this interface. If you want to view all users assigned to a role or edit
this list from the role perspective, then you must use the Security
Management dialog.

NOTE: The password display is always blank. You can change a user’s password
by entering a new password. When you save and then refresh the spreadsheet,
the password field will return to blank.

Permissions For users, specify one of the following:
l Inherit: The user will inherit the permission from any role assignments.
l True: The user is explicitly granted this permission; role inheritance is

ignored.
l False: The user is explicitly denied this permission; role inheritance is

ignored.

For roles and subsystems, specify either True or False.
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Item Description

File Groups This section works the sameway as the Security Management dialog, with the
following exceptions:
l FGName [calc method permission]: This item combines the Allow Calc

Method Insert and Allow Calc Method Change options from the Security
Management dialog. Valid entries are Insert, Change, or Insert/Change.

l FGName [create new records]: This item is listed for all file groups, but only
applies to on-demand file groups. A save error will result if this item is set to
TRUE for a standard file group.

l If a user has multiple permission sets, only the first set can be edited within
the spreadsheet interface.

Tables and Table
Types

These sections work the sameway as the Security Management dialog. All table
types are listed first, followed by all individual tables.

Security tools
Axiom Cost Accounting provides security tools to control and monitor user access to Axiom Cost
Accounting.

Viewing the list of logged in users

Administrators can view a list of users who are currently logged into the system. For example, you may
want to check to make sure that nobody is logged into the system before performing actions such as
system upgrades.

For each user that is currently logged in, the list displays information such as:
l Full name and user name (login name)
l Email address
l Computer where the user is logged in
l Date and time the user logged in
l Date and time of the user's last activity during the session

The list of logged in users is for information purposes only—you can see whether any users are logged in,
but you cannot manually log them off and end their sessions.

NOTE: Axiom Cost Accounting maintains a log of all login attempts, including failed logins. Currently
there is no user interface to view this information, but it can be accessed directly in the system
database in the SystemAccess table. For assistance, please contact Axiom Cost Accounting Support.
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To view the list of logged in users:
l On the Axiom tab, in the Administration group, clickManage > Security > Logged in Users.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click Security > Logged in Users.

The Currently Logged In Users dialog opens, listing the users who are logged into this system. You can
sort and filter the list using standard Axiom grid functionality.

� Orphaned session records
When a user logs off normally, their session record is removed from the Logged in Users list. If a user's
session ends unexpectedly—for example, due to a software crash or shutting down the computer
without logging off—then the session record will be removed from the list after a fewminutes, once the
session no longer "reports back" to the Axiom Application Server.

NOTE: For Web Client sessions, closing the browser window does not automatically log out the user.
In this case, the orphaned Web Client sessions will be automatically removed from the list in a few
minutes as described above.

Axiom Cost Accounting does not automatically remove any session records based solely on time logged
in. As long as the session remains connected and continues to report back to the application server, the
session will continue to be listed indefinitely.

� Removing session records
If desired, you can manually remove any logged in records by selecting the record in the list and clicking
Remove. This simply removes the record from the list; it has no impact on any user's session. If a user is
actually logged on and you remove their session record, the user will remain logged on.

In most cases this action should not be necessary, because sessions that are truly invalid will be
automatically removed from the list in a fewminutes as described above.

Enabling password rules

By default, Axiom Cost Accounting enforces a basic set of password rules. These rules apply to users
assigned to Axiom Prompt authentication.

The built-in password rules are as follows:
l Must be at least 8 characters long
l Must contain at least 1 upper-case letter and at least 1 lower-case letter
l Must contain at least 1 non-alphabetic character (a number or a symbol)

The password rules are only enforced when creating new passwords. If any existing passwords do not
meet these rules, those passwords will continue to be valid.
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When the password rules are enabled, a Generate Password link is available on the Set Password dialog
so that you can generate a random password that meets these rules. (This feature is not available if the
password rules are changed from the built-in rules; see the note below.)

Password rules are enabled or disabled by using the system configuration property
EnablePasswordPolicy. This setting is True by default. If you do not want to apply these rules, you can
disable the setting by changing it to False, which means that any password is considered valid. You can
do this by using the SoftwareManager, or by using a Save Type 4 report that has been set up to modify
the system configuration table. Only administrators can modify system configuration settings.

NOTE: The system configuration settings contain two additional options related to
EnablePasswordPolicy. PasswordRegularExpression defines the password rules, and
InvalidPasswordMessage defines the error message displayed if a new password does not meet the
rules. Axiom Cost Accounting does not currently provide a methodology for clients to change the
password rules from the built-in rules, therefore, these two options should not be changed from
their default settings. If you have a need to use different password rules, please contact Axiom Cost
Accounting support for assistance.

Testing user security

Administrators and other users who manage security may need to log into Axiom Cost Accounting as
other users, in order to test security permissions. For example, you may define a table access filter for a
particular security role. In order to test that the filter is providing access to table data as expected, you
can log in as a non-admin user who belongs to that role.

Using the Security Management dialog, you can "log in as" another user, for the purposes of testing their
security settings.

To log in as a different user:
1. On the Axiom tab, in the Administration group, clickManage > Security > Security Manager.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click Security > Security Manager.

2. In the Security Management dialog, select the user whom you want to log in as. The following
limitations apply:

l Subsystem administrators can only log in as users who belong to their subsystem.
l If a user is an administrator, subsystem administrators and users with the Administer

Security permission cannot log in as that user.
l The "log in as" feature cannot be used with users who are Axiom Support users.

3. In the lower left-hand corner, click Log in as selected user.
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A new instance of Axiom Cost Accounting is launched, and you are automatically logged in as the selected
user—you do not need to input a user name and password. The client version for the instance is
whichever client version you are currently using (Excel Client or Windows Client).

Creating a permission report

You can create a report that details the effective security permissions for each user, for a particular file
group or for all tables. This report may be useful for auditing purposes and for reviewing permissions to
make sure they are set as intended.

The report is created as an Excel file. Once it is created, you can print it, or save it locally or within the
Axiom file system as needed.

Only administrators and users with the Administer Security permission can create a permission report.
Subsystem administrators do not have access to this feature.

� File group permission report
The file group permission report is created on a per file group basis. When you create the report, you
specify which file group you want to report on.

Each user defined in the system has at least one row in the report:
l If the user is an administrator, then the user has one rowwith a notation of: (Admin-Full Access).
l If the user has no access to the file group, then the user has one rowwith a notation of: (No

Access).
l If the user has access to all plan files in the file group via a single permission, then the user has one

rowwith a notation of: All Plan Files.
l In all other cases, the user has multiple rows in the report—one row for each individual plan file

that they have access to. Each row details the user's permissions to that particular plan code,
including the access level, calc method permissions, ability to save data, etc.

For example, if a non-admin user with access to the file group has permission to 3 plan files, then there
will be 3 rows in the report for that user, one for each plan file.

The permissions displayed in the report are the full effective permissions of the user, taking into account
all factors such as admin status, role inheritance, multiple file group permission sets, and subsystem
restrictions.

NOTE: Permissions granted by process ownership are not reflected in this report. Users may be
temporarily "elevated" to read/write and save data status when they are the assigned owner of an
active process task for a particular plan file.
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To create a file group permission report:
1. On the Axiom tab, in the Administration group, clickManage > Security > File Group Permission

Report.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click Security > File Group Permission Report.

2. In the Permission Report dialog, select the file group for which you want to create the report, and
then click OK.

The report opens as an Excel spreadsheet file. The file group it was generated for and the current
date/time are noted at the top of the report. Excel’s auto-filtering is automatically applied to the columns
to make it easier to sort and filter the data.

� Table permission report
The table permission report details user permissions per table. All tables are included in the report; it is
not possible to filter by a particular table or table type.

Each user defined in the system has at least one row in the report:
l If the user has full access to all tables, then the user has one rowwith a notation of: (Full access to

all tables).
l If the user has no access to any tables, then the user has one rowwith a notation of: (No access

to any tables).

NOTE: It would be a rare situation for a user to have no access to any tables, because by
default all users are granted access to document reference tables using the Everyone role.

l In all other cases, the user has multiple rows in the report—one row for each table that they have
access to. Each row details the user's read and write permissions to that particular table. If a table
is not listed, then the user does not have access to that table.

For example, if a user has access to 5 tables, then there will be 5 rows in the report for that user, one for
each table.

The permissions displayed in the report are the full effective permissions of the user, taking into account
all factors such as admin status, role inheritance, table type inheritance, and subsystem restrictions.

To create a table permission report:
l On the Axiom tab, in the Administration group, clickManage > Security > Table Permission

Report.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click Security > File Group Permission Report.
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The report opens as an Excel spreadsheet file. The current date/time are noted at the top of the report.
Excel's auto-filtering is automatically applied to the columns to make it easier to sort and filter the data.

Security Integration
Axiom Cost Accounting can integrate with your organization's existing network security. You can:

l EnableWindows Authentication for user authentication against your Windows domain, including
the option to import users from Active Directory.

l Enable LDAP Authentication for user authentication against your LDAP server.
l Enable SAML Authentication for user authentication against a SAML identity provider.
l Enable OpenID Authentication for user authentication against an OpenID provider.

NOTE: This guide discusses how to set up and use security integration features once they have been
enabled for your system. For information on enabling the associated system configuration settings,
see the System Administration Guide.

Using Windows Authentication

You can enableWindows Authentication for a system, to authenticate users based on their Windows
domain credentials.

� Windows Authentication behavior
When the Axiom Cost Accounting login screen displays, users must enter their Windows user name,
domain, and password. If the domain is an allowed domain and theWindows user namematches a user
name in Axiom Cost Accounting, then the credentials are passed to Windows for authentication into
Axiom Cost Accounting.

If theWindows Authentication configuration for Axiom Cost Accounting only allows one domain, then
that domain is assumed for authentication and users do not need to specify it when logging in. If
multiple domains are allowed, then the domain must be specified in one of the following ways:

l The user must include the domain with their user name, such as: DomainName\UserName.
l The user must specify the appropriate domain using theDomain selection list on the login screen.

This is an optional setting that can be enabled for your installation. For more information, see
Domain selection list.

Users must enter their credentials each time they log in, unless they select Remember me to store their
credentials for future use. For more information, see Remember me.

� Setting up Windows Authentication
The following summarizes the setup process for Windows Authentication.

1. Windows Authentication must be enabled for the system.
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For on-premise systems, Windows Authentication can be enabled during the Axiom Application
Server installation. If it was not enabled during the installation, you can configure it later using
either of the following options:

l Use the Configure Authentication Methods page of the Axiom SoftwareManager. For
more information, see the Installation Guide.

l Use a Save Type 4 report to modify the applicable system configuration settings
(WindowsAuthEnabled andWindowsAuthAllowedDomains).

When you enableWindows Authentication, you must specify the valid domains for
authentication. You can specify multiple domains, separated by commas. You can also choose to
enable Active Directory Synchronization if you want to import and synchronize users from Active
Directory (for more information, see Synchronizing users with Active Directory).

For cloud systems, Kaufman Hall Software Support will enableWindows Authentication for you as
part of the system setup, if that is your chosen authentication method.

2. In security, Axiom Cost Accounting users must be set up as follows to support Windows
Authentication:

l The user's Axiom Cost Accounting login namemust match their Windows login name.
l The user's Authenticationmethod must be set toWindows User. This is the default setting

for new users ifWindows Authentication is enabled for your installation.
If users are imported from Active Directory, then they will automatically be created with the
appropriate login name and authentication type.

3. Cloud systems have the following additional requirements:
l Installation of the Cloud Integration Service is required to enable the cloud system to

communicate with your localWindows domain, to validate user credentials. For
information on installing the Cloud Integration Service, see the Cloud Service Technical
Guide and contact Kaufman Hall Software Support as needed.

l A remote data connection must be created in Scheduler, with the option Use for
authentication service enabled.

All users who are assigned to theWindows Authentication method will be authenticated based on their
Windows credentials. This is the only way that these users can log in—they cannot log in using an
internal Axiom Cost Accounting password.

If you need to test the security settings of a Windows Authentication user, you can use the Log in as
selected user feature to log in to Axiom Cost Accounting as that user. For more information, see Testing
user security.

Synchronizing users with Active Directory

You can import users from Active Directory, to automatically create users within Axiom Cost Accounting
and assign them to the appropriate roles. Subsequent imports can be used to create new users and
synchronize previously imported users.
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Active Directory synchronization can only be used in conjunction with Windows Authentication. For
more information, see Using Windows Authentication.

To set up Active Directory synchronization:
1. Enable Active Directory synchronization for your system.

For on-premise systems, Active Directory synchronization can be enabled during the Axiom
Application Server installation. If it was not enabled during the installation, you can configure it
later using either of the following options:

l Use the Configure Authentication Methods page of the Axiom SoftwareManager. For
more information, see the Installation Guide.

l Use a Save Type 4 report to modify the applicable system configuration setting
(WindowsAuthUserSyncEnabled).

For cloud systems, Kaufman Hall Software Support can enable Active Directory synchronization
for your system.

2. Create a job in Scheduler with an Active Directory Import task, and schedule the job to run
periodically as needed for your environment.

Each import task can import users from a single Active Directory domain into the current Axiom
Cost Accounting system. The import task specifies the Active Directory domain and groups to
import, role mappings, and notification settings. If you need to import from multiple Active
Directory domains, then you must create an import task for each domain.

When the Scheduler job is run, new users are created as needed and existing users are synchronized with
Active Directory.

Creating a Scheduler job to import users from Active Directory

Once Active Directory synchronization has been enabled for your system, you must create a Scheduler
job in order to import users from Active Directory into Axiom Cost Accounting.

The Scheduler job must contain an Active Directory Import task. Each import task can import users from
a single Active Directory domain into the current Axiom Cost Accounting system. The import task
specifies the Active Directory domain and groups to import, and role mappings for those groups. When
setting up the job, you can configure a scheduling rule so that it runs nightly, weekly, or whatever
frequency is appropriate for your organization.

If you need to import users from multiple Active Directory domains, then you must create an import task
for each domain. You can create a single Scheduler job with multiple import tasks, or you can separate
the import tasks into multiple Scheduler jobs. If all of the import tasks can use the same schedule, then it
is easiest to create a single job with multiple tasks.

For Cloud Service systems, the Active Directory Import task can import users from your local Active
Directory by use of the Axiom Cloud Integration Service. If you have a remote data connection that is
enabled for user authentication, this task will use that connection when the job is executed by Scheduler.
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� Before you begin
Before creating the job, you should make sure you are prepared with the following information:

l The name of your Active Directory domain, or the server name that hosts Active Directory. You
will need to specify one of these to identify the source domain for the import.

l The user credentials to use to access Active Directory. You can specify a user name and
password, or you can use the credentials of the Axiom service that is performing the process.

l The groups to import from Active Directory. You must know the names of the groups that you
want to import from Active Directory. All users in the selected groups will be imported into Axiom
Cost Accounting. If you do not have groups that exactly correspond with the users that you want
to create in Axiom Cost Accounting, you may need to work with your Information Technology
department to create new groups or refine existing groups.

l The Axiom Cost Accounting roles, subsystems, user license types, and authentication types for
each imported group.When users are imported, they can be automatically assigned to one or
more roles and subsystems in Axiom Cost Accounting, and assigned a user license type and an
authentication type. Make sure you knowwhich options to use.

� Creating the job
In order to create a Scheduler job, you must be an administrator or have the Scheduled Jobs User
security permission. Non-admin users must also have read/write access to at least one folder in the
Scheduler Jobs Library.

Scheduler jobs can only be created in the Desktop Client. Although you can view the status of existing
jobs in theWeb Client, you cannot create new jobs in that environment.

IMPORTANT: The Active Directory Import task can only be executed by a user who has permission to
create users in security—an administrator, a subsystem administrator, or a user with the Administer
Security permission. If you plan to schedule the job for automated execution, the job owner must
have the required permissions to execute the task. The job owner is the user who last saved the job.
Effectively, this means that the job must be created by a user with the required permissions. If the
job is created by a user who does not have the required permissions, then the job must be saved by
a user with the required permissions in order to re-set the job owner. You can see the current job
owner for the job in the Job Variables section of the job properties.

To create an Active Directory Import job in Scheduler:
1. On the Axiom tab, in the Administration group, clickManage > Scheduler.
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Scheduler on default Axiom ribbon tab

In systems with installed products, this featuremay be located on the Admin tab. In the System
Management group, click Scheduler.

Scheduler on Admin tab (example product ribbon)

2. In the Scheduler dialog, click New.
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A new job is opened in the dialog, with a tab name ofNew Job.

3. Click Add > Active Directory Import to add the task to the new job.

The task is added to the job, and you can now configure the task properties. In the Task Details
section, the task has three tabs: Source Directory, Notification, and Preview Import.
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4. On the Source Directory tab of the Task Details, select either Domain or Server to specify the
source domain for the import.

l If you select Domain, enter the name of the domain.
l If you select Server, enter the name of the domain controller server.

The server option is available in case you are not currently logged into the source domain, and
your current domain does not have access to the source domain. In this case, you must use
domain credentials in order to access the source domain.

Only one domain can be selected per import task. If you want to import users from multiple
domains into an Axiom Cost Accounting system, then you must createmultiple import tasks.

5. For Credentials, specify the user credentials to use when accessing Active Directory for the import.
Select one of the following:

l Use process credentials: (Default) Use the credentials of the network service account for
Axiom Scheduler Server (on-premise installations) or Axiom Cloud Integration Service
(Cloud Service systems).

l Specify domain credentials: Enter the credentials of a specified domain User and
Password. This option is required if you identified the source domain using the server name
instead of the domain name.
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6. If you do not want new and synchronized users to be automatically enabled by the import, select
Never Enable Users. This option works as follows:

l If unchecked (default), then newly imported users are enabled as part of the import.
Additionally, any existing imported users who have been changed to disabled are re-
enabled.

l If checked, then newly imported users are not enabled as part of the import. A security
administrator must modify the security settings after the import is complete to enable the
new users. Existing imported users retain their current enabled status.

We recommend enabling this option because in most cases it is necessary for a security
administrator to make further changes to security settings before the user account is fully ready
for use. Additionally, if your system uses subsystems, any newly imported users will not be able to
log in anyway, since the import does not assign users to a subsystem.

7. In theGroups to import section, click Add to select one or more groups to import.
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The Select Groups dialog opens, displaying a list of groups from the source domain.

l Select the group or groups that you want to add, and then click OK. You can use the search
box at the top of the dialog to find a group by name. You can use the SHIFT or CTRL keys to
select multiple groups in the list.

l The selected group(s) display in theGroups to import box. If you have added a group by
mistake, you can select it and click Remove.
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8. In theGroups to import section, click Role Mapping to define the role mappings for each selected
group:

l In the Role Mapping dialog, click the Add mapping icon in the top right to add a
mapping row to the dialog.
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l In themapping row, select a Directory Group to map, then select the following:
o The Axiom Role that you want the users to belong to.
o The Subsystem that you want the users to belong to. This option is only present if

subsystems are enabled for your system.
o TheUser Type for the users. This means license type, such as a Standard license or a

Viewer license.
o The Authentication Type for the users,Windows User or SAML. If you want to use a

different authentication type, then you must update the users after importing to
assign them to the desired authentication type. You may be able to create a Save
Type 4 report to Axiom.Principals to update the users, and process that report
within the same Scheduler job, after the Active Directory import task is performed.
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l Repeat these steps for each group to be imported. If you want the users in a group to
belong to more than one role and/or subsystem, you can createmultiple mapping rows for
that group. If you need to remove a mapping row, select it and then click the Remove
mapping icon in the top right of the dialog.

l When you are finished defining mappings, click OK to return to the Scheduler task
properties.

The defined role mappings do not display in theGroups to import box. If you want to review or
edit the role mappings, click Role Mapping.

NOTES:
l If a group has multiple mapping rows to assign the users to multiple roles and/or

subsystems, then the specified user type and authentication type should be the same
on each row. If the user type or authentication type is different, then the entry on the
last processed mapping will be used. Role mappings are processed in role ID order.

l If a group has no defined role mappings, then the users will not be assigned to any roles
or subsystems. If the import creates new users without role mappings, the assigned
user type is Standard and the assigned authentication type is Windows User.

9. On theNotification tab of the Task Details, enter one or more email addresses to send a
notification when users have been added or synchronized due to running the Active Directory
Import task. Separatemultiple addresses with a semi-colon.

Administrator's Guide 2019.4 Axiom Cost Accounting │ 537



When the import task is run, if any users are created or modified in the Axiom Cost Accounting
system, an email notification will be sent to the addresses specified here. The email summarizes
the changes made. This email notification is independent of any job-level notification settings
(which notify based on overall job completion or failure).

We recommend setting up this task-level notification to send emails to the security administrator
(s) responsible for maintaining the security settings in Axiom Cost Accounting, so that he or she
can define security settings for newly added users, validate changes made to existing users, and
perform any other follow-up tasks.

10. On the Preview Import tab of the Task Details, click Preview to see the changes that will bemade
to Axiom Cost Accounting Security when the Active Directory Import task is run.

The preview feature is intended to help you verify that you have set up the task correctly. If the
reported changes are not as you expect, then you can review and adjust the task settings as
needed. No changes aremade to security when preview is run.

This completes the settings for the Active Directory Import task. However, there are a few general
job properties that should also be reviewed and completed as needed.
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11. In the left-hand pane, click Scheduling Rules. Using this section, you can define a scheduling rule
so that the job runs automatically as needed. Typically, organizations want the Active Directory
Import task to run regularly so that users are kept in sync.

Click Add to add a scheduling rule to the job, and then complete the rule as needed based on your
desired schedule. In the following example, this job will run Monday through Friday at 11:00PM.

12. In the left-hand pane, click Notification. Using this section, you can configure the notification
settings for the overall Scheduler job. The job-level notifications are intended to inform interested
parties when the job completes successfully or has errors. These notifications do not contain any
information about user changes to Axiom Cost Accounting Security—to inform someone about
specific user changes, you must use the task-level notification settings as described in step 9.

By default, jobs are configured to send a notification whenever the job is run (Send all email
notifications). You can change the Job Notification Level as needed, and you can modify the
recipients, subject, and message. In the following example, a notification is only sent when the job
has errors.
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13. Complete any other job or task properties as needed. In most cases, the default settings are
sufficient.

14. Click Save. You can define a name for the job and save it to the desired location in the Scheduler
Jobs Library.

Once you save the job with an active scheduling rule, the job is immediately added to the schedule to
await the first scheduled execution time. You can see this scheduled instance on the Scheduled Jobs tab.

You can also run the job manually as needed by opening the job and clicking Run Once. Note that when
using Run Once, the job runs as the current user instead of the job owner, so you must have the
required permissions to perform the import.

For more information on what happens when the Active Directory Import task is run, see HowActive
Directory user synchronization works.

How Active Directory user synchronization works

This topic describes how newusers are created and how existing users are updated when an Active
Directory Import job runs in Scheduler.
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NOTE: The Active Directory domain name is always used to determinematching users for purposes
of the Active Directory import. If a user namematches but the domain does not, that user is not
considered to be a matching user.

� Creating new users via Active Directory import
For each unique user name in the import, Axiom Cost Accounting looks for a matching user name in
Axiom Cost Accounting Security. If no match is found, then a new user is created. If a match is found,
then the user synchronization behavior applies as detailed in the following section.

New users are created with the following user properties:
l Login (from Active Directory)
l Domain (from Active Directory)
l First name (from Active Directory)
l Last name (from Active Directory)
l Email address (from Active Directory)
l License Type (from Scheduler task settings)
l Authentication (from Scheduler task settings)
l Enabled (from Scheduler task settings)
l Assigned Roles (from Scheduler task settings)
l Assigned Subsystems (from Scheduler task settings)
l Directory Sync Enabled (assumed as enabled)

NOTE: The imported user's domain does not display in the Security dialog, but it is stored in the
database and can be reported upon by use of an Axiom query to the Axiom.Principals table. The
relevant domain also displays before each user namewhen using Open Security in Spreadsheet. The
domain is stored in case of a situation where two users with the same user name are imported from
different domains.

� Synchronizing users via Active Directory import
If a user name in the Active Directory import matches an existing user name in Axiom Cost Accounting
security, then that user will be updated ONLY if theDirectory Sync Enabled check box remains selected
for thematching user. Matching users are updated as follows:

l User Properties: If the first name, last name, or email address has changed in Active Directory, it is
updated in Axiom Cost Accounting.

l User License Type: If the assigned user license type for the Active Directory group has changed,
then the license type is updated in Axiom Cost Accounting.

l Authentication Type: If the assigned authentication type for the Active Directory group has
changed, then the authentication type is updated in Axiom Cost Accounting.
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l Role and Subsystem Assignments: The user's role and subsystem assignments are updated as
follows:

o If a role or subsystem assignment has been added for the Active Directory group, the user
is assigned to that role or subsystem.

o If a role or subsystem assignment has been removed from the Active Directory group, the
user is only removed from the role or subsystem if another group is mapped to that same
role or subsystem (and the user does not also belong to that other group). If the previously
assigned role or subsystem is not present in themappings at all, then the user is not
removed from the role or subsystem.

o If the user no longer belongs to the Active Directory group, and that group's role or
subsystem mappings still exist, then the user is removed from those roles and subsystems
(unless the user belongs to another Active Directory group in the import that is mapped to
the same roles and subsystems).

l Disabled Users: If the user is disabled in Active Directory, then the user is disabled in Axiom Cost
Accounting. If the user is disabled in Axiom Cost Accounting but enabled in Active Directory, then
the user will either be re-enabled or left as disabled depending on whetherNever Enable Users is
checked in the Scheduler task settings.

If theDirectory Sync Enabled check box is cleared for thematching user, then that user will be ignored
by the Active Directory synchronization process and left as is.

If theDirectory Sync Enabled check box is selected for a user and that user does NOTmatch a user name
in the Active Directory import, then the user is disabled. If you still need the user account, you can re-
enable the user and clear the Directory Sync Enabled check box so that the user will be ignored by future
imports.

NOTES:
l Rolemappings are processed in role ID order. If a group has multiple mappings, and the user

license type or authentication type does not match on all of themappings, then users in the
group will be assigned to the license type and authentication type associated with the last-
processed role.

l If a role mapping uses a subsystem-specific role, users will be assigned to that role regardless
of whether they also belong to the associated subsystem. This creates an invalid security
configuration that must be corrected after the import.

� Editing imported users
Once an imported user has been created in Axiom Cost Accounting, you can edit the user's permissions
in Security as appropriate.
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You can assign the user to additional roles and/or subsystems, and those additional assignments will
persist through subsequent imports. However, if the user is part of an import that contains a mapping
with those roles or subsystems, and the user is not in the group affected by that mapping, then the user
will be removed from those roles or subsystems.

You can edit user properties such as name, email, and authentication type, however, these changes will
be overwritten the next time the Active Directory import task is run, assuming that Directory Sync
Enabled is still checked for the user.

If you do not want the user to be synchronized with Active Directory anymore, but you still want the user
to be active in Axiom Cost Accounting, then you should clear theDirectory Sync Enabled check box for
the user. Once this option is disabled, the user will be ignored by the import and will be treated like a
manually created user.

� Treatment of manually created users
If Active Directory Import is enabled for your system, you can still manually create users and exclude
them from the Active Directory import and synchronization process by clearing theDirectory Sync
Enabled check box for the user. The user will be ignored by any future Active Directory Import jobs.

If you manually create a user and leave theDirectory Sync Enabled check box selected, then the user will
be treated as follows the next time an Active Directory Import job is run:

l If the user matches a user name in the Active Directory import, then the user will remain active
and will be synchronized with Active Directory.

l If the user does not match a user name in the Active Directory import, then the user will be
disabled.

Using LDAP Authentication

You can enable LDAP Authentication for Axiom Cost Accounting, so that users are authenticated against
your LDAP server when launching Axiom Cost Accounting.

NOTE: LDAP Authentication is not supported for use with Axiom cloud service systems.

� LDAP Authentication behavior
When the Axiom Cost Accounting login screen displays, users must enter their LDAP user name (with or
without the suffix) and their LDAP password. If the LDAP user namematches a user name in Axiom Cost
Accounting, then the credentials are passed to LDAP for authentication into Axiom Cost Accounting.
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If the LDAP Authentication configuration for Axiom Cost Accounting only allows one LDAP suffix, then
that suffix will be used for all LDAP authentication. The user can include the suffix or not when logging in,
and the Axiom user name can contain the suffix or not. Axiom will automatically append the suffix as
needed when sending the credentials to LDAP for authentication. However, if multiple suffixes are
allowed, then the suffix must be specified using any of the following approaches:

l The user must specify the appropriate suffix using theDomain selection list. This is an optional
login setting that can be enabled for your installation. For more information, see Domain selection
list.

l The user must include the suffix as part of their user namewhen logging in.
l The user names in Axiom Cost Accounting must include the appropriate suffix for each user.

Users must enter their credentials each time they log in, unless they select Remember me to store their
credentials for future use. For more information, see Remember me.

� Setting up LDAP Authentication
The following summarizes the setup process for LDAP Authentication.

To set up LDAP Authentication:
1. LDAP Authentication must be enabled for the system.

LDAP Authentication can be enabled during the Axiom Application Server installation. If it was not
enabled during the installation, you can configure it later using the Configure Authentication
Methods page of the Axiom SoftwareManager. For more information, see the Installation Guide.

When you enable LDAP Authentication, you must specify the connection string to the LDAP
server, as well as a user name and password for the connection. You must also specify the allowed
suffix(es) for user names.

2. In security, Axiom Cost Accounting users must be set up as follows to support LDAP
Authentication:

l The user's Axiom Cost Accounting login namemust match their LDAP login name.

The user name can contain the LDAP suffix or not as desired. Note that the user namemust
include the suffix if there is a naming conflict with another user who is configured with a
different authentication type (or with a different LDAP suffix). For example, if you have an
Axiom Prompt user jdoe, and you have an LDAP user jdoe, then the LDAP user must
include the suffix on their user name to differentiate the two users.

l The user's Authenticationmethod must be set to LDAP Prompt. This is the default setting
for new users if your installation is enabled for LDAP Authentication.

All users who are assigned to the LDAP authentication type will be authenticated by your designated
LDAP directory. This is the only way that these users can log in—they cannot log in using an internal
Axiom Cost Accounting password.
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If you need to test the security settings of an LDAP authentication user, you can use the Log in as
selected user feature to log in to Axiom Cost Accounting as that user. For more information, see Testing
user security.

Using SAML Authentication

You can enable SAML Authentication for Axiom Cost Accounting, so that users are authenticated based
on a designated identity provider (such as Shibboleth or Windows Active Directory Federation Services).
This option is only supported for use with Axiom Cloud Service systems.

� SAML Authentication behavior
SAML Authentication (Security Assertion Markup Language) is a web-based authentication method.
Users access Axiom Cost Accounting by going to the AxiomWeb Client in a browser. Users must enter
their user name and password for their identity provider. Once they are authenticated, if the user name
matches a user name in Axiom Cost Accounting, then the user can access the AxiomWeb Client or install
/ launch the Axiom Excel Client or Windows Client from the web page.

Users assigned to SAML Authentication can only access Axiom Cost Accounting from the web. The Excel
Client and Windows Client cannot subsequently be launched using a shortcut on the user's computer;
the user must continue to log into the AxiomWeb Client in order to start the Desktop Client. When using
SAML Authentication, you may want to configure the Axiom Application Server installation so that no
shortcuts are placed on user computers during the client installation, since users will not be able to use
these shortcuts.

NOTE: SAML Authentication is not supported for use with the iPad app.

� Setting up SAML Authentication
The following summarizes the setup process for SAML Authentication.

1. SAML Authentication must be enabled for the system.

For cloud systems, Kaufman Hall Software Support will enable SAML Authentication for you as
part of the system setup, if that is your chosen authentication method.

2. Complete any additional configuration requirements to enable SAML Authentication.

SAML Authentication requires additional setup steps. These steps differ depending on the
designated identity provider. Please contact Kaufman Hall Software Support for assistance in
completing the SAML Authentication setup.

3. In security, Axiom Cost Accounting users must be set up as follows to support SAML
Authentication:

l The user's Axiom Cost Accounting login namemust match their login name for the SAML
identity provider (with or without an @suffix as appropriate).
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l The user's Authenticationmethod must be set to SAML.

If you need to test the security settings of a SAML Authentication user, you can use the Log in as
selected user feature to log in to Axiom Cost Accounting as that user. For more information, see Testing
user security.

� Logging in as an Axiom Prompt user when SAML Authentication is enabled
You can also set up Axiom Prompt users when SAML Authentication is enabled, such as to allow
Kaufman Hall Software Support to access the system without giving them credentials for the
SAML identity provider. These users must go a special area of the web site in order to log in:

https://ServerName/Axiom/Home/Login

Where ServerName is the name of your Axiom Application Server and Axiom is the name of the
virtual directory.

Using OpenID Authentication

You can enable OpenID Authentication for Axiom Cost Accounting, so that users are authenticated based
on a designated OpenID provider (such as Google OpenID Connect).

� OpenID Authentication behavior
OpenID Authentication is a web-based authentication method. Users access Axiom Cost Accounting by
going to the AxiomWeb Client in a browser. Users must enter their user name and password for their
OpenID provider. Once they are authenticated, if the user namematches a user name in Axiom Cost
Accounting, then the user can access the AxiomWeb Client or install / launch the Axiom Excel Client or
Windows Client from the web page.

Users assigned to OpenID Authentication can only access Axiom Cost Accounting from the web. The Excel
Client and Windows Client cannot subsequently be launched using a shortcut on the user's computer;
the user must continue to log into the AxiomWeb Client in order to start the Desktop Client. When using
OpenID Authentication, you may want to configure the Axiom Application Server installation so that no
shortcuts are placed on user computers during the client installation, since users will not be able to use
these shortcuts.

NOTE: OpenID Authentication is not supported for use with the iPad app.

� Setting up OpenID Authentication
The following summarizes the setup process for OpenID Authentication.

1. OpenID Authentication must be enabled for the system.
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For on-premise systems, OpenID Authentication can be enabled during the Axiom Application
Server installation. If you did not enable it during the original installation, you can use Repair to
change the installation to enable it. For more information, see the Installation Guide.

When you enable OpenID Authentication for Axiom Cost Accounting, you must specify the Client
ID and Client Secret for your OpenID provider.

For cloud systems, Kaufman Hall Software Support will enable OpenID Authentication for you as
part of the system setup, if that is your chosen authentication method.

2. Complete any additional configuration requirements to enable OpenID Authentication.

At minimum, you must configure the OpenID provider with the redirect URI to the Axiom Cost
Accounting login page (such as <URLtoAxiom>/openid/login). Other setup steps may be
necessary, depending on your particular configuration. Please contact Kaufman Hall Software
Support as needed for assistance in completing the OpenID Authentication setup.

3. In security, Axiom Cost Accounting users must be set up as follows to support OpenID
Authentication:

l The user's Axiom Cost Accounting login namemust match their login name for the OpenID
provider, including the@suffix.

l The user's Authenticationmethod must be set to OpenID.

If you are an administrator and you need to test the security settings of an OpenID Authentication user,
you can use the Log in as selected user feature to log in to Axiom Cost Accounting as that user. For more
information, see Testing user security.

� Logging in as an Axiom Prompt user when OpenID Authentication is enabled
You can also set up Axiom Prompt users when OpenID Authentication is enabled, such as to allow
Kaufman Hall Software Support to access the system without giving them credentials for the OpenID
identity provider. These users must go a special area of the web site in order to log in:

https://ServerName/Axiom/Home/Login

Where ServerName is the name of your Axiom Application Server and Axiom is the name of the
virtual directory.

Login behavior options

The following options apply to all authentication types except SAML and OpenID Authentication.

� Domain selection list
When a user logs in, Axiom Cost Accounting looks for a matching user namewithin Axiom security and
applies the specified authentication type for that user. For LDAP Authentication and Windows
Authentication, if only one allowed domain or suffix is specified, that information can be assumed and
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the user does not need to include it when logging in. If multiple domains or suffixes are specified, then
the user must include that information as part of their user name. For example:
DomainName\UserName for Windows Authentication.

Alternatively, you can configure your system so that all users must specify their authentication type /
domain when logging into Axiom Cost Accounting, using theDomain selection list. The Domain selection
list displays the following:

l Axiom Named User (for Axiom Prompt login)
l Each allowed Windows Authentication domain (ifWindows Authentication is enabled for the

installation)
l Each allowed LDAP suffix (if LDAP Authentication is enabled for the installation)

When the Domain selection list is enabled, the user must make the appropriate selection in order to log
in. For example, a Windows Authentication user must select their Windows domain name. Because it is
specified separately, the domain or suffix does not need to be added to the user name, even when there
aremultiple allowed domains or suffixes.

The following screenshot shows an example of the Domain selection list. In this example, the installation
has enabled Windows Authentication with two allowed domains. The two domain names display on the
selection list as well as the choice to log in as an Axiom Named User.

The Domain selection list can be enabled or disabled using the
AuthenticationDomainSelectionListRequired system configuration setting. By default this is set to False,

Administrator's Guide 2019.4 Axiom Cost Accounting │ 548



which means the Domain selection list only displays if your system contains duplicate user names that
require the domain to be specified to differentiate those users. If you set this to True, then the Domain
selection list displays at all times.

If the Domain selection list is enabled, and ifWindows Authentication is enabled for the installation, then
by default the user's current domain will be selected in the list (if that domain is one of the allowed
domains). Otherwise, the first option in the list is selected by default. Options are ordered as follows:
LDAP suffixes, Windows domains, Axiom Named User.

� Remember me
Users can optionally select Remember me at the login screen to store their Axiom Cost Accounting
authentication for future use. This information is encrypted and only applies to the current user for the
current machine. The next time the user starts Axiom Cost Accounting on the current machine, they will
not be prompted to log in.

Although all Axiom Cost Accounting clients have a Remember Me check box on the login screen, note
that the remembered status is stored separately for access to theWeb Client versus the Desktop Client.
For example, a user can choose Remember Mewhen logging into the Excel Client, and then that user will
not be prompted when subsequently accessing either the Excel Client or theWindows Client. However, if
the user attempts to access theWeb Client, they will be prompted for credentials (and can then choose
to be separately remembered for theWeb Client).

NOTE: Logging out of a client will clear the remembered status for that client type. Although the Excel
Client and Windows Client do not have an explicit log out feature, logging out of theWord or
PowerPoint add-in will clear the remembered status for the Desktop Client (but only if you are not
also currently logged into another instance of the Desktop Client).

If you do not want users to have access to the Remember Me option, so that they must log in each time,
then you can disable the feature by setting the system configuration setting ShowRememberMe to
False. This will hide the option from the various login screens. Keep in mind that if a user has already
used the Remember Me option, hiding the setting will not clear the user's stored credentials. The user
will continue to be remembered until they log out and cause their credentials to be cleared.

Filters
This section contains reference information for creating filter criteria statements. Security settings for file
groups and tables can use filters to determine access.

Filter criteria syntax

Several areas of Axiom Cost Accounting use criteria statements to define a set of data. The syntax for
these criteria statement is as follows:

Table.Column='Value'
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l Table is the name of the database table.
l Column is the name of the column in the database table.
l Value is the value in the column.

If the column is String, Date, or DateTime, the valuemust be placed in single quotation marks as shown
above. If the column is Numeric, Integer (all types), Identity, or Boolean, then the quotation marks are
omitted.

For example:
l To filter data by regions, the filter criteria statement might be: DEPT.Region='North'. This

would limit data to only those departments that are assigned to region North in the Region
column.

l To filter data by a single department, the filter criteria statement might be: DEPT.Dept=100. This
would limit data to only department 100.

If the table portion of the syntax is omitted, then the table is assumed based on the current context. For
example, if the filter is used in an Axiom query, then the primary table for the Axiom query is assumed. If
the current context supports column-only syntax, and the specified column is a validated key column,
then the lookup table is assumed.

� Operators
The criteria statement operator can be one of the following: =, >,<,<>,<=,>=. Greater than or less than
statements can only be used with numeric values. For example:

ACCT.Acct>1000

SQL IN and LIKE syntax can also be used. For example:
DEPT.Region IN ('North','South')

� Compound criteria statements
You can use AND and OR to combinemultiple criteria statements. If you are creating long compound
criteria statements with multiple ANDs or ORs, you can use parentheses to group statements and
eliminate ambiguity. For example:

(DEPT.Region='North' OR DEPT.Region='South') AND (ACCT.Acct=100 OR
ACCT.Acct=200)
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NOTES:
l When filtering on multiple values in the same column, you must use OR to join the

statements, not AND. In the example above, if the statement was instead
DEPT.Region='North' AND DEPT.Region='South', that statement would return no
data because no single department belongs to both the North and South regions. When you
use OR, the statement will return departments that belong to either the North or the South
regions.

l Alternatively, you can use the SQL IN syntax to create a compound statement for values in the
same column. For example, the statement DEPT.Region='North' OR
DEPT.Region='South' can also be written as DEPT.Region IN ('North','South').
The Filter Wizard uses IN syntax by default.

� Using criteria statements in functions
If you are using a criteria statement in a function, such as GetData, you must place the entire criteria
statement in double quotation marks. For example:

=GetData("Bud1","DEPT.Region='North'","GL1")

You can also place the criteria statement in a cell and then use a cell reference in the function. In this
case, you do not need to use double quotation marks in the function, unless you are concatenating text
and cell reference contents within the function.

� Referencing blank values in filters
If a string column contains a blank value, you may want to create a filter that includes or excludes records
with these blank values. For SQL Server, the blank value is stored as an empty string. This empty string is
indicated with empty quotation marks in the filter. For example: ACCT.CMAssign='' or
ACCT.CMAssign<>''

If you use the Filter Wizard to construct the filter, it will automatically use the appropriate syntax.

� Referencing values with apostrophes in filters
If a string column contains a value with an apostrophe (such as O'Connor), then that apostrophemust
be escaped with another apostrophe so that it is not read as the closing apostrophe for the filter criteria
statement. For example:
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Dept.VP='O'Connor'

Invalid. This construction does not work because Axiom Cost Accounting reads it as Dept.VP='O'
and then does not knowwhat to do with the rest of the text.

Dept.VP='O''Connor'

Valid. The extra apostrophe tells Axiom Cost Accounting that the apostrophe is part of the string
value and is not the closing apostrophe.

NOTE: This syntaxmust use two apostrophe characters in sequence and not a double
quotation mark. If you create the filter using the Filter Wizard, Axiom Cost Accounting will
construct the appropriate syntax for you.

� Referencing Date or DateTime values in filters
If your locale uses a date format where the first value is the day, filters using that date or date-time value
will not process correctly. Instead, the date or date-time valuemust be in standard format. Standard
format is YYYY-MM-DDTHH:MM:SS for DateTime and YYYY-MM-DD for Date.

If you use the Filter Wizard to construct the filter, it will automatically convert the date or date-time value
to the appropriate syntax.

Filter variables

Axiom Cost Accounting provides a set of filter variables that can be used in filter criteria statements
throughout the software. Currently, these variables allow filtering based on the current user.

For example, you may have a column on a plan code table such as Dept.Owner, which contains user
login names. When setting up plan file filters in security, you want each user to have a filter such as
Dept.Owner='UserName'. Without using variables, you would need to set up each user with a user-
level filter such as Dept.Owner='JDoe', Dept.Owner='RSandstone', and so on. With variables, you
can instead set up a single role-level filter such as Dept.Owner='{CurrentUser.LoginName}'. For
each user in the role, this filter will be resolved using that user's login name.

Filter variables can be used in any place that takes a filter criteria statement. For example, you can use
the variables to impact data queries in places such as Sheet Filters, Axiom query filters, Web Report data
source filters, Quick Filter, and GetData functions. You can also use the variables in utilities such as
Process Plan Files and Create Plan Files.

To use a filter variable, place the variable in curly brackets within the filter criteria statement. All other
filter rules still apply—for example, if the variable will resolve to a string value such as a user name, the
variable must be placed in single quotation marks. The filter must result in a valid filter criteria statement
once the variable is resolved to its current value.

Administrator's Guide 2019.4 Axiom Cost Accounting │ 552



Variable Resolved Value

{CurrentUser.EmailAddress} The email address of the current user.

{CurrentUser.FirstName} The first name of the current user.

{CurrentUser.LastName} The last name of the current user.

{CurrentUser.LoginName} The login name of the current user.

{CurrentUser.PrincipalID} The database ID of the current user.

{CurrentUser.QualifiedLoginName} The qualified login name of the current user
(domain\username). If the user does not have a defined
domain, the regular login name is used.
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